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Copyright 
This documentation is protected by law. All rights, especially the right to duplicate, 
circulate, and translate, are reserved. 

No part of this publication may be reproduced in the form of copies, microfilms or 
other processes, or transmitted into a language used for machines, especially data 
processing machines, without the express written consent of the publisher. 

All copyrights reserved. 

All other product names are trademarks of the corresponding manufacturers. Errors in 
and changes to the contents as well as program modifications reserved. 

Copyright © MAGIX Software GmbH, 2001 - 2012. All rights reserved. 

MAGIX is a registered trademark of MAGIX AG. 

Created under license from Dolby Laboratories 
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Other named product names may be registered trademarks of their respective 
owners. 
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Preface 
Congratulations! You have purchased a complete, fully-equipped, yet easy-to-use 
video studio! 

The possibilities are endless - from quick holiday video editing to demanding and 
detailed advanced film editing. MAGIX Movie Edit Pro 2013 also offers: 

• Recording and import of all standard video formats 
• Video and audio content optimization 
• Possibility of adding fades, titles and effects 
• Disc menu creation for DVD, Blu-ray Disc and others 
• Upload videos to the Internet, e.g. to YouTube or Facebook 

This manual contains the functions of both program versions MAGIX 
Movie Edit Pro 2013 and MAGIX Movie Edit Pro 2013. Additional features of the 
Plus/Premium version are marked accordingly. 
 
This information will get you started on your way to making your first movie 
masterpiece. The reference chapter later on and the index can also be used to help 
quickly when you need it. 

Enjoy! 

Your MAGIX Team 
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Support 
Dear MAGIX customer, 

Our aim is to provide fast, convenient, solution-focused support at all times. To this 
end, we offer a wide range of services: 

• Unlimited web support: 
As a registered MAGIX customer, you have unlimited access to web support 
offered via the convenient MAGIX service portal on http://support.magix.net, 
including an intelligent help assistant, high-quality FAQs, patches and user 
reports that are constantly updated. 
The only requirement for use is product registration at www.magix.com 

• The online community, on-the-spot support and a platform for exchange: 
MAGIX customers have free and unlimited access to the online community at 
www.magix.info, which includes approx. 150,000 members and offers the 
opportunity to ask members questions concerning MAGIX products as well as 
use the search function to search for specific topics or answers. In addition to 
questions & answers, the knowledge pool includes a glossary, video tutorials and 
a discussion forum. The multiple experts, found round-the-clock at 
www.magix.info guarantee quick answers, which sometimes come within 
minutes of a question being posted.  

• Email support for MAGIX products:  
For every new MAGIX product you will receive, as of date purchase, 12 months of 
email based customer service. 
Premium email support: 
For priority support, or if you want the MAGIX support team to help with non-
MAGIX related hardware problems you can purchase a Premium email support 
ticket. Log in at http://support.magix.net and click on "Purchase access code", 
the ticket is for a specific problem, and is valid until it is solved, it is not restricted 
to an email. 

Please note: To be able to use the Premium email support and free product email 
support via the Internet, you have to register your MAGIX product using the serial 
number provided. This can be found on the CD case of your installation CD or on the 
inside of the DVD box. 

• Additional telephone service: 
Besides the large number of free customer service offers, we also offer a fee-
based telephone customer service. 

Here you can find a summary of our technical support telephone numbers: 
http://support.magix.net/ 

Mail (Europe): MAGIX Development Support, P.O. Box 20 09 14, 01194 Dresden, 
Germany 
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Mail (North America): MAGIX Customer Service, 1105 Terminal Way #302, Reno, 
NV 89502, USA 

Please make sure you have the following information at hand: 
• Program version 
• Configuration details (operating system, processor, memory, hard drive, etc.), 

sound card configuration (type, driver) 
• Information regarding other audio software installed 

MAGIX Sales Department 

You can reach the MAGIX Sales Department workdays for help with the following 
questions and problems: 

• Orders 
• Product consulting (pre-purchase) 
• Upgrade requests 
• Returns 

Europe 
Monday - Friday, 09:00-16:00 GMT 

U.K.: 0203 3189218  
Denmark: 45 699 18763 
Sweden: 46 852 500713  
Finland: 35 89 42419023 
Norway: 47 210 35843 

North America 
9 am to 4 pm EST Mon-Fri 
Phone: 1-305-722-5810  
 

Uninstalling the program 
If you would like to uninstall MAGIX Movie Edit Pro 2013, you can do this in the 
control panel under "Software" or go to "Programs > MAGIX > MAGIX Movie Edit 
Pro 2013 > Service and Support > Uninstall MAGIX Movie Edit Pro 2013". 
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Serial number 
A serial number is included in each product. This serial number is required for the 
installation of the software and enables usage of additional bonus services. Please 
store this number in a safe place. 

What can a serial number do? 
With a serial number your program is clearly assigned to you and only you. This will 
allow you take advantage of the free email support service. Serial numbers also help 
to protect against software piracy which ensures that we are able to continually 
provide our customers with an optimal price/performance ratio. 

Where can the serial number be found? 
The serial number can be found on the reverse side of your CD/DVD case. If your 
product is packed in a DVD box, you'll find the serial number on the inside. 

If you have purchased the download version, you will receive a confirmation email 
with the serial number. 

When will you need the serial number? 
The serial number is required when you start or register the program for the first time. 

Note: We explicitly recommend registering your product (free), since only then are 
you entitled to download updates and to use MAGIX support services (view page 
10) or activate codecs (view page 289). 
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Introduction 

What is MAGIX Movie Edit Pro 2013? 
MAGIX Movie Edit Pro 2013 is a complete all-in-one movie studio for your PC. With 
MAGIX Movie Edit Pro 2013 you can easily transfer your recordings to your computer 
and then, once you have improved and enriched them, burn them onto DVD, AVCHD 
or Blu-ray™  – perfect for theater-quality presentation on TV, screen, or monitor. 

Videos, photos, as well as additional audio and video material can be transferred from 
various devices to the PC. Long movies can be separated into chapters or scenes 
automatically. You can also do the opposite and automatically combine individual 
recordings to make a single movie. 

Add music, theater-quality transitions, text and selected effects to your own movies 
with a mouse-click. The easy-to-use interface, advanced technology and handy 
wizards guarantee perfect results at lightning speed! 

Once your video is finished, you can use it in different ways: transfer it back onto the 
tape or to your camcorder. You can burn it to disc and watch it, for example, on TV. 
Or, you can upload your video to Internet platforms such as YouTube, Facebook or 
your own personal MAGIX Online Album. 
 

What's new in MAGIX Movie Edit Pro 2013? 
• Improved timeline display with video and audio in one track. 
• Support of the new video standard AVCHD Progressive (50p) 
• Accelerated AVCHD export with automatic graphics card recognition (NVIDIA 

GeForce 8000 series and better (CUDA) or AMD Radeon 5000 series and 
better (OpenCL) or integrated graphics with Intel Quick Sync Video) 

• Improved user interface with quick access features. 
• High-quality decorative elements and intro/outro templates. 
• Fast and direct GPU calculation of all essential video effects. 
• New Chroma Key Engine for perfect object extraction. 
• Import of QuickTime interlaced footage. To use this feature open the "Object 

properties > Intermediate image calculation" and activate "Automatic interlace 
processing" and then "Interlace top field first" or "...bottom field first". 
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Additional features new in the Plus/Premium 
version 
• New templates for professional movie trailers including music. 
• Preview rendering for stereo 3D and multicam projects. 
• Automatic synchronization of multicam projects using the audio track. 
 

Additional programs 
On the MAGIX website you'll find many additional programs you can use with 
MAGIX Movie Edit Pro 2013. Have a look at the sections "Video > Additional 
Products" and "Free Downloads". 

In the "Free Downloads" section you'll find the Videorekorder, a PC TV with video 
recorder. You can use it to watch and record TV programs on your computer. A 
functional TV card/TV tuner box or DVB-T/S card is required to use Videorekorder.  
 

Features 
Recording 
MAGIX Movie Edit Pro 2013 features the following recording options: 

• AVCHD camera 
• HDV cameras: HDV1 and HDV2 camcorders 
• DV cameras: Mini DV camcorders or DV video recorders 
• Video: Analog TV, video input, VHS recorders, webcams 
• Audio: Microphones, cassette recorders, MiniDisc players, turntables 
• Screen (Plus/Premium version):  PC monitor. 
• Single frame: Single and series images from webcams, video recorders, video 

cameras, or TV cards 

Analog capture requires capture cards compatible with DirectShow. DV recording 
take place via FireWire. 
 

Import and export formats 
Supported import formats  
Video: AVI, DV-AVI, MPEG-1, MPEG-2, MPEG-4, MTS, M2TS, MXV, MKV, MJPEG, 
QuickTimeTM, WMV(HD), VOB, MKV 

Audio: WAV, MP3, OGG, WMA, MIDI, Dolby Digital Stereo/5.1 (Classic version: 
downmix to stereo) 
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Images: JPEG, BMP, GIF, TIF, TGA 

Supported export formats 
Video: AVI, DV-AVI, MPEG-1, MPEG-2, MPEG-4, MXV, MJPEG, Quicktime, 
WMV(HD) 

Audio: WAV, MP3, Dolby Digital Stereo/5.1 (only Plus/Premium version) 

Images: JPEG, BMP 

Note: For copy protection reasons, MPEG-4, MPEG-2, and Dolby Digital Stereo 
must first be activated. Initial activation is free of charge. MP3 export requires 
installation of Windows Media Player version 10 or higher. Online Services offered 
inside the program as well as the Online Update require an Internet connection. 

 

Editing 
• Picture optimization: Color improvement (RGB,saturation), sharpness (focus and 

feathering), brightness regulator (brightness, contrast), anti-flicker filter. 
• Sound optimization: The equalizer allows you to manipulate the frequency 

spectrum – perfect for cleaning-up muffled dialog. The compressor is a dynamic 
volume regulator. The StereoFX processor controls the position of the sound 
within the stereo panorama. The denoiser and dehisser are professional noise 
reduction tools for removing noise and hisses. 

• Video effects: For example, creative filters, distortion, video mix (Chromakey), 
movement effects (e.g. camera/zoom or rotation), cropping, picture-in-picture 
collages, video effect plug-in support. 

• Automatic scene detection 
• Slideshow Maker turns drab photo collages into spectacular multimedia shows. 
• MAGIX Soundtrack Maker offers a huge selection of fitting sounds for your 

background music. 
 

Burnable disc formats 
• DVD 
• Blu-Ray disc 
• AVCHD disc (on DVD and Blu-ray Discs) 
• MultiDisc (DVD + WMV HD) 
• Project backups, backup copies, and 1:1 copies of DVDs 
 

Multimedia editable disc menus 
Included are many disc menu templates which offer selection options for movies and 
chapters on the screen. Many of these are also available in 16:9 format. They can be 
included during burning and give the disc a professional appearance. 
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Every menu template may be customized with personal photos, thematic animations, 
3D captions, sound, intro videos, etc. 
 

Also in the Plus/Premium version 
Professional video editing 

• 99 tracks, editing & effects automation 
• Live preview, MultiCam editing  

Unique effects creation 

• Chroma keying with alpha channel 
• Movie templates, fades with sound, title editor 

Perfect audio dubbing 

• Create Dolby®Digital 5.1 Sound yourself, restore audio tracks 
• Audio Mastering Suite, Soundtrack Maker  

DVD / Blu-ray design 

• Professional menu design, ISO output  

Full stereo3D support 

• Full support for stereoscopic footage 
• Full import functions for many 3D camera models 
• Editing of own 3D recordings made, for example, with two cameras 
• Real 3D fades and titles for 3D video projects 
• Preview and output to all standard 3D display devices 
• Output in all formats (DVD, Blu-ray, file, YouTube, etc.) 
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Quick start 
This chapter explains the basic functions of MAGIX Movie Edit Pro 2013 with a step-
by-step introduction. A systematic description of all program functions can be found 
in the following chapters. 

Tip: Use the online tutorial videos that can be accessed in the "Help" menu. This 
feature requires an Internet connection. 

The program keyboard shortcuts (view page 279) for commonly used processes 
and functions are also very helpful. 

 

Program start 
Once you have installed MAGIX Movie Edit Pro 2013, start the program from the 
Windows start menu. The following dialog opens: 

 

Here you can decide if you want to "Load an existing project" for further editing and 
burning to disc or if you want to "Create a new project". 

In „Options“ you can  „Create a new project folder“. All of the files for that film will be 
saved as copies in this folder and used for editing. This option is meant to keep things 
centralized when files from various media, e.g. hard drives, USB flash drives, SD cards, 
are being used in one project. The internal hard drive is the best option for working on 
projects in MAGIX Movie Edit Pro 2013 because it allows faster access to files 
compared to external storage devices. If files stored on external devices are used it 
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can lead to delays and stutters during project editing. You can create a backup of the 
project folder at a later time. 

In „Movie settings" you can set up the target format for your movie you want to 
create (display norm, resolution, frame rate). This setting has no effect on the internal 
processing quality and can be changed at any time by going to "File > Settings > 
Movie" (view page 55). 

Note: If your hard drive is partitioned, you should not save your project folder in C, 
i.e. where Windows is installed. MAGIX Movie Edit Pro 2013 requires a lot of space 
and there may not be enough room on C for it to function properly. 

In MAGIX Movie Edit Pro 2013 you can also use movie templates (view page 185). 
Movie templates are have preset placeholders and elements that are very helpful for 
creating stories in various themes. 

You can watch the introductory video to get a general idea of how MAGIX Movie Edit 
Pro 2013 works. 
 

Import video 
In the following we assume that you want to import an AVCHD recording into the 
program.  

Tip: Pay close attention to which folders you use to save your files and footage so 
you can find them again easily to import and edit them in MAGIX Movie Edit Pro 
2013. Do not save files in C:\Windows\ or in program folders. Give your files and 
folders short, concise names. 

If you don't have such a recording at hand now, you can load material form the hard 
disk in order to try out the MAGIX Movie Edit Pro 2013 workflow. Here the included 
demo project is recommended.  
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• In the Media Pool, click the button "My Media > 
Projects".  

• Next, open the "_Demo" folder by double clicking 
and then load the MVP movie files.  
( „_Demo.MVP“) by double clicking. 

Note: If you import media to a project, MAGIX Movie Edit Pro 2013 must always 
have access to these files. This means that you cannot rename these files, e. g. in 
Windows Explorer or Media Pool, if they have already been imported because 
MAGIX Movie Edit Pro 2013 won't be able to find them. Renaming or relocating files 
can lead to error messages and you will have to indicate the files and folders again. 
For larger projects this can be a very complicated and time-consuming process. 

 

Insert AVCHD material 
• Connect your AVCHD storage devices (camera, USB stick, SD card and others) 

to your PC. You may have to first turn your camera on. 
• To open the recording dialog, click on the red "Record" button below the preview 

monitor. 
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• Select "AVCHD" from the recording dialog. 
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• The AVCHD import assistant will then open. Select your connected storage 
devices as "Video source". A file list will appear. 

 

• In the file list, select all the recordings that you've imported from the device. 
• You can preview all your recordings using the preview monitor in the middle of 

the dialog in order to decide if they are suitable for your movie.  
• After selecting all videos, in "Import options" you can select whether the 

recordings should be directly placed into your movie project or simply copied to 
your computer's hard drive (you can select the location in the next dialog). You 
can also automatically delete your recordings after import. 

 

Play movie 
• To play the recording ( or the demo project), click on the play button 

on the transport control below the preview monitor.  

Tip: An even easier way to control playback is by pressing the space bar on your 
keyboard. 

During playback, a vertical line will move across the arranger, i.e. the playback marker 
that displays the current position. You can reposition it by clicking at different 
locations as desired. 
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Media Pool 

 

The Media Pool can be used to access and load media files of all kinds: videos, photos, 
MP3 files, audio CD tracks, fades, effects and Internet media, e t c.  

• Search your computer for media you would like to use. The navigation buttons for 
the various drives and folders are located in "Import" above the main display area. 

If you hover the cursor over a media file, three icons for the options (Preview, Trim, 
Import) will appear. 

• Preview: All media files can be played back using this function. If you click on the 
playback icon, the file will be played back in the preview monitor. Video and 
image files are displayed and audio files are played back through the sound card. 
There are previews for the templates and effects included to make it clear how 
they will function.  

• Trim: If you want to include only certain part of a video clip in your project, you 
can click on the Trim icon with the curved brackets. The video clip will then 
appear in the preview monitor. Use the brackets to mark the area you want to 
import on the timeline. Drag & drop the video from the preview monitor into the 
project by clicking on it and holding down the mouse button. Only the area 
marked by the brackets will be imported as a video object. 

• Import: All media files from local drives or the Internet can be dragged and 
dropped into the project or loaded through the Import icon. 

Tip: Improve access to your media folder by creating a link in the "Import" area of 
the Media Pool. You can do this by right-clicking on one of the entries and selecting 
"Create link". Select the media folder and click "OK" to confirm. 
Note: All links are automatically deleted if the function "Reset standard program 
settings" is used. 
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Display modes 
The three switches on the toolbar in the center activate the "Timeline", "Storyboard", 
and "Scene overview" modes (there are 4 switches and 4 modes available in the 
Plus/Premium version). 

 

Storyboard mode (first button) is the preset view. 
This view offers an easy, streamlined interface to 
simplify the editing process. All scenes from your 
film are listed sequentially in the "Storyboard" 
mode. Every scene is displayed with a preview 
picture in the storyboard. 

The scene overview (second button) provides a 
scaleable overview of the scenes. You can use 
this to comfortably view, sort, and delete 
unnecessary scenes.  

In the Timeline mode (third button) your films are displayed as "Objects" in the 
"Timeline". This means: The longer the object, the longer the corresponding film. 

Especially practical: you can display all modes in full screen using the button at the 
top right. 

Multicam mode is found under the fourth button in the Plus/Premium version of 
MAGIX Movie Edit Pro 2013. Multi-cam editing enables easy cutting of various 
recordings of the same scene from different camera perspectives. 
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Storyboard mode 

 

"Storyboard" mode represents all scenes in linear sequence on the storyboard. Each 
scene offers the following editing options: 

 
Add title and text: Titles and text can be added to any film. Click on the "T" 
button, enter your text directly in the program monitor and select from 
different animations (try movement from bottom to top for a classic end 
credits effect). 

 
Set volume: The volume in each scene can be set via the loudspeaker 
button. 

 Effects menu: This switch accesses a menu with different editing functions 
like scene recognition, image stabilization, or the trimmer dialogs. The 
hissing on the track can be minimized by selecting "Audio cleaning". 

 
Transitions/Fades: Click on the large button between the scenes and select 
a scene transition (or "Fade"). 

 
Rotate image (only with image files): If an image or photo is on its side or 
upside down, click on this button. The photo will rotate 90 degrees. 
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Timeline mode 

 

All advanced editing functions should be undertaken in "Timeline" mode. Your movies 
and scenes are shown here: The longer the object in the track, the longer the 
corresponding movie. 

Playback range: Clicking in the range bar above the first track lets you define start 
markers, i.e. the starting point of the playback range. If you right click further on, the 
end marker will appear to indicate the end point of the playback range. The length of 
the playback area is shown in the center of the section display. 

 

• When the end marker has been reached, the playback cursor jumps back to the 
start marker and begins playing everything again as a loop. 

• The entire playback range can be moved using the mouse by clicking on the bar 
in the middle and dragging it. The in and out points can be moved with the 
mouse. Left clicking positions the in point, and the right mouse button sets the 
out point. The playback range above the first track is linked to the playback range 
of the preview monitor. Both can only be changed simultaneously 

• To move the start and end markers to the beginning and the end of the film again, 
click "Optimize movie view" in the "Window" menu. 

Handles: All objects can be shortened by moving the mouse to one of the lower 
corners of the object until it turns into a stretch symbol. Move the mouse over one of 
the lower corners of the object until the mouse pointer becomes a stretch symbol. At 
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the top corners of every object, you’ll find two fade handles that can be adjusted to 
fade an object in or out. The handle at the top center can be used to adjust the volume 
of audio objects and the brightness of video objects. 

 

Object selection: For advanced effects editing, the objects must be selected first. 
Each object can be selected by clicking it. Objects will change color to show that they 
have been selected. Multiple objects can be selected by holding down "Shift". You can 
also click and drag out a rectangle to select multiple objects. All objects included in 
the rectangle will be selected. 
 

Removing unusable scenes 
One of the most important steps during import of your footage is cutting out unusable 
scenes from the material. There are two options in this case: 

• Option 1: First, the complete material is loaded into your project and the unusable 
scenes are cut out.   

• Option 2: You can cut the material already in the Media Pool, i.e. BEFORE you 
import it, and then proceed to import only the scenes you need. This process is 
recommended for long movies with a lot of editing. 

 

Cut videos in the project 
Let's assume that you have already imported your film material into a project and 
would now like to edit it. 

• Play your video by clicking on the up arrow on your keyboard. 
• Pause playback at the position where the scene is located by pressing the 

downward arrow. The playback marker stays near the start of the scene to be 
removed. 

Note: You can also use the space bar or the play button on the transport bar to start 
and stop playback. However, in order to move the playback marker to the position 
where you stop the playback, you must first go to program settings (File > Settings > 
Program) in the "Playback" tab under "Space bar behavior" and select the "Space bar 
stops at current playback position" function. 
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Tip: In case of long films or to speed up search, you can also fast forward the video 
following the action on the preview monitor. To do so, pull the playback marker 
across the timeline (but not too fast!) while holding down the mouse key. 

• Set the playback marker exactly at the start of the unusable material. The zoom 
function is recommended to get a better view of longer videos (the +/- buttons in 
the bottom right corner). 

 

• Press "T" on the keyboard. This will split the current scene into two sections at 
the position of the playback marker. 

• Repeat these steps for the end of the unusable scene. Find the end of the 
unusable scene, place the play marker as close as possible to the end point, and 
then press the "T" key on the keyboard again. 

 

• Now you have "isolated" the unusable scene and may delete it from the movie 
using the "Del" key on the keyboard. Before this, the scene must be selected by 
clicking it with the mouse. 
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• If you didn't work accurately during cutting, then don't worry; you can use the 
lower object handles to stretch or shorten the remaining objects to recover or 
exclude material from the deleted section. 

 

• After deletion a gap will appear in the film sequence at the position of the 
removed material. How do you remove gaps out of the film? Easy: Pull the later 
scenes up to the earlier scenes until they "dock" with each other. Remember to 
"take" all objects that are further behind, otherwise the gap will just be "passed" 
to the end. To pull up later objects, use the "All tracks" mouse mode, since this 
automatically takes all the objects found later on the timeline along with the 
object being pulled. 

 

Note: If your project has a sound track next to the image track, it is usually 
necessary to cut audio and video tracks in synchronization. After import from the 
camera, video and sound tracks are automatically grouped, which is why all cutting 
and moving actions have an effect on video and sound tracks simultaneously. 
However, if you have added a separate soundtrack which has not yet been grouped 
with the image sequence, then you should group them before starting to edit.  

 
To do so, select the video object and the audio object via "Ctrl" + click, and in 
the "Edit" menu select the "Group" option (or click the group tool). 

Go ahead and experiment with the editing functions in all processes (and all other 
editing operations in MAGIX Movie Edit Pro 2013), the original material on your hard 
disk is not changed. 
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Importing individual scenes from longer movies 
If you have saved a longer video as a file on your hard disk and only want to use a 
section of it for your project, you can proceed as follows: 

• Select the file in the Media Pool and click on the Trim icon in the middle of the 
features that appear above the file. 

• Now you can play the selected file in the Media Pool using the transport control. 
Find the area you want to import. Position the play marker above the transport 
control at the start position of the range and click the "Set in point" button. 

 

• Next, position the playback marker at the end of the section and click the "Set 
out-point" button. 

 

• The currently selected range appears as a blue bar in the range display. You can 
play back this range separately with the "Range playback" button.  

 

• All range limits can be moved by holding down the mouse button and dragging. 
Once the range matches the section that you want to import, click on the preview 
image in the monitor and drag it onto the track. An object will appear, 
corresponding to the selected area. 
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Regroup scenes 
It will often be the case that you will want to move whole scenes or even groups of 
scenes to a different place within a film. This happens completely intuitively: Single 
scenes can be selected in any view ("Timeline", "Storyboard" or "Overview" modes) 
using just a mouse-click, and then moved to the desired spot with the mouse button 
held down. In the "Timeline" and "Overview" modes you can also create scene groups 
which can be moved together: "Ctrl + mouse-click" lets you select more than one 
scene, "Shift + mouse-click" selects the scenes that lie in between. 

Three final tips for advanced video arranging: 

• Using "Intelligent mouse" mode, which is available in the "Timeline" mode, you 
can move not just the selected scene, but also all elements directly bordering it 
(e.g. transitions, fades, and scenes following the selected scene and those on 
neighboring tracks). 

• The commands "Group (view page 251)" and "Ungroup (view page 252)" let you 
join any scene into groups which can then be moved together as a block. 

• If editing and moving scenes left your project looking like a junkyard, then you 
can also work in the opposite direction by selecting the scenes you want to use 
and saving them to the Media Pool directory. Collect scenes that you want to use, 
place them into the "Takes" folder, start a new project, take scenes from that 
folder, then place them in the second project in the order you want them. The 
"Takes" folder can be accessed in the Media Pool via the "Import -> My Media" 
button. 
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Burn DVDs with interactive menus 
Once you are satisfied with your video, move to the "Burn CD" screen to burn it with 
an interactive DVD menu onto a disc. 

 

• If you simply want to burn a DVD the quickest way 
possible, then click the button to burn a DVD. 

For multiple films that are subdivided into individual scenes or chapters, the DVD 
selection menu becomes even more important. This is because you require 
manageable navigation to be able to jump between each film and each scene. 

 

The "Burn" screen has two views: "preview" an "Edit". Use the buttons located in the 
upper left to switch between them 

In both views, you will see a preview of the DVD menu. All movies appear as 
uppermost entries, and all scenes appear as sub-entries. 

You can use the remote control to the right to test the function of the menus just like 
in a real DVD player. 

In the "Edit" view you can access the structure of the selection menu in "Navigation". 
You can delete unnecessary scenes by clicking the corresponding box. The entry will 
be removed from the menu, but the scene will not be removed from the movie. 
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To make sensible chapter divisions in your movies, each movie must feature 
corresponding chapter markers in the "Edit" window. If you want to change the 
current scene splits, it is best to switch back to the "Edit" screen and then choose the 
movie which you would like to split. Place the Start marker where you'd like to have it 
and choose the option "Chapter marker" from the Edit menu (keyboard shortcut: Shift 
+ Enter). If you select the option "Automatic Chapter markers", a Chapter marker is 
automatically placed at the beginning of every scene. Superfluous chapter markers 
may simply be clicked and deleted. 

If you are satisfied with the subdivision of the movies and chapters, you can devote 
yourself to the layout of the selection menu.  

At the bottom of the screen, you'll see an array of preset menu templates. Use the 
scroll bar to view each template. There are plenty to choose from: 

• If you wish to fully apply a template, first click on "Layout" in the template bar 
and double-click on the template of your choice. The complete template will then 
be applied. 

• In the "Edit" view you can also combine various elements of individual templates 
with one another. For example, if you want to combine the text format of a 
template with the background of another one, then select "Font" first and double 
click the template with the text of your choice. Then select "Order" and double 
click the order you like. The preview in the middle shows you the results 
immediately. 

• Double click the preview picture or a menu entry to change the film or chapter 
name and select a different preview picture. 

When all videos and chapters (scenes) are logically arranged and you are satisfied 
with the selection menu, you can go ahead and burn. 
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Workspaces 

Projects, movies and scenes 
MAGIX Movie Edit Pro 2013 works with "Projects", "Movies", and "Scenes". In order 
to work quickly and intuitively, is it important to know the differences between these 
three hierarchically-ordered terms. 

Project A "Project" includes everything that you want to include on a disc. 
Normally this means one or more movies and a menu structure for 
selecting movies for playback. Projects can be saved as "MVP" files on 
your hard drive and can be loaded later to do further editing to the 
movies. 

Movie A "Movie" can be one single video clip or a combination of clips and 
photos. It can also include music, titles, transitions and much more.  
Each movie can be exported individually as a video. The "project" can be 
considered a type of drawer into which you can put multiple movies that 
will be edited together and burned to the same disc. 

Scene: Scenes are the main components of a movie. They may contain 
integrated photos that are displayed as still shots or animated images. 
Along with photos and videos, a movie has many other elements such as 
titles, transitions, decorative elements, music, voiceover commentary 
etc. 

Summary: „Projects“ contain „Movies“ and „Movies“ contain „Scenes“. When you 
burn a disc, the movies of a project appear as menu items and the scenes are the 
menu items for each movie. 
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"Edit" screen 
 

 

1 Upper toolbar: These are the buttons for quick access to important commands. 

2 Menu bar: This contains important MAGIX Movie Edit Pro 2013 functions. 
3 Preview monitor: Video and image objects are displayed and files from the 

Media Pool can be previewed here. 
4 Media Pool: Here you'll find your hard drive content and the areas for transitions, 

titles and effects. Using the "Import" navigation buttons you can access all of the 
folders on your PC. 

5 Content: Various content will be displayed depending on which area of the 
Media Pool you are in. You can preview templates or import media to your 
project. In the "Effects" area you can fade in the effects to create effect curves. 

6 Modes:  
• Storyboard mode displays all scenes in the current video in a panel so that 

they can be easily manipulated and arranged.  
• Timeline mode is for more involved arrangement and effects work.  
• Overview mode displays all of the objects on the first track and enables 

quick sorting of scenes.  
• The right button activates Multicam mode in the Plus/Premium version. 

7 Lower toolbar: Select the "Timeline" or various different mouse modes for 
diverse editing functions. 

8 Timeline with range markers: Defines the range that will be played. It is 
equipped with a time scale. 

9 Arranger: Drag & drop files from the Media Pool, then arrange and edit files in 
detail here. 
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10 Scroll bars: The lower scroll bars can be dragged apart and pushed together for 
zooming with the mouse.  The right scroll bar zooms into the tracks vertically. 
Click on the edge of the scroll bars while holding the mouse button to change the 
visible part in the arrangement window. 

 

Project management 
The "Edit" area can be used for editing films and also for managing your projects, i. e. 
here you can sort the order of the movies, add new movies, remove existing movies 
from the project or rename the movies.  

Each film in a current project can be controlled through its own tab above the tracks. 

 

To rename, sort, load or delete movies, the easiest way is to right-click on one of the 
tabs. You can then select the action you want from the context menu that appears. 
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The "Burn" screen 

 

1 Menu preview: Here you can see a selection menu preview. For more 
information, read the "Edit disc menu" (view page 234) chapter. 

2 Switch views: Here you can switch between preview and edit views. 
3 Remote control: Here you can check how your future disc will react when you 

press the buttons of your player's remote control. 
4 Output:Before burning the project, select the desired format (view page 223). 

5 Play preview: Play the preview menu and test how it works with the remote 
control.  

6 Template category: Select the desired section from various categories with 
different menus. 

7 Menu templates: Switch between different templates for designing your menus. 
8 Use templates: Here you can select whether a template should be assigned to a 

page, the menu or all menus on a disc. 

You will find more information in the "Burning" (view page 212) section. 
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Toolbars 
Upper button bar 

 

The upper button bar can be found in the monitor to the top left. It has the following 
functions: 
 

New project 

 
Creates a new MAGIX Movie Edit Pro 2013 project. A dialog with settings for a 
new disc project or a new film opens to get started. 

Keyboard shortcut:  Ctrl + N 
 

Load project 

 With this option you can load a project or a media file. Please note that all 
media files associated with it must be loaded along with a project. MAGIX 
Movie Edit Pro 2013 will search for all used sounds and video files in the 
folders in which they were located when the move was saved. 

Keyboard shortcut:   Ctrl + O 
 

Save project 

 
The current movie is saved with the name displayed in the project window. If 
you have not yet specified a name for your project, a dialog will open wherein 
MAGIX Movie Edit Pro 2013 asks you to do so. 

Please note: In the project file (*.MVP), all information about the used media files, 
cuts, effects, and titles are saved, but not the picture and sound material itself. This is 
found in the recorded or imported media files that remain unchanged during the 
entire MAGIX Movie Edit Pro 2013 editing process. To save the full movie into a 
dedicated directory, for instance to continue editing on a different PC, please use the 
command "Copy movie and media into directory". 

Keyboard shortcut: Ctrl + S 
 

Program settings 

 
Opens the program settings (view page 56). 

Keyboard shortcut: Y 
 

Context help 
The mouse cursor will turn into an arrow with a question mark.  
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Click on any button of the main screen, to open program help which will describe the 
control element in question. 

Shortcut:  Alt + F1 
 

MAGIX News Center 
The MAGIX News Center features links to current online tutorials and tips & tricks on 
the software application examples. The "News" is indicated by color according to 
content:  

• Green indicates practical tips & tricks for the software 
• Yellow reports the availability of new patches and updates 
• Red for special offers, contests and questionnaires 

If no new messages are present, the button will appear gray. When the MAGIX News 
Center is clicked, all of the available information will be displayed. Click the messages 
to reach the corresponding website. 
 

Lower toolbar 
The following toolbars are displayed in Storyboard Mode: 

 

 
 

Undo 
With this command you can undo the last changes you made. This way, it's no 
problem if you want to try out critical operations. If you don't like the result, 
then you can always revert to the previous state by using "Undo". 

Clicking on the arrow next to the button opens a list of changes made until now, 
allowing you to undo several changes made in sequence. 

Note: You can adjust the length of the list to your needs in program settings (view 
page 56). In general: The longer the list, the more RAM is used. 

Keyboard shortcut:  Ctrl + Z 
 

Redo 

 

This function undoes the previous "Undo" function. 

Clicking on the arrow next to the button opens a list of changes made until now, 
allowing you to undo several changes made in sequence. 
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Note: You can adjust the length of the list to your needs in program settings (view 
page 56). In general: The longer the list, the more RAM is used. 

Keyboard shortcut:   Shift + Y 
 

Delete objects 

 

This function deletes the selected scene (or the selected object in the Timeline 
mode). 

Keyboard shortcut:  Del 
 

Cut objects 

 

This function extracts the marked scene and copies it to the clipboard. You 
can then use the "Paste" command to copy it into any movie. 

 

Copy objects 

 

This function copies the selected scene (or the selected object in the Timeline 
mode) to the clipboard. You can then use the "Paste" command to place it into 
any movie. 

 

Insert clipboard 

  
This command inserts the clipboard material (photo or object) at the 
current position of the start marker.  

Keyboard shortcut: Ctrl + V 
 

Title editor 

 Opens the Title editor for the selected photo, video, or title object. 

Keyboard shortcut:  Ctrl + T 
 

Cut button 
You can split objects with the cut button, you can remove the object start or object 
end or divide the film up. Select the object you want to edit and place the playback 
marker at the desired position. Clicking on the cut button cuts the object in two. You 
can reach extra options using the drop-down menu. 
 

Split 

 This command cuts a scene at the point where the playback marker is 
positioned. This way, two free-standing objects are created. 

Keyboard shortcut:   T 
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Remove start 
This command cuts a scene at the point where the playback marker is positioned and 
removes the material before the playback marker. 

Keyboard shortcut: Z 
 

Remove scene end 

 
This command cuts a selected object at the playback marker position and 
removes the material behind the playback marker. 

Shortcut:  U 

Hint: If the commands "Split" and "Remove beginning/end" are applied without a 
selection, all objects at the position of the playback marker are cut. 

 

Remove scene 

 
This command allows you to completely remove selected objects. The parts 
that follow will be automatically moved to the end of the object in front of the 
object to be removed. 

Keyboard shortcut:  Ctrl + Del 
 

Split movie 

 
This command divides the movie into two individual movies at the position of 
the playback marker. 

The current arranger retains the portion that is located in front of the playback 
marker. The latter part will be removed from the current arranger and placed as a new 
film. You can find this movie by going to the "Window" menu. 

Shortcut: Alt + Y 
 

Special functions to insert new objects 
MAGIX Movie Edit Pro 2013 offers various possibilities how an object selected in the 
Media Pool will be pasted into the project. 
 

Apply automatically 

 
Pastes the file selected in the Media Pool into the arranger. Video and image 
objects will always be placed behind the last object into the first track; audio 
and text objects are separated into different tracks.  
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Single-track ripple 

 
Inserts an object from the Media Pool at the position of the playback marker 
and simultaneously moves the objects on the track following it.  

• In contrast to automatic placement, with track ripple, all objects will be placed at 
the position of the playback marker. Objects on the target track are automatically 
moved behind the inserted object. Bordering tracks are unchanged. 

• Videos and images will be loaded to the first track, as usual. If another object is 
found at the playback marker position, then it will be cut continued at the end of 
the inserted object (so that the inserted object can start exactly at the point of 
insertion). 

 

Multitrack ripple 

 
The object selected in the Media Pool will be inserted on the target track at the 
position of the playback marker. All objects found at the playback marker 
position will be split and moved down the length of the inserted object. All 
objects on the track located further on will also be moved. 

• In contrast to automatic insertion, all objects will be inserted at the position of 
the playback marker. 

• Videos and images will be loaded to the first track, as usual. If another object is 
found at the playback marker position, then it will be cut continued at the end of 
the inserted object (so that the inserted object can start exactly at the point of 
insertion). 

• If other objects are located at the playback marker position, these will also be 
separated and moved further along the track. 

• Objects lying further along on all tracks will be moved further down. 
 

Replace 

 
Replaces the selected object with an object selected in the Media 
Pool. 

 
 

Overwrite 

 
Overwrites the object in the target track at the position of the start marker 
with the object selected in the Media Pool. 

Hint: In contrast to "Replace", no length adjustment takes place. With "Replace", any 
downstream objects are moved, while "Overwrite" overwrites downstream objects 
as well (sometimes only partially), depending on the length of the object being 
inserted in comparison to the object being overwritten. 
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Additional functions in Timeline mode 
The following buttons are available only in the Timeline Mode: 
 

Set chapter marker 

 
Places a chapter marker at the position of the playback marker. This creates a 
chapter entry in the disc menu in case the movie is being burned to disc. 

You can rename the chapter markers by right clicking and selecting "Rename". The 
new name will appear in the chapter menu (view page 214). 

Keyboard shortcut:  Shift + Enter 
 

Object grid 

 
Use this button to switch the object grid (view page 96) on and off. When the 
object grid is switched on, the objects snap into place beside one another so 
that everything fits in seamlessly. 

 

Form group 

 
Orders all selected objects into groups. As soon as an object from the group is 
selected, all other objects in the group will be highlighted as well so that you 
can work on them collectively. 

Keyboard shortcut:  G 
 

Ungroup objects 
This turns all selected objects into free-standing objects again. 

Keyboard shortcut:  Shift + G 
 

Mouse modes 

 
MAGIX Movie Edit Pro 2013 offers special mouse modes for different kinds of 
editing. These may be selected using the small arrow next to the button. 

  

Move everything 

  
This mouse mode in principal behaves like the "Single object mouse mode". All 
objects that have the same or a later starting point will be moved. 

This is useful if something should be inserted in the middle of an arrangement, but 
there is not enough space, meaning that all contents have to be moved down. 

Shortcut:  7 
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Move everything on the track 

 
Basically, this mouse mode behaves like the mouse mode for individual objects, 
but moving one object will also move all other objects located behind it on the 
same track. 

This is practical if space is needed at the start of a track, since all objects can be 
moved together without moving them underneath each other. 

Shortcut:  8 
 

Mouse mode for individual objects 
This is the preset mouse mode where most work is performed. 

Select objects by left-clicking them. You can move an object by holding down the 
mouse over it while dragging it to the desired position. 

Keyboard shortcut:  6 
 

Curve mouse mode 

 
This mouse mode is used especially for drawing effects curves. 

The effects curve controls the intensity of the effect: The more higher the curve point, 
the more intense the respective effects parameter at this location. The curves can be 
used for video and image objects on the image tracks and also for audio objects on 
the audio tracks. 

More information about this can be found in the chapter "Animate objects", section 
"Editing object effects curves". 

Keyboard shortcut:  9 
 

Stretch mouse mode 
This special mode is for customizing the length of objects. 

With timestretching, audio objects can be expanded or compressed using the handles 
at the bottom. The duration of the audio material is therefore lengthened without 
changing the pitch. Playback of the video objects is accelerated/decelerated with the 
help of the handles at the bottom. 

Warning! If the object to be stretched or compressed is going to be animated with 
an effects curve, then the option "Connect curve length with object length (view 
page 138)" should be set for the effects curve. 

Keyboard shortcut:  0 
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Preview audio 

 
This mode allows you to preview audio objects (as long as the mouse button is 
held down). 

In this mode, objects cannot be moved or changed. 

Shortcut:  Alt + 6 
 

Preview rendering 

 You can access the preview rendering options by pressing this button. 
 

Media Pool 
The structure and workflow of the Media Pool is similar to that featured by Windows 
Explorer; however, the difference is that only the used files are displayed. This is used 
to access and load multimedia files of all kinds: video files, audio files, fades, effects, 
and also complete projects. 

 
 

Importing 
Navigation buttons 
The navigation buttons let you navigate through your computer’s drives and folders.  

Forward/ 
back  

These buttons access the previously viewed folders.  

 

Higher 
directory  

This button accesses the next highest folder level. 

Folder tree 
 

Here you can activate a folder tree to navigate through 
your computer system. 
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Search 
 

The search function allows you to find specific files 
quickly. You may specify your search according to file 
type, date, or certain folders. 

 

Browse 
history list 
and path 
details 

 

 

The path information for the current 
folder is displayed in the center above. 
Use the arrow button to open the menu 
to find the folders you previously visited. 

 

Options All functions of the context menu (switch views, 
rename, or delete files, etc.) can also be accessed 
via the options button. 

 

Display 
options  

Settings for how detailed the entries should be listed 
may be specified here. 

Zoom 
 

A zoom slider can be used to set the number and size of 
visible symbols in the "Large symbols" view. 

 

Search 
The Media Pool has an easy search function for finding files on the computer. It may 
be activated and turned off again with the shown button. 

 
 

File name: Enter any part of the name of the file you are looking for in the "File name" 
field. The X symbol deletes the entry. A "?" may be used as a placeholder for a single 
character, and "*" for any number of characters. 
 

File type: Here you can enter a file name extension. Multiple entries are separated 
using a semicolon. Below the entry field, various presets may be selected for often-
used file name extensions. 
 

Date: Here, you can set time period limits on your search. Choose an entry from the 
list. 
 

Folder: If you don't want to search the entire computer, but only look on certain drives 
or in a single folder, you can define a certain search path. 
 

Search depth: Here you have various options that determine whether additional 
locations should be searched. 

• Search indexed locations and the selected folder 
• Search indexed locations, the selected folder and personal files.  
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• Search indexed locations, the selected folder, personal files and the project file. 

"Indexed locations" are folders, which are searched and cataloged in Windows via the 
index list. If the index list is activated, the files in the indicated folders will be indexed 
while the computer is idling, so that the user's search query may be completed faster. 

Note: In Microsoft Windows XP, the indexing service is usually deactivated by 
default. The search functions in Windows Vista® may be installed with the current 
version of "Windows Search". They make it possible to easily add to the indexing 
service. Please refer to the installation instructions from Microsoft. 

 

Computer 
The link button "Computer" displays the drives in the Media Pool. All drives will be 
listed along with their drive letters and can be opened with a double click. 
 

User directory 
The second button featuring the user's name opens their personal folder in the Media 
Pool. 
 

My media 
The "My media" button lets you select "Projects", "My videos", "My music", "My 
images", and "Recordings". 
 

Projects: Here you can switch to the folder where your projects and films are usually 
stored. 

You will find the "Show project contents" function in the context menu of a project. 
Using this function, you can display all objects of a project and copy them into the 
current project, retaining the editing and effect state of the object. This means that 
you don't have to edit the objects again to keep the status of the "old" project. But you 
can certainly continue editing the transferred object. These changes will be then 
saved in the current project. 
 

My videos: Displays all usable files found in "My documents\My videos." 
 

My music: Displays the contents of the "My Documents\My Music" folder. MAGIX 
Music Manager also suggests this folder for importing your music collection into the 
database. 
 

My pictures: Switches to the "My documents\My pictures" folder. This folder is often 
used by digital cameras and scanners to store transferred images by default. The 
included MAGIX Photo Manager program also uses this folder (e.g. during image 
import). 
 

Recordings: MAGIX Movie Edit Pro 2013 specifies standards for all recordings. 
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MAGIX Tools 
The "MAGIX tools" link selects links to "Downloads", "Database", "Online Album", 
and "Internet Media". 

Downloads: Use this button to access the media files that you downloaded with 
Catooh. 

Database: Use this button to open the database view. Right-clicking opens the 
database search. The database first must be created using the provided additional 
programs MAGIX Photo Manager and/or MAGIX Music Manager. 

Online Album: This buttons opens MAGIX Online Album. This provides a shortcut for 
uploading and deleting data. To do this, you must first register on MAGIX Online 
Album.  

There are many ways to upload data: 

1. While holding "Ctrl" down, select the data to be uploaded in the Media Pool, 
and select "Copy" in the context menu (opened by right clicking). Switch to the 
MAGIX Online Album screen, open the desired folder, and select "Paste" in the 
context menu. 

2. In the Media Pool, click on "Online Album", and go to the desired directory. 
Open the Windows Explorer, select the desired data with "Ctrl" held down, and 
drag it into the Media Pool. 
 

Both options will result in your desired data being uploaded to your MAGIX Online 
Album. 

Note: This function requires an Internet connection. Make sure you have your login 
details (email address and password) ready. 

Internet media: This opens the integrated browser (view page 287)in MAGIX Movie 
Edit Pro 2013. This allows you to collect media directly form the Internet, e. g. images 
for a current film project etc. 

Travel route: Click here if you would like to create a travel route (view page 190). 
 

Movie templates 
Here you will find various movie templates, which can be customized as you wish 
(view page 185). 
 

Fades 
Here you can find all fades from MAGIX Movie Edit Pro 2013, sorted into various 
categories. One click on a category displays all of the fades that are contained. 



 

48   

www.magix.com 

To load a fade, drag it with a held-down mouse key onto the object, into which you 
would like to fade. 

You can find additional information in the "Fades" section of the "Objects (view page 
93)" chapter. 
 

Title 
This displays the title settings and the title editor. These presets are sorted into 
different categories and may be loaded by double-clicking or drag & drop. The 3D title 
templates are also located here.  

The text featured by title objects may be changed directly in the program monitor by 
double-clicking. 
 

Effects 
This provides access to the effects that are sorted into the various categories. Read 
more about this in the chapter "Effects" (view page 111). 
 

Video effect templates 
Here you can find pre-configured effect templates that can be dragged-and-dropped 
onto a video or image object. These effect templates consist of a combination of 
various effect settings which you can adjust in the appropriate effect dialogs. 

In the "Video mix effects" subfolder you will find templates for mixing two video or 
image objects. To do so, two video or image objects have to lie on two tracks directly 
above or below the other. To use a mix effect template, drag on the lower object. 
 

Video effects 
Here you can find adjustable effects for video and photo objects. The effects can be 
set only after selecting an object in the respective effects dialog. For more 
information, go to the "Video effects in the Media Pool" (view page 112) section in the 
"Effects" chapter. 
 

Movement effects 
These are movement effects you can use to animate the frame by using zoom or 
camera movements. For more information go to the "Effects" chapter, section 
"Movement effects in Media Pool" (view page 119). 
 

Stereo3D 
This accesses the program's Stereo 3D functionality. Please read the corresponding 
chapter "Stereo 3D". (view page 177) 

Note: This function is available only in the Plus/Premium version. 
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Audio effects 
Here you will find many audio effect templates such as echo, reverb, equalizer, 
compressor, etc. Read the "Audio editing" (view page 146) for more information.  
 

Design elements 
Multi picture-in-picture: Various effects presets for image stacking. 

Collages: These work similarly to normal picture-in-picture effects, but more objects 
are used. Depending on the collage, arrange the selected objects one after the other 
and drag the collage onto the first object. 

Color spaces: The color spaces are a collection of various backgrounds. Professional 
test images are included for calibrating your system. You can also use the colored 
backgrounds for your own color transitions, for instance. The special "User" template 
opens a color selection dialog where you can choose the desired color. 

Backgrounds: Here you can find static and animated photo and video backgrounds. 
Video backgrounds are capable of being looped, meaning that their length can be 
extended by duplication. 

Image objects: Here you will find various image objects like black bars, thought 
bubbles for cartoons, etc. 

Intros/Outros: These are beginning and end scenes for films with various themes. 

You can find additional information in the "Effects (view page 126)" chapter, in the 
section "Design element in Media Pool". 
 

My Presets 
Here you will find the folder for your own effect templates. For more details, please 
read the "My Presets in Media Pool" section in the "Effects" chapter (view page 127). 
 

Additional Effects 
Here you will find all available effect plug-ins. Please read the "Additional effects in 
the Media Pool" section in the "Effects" chapter (view page 132). 
 

Various file list view modes 
All supported multimedia files and subfolders of the currently selected folder are 
displayed in the file list. Three different views (list, detail, large symbols) can be set by 
right-clicking on the Media Pool context menu. 
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List: Only file names are listed. This 
view mode displays the most files 
simultaneously. 

 

Details: For each media file, its type, 
size and date of last change will be 
displayed next to its name.  

 

Large symbols  can be quite useful 
because they show a preview frame for 
each movie and picture file. This allows 
you to sort through the material 
quicker.  

As soon as you activate this display, 
the zoom function will appear. With it, 
you can additionally magnify 
thumbnail images. 

 

Preview function 
This is a preview function for all files in the Media Pool which can be started by 
dragging & dropping onto the video monitor or by pressing the play button. 

There are also previews for effects that illustrate their functionality. 

The "Extras" button or the enhanced transport control function provides a selection of 
sections from a longer video file in the Media Pool. Please refer to the "Inserting 
objects into the project" chapter. 
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Transport console 
Transport controls on the preview monitor enable you to play back video and image 
material in the arranger or as a preview in the Media Pool. 

 
 

Transport control buttons 
Range: Above the playback functions you can 
select the range between the in and out points 
using the mouse.  

 

 
Playback marker: This marker indicates the position of the image 
currently displayed in the preview monitor. 

 

Set in/out points: Defines the start and end of the playback range. 

 

To range start: This button sets the playback marker to the start of the 
current range. 

 

Jump to movie start: Sets the playback marker to the start of the movie. 

 

Play/Stop (pause): The playback button in the middle starts playback. 
A second click stops playback. 

Tip: In the menu "File -> Settings -> Program -> Playback", you can set whether the 
playback marker will go back to the start position (stop) after the second click or 
following the appropriate shortcut (space bar), or if it should stay at the current 
position (pause function). 

 

Range playback:This button plays the current range.  

 

To range end: This button sets the playback marker to the end of the current 
range. 

 

Audio or video recording: Quickly jumps to the Recording selection dialog. 

 
Switches the video monitor to the "Movie overview" mode. 
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 Jog wheel: Using this wheel, you can move by single 
frames within the video and zoom in for precise 
positioning of the playback marker. 

 Shuttle control: The further the slider control is moved 
to the side, the quicker the arrangement is played in the 
corresponding direction. This way a specific position can 
be reached quickly. 

 

 Zoom: Click on the arrow and set the zoom level in the preview monitor. 

 Resolution: If the video judders during playback you can activate half 
resolution for the preview monitor.  
You can also find this option in "Program settings > Video/Audio > Movie 
display". The quality of the movie will not be affected when you export or 
burn your project to disc. 

 

Arranger 

 

MAGIX Movie Edit Pro 2013 offers an editing interface for advanced editing: audio 
dubbing, professional editing, plus precise transitions and effects editing.  

 
There are corresponding views for different applications: 
"Scene overview", "Storyboard" mode, and "Timeline" 
mode. 

 

Tracks 
The Arranger offers tracks for multimedia material positioning and editing. The 
number of tracks displayed may be specified in the file menu under "Movie settings". 

In principle, any object type may be placed on any of the tracks. Video and image 
objects may also be combined with MIDI and audio objects on any of these tracks. 
The maximum length of a movie is restricted to 6 hours. 

 

Mute a single audio track by clicking on the “Mute” button 
or play individual tracks separately (“Solo”) to emphasize a 
particular scene.  

Clicking the lock symbol protects all objects in a track against unwanted editing. The 
track name can be changed by double-clicking on the text above the buttons. 



 

Workspaces 53  

 

A right-click on the track box opens the context menu: 

• MultiCam > Source track: Here you can activate/deactivate a track as a source 
track. 

• MultiCam > Master audio track: Here you can designate the master audio track 
for Multicam editing (view page 105). 

• Track height: Set whether the selected track or all tracks should be displayed as 
small, large or in standard size.  
You can also adjust the size using your mouse. To do so, drag the lower border of 
a track box downward using a mouse. 

 

Zoom 
The vertical zoom function sets the number of 
visible tracks. On many tracks zooming is useful 
for selectively editing a track or an object in full 
view. 

Use the horizontal zoom functions to set up the visible section of the arrangement on 
the timeline. 

Clicking and dragging on the bottom border of a track allows you to adjust the height 
of the display. 
 

 Object zoom: Vertical and horizontal zoom stages are enlarged so that all of 
the selected objects are displayed at maximum size. 

 Optimize view: Displays the complete arrangement in full width. Zoom will 
be set to 100%. 

When the function is turned off, the old zoom level will be reactivated. 
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Adjusting the workspace 
The arranger, video monitor and Media Pool can be positioned anywhere on the 
screen or completely hidden. Personal settings are automatically saved when MAGIX 
Movie Edit Pro 2013 is closed and remain when the program is reopened. 

For larger arrangements, the program monitor can be used to show an overview of 
the arranger (Window -> Movie overview (view page 262)). 

Note: If lose track of the settings, you can use "Window -> Reset window 
arrangement" or the keyboard shortcut "F9" to reset the basic settings. 

Tip: If you are working with two monitors, you can use one to display the preview 
monitor as a full screen. To do this, move the cursor to the upper border of the 
preview monitor and click and drag it to the other screen. Then click on the small 
rectangle in the upper right. The preview monitor will now be displayed in fullscreen 
mode. 
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Settings 
All settings dialogs can be reached via "File > Settings". 
 

Project and movie settings 
You can reach these settings through "File > Settings > Movie". Here you can 
determine the settings that can be individually adjusted for every movie and project. 

Note: A project can include multiple movies. 

 

Settings 
Play film in loop mode: The movie is played over and over again, i.e. when the movie 
reaches the end marker, it starts again from the beginning. 

Use as presets for new projects: The settings specified in the dialog are used as the 
standard settings for newly created projects. 

Automatically adjust new images to fill screen (borders are faded out): This option 
is especially useful for photos that are part of the arrangement but have a different 
format. When the option is activated, there are no bothersome black bars; however, 
parts of the image along the edge will be hidden. 

Number of tracks: Here you can change the number of tracks. 

Audio sample rate: The preset sample rate is 48 kHz. This sample rate is used for all 
recordings and is also a prerequisite for audio tracks of DVDs. This setting guarantees 
optimal sound quality. Audio material at different sample rates (e. g. CD Audio with 
44 kHz) is automatically adapted when loaded (resampling).  Only change this value 
if you want to use audio with a different sample rate or if your sound card does not 
support this sample rate.  

Video settings:  This is where you set the standard settings for the picture format and 
frame rate for PAL or NTSC TV pictures or for your own format. 
 

Movie information 
This option opens an information window: 

Name: Here you can enter the name of the current movie. 

Date of creation: Displays the time the movie was created. 

Last changed: Displays the time of the last save. 

Number of used objects: Displays the number of all objects in the movie. 
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Used files: All files used in the movie are listed here. 
 

Project settings 
You can change project settings here. A project can consist of multiple movies and is 
saved as an MVP file. 

Name and path: Displays the name of the movie and the location where it is stored on 
the computer. 

Description:  Here you can give your project a description - perhaps a few statements 
about the state of the editing progress, e tc.  This is something like a notepad function. 

Date: Here you can assign your project a specific date. You can choose between a 
date - e. g. "Dec. 25, 2010" - or a written description - e. g. "Christmas 2010".  

Preview: This is the preview in a file manager such as Windows Explorer. You can use 
the automatic selection for the preview image or choose an image from your hard 
drive. You can also use a preview image from movie project. 
 

Select preview image automatically: MAGIX Movie Edit Pro 2013 uses an 
automatically-selected preview image. 
 

Use image file 
Clicking the folder button opens a dialog to load image files. In this dialog, you can 
navigate to the directory where the image file is found and select it by double clicking. 
 

Use preview image from movie 
Use the controller to select a frame from the corresponding directory. 
 

Program settings 

  
All basic settings for MAGIX Movie Edit Pro 2013 are made in this window. 
This allows you to influence the settings in MAGIX Movie Edit Pro 2013 in 
detail. 

Keyboard shortcut:  Y 
 

Playback 
Audio playback 
Driver selectionHere you can specify whether the Windows Wave driver or the 
DirectSound driver will be used for audio playback. DirectSound is a component of 
DirectX and, if necessary, is installed together with MAGIX Movie Edit Pro 2013. 
DirectSound has the advantage that the sound output (for all modern sound cards or 
onboard soundchips) can also be used by other programs open simultaneously. WAV 
drivers are recommended if the CPU load is higher, as the larger buffers allow better 
handling of the load peaks (otherwise this would cause crackling). 
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Note: "DirectSound" must be activated to work with 5.1 Surround Sound. 

Output device: Use this option to specify which sound card plays the wave audio 
objects. This is especially important if you have multiple sound cards installed on your 
computer, e.g. "onboard sound" as well as an additional sound card.  

Audio buffer: In order to allow smooth playback of a complex arrangement, MAGIX 
Movie Edit Pro 2013 creates a RAM data buffer into which the current data is loaded.  
This allows for step-by-step preprocessing instead for preprocessing for the entire 
arrangement. 

Number of buffers: Here you can specify how many buffers should be used. More 
buffers increase reliability, for judder-free arrangement playback, but this also 
increases the memory requirements. If played via DirectSound (see settings in the 
"Playback parameter" dialog), only one buffer is used automatically. 

Note: If response and loading times are too slow, reduce the buffer size; otherwise 
increase the buffer size if the audio playback is choppy or if real-time errors occur. 
Since error-free playback is usually more important than fast reaction times, the 
buffer size should be raised to 16384 or 32768 for drop-outs. The possible number 
of used buffer updates is between 2 and 10. 

Multitrack size/Preview size: Specify the buffer size used to play the entire 
arrangement or for previewing waves in the file manager. 

Video playback 
Overload optimization for realtime playback: Here you can activate or deactivate 
overload optimizing during realtime playback of the arrangement. This feature is 
particularly suitable for lower performance PCs. 

Instant Cache Refresh in Multicam Mode: Activate this mode to empty the cache in 
short intervals which will make the preview for multicam editing immediately visible 
in the preview monitor. This may result in juddering during playback. 

Track number for parallel track optimization: This is an option, which is useful for 
projects with an especially high track number which leads to problems when saving 
the project. If you get errors, try using a value of "2" here. If you continue having 
problems, try using "1". 

This option influences program function only when MPEG and AVCHD material is 
being edited. However, performance declines to reduce disk space usage with 
increasing values. 
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Arranger 
Autoscroll during playback: If autoscroll is activated, the screen view automatically 
shifts when the playback cursor reaches the right edge of the screen, which is useful 
for longer arrangements. You can select the size of the scrolling steps from either 
"Fast" (whole pages) or "Slow" (half pages).  

Attention:  Scrolling requires constant recalculation of the screen view which may 
lead to interrupted playback if system RAM is too low. If this happens, simply 
deactivate the autoscroll feature.  

Display: Display of objects in timeline mode can be simplified to improve 
performance. You can decide whether to display preview frames for video objects 
across the entire object, or just for the first and last frames. For audio objects you can 
hide the wave form display. This is particularly recommended for MPEG data streams. 

Update in background: The update if the object display after move and zoom 
operations in the arranger is performed in the background in order to let you work 
smoothly. 

Spacebar behavior: Here you can determine whether pressing the spacebar during 
playback resets (deactivated) the playback marker or leaves it at the current playback 
position (activated). 

Image playback 

Resizing high-quality image material: Use this feature to improve the quality during 
resizing, particularly when downsizing to less than half of the original size (e.g. for 
picture-in-picture effects). This, on the other hand, requires more processing power. 

Load image material in background: Activate this option in order to load inserted 
image material already before playback in background. 
 

Folder 
Here you can set the path where 

• you want to save your projects (Projects) 
• files are exported (Export) or imported (Import), and recordings (Recordings) are 

saved, 
• Disc Images are saved 
• and where EXE files for the external audio and picture editor are located so that 

they can be launched via the Effects or Prepare menu (only Plus/Premium-
Version) 
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Note: Folders placed here are fundamental for the entire program. Newly created 
projects are stored in a separate subfolder, which you can define in the "Program 
start" (view page 17) screen.  

 

Video/Audio 
In this tab you will find all settings concerning video and audio files.  

Video standard 
Normally the right video standard is set up automatically. PAL is used in Europe; the 
United States, Canada, and Japan use NTSC. 

Movie display 
The resolutions that can be set here concern only the picture display in the arranger. If 
playback begins to stutter, "Half resolution" is recommended. This does not influence 
the quality of exported videos. 

Automatic interlace processing: MAGIX Movie Edit Pro 2013 normally detects 
whether the loaded video files were recorded with the interlace or progressive 
processes automatically, and half-image format is detected for interlaced movies. In 
case automatic detection fails, you can deactivate it here and set the object properties 
(view page 269) of video objects to the correct process. 

Arranger 
Simple display of video objects (first and last image): Activate this function if you are 
having performance problems. The preview images of a video in the arranger will only 
be display at the beginning and end of the video.  

Half waveform display: Half of the waveform display (upper part) is enough for audio 
editing. This is the default setting. If you want to do more detailed, professional audio 
editing, you can display the complete waveform. 

Video/Audio on one track: Activate this option if you want imported video footage to 
be displayed as one object with video and audio on one track. You can always use the 
options in the object menu to put the video and audio on separate tracks later to edit 
them individually. 

Import 
Automatically create frametable during import Sometimes, rebuilding a frame table 
can get rid of problems in certain MPEG files. For example, such problems can be 
present if the navigation (positioning of the playback marker, transport) is bumpy or 
doesn't function at all. 
Normally, when loading MPEG video, a frame table is not created in order to speed up 
the loading process. If you do create one anyway, MPEG files are normally noticeably 
faster and easier to edit. 
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Extract sound from video: If a video file contains video and audio data the audio track 
of the video will also be imported if this option is activated. It will be displayed as an 
audio object in the arrangement below the video object. Both are automatically 
grouped together. If the audio track has to be edited or replaced later, you first have to 
ungroup it ("Ungroup" button in the tool bar or via the "Edit" menu). 

Allow user-defined names for sound extracted from VOBs: Specifies whether a 
warning will be displayed for each imported file during VOB (Video Object Block) 
import (VTS_01_1.vob) allowing you to enter a name for your movie (check box 
"checked") or whether you would like an automatically generated name to be 
assigned (check box "unchecked"). 

Standard display time: Specify how long an image in the project should be displayed 
before moving to the next object.  

Note: Adding transitions between the objects will reduce the actual display time. If 
you plan on using transitions, it is best not to set the display time too short. 

Trim videos: Sometimes video clips have damaged frames at the beginning or end. 
Most often these are green, black or incomplete. Here you have the option of 
automatically trimming your videos during import if your footage constantly has 
damaged frames. Specify how many images (frames) should be trimmed at the 
beginning and the end of the video.  

Note: The frames are not lost due to the shortening. By adjusting the object length 
you can make the trimmed frames reappear. 

Export 
Automatically preview exported clips: This option starts the clip immediately after 
exporting for verification. 

Apply picture effects when exporting to MAGIX Online Services: If this option is 
selected, all the picture effects are included with the sent file. 

Hardware acceleration during MPEG-4/AVCHD export if possible: Here you can 
activate Hardware acceleration (view page 239) during MPEG-4/AVCHD export if 
your system supports it. 

Other 
Reduce bitmap resolution for preview: The resolution of image files is reduced during 
playback to decrease required memory. This requires less computing power than 
playback in full resolution; full resolution is always calculated during export. 

Relocate memory for bitmaps to other process: Activating this option will improve 
handling of bitmaps as they will be processed differently. This function can lead to 
delays in 32 bit systems. If this happens, you can deactivate the function. 
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GPU acceleration for standard fades: Here you can (de)activate hardware 
acceleration of your graphics card for 3D effects. More information about this topic is 
available in the 3D transitions (view page 94) chapter. 
 

System 
Reactivate warning dialogs:In its newly installed state, MAGIX Movie Edit Pro 2013 
displays a number of security queries at various parts of the program. Each of them 
can be switched off by clicking the small box at the bottom that says "Don't show this 
message again". To display these warning messages, select the "Reactivate dialogs" 
option. 

Begin online configuration: If you have an Internet connection and use MAGIX Online 
Services, you can configure your services here. 

Undo/Redo 
Here you can set the maximum number of undo commands. The higher the value, the 
higher the CPU load on the computer. 

Save automatically 
Auto Save projects allow you to set a time interval at which the project will be 
automatically saved. If the program crashes, this feature will restore the project to the 
state it was in when last saved. 

Other 
Automatic preview when changing transitions: When this option is activated, a short 
preview of the transition effect will be quickly played between the two objects you 
selected. 

High output quality for dynamic zoom and combination effects: The Title Editor is 
used in high resolution by default. The display quality of titles is improved, but this 
also results in longer loading times for movies. 

Move playback marker when selecting objects: This option automatically moves the 
playback marker to the beginning of the selected object. 

Double-click properties: Specify whether a double-click plays back files in the Media 
Pool or imports them to the arranger.  

Import Formats 
File formats that you never use can be deselected here. Once deselected they won't 
be imported anymore. Please keep in mind that several import modules exist for some 
file types (AVI, WMA). MAGIX Movie Edit Pro 2013 uses the fastest one in each 
case. If you experience problems during the import of certain files, you can 
experiment with deactivation of certain import modules, forcing the program to use 
the slower, but more compatible import module. 
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Display options 
Activate video output 
Video output on a DV device: With this option, you can display your arranger view on 
your TV via your DV camera. This is useful if your graphics card doesn't have a TV 
output. However, since your PC must then compress the video signal in real time in 
DV-AVI format, in addition to processing all real time effects, you need to have a 
powerful PC for jitter-free playback. Even if your computer is not particularly powerful, 
you can still use this function to see how your video looks on your TV screen, since 
the analog video output signal of a good DV camera is better than the TV output of an 
average graphics card. 
 

Preview in the Arranger/preview window and playback in video 
recorder/analog recording 
You can set the playback mode separately for the arranger (including all preview 
windows and effects dialogs) and the preview monitors during recording and in the 
video recorder. 

Always use DirectX9: Normally DirectX11 is activated for the preview in the arranger. 
DirectX9 can be activated for Windows XP and graphics cards that don't support 
DirectX11. You can also activate it if you are having general problems. 
 

Video mode 
The default setting is "Hardware accelerations (Direct3D)", which you shouldn't 
change because it delivers the best results. If you are running into problems, such as if 
the image remains black, you can see if the other modes work better. "Compatibility 
mode (VideoForWindows)" switches hardware acceleration completely off, and thus 
this setting should work best. It is also the slowest mode, in which the project 
probably won't play smoothly. These options are irrelevant for file export and disc 
burning. 

Tip: Change video modes only in case of problems with presets, such as jerks or 
persistent image artifacts. 

Preview in arranger 
Compatibility mode (Video for Windows): This is the (tried-and-true) standard 
mode, which works on all systems. 

Hardware acceleration (Direct 3D): This mode offers extreme speed advantages, 
processing effects, mixing and various transitions directly on the graphics card. 
Depending on the graphics card, performance can increase by 300%. The graphics 
card will not be used during export. 

Warning: To be able to use this mode, the graphics card must have at least 128 MB 
disk space of its own. Direct 3D 9 or higher must be installed and the graphic card 
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driver must support "High Level Pixel Shader Language 2.0". MAGIX Movie Edit Pro 
2013 checks the corresponding properties when this mode is selected, and switches 
it off if necessary. 

Preview and playback on VCR/Analog recording 
Alternative mode 1 (Overlay Mixer): In this mode you can use hardware deinterlacing 
for export to PC monitor or progressive scan-enabled projector, which noticeably 
improves reproduction quality of analog video recorded with interlacing. 

Alternative mode 2 (Video Mixing Renderer 9): This mode uses hardware 
deinterlacing of modern graphics cards together with DirectX9. Make sure that you've 
installed the latest graphics card drivers and the card is compatible with DirectX9. 
This mode works better than the standard mode (Overlay Mixer) only for a few 
graphics card models. 

Standard renderer: The DirectShow standard renderer is used for viewing. 
 

Image formation in Vertical Blank Intervals (VBI) 
The image formation takes place in the vertical blank intervals of the monitor signal 
(or the connected TV signal). This helps avoid image interruptions. Warning: Because 
of the necessary waiting time on the next VBI, this process adds significant 
computation time! 

You can deactivate this option for digital displays such as TFT monitors. In "Overlay" 
mode, image formation occurs exclusively via VBI. 
 

De-interlacing 
The DirectShow modes "Overlay mixer" and "Video mixing renderer 9" enable 
activation of hardware de-interlacing for the graphics card. For general information 
about de-interlacing and the options "Top/bottom field first", please read the 
corresponding article "De-interlacing (view page 317)" in the manual. 
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Preview rendering 
Use this dialog to set how MAGIX Movie Edit Pro 2013 renders a set range in the 
arranger. This dialogs may be accessed via "File -> Settings -> Preview rendering".  

Note: The preview rendering function enables complicated passages in the project 
to be rendered beforehand for fluid video previewing. This may be accessed via the 
marker bar's context menu. You can find more details in the "Preview rendering" 
section.  

 

Presets: You have the option to select presets or save your own settings for later use. 

Format settings: Specify here which format should be used to render a set range. 
"Advanced settings" enables you to adjust the selected format to suit your own 
particular requirements. 

Stereo3D: Activate this option when rendering 3D footage to view the preview in 3D. 

Other: Access this dialog prior to every rendering process. It does not appear by 
default. 

Note: Rendering may take longer depending on the selected format and size of the 
set range. 
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Video recording 

Select the recording method 

 
To start recording, click on the red "Record" button below the preview monitor. 
 

The following selections are possible in the dialog window: 

 

• AVCHD for AVCHD cameras  
• HDV camera: For HDV cameras 
• DV cameras: For mini DV cameras and DV video recorders 
• Video: For analog video cameras, analog TV, VHS recorders, webcams and others 
• Audio: For microphones, cassette recorders, MiniDisc players, turntables, etc. 
• Screen: Records directly from the computer monitor 
• Single frame: For single and series images from analog cameras, analog TV, or 

VHS recorders, webcams, etc. 
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Recording AVCHD 
Connect camera 
Suitable cameras are essentially available in three varieties: 

• Cameras featuring removable data storage: These cameras have a slot for a 
memory card. Your computer should have a card reader for the corresponding 
memory card, which you can then remove from the camera and insert into the 
card reader. Different camera models can also be connected via USB. 

• Cameras which burn DVDs directly (usually 80 mm diameter instead of the 
regular 120 mm): The DVD can simply be taken out of the camera and inserted 
into the computer. For so-called "Slot in DVD" drives, look beforehand in the 
operational manual whether or not 80 mm DVDs (also called 3" DVDs or 
MiniDVDs) are acceptable. 

• Cameras with built-in hard drives: The camera will respond as a drive as soon as 
it is connected via a USB cable to the PC. This additional drive will appear in 
Media Pool. 

Hint: The listed options and procedures reflect our experience with what works. Still, 
we recommend you read the camera's manual for the exact sequence of actions and 
contact the manufacturer in case of problems. 

 

AVCHD import 
AVCHD recording is actually not really a recording as such, but rather "only" the 
transfer of the already created video file and its import into the existing project.  

On older systems, it may be helpful to transfer AVCHD files into MPEG-2 format 
during import. A corresponding query appears during importing of these files. 

Note: During AVCHD import, it is necessary to activate (view page 289) the MPEG-
4 and the Dolby Digital Stereo codecs. MAGIX Movie Edit Pro 2013 offers this 
option as soon as the codec is required.  
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After you have selected AVCHD recording, the following dialog opens. 

 

Video source: Here you can navigate to the drive that corresponds to the attached 
AVCHD camera. 

Save in following folder: Create a target folder for the files to be imported. 

Advanced settings: Adjust various settings for the name and date of the files to be 
created. 

Preview monitor and transport control: Here you can play back, rewind or fast 
forward clips in the file list. 

Medium/general: An info area for the files is provided to the right next to the preview 
monitor. 

File list: The contents of the selected drive are shown here. Use the display filters to 
reduce the types of files shown. You can select every file separately using the little 
check boxes in order to import them later. At the top right of the list you can find 
options for displaying the files. 

Note: The files are color-coded. The colors indicate recording times, so that you can 
quickly recognize which recordings were made at the same time. 
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Select: This offers self-explanatory options for file display ("all", "only new", or 
"none"). 

Display filter: Here you can choose whether to view "Movies" or "Photos". With the 
option "Show only selected", all non-selected elements will be hidden. You should 
only use this option if you've already selected elements. 

Insert into movie: With this option active, media will be inserted directly into the 
MAGIX Movie Edit Pro 2013 Arranger as objects. When inactive, they will be simply 
copied into the target folder and may be selected from the Media Pool at any time. 

Delete all media after camera import: This option deletes the selected media after 
importing from the camera. 

Optimize for DVD output: If you plan on making a DVD you can select this option. 
This means that HD material is converted to DVD format when being transferred so it 
can be edited more easily. 

Import:  Starts the import process of the selected files into the target directory. 

Cancel: Closes the dialog without import. 

Tip: The AVCHD import dialog is basically a universal import dialog, appropriate for 
external drives, photo or video cameras, containing usable files. If you find the 
display filters useful for your camera as well, nothing stands in the way of 
connecting the camera to the computer and then activating AVCHD recording in 
MAGIX Movie Edit Pro 2013.   
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HDV camera 
Use this option to open the HDV camcorder record dialog. To do this, you have to 
connect an HDV camcorder. 

 

The options in this dialog can also be found above in DV recording. 
 

DV camera 
DV devices 
MAGIX Movie Edit Pro 2013 supports continuous editing of DV (digital video) files. A 
DV recorder or camcorder and a computer with a FireWire interface are required. 

To record digitally, the digital output of the Mini-DV camcorder or DV video recorder 
must be connected to the DV interface of the PC, yet switched off. You must also 
have Microsoft’s DirectX8a (or higher) installed on your PC. Now switch your 
camcorder to “video recorder” or “playback” mode (depending on your particular 
device) and open the DV capture dialog. 
 

Connect a DV or HDV camera 
• Connect the digital output of the switched-off camera with the computer's DV 

interface (also called FireWire or iLink). 
• Insert a DV cassette or the storage device into the camera. 
• Switch your camera’s operating mode to "Video recorder" or "Playback". 
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The camera is now ready to transfer video to the computer. 
 

Note: You may also use a HDV camera in DV mode to, for example, transfer 
recordings in the old DV format. We have noted problems with this mode in many 
cameras, and therefore recommend that the Record mode of the camera is also 
switched to DV, switching the camera off and then on again. 

 

Capturing DV recorders or cameras 

 
To start recording, click the "Record" button below the source 
monitor. 

• Select "DV camera" from the recording dialog. Uncompressed DV capture 
requires approx. 220 MB per minute of video. If you would instead like to record 
using the more space-saving MPEG format, then you should first activate the 
"Record DV as MPEG" option. 

 

• This opens the actual recording dialog. Check to see if a DV camera driver has 
been selected. 

• Name your recording. It's worth choosing a logical name which will allow you to 
find it easily again on the hard drive. 

• You can access the appropriate place on the camcorder tape by using the remote 
control buttons: shuttle forwards, backwards, and start/stop playback. To start 
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recording, click on the "Record" button. Keep an eye on the remaining hard drive 
space. 

• Cease capturing with the "Stop" button and exit the record dialog. You can see 
the recording in the film-strip in the lower third of the screen. 

Tip: In the DV recording dialog, you can set clips from the DV video which then will 
be recorded one after the other (batch capturing). Read more on this in the chapter 
"Batch processing" (view page 74). 

 

"DV capturing" dialog 

 

Note: Keep an eye on the available hard drive space before each recording. DV 
capture requires approx. 220 MB per minute of video! 

 

Select DV device driver: The device driver for your DV device should be listed here. If 
"Record audio" is deactivated, then video without sound is recorded only. "Audio 
preview" activates the audio output of the recording. 

Note: The audio preview is deactivated at first, since DV cameras usually include 
built-in speakers. 

 

Save movie file as/save in folder: Enter the name of the movie to be recorded. You 
can also select the folder where you wish to store your video file. The default 
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recording directory is set by default, but you can change the Path settings (view page 
58) under menu item "File -> Program settings -> Path settings". 
 

Edit after recording: This provides access to the automatic editing options. 
 

Start the DV device automatically: Starts the DV recorder or DV camera 
automatically when the "Record" button is pressed. This does not function with all 
digital cards/video devices. 
 

Video preview: On the preview monitor you can see a preview of your movie. 
 

Original size: This option allows you to preview the video in the original size. To 
return to the dialog use the "Esc" key. 
 

Batch recording: Here the start and end points can be set for the capturing. This 
allows you to search the entire video for all captures to be used and list them for 
planned batch capture. This is then processed in sequence when the recording starts 
(via the red button). That way you don't need to record each scene individually. You 
simply determine recording time points, and the computer takes care of the rest. To 
set the start and end points precisely, click "Enter start/end point (view page 73)" 
 

Record list: Use this button to view the available list of already recorded videos and 
scheduled recordings. All entries from the list can be selected and deleted.  
 

Record: Starts the recording process. Also contains the list of scheduled recordings. 
These are processed step-by-step (batch capturing). 
 

Stop: Stops the recording process. 
 

Snapshot! With the Snapshot! button, you can create a frozen image directly from the 
preview monitor. Start the camcorder and watch the preview window. When the 
image you want appears, click "Snapshot". Or you can navigate using the remote 
control to the position you want, and stop there in Pause mode. Stopped playback on 
the DV camera will not deliver an image! The images are saved in the record directory 
as graphics files in the set resolution.  
 

Remote control 
MAGIX Movie Edit Pro 2013 also supports remote controls for most digital 
camcorders. This does not function with all digital cards/video devices. If your 
hardware does not support the remote control function, the buttons will not be 
usable. 
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The transport controls required for this are featured in the DV or HDV recording 
dialog. 

 
 

Tape title: Enter a name for your tape here. MAGIX Movie Edit Pro 2013 requires this 
name for the DV logging feature. 
 

Recording information: Displays various information about your recordings. 
 

Set recording start/end point: Enter the exact start and end point or the recording 
length for a scene. 

Both values can be entered as ATN (absolute 
track number) or as a timecode in 
hours:minutes:seconds:frames. 
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DV as MPEG 
This recording selection dialog option allows you to transfer DV recordings directly 
into the space-saving MPEG format on the harddisk. 

 

From the "DV as MPEG" dialog window you can find 
MPEG encoder settings options under "Advanced". 
You can also burn your DV material direct to disc 
without any intermediate steps. 

 

Recording list 
Set the start and end points for the capture here. This allows you to search the entire 
video for all captures to be used and list them for planned batch capture. This is then 
processed in sequence when the recording starts (via the red button). That way, you 
don't need to record each scene individually. Simply specify the recording time points 
and the computer takes care of the rest. To set precise start and end points, click 
"Enter start/end point (view page 73) 

 

Record list: Press this button to view the available list 
of already recorded videos and scheduled recordings. 
All entries from the list may be selected and deleted.  

Every batch recording is automatically logged. 
Conversely, every "manual" DV and HDV recording is 
transferred into the recording list in order to restore lost 
recordings without much effort. 
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Logging 
Logging means that MAGIX Movie Edit Pro 2013 also saves the original save location, 
position and additional information (metadata, e.g. scene, take, rating, comments, 
etc.) about DV video and audio files. 

Everything copied using DV recording, DV to MPEG recording and HDV recording 
appears in the recording lists of the corresponding recording dialog. Recordings for 
which the corresponding video material is no longer on the hard disk will appear as 
"planned recordings". 

If MAGIX Movie Edit Pro 2013 does not find the corresponding DV and WAV files 
during the loading of a video, it will ask that the corresponding DV tape is inserted 
into the connected camcorder again for automatic scene import. 

You no longer have to save DV AVI and audio files (which can be very large). If at a 
later time you would like to work on a film again, but do not have the space to keep 
the material for it on your hard disk, then you can simply delete the bulky DV AVI and 
audio files. 
 

Analog video recording 
Connect analog video source 
Connect the video out of your video camera, DVD player or VCR to the video in (TV, 
video, or video-in graphics card) of your computer, and the audio out to the line in of 
your sound card. 

Due to the variety of device configurations, it is difficult to say which cable will 
function best with your setup. If you’re not sure, check the manual of your VCR or 
your TV-, video- or graphics cards. 

Example: Many VCRs have a SCART output and most DVD players have three RCA 
outputs (two for the stereo track, one for the image). In such cases, you will need a 
SCART to RCA adapter, a cable with 3 RCA plugs at each end. 

   

SCART/RCA adapter Scart/RCA adapter with 3 
RCA jacks 

Stereo RCA/mini phone jack 
adapter 
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Most sound card inputs are mini stereo jacks. To connect the audio out of your VHS 
recorder to the sound card audio in, you will need a stereo RCA/ mini phone plug 
adapter. 

You will have to purchase a cable with three RCA plugs and a stereo RCA/mini phone 
plug adapter. 
 

Analog video recording 

 

Video/Audio driver: Here you can set up the video card or sound card for recording. 
In practically every case the driver software supplied with the hardware must be 
installed. 

Hint: Under "video driver" you will find a "screen capture" entry in the Plus/Premium 
version. You can read about how it functions in the "Record screen contents 
(Plus/Premium version)" (view page 82) section. 

Input/Tuner settings: If your video capture card supports multiple sources, i.e. your 
card also has a TV tuner or multiple inputs (SVHS, composite, etc.), then you can 
select the proper recording source and the TV channel to be recorded here. 

Save movie file as/Save in folder: Enter the name of the movie to be recorded. You 
can also select the folder where you wish to store your video file. The standard 
recording folder is set as default. The location of this folder can be changed in "Path 
settings (view page 58)" under "File -> Program settings -> Folders". 

Edit after recording: Use this to access the automatic editing options. 
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Record quality: You can choose between various predefined recording qualities in the 
list box according to your computer's processing power and how you wish to use the 
picture material. They are sorted according to picture quality. Use Configuration to 
fine-tune the quality for the preset. 

Presets displayed with MPEG record directly in MPEG format. 

Tip: Use the presets marked MPEG if you want to burn your recordings straight 
away, since smart encoding can omit laborious encoding after recording. 

Advanced...: Opens the video driver settings dialog (view page 77). 

Capture control: Here you'll find the "Red" record and "Stop" buttons. With them, you 
can start and stop recording. 

Timer recordings active/time limit: Here you can specify a recording start time and 
length, and thus turn your PC into a fully functioning VCR. 

Snapshot!: With the "Snapshot" button, you can create a still image directly from the 
preview monitor. The images are saved in the recordings folder as graphics files in the 
resolution you have set. 

Recording details: This shows statistical information such as the recording time, 
available space on the hard-drive, the recorded frames, and the “dropped” frames. 
Dropped frames are frames that have been left out because the computer processor 
is too slow for the selected image format and cannot accept all incoming frames. 

Preview: Some graphics adapters allow you to reduce the system lead by deactivating 
the video preview. If you hear an "echo", deactivate the audio preview. 
 

Advanced configurations in the video capturing dialog 
Here you can adjust certain settings for the video recording driver. 

These dialog boxes, so-called “property sheets,” come with the video card drivers. 
These driver-specific performance properties may deviate depending on the cards. 
We also have a very limited influence on the behavior of these drivers. If you 
encounter any difficulties, please contact the video card manufacturer for the latest 
driver updates. 

Source: Sets the crossbar of the video card. 

The crossbar determines which video and audio input signal will be recorded. The 
crossbars are connected in series to the video recording chip itself. In the output field, 
the video output (for the crossbars) is the input for the recording chip (video or audio 
decoder-in) of the video card. In the “Input” field, select the signal source that will be 
used by the video card to capture for this input. Many video cards have separate 
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crossbars for audio and video. If you have a problem, try out the different 
configurations until the right sound matches the right image. 

Composite-in = the normal video input (typically a cinch jack) 
S-video = S-video input (mini-din jack) 

SVHS-in = SVHS input (special cable) 

Tuner-in = TV signal of the integrated tuner 

Display 
Video decoder: If the picture only appears in black & white or it flickers, the video 
standard may be set incorrectly. In mainland Europe, PAL_B is used. 

VideoProcAmp: Fine-adjustment of colors, brightness, contrast etc. We recommend 
against changing any of the manufacturer’s settings. 

Format: Please do not change anything here. The capturing format is set in the 
"Recording quality" option in the video recording dialog. 

Station selection 
This option is only available if a TV tuner is integrated into your video card. 
 

Audio 
Songs, noises, or instruments can be easily recorded in MAGIX Movie Edit Pro 2013 
using the audio recording function. A hooked-up microphone or various audio devices 
(especially a stereo system) can be used as recording sources. 
 

Connecting the source for recording 
First of all, the source of the audio material must be connected to the sound card 
input. Again, there are several possibilities which primarily depend on the type of 
equipment you have. 

If you are recording from a microphone, then please connect the microphone to the 
microphone jack on your sound card (usually red). 

If you want to record material from a stereo system, then you can use the line-out or 
AUX out jacks on the back of your amplifier or tape deck. This involves connecting 
them to the sound card input (usually red).  

If your amplifier has no separate output (other than for the speakers), then you can 
use the connection intended for headphones for your recordings. In most cases, you 
will need a cable with two mini-stereo jacks. This type of connection has the 
advantage of being able to set the headphone input signal level with a separate 
volume. As headphone connections generally are not the best, it is advised that you 
use the line outputs if possible. 
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When recording cassettes from a tape deck, you can connect the tape deck's line out 
directly to the sound card input. 

When recording from vinyl records, you should not connect the record player's output 
directly with the sound card because the phono signal needs to be pre-amplified. A 
more suitable method would be to use the headphone connection or an external pre-
amp. 
 

Adjusting the Signal Level 
Adjusting the signal level to the sound card is also recommended to get the best 
sound quality during digital recording. 

Once a recording source is connected to the sound card, the "Record" button opens 
the recording dialog and starts the recording source. 

You can now adjust the recording level with the help of the LED display in the 
recording dialog. For this, you must first check off "Show Levels". 

If the adjustment is set too high, distortion occurs and the incoming signal must be 
reduced. If you have connected the source through either an amplifier or tape deck 
output to the sound card, you can only reduce the signal level in your sound card’s 
software mixer interface. You can access the mixer directly from within the recording 
dialog via the “Recording Level” button. 

If you reduce input sensitivity by using the input fader, the resolution at which the 
analog signal is digitized is also reduced. Try to set these automatic controllers to the 
loudest sound level possible. 

The maximum setting for an optimal level is the loudest part of the material. The 
loudest part should be adjusted to be the maximum. The actual recording begins 
when you press the "Record" button.  At the end of the the recording you will be 
asked if you want to use the recording. Upon confirmation, the newly-recorded 
material will be placed at the next free position of the start maker in the arrangement. 
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Audio record dialog 

 

Audio driver: Selects the sound card for the recording. 

Save audio file as/ Save in folder: Here you can select the title of the audio file you 
wish to record. You can also select the folder where you wish to store the file. 

Recording quality: Sets the sound quality of the recording. In the preset menu you can 
choose between medium wave radio ("AM tuner"), UKW ("FM Radio"), DAT (Digital 
Audio Tape) and CD quality. 

Display Volume control: Using the peakmeter, you can monitor the level of the 
incoming signal. Please read more on this in the chapter "Adjusting levels" (view page 
79) 

Record: This button starts the actual recording. 

Stop: Click this button to stop recording 

Normalize after recording: With this option activated, your material's volume is 
raised to a proper level after recording is completed. In order to achieve good results, 
you should try to record the source as loud as possible without overmodulating it. To 
do so, refer to the peak meter reader in the recording dialog. 

Play while recording: This option is particularly important for spoken commentary, 
etc. If activated, the selected movie (or selected scene if recorded in the "Edit" screen) 
is played while recording. This acts as orientation for the movie. 
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Advanced: Use this button to open a window where you can select from special 
features: 
 

Advanced settings for audio recordings 
• Mono recording: Activate to record in mono. This reduces the required memory 

space in half. Mono recordings are recommended for voice recordings made 
using only one standard mono microphone. 

• Real-time resample to project's current sample rate: Automatically matches the 
sample rate of a new file to be recorded with the sample rate of the current 
movie's sound track (set in the video recording). 

• Automatic volume reduction of other audio tracks ("ducking"): To add narration 
or other sound material to a video that already has sound volume levels set, 
activate the option ”Automatic reduction of sound volume of remaining audio 
tracks”. This automatically reduces the volume of audio objects in the 
arrangement during the recording session (”ducking”). This is achieved using an 
automatically configured volume curve: Before and after the recording, other 
tracks will be faded in or out, resulting in a homogeneous total volume level. 
(Lowering of volume level during spoken comments is also called "Ducking".) 

 

Single frame 
Single frame recording may be used to record snapshots from the connected video 
source. This requires a DirectShow compatible video recording or TV card or a 
corresponding USB device (e.g. a webcam). 

The time control function allows you to automatically take snapshots. This is useful 
for the following applications: 

• to create slideshows using videos 
• for animation films (stop-motion recording) 
• for video surveillance 
• or in time-lapse photography 

The recorded images are added to the current arrangement. 
 

Timer-controlled recording 
Recording interval: When active, starting recording produces a sequence of images. 
Snapshots are saved according to the selected time interval and numbered 
sequentially. For example, if snapshots are taken every two seconds and then inserted 
every five frames into the slideshow, then a ten times accelerated time lapse 
recording will result. 

Photo length in frames: Specifies how long the photos appear in the slideshow. 
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Enhanced single-frame recording dialog settings 
You can adjust certain settings for the video recording driver. 

These dialog boxes, so-called "property sheets", come with the video card drivers. 
The driver-specific features may slightly vary from driver to driver. The MAGIX team 
has little direct influence on the performance of the various drivers. If you encounter 
any difficulties, then please contact the video card manufacturer for the latest driver 
updates. 

Input: Sets the crossbar switch of the video card. This lets you define what video and 
audio signal is used in the recording. The crossbars are connected in series to the 
video recording chip itself. 

Output: In the "Output" field, the video output (for the crossbars) is the input for the 
recording chip (video or audio decoder in) of the video card. In the "Input" field, you 
select the signal source to be used for this input by the video card during recording. 

Composite in = the normal video input (typically a cinch jack) 

S-VHS in = S-VHS input (special cable) 

Tuner in = the TV signal of the built-in tuner 

Video decoder: If the picture only appears in black & white or it flickers, then the 
video standard may be set incorrectly. PAL_B is used in Germany and most European 
countries (France: SECAM; US/CAN: NTSC). 

VideoProcAmp: For fine tuning of colors, brightness, contrast, etc. We recommend 
against changing any of the manufacturer's settings. 

Format: Do not change anything here! The capture format settings can be changed 
under "Resolution" in the "Recording" dialog box. 
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Screen Capturing 
Use this feature to record everything that moves on your monitor. This process is 
called "screen capturing". 
 

Note: This function is available only in the Plus/Premium version. 

 

Step-by-step screen capture 
Use this feature to record your screen content. This process is called "screen 
capturing". 

• Under Recording quality, you will find 
various presets for different 
applications. You can either record the 
entire monitor ("fullscreen"), a frame of 
variable size (e.g. to film the Windows 
Media Player display), or a different 
video player. Click "Configuration" to 
make custom size adjustments. 

Hint: Because many video players work 
with overlay, it is recommended to open 
each player before starting the capture! 
This way switching into "Overlay" mode 
can be prevented. 

• Select the "Screen" option in the recording selection dialog.  

An additional dialog with a red record button, a black stop button as well as a frame 
with dashed bordering appears.  

• Activate the option "Record mouse pointer" to record the movements of the 
mouse pointer. 



 

84   

www.magix.com 

 
• Now select the screen area you wish to record, i.e. the screen of the video player 

in which the video is playing. Drag the frame over the area you wish to record and 
adjust its size as required by dragging the edges and corners. 

Note: If you previously selected "Fullscreen", the window will be hidden. 

• To start recording, press the red record button. The recording starts; the record 
symbol appears in the task bar (tray). 

• If you are finished with everything, click on the record button or the stop button 
to stop recording. Recording ends and the recording dialog is visible once again. 

 

Edit after recording 

 

The "Edit after recording" dialog can be 
opened from the "HDV Camera", "DV 
Camera" and "Video" recording dialogs. 

This dialog offers the these options: 

• Automatic scene recognition: This divides the footage into scenes. Please also 
read the section "Automatic scene recognition" (view page 189). 
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• Automatically set chapter markers: Please also read the section "Set chapter 
marker automatically (view page 254)" in the chapter "Edit" in the PDF manual 
(press "F1"). 

Burn project immediately after recording: You can use this option to record and burn 
to a disc in a single step. Simply select the format you would like to burn, insert a 
suitable blank disc into the drive, and press record.  

Note: Make sure that the selected recording quality corresponds with the disc type 
(for DVDs the preset "MPEG DVD"). 

If you use your own settings for MPEG encoding (e.g. half image resolution for long-
play DVDs) make sure that settings for recording and later for burning are the same 
so that no new encoding is necessary (Smart encoding). 

After recording, the program automatically switches to the "Burn" screen, the burn 
window opens and the disc is burned. The last set layout is used for the menu layout 
for the DVD. 

Tip: This function is particularly suitable for handling lengthy projects in one go. You 
can start recording in the evening and have the finished DVD by morning. 

Export for mobile device: The recorded movie is immediately converted into the 
format of the selected mobile device and transferred. The preset in the list field is the 
device which has been selected in the Export video/audio (view page 242) dialog. 

Settings: Opens the Export settings (view page 235) for the selected target device. 
 

Import a non-copy-protected DVD 
Click in the Media Pool under "Import" on "Computer" and select by double clicking 
the DVD drive where the DVD to be imported is located. 

Now you can load the listed VOB files into the project as described in the "Add 
objects into the project" (view page 86) chapter. MAGIX Movie Edit Pro 2013 
recognizes which files belong together, so that you only have to load one file. 
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Objects 
Objects are used while in MAGIX Movie Edit Pro 2013's "Timeline" mode. The 
general term "object" includes all media types that are present on the arranger's 
tracks. There are video objects for video files, audio objects for audio files, image 
objects for images and photos, title objects for subtitles, and even synthesizer objects, 
which contain MIDI files. 

In the following chapter you can read about what you can do with these objects. The 
workflow for all object types is the same. 

Tip: You will find many functions in the object context menus, which you can open 
with a right click on the corresponding object. There, you will also find the "Object 
properties" dialog, where in addition to current settings you can also change 
interlace settings for the object. In the "Context menu" chapter of the PDF manual or 
in Help (F1 key) you will also find detailed information. 

 

Insert object into the project 
Data selection using the preview monitor 
You can view and cut your footage in the preview monitor before importing. There are 
various buttons on the transport console (view page 51) for this. There is a preview 
function for most of the files in the Media Pool. 

• Use the playback button to start the preview of video or image objects in Media 
Pool. A preview is also provided for special objects like titles or fades. 

• Audio files from the Media Pool can also be previewed via the playback button. 
 

Full-page view of image 
• The option "full screen" in the context menu maximizes the preview monitor. 

Alternatively, a double click on the monitor or press "A + Enter" to maximize the 
window. The fullscreen view is especially recommended for working with two 
screens; one screen for the film preview, and the other for the arranger. 

• You can also shift the monitor into full screen mode and access it via the context 
menu (right mouse button). There, you can also hide and display the basic 
transport controls. 

• With "Esc" you will go back to the normal view (or click on "smaller" button to 
the right in  the fullscreen mode). 

 

Show movie overview 
The option "Film overview" in the "Window" menu enables an overview of the entire 
arranger. All objects in the arranger will be displayed in the program monitor. The 
overview display is especially recommended for work with long movies because the 
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reduced overview in the program monitor and the zoomed detailed view in the 
arranger present a good combination.  

The film overview can be used for moving around in the movie and for editing certain 
parts: 

• When you click on a certain object in the video monitor, the arranger will zoom 
on that object.  

• Using the mouse, you can draw a frame in the video monitor – and the 
corresponding range will be zoomed in the arranger. 

• When you move the playback marker in the video monitor, the arranger playback 
marker will also move correspondingly. 

Tip: If you use this option very often, you can use the keyboard shortcut (Shift + A). 

 

Load files 
Media files can be loaded into the arranger from the Media Pool in several different 
ways: 

• The fastest way: Drag the desired file from the Media Pool into the desired track. 
If an object is already present at this position, the file is inserted at the desired 
time position on the next empty track below. 

• Load several files: If you would like to load several files, hold down the "Ctrl" key 
while clicking on the entries you would like to use. If you would like to load a 
sequence of files, hold the "Shift" key and click the first entry, then on the last. All 
entries in between are selected. Then you can drag all of the selected files into 
the Arranger with the mouse button pressed.  

• Insert by command:You can also use the commands of the "Insert modes" (view 
page 40). 

 

Files with multiple audio tracks 
MAGIX Movie Edit Pro 2013 also loads VOB files that contain multiple audio tracks. 
After the VOB file has been loaded, simply click the audio object created and select 
the desired audio track. 

Note: To view and select audio objects in the arrangement, Timeline mode must be 
active. 
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Loading parts of movie files 

 

For longer videos, it is recommended to define the areas which should 
be loaded into the project before importing. An in and out point is set 
to define the area for this purpose.  

Proceed as follows: 

• Select a file from the Media Pool by double clicking it. Play it back using the play 
buttons to indicate the section which you want to use in the project. 

• Either move the range markers directly by dragging them with the mouse or set 
them using the buttons or the shortcuts I and O. The shortcuts are especially 
useful for exact positioning using the shuttle and the jog wheel 

• Left click on the monitor and drag it to the arranger. An object will appear on the 
track, corresponding to the selected area. 

 

Select and group objects 
To edit or delete objects using menus, you must first select them. To do so, simply 
click on the object you wish to select. Objects will change color to show that they 
have been selected. 

When the Shift key is pressed, multiple objects are selected. You can open up a 
rectangle positioning the mouse over the object, then holding down the mouse button 
and marking all objects within the rectangle (”elastic band selection”) by left-click-
dragging. 

Any object can be combined with others to make up a group, to avoid the objects 
being unintentionally moved out of relation to each other. Once they are combined, 
clicking on one object of a group will select the entire group. To group or ungroup 
objects, use the buttons in the tool bar or the corresponding commands in the "Edit" 
menu. 
 

Move Objects 
Hold down the mouse button to move selected objects to any tracks and positions via 
drag and drop. It is recommended to place objects that belong together on 
neighboring tracks and to create separate tracks for audio and video objects. For this 
reason, videos that should overlay each other should usually be placed on the same 
track. 

If the Shift key is pressed, objects can be moved from one track to another, without 
the time position being changed. 
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Cutting objects 
All objects can be split. Each object section then becomes is an independent object. 

 
• Select the object to be cut. 
• Position the playback marker at the position where the movie is to be cut. 
• Click on the "Cut" (view page 39) button or select the "Cut" option in the 

"Edit" > "Split scene" menu.  

Note: If the commands "Split scene" and "Remove beginning/end" are applied 
without a selection, all objects at the position of the playback marker are cut. 

Tip: You can find detailed step-by-step instructions on how to remove (view page 
26) unusable scenes from video material in the "Quick start" chapter of the print 
manual. 

There are three options for joining split objects:  

• Click on the undo button in the lower toolbar (view page 38). This will work only 
directly after applying the split command. 

• In order to rejoin these split objects at a later stage, simply highlight the 
individual parts and select the "Group" command to join the selected objects 
together into one group. 

• Remove the rear object and move the front object forward and restore the 
original length using the bottom right handle. 

 

Duplicate objects 
Objects may be duplicated very easily. Click on the object to be copied with the 
mouse while holding down the "Ctrl" key. This generates a copy, which you can 
immediately drag to the desired position or cut separately. 
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Object handles 
All objects can be re-sized with their lower edge “object handles”. Move the mouse 
over one of the lower corners of the object until the mouse pointer becomes a double 
arrow. Move the mouse over one of the lower corners of the object until the mouse 
pointer becomes a stretch symbol. 

 

5 "handles": Length, fade, transparency (volume) 

An object can be faded in or out with the handles to the left and right upper corners of 
the object. Cross-fades between different objects can be created by overlapped 
positioning of objects that are fading in and out. The length of the cross-fade can be 
adjusted with the handles. 

Using the transparency/volume handle located centrally at the top of the object, 
adjusts the transparency of video and Bitmap objects, or the volume of audio and 
image objects.  

If you adjust the middle handle of a video object all the way down, the object will 
become transparent. If a second object is located on a track above it, a black color will 
appear from below it, so that brightness will be reduced. 
 

Trim Objects 
Trimming provides exact placement of object borders or transitions. MAGIX Movie 
Edit Pro 2013 has two different trimmers, and these can be opened using the context 
menu for a video or image object. 
 

General advice for operating both trim editors 
Play functions: The trim window contains its own play functions that allow the object 
to be played individually or in relation to the arrangement.  

The right play button plays the arrangement normally. Replays can sometimes appear 
shaky because the processor may be over-worked. Those frames that the processor 
cannot calculate quickly enough are left out.  
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The middle play button plays the arrangement “frame by frame”, which means no 
frames are left out. Depending on the processor load, playback may thus be slower, 
but still smooth. 

The left play button renders material before playing, i.e. the current settings are 
calculated first and then exported. This method ensures a smoother playback.  

With the fast forward and rewind functions you can change the range start in the 
timeline. This allows for complete control of transitions between two videos. 

Increments:  A click on the arrow buttons in both trim editors moves the handle or 
the material within an object exactly by one frame. With the Ctrl key you can increase 
the frame rate gradually to 5 frames per mouse-click. 
 

Trimmer for individual objects 
A schematic display of the selected object and its handles can be found in the center 
of the trimming window.  

 

Fade in/out (4, 5): These buttons adjust the upper fade handles of an object. 

Object content (3): Here you can move the video material to be played without 
changing the object length. 

Position (2): Moves the object on the track. 

First frame/End fade-in (7): Toggles the left monitor between the first frame of the 
object and the end of the transition. 

Start fade-out/Last Frame (8): Toggles the right monitor between the start of the 
transition and the last frame of the object. 

Left/right arrow buttons (1, 6): Here you can adjust the lower object handles. 

Next object/cut (9, 10): The buttons below and to the right skip to the next/previous 
object and/or cut in the arranger. These buttons make it easy to move and trim 
objects in the arrangement without having to leave the trimmer. 
Keyboard shortcut: Shift + N 
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Cut trimmer 

 

A schematic display of the selected transition and its handles can be found at the 
center of the trimming window.  

Left arrow buttons (1): These buttons move the last frame of the first object while 
adjusting the second. The length of the transition remains. The display indicates the 
relative change in comparison with the starting situation when the trimmer was 
opened. 

Position (2): Moves the second object. The length of the transition is changed. This 
corresponds with shifting an object in the arranger.  

Object content (3): Moves the movie under the second object. The length of the 
object and the object itself are not changed. 

Crossfade (4): Changes the transition’s length between both objects. The objects 
remain of equal length. The length can be numerically entered. 

Middle arrow buttons (5): Shifts the existing transition. Both objects remain in their 
positions, but the transition’s center point moves. 

Transition (6): Displays the type of transition. A mouse click opens a popup window 
from which you can select a transition. 

Right arrow buttons (7): Move the first frame of the second object. The first object 
and the transition remains. Only the length of the second object changes. 

Start fade-out/Last frame (8): Switches the left monitor between the start of the 
transition and the last frame of the object. 

First frame/End fade-in (9): Switches the right monitor between the first frame of the 
following object and the end of the transition. 

Next cut (10)/Next object (11): The buttons below and to the right skip to the 
next/previous object and/or cut in the arranger. These buttons make it easy to move 
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and trim cuts in the arrangement without having to leave the trimmer. 
Keyboard shortcut: N 
 

Extract sound from videos 
Video with sound material appears in the arranger on two tracks as two objects (an 
audio object and a video object). The two objects automatically form a group. 

To edit the video and audio material separately from one another, the objects can be 
separated with the Ungroup (view page 252) function in the "Edit" menu or button in 
the arranger. Now you can replace the audio or the video track, or process each file 
separately. Rejoin/regroup the tracks with the ”Export arrangement” function. 
 

Transitions (fades) 
When importing video files into the arranger, individual objects usually follow directly 
after one another. This is called a "hard cut". However, you can make scenes blend or 
“transition” into each other. 

This means that for the duration of a transition, two objects are shown at once and 
can be mixed "faded" together in different ways. You will find numerous blends in the 
Media Pool’s transition directory. 
 

Simple crossfade 

 

A simple transition can be created in the arranger by dragging one object over 
another. A crossfade will be automatically created. During this standard transition, 
the brightness of both objects is increased, i.e. the first clip fades out while the second 
clip fades in. The duration of the crossfade is displayed in the arranger by white 
crossing lines. You can adjust the length of the crossfade by dragging the upper 
handle of the second object to the left or to the right. 

  

To select a different fade click on the transition symbol displayed when 
an object is selected. 

The fade menu opens. The transition icon will change, depending on your selection. 
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Fades from the Media Pool 
• To open the fade directory, click on the "Fade" button.  
• A click enables a preview of the fade on the preview monitor. 
• Simply drag the desired fade preset onto the border between the two objects. 

Only when the mouse pointer with the transition preset is placed over a scene 
change will it turn into an object symbol. The object at the back will be shifted to 
the front to accommodate the transition.  

The length of a transition is decided by you, if a transition is shortened, it means that 
the resulting effect is speeded up.  

Some transitions can be adjusted even more exactly. To do so, click on the 
corresponding fade symbol in the Timeline or in the Storyboard and select "Settings". 
Thus, an object's fade symbol in the Media Pool can represent an entire group of 
different effects. 

The so-called alpha fades ("Iris", "Objects", "Random", etc.) are actually pre-produced 
black and white videos combined with the alpha keying effect. 

Other fades use sound effects. Look around at all the contents to form an idea of what 
you can use in future projects. 

Note: Use transitions economically! Most professional movies or TV shows use hard 
cuts as the rule and transitions less frequently. Videos appear unprofessional and 
too ornate if fade effects are added to every change of scene. 

 

Exporting own fades 
Alpha keying extends the range of transition effects used in MAGIX Movie Edit Pro 
2013 to produce black & white movie transitions or selected color fade-ins and fade-
outs. You can create such a video from any video material (also color) by exporting it 
as a transition (File -> Export movie -> Export as transition). 

The loaded movie is then exported as a black and white video in mxv format and 
stored in the fade directory. Afterwards, it will be available in the Media Pool and the 
fade menu. 
 

3D fades 
General 
3D effects offer exciting and varied opportunities to create transitions between two 
videos. You can find 3D effects under "Fades" > "Spatial fades" in Media Pool. 

Settings 
The fade settings enable the behavior and appearance of the 3D fades to be 
influenced. Click the corresponding fade symbol for the object and choose "Settings" 
to do this. 
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You have the following options: 

Anti-Aliasing: A bothersome jagged edge sometimes appears on the borders of 3D 
objects. Anti-aliasing reduces this effect, but also requires more computer power. The 
setting applies globally to all 3D fades, switching on anti-aliasing during 3D fades has 
the effect that all other 3D fades are also affected by this setting. 

Mirror X / Y: You can change the movement trajectory of 3D objects inside the fade. 
The option "X-axis mirror" mirrors the movement of the object horizontally (along the 
X-axis). The option "Y-axis mirror" mirrors the movement of the object vertically 
(along the Y-axis). 
 

3D series 
The 3D series are a further development of 3D fades (view page 94), where the 
transitions are thematically sorted. For instance, you can let photos pop up and 
disappear on a notice board or make it look as if the photos were hung on the walls of 
a gallery.  

You have the following options to open 3D sequences for photos or scene transitions: 

• In Media Pool, click on "Fades" > "Spatial Fades" > "3D Sequences". Select the 
desired 3D series and drag it onto the first scene or image transition where the 
3D series should start. 

You can select how many of the subsequent fades should be replaced by the 3D 
series in the dialog. 
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Overview mode 

 

The “Scene overview” mode is a special view that improves manageability and 
categorization of scenes. All scenes are listed one after the other (in multiple lines, 
like in a text program) and can be copied, cut, moved, deleted and inserted. 

"Overview" mode does not indicate start, playback, or end markers. The scene which 
is currently being played has a frame around it. 

The zoom slider enables the view 
to be enlarged or reduced. 

This controller also specifies how many scenes are displayed. The smaller the preview 
pictures, the more will fit onto the overview. 

 
Maximize: Use this button to maximize the scene overview to fullscreen mode. 

 

Snap 
The arranger interface features a frame-exact snap grid. This ensures that video and 
image objects snap exactly to the borders of a frame. 

The snap stages depend on the frame rate specified in the movie settings ("File -> 
Settings -> Movie"). Choose between Europe's standard frame rate for PAL (25 
frames per second) and America's and Japan's standard frame rate NTSC (29.97 
frames per second) or any other manually set frame rate. 

 

When moving an object, the position display indicates at which frame the first image 
of the object is shown. 
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The position is displayed in the form of a 
tooltip when moving the object.  

This informs concerning the 
"hours:minutes:seconds:frame". 

 

In addition to the constantly active frame grid, an object grid may also be activated. 
This ensures that two consecutive objects will seamlessly snap together even if they 
are on different tracks. This avoids undesired gaps or overlaps. 

 
The object grid may be activated/deactivated via the magnet symbol in the 
lower toolbar. 

 

Zoom 
• Using the context menu, you can minimize or maximize the video monitor up to 

fullscreen view. 

 

• The video image in the video monitor 
can be minimized and maximized with 
the help of the zoom button. This 
comes into use (view page 140) 
especially during effect animation. 

Note: This zoom applies only to the 
current view in the preview monitor and 
will not be applied as a video effect. 
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Markers 
In MAGIX Movie Edit Pro 2013 you can set various types of markers within your 
project. 

 

The Lock button (at the very front, next to the time ruler) lets you lock all 
markers (jump markers, chapter markers) against accidental moving or 
deleting. 

 

Playback marker 

 

The playback marker indicates the point from which the material – 
either the arrangement or a selected file from the Media Pool – will 
be played back. There is a playback marker below each preview 
monitor and an additional one above the timeline in the arranger. 

The playback marker is displayed as a red triangle below the monitors. In the arranger 
it is displayed as a red triangle. 

In order to move the playback marker, simply double click on the desired area below 
the monitor. Alternatively, you can click on the playback marker and move it by 
dragging it with the mouse. While being moved, the current image will appear on the 
monitor, letting you see exactly where in the material you are located. 

The playback marker in the video monitor can also be moved by clicking on the lower 
section of the time scale in the arranger. The playback marker will also be moved on 
the program monitor, as both markers are coupled to each other. 

The exact position of the playback marker can be seen in the time display at the top 
left, below the corresponding monitor. There, you can change the displayed values 
(Hour:Minute:Second:Frame) per mouse click to reach a certain point in time. Simply 
enter the desired value and the playback marker will jump to the corresponding 
position. 

Tip: In the "Playback" tab under "File -> Settings -> Program", you can set whether 
repeatedly pressing the space bar resets the playback marker to the current position 
or moves it to the original position. 
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Project markers 
The "Edit" menu or the keyboard shortcut "Shift + numerical keys 1-0 (0 for the tenth 
marker) allow you to set a project marker (view page 253) at the current position of 
the playback marker. They function as a mental marker or indicate certain positions or 
events within the project. 

After selecting the menu item, a dialog appears to input a name for the marker to be 
created. The first ten project markers may be accessed via Ctrl + number keys 1-0. 
This allows you to jump to a particular position of a longer video immediately, without 
scrolling and searching. 

Project markers may be deleted or renamed via the context menu at any time. This 
does not provide direct influence on the result, but they do make the workflow much 
easier. 
 

Area marker (in and out points) 
Area markers are the start markers (in-points) and end markers (out-points). The 
serve to mark a certain area, which will be played back by pressing the "area 
playback" button at the bottom of the corresponding monitor. 

 

To the left, you see a start marker, and to the right, an end marker. 

The area markers in the arrangement serve to indicate the paste position of new video 
or sound material. 

Hint: The value between both markers shows the length of the selected area 
following the pattern of Hours:Minutes:Seconds:Frames. 

 

There are various options for changing the playback range, and with it the project 
start and end markers. 

• Set the playback marker at the desired position and press "Set start of range (in-
point)" or "Set end of range (out-point)" underneath the monitor to set the in and 
out points of the range. 

• Click on one of the markers below the preview monitor and move it with the held-
down mouse key to the desired position. 

• Click one of the markers in the upper-most bar in the arranger and drag it. 
• A right click on the bar moves the range end to the position of the mouse cursor. 

A left click moves the start of the range. The area grows or shrinks in size 
correspondingly. 
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• You can adjust the position of the entire range by clicking the blue bar between 
the markers and moving it by dragging while holding down the Crtl button. 

 

Chapter markers 

 

The chapter marker defines the start of a new chapter. Chapters serve to 
improve navigation when burning the project to disc. 

The following options are provided via "Edit -> Marker" or by right-clicking on the 
playback marker. 
 

Marker > Set chapter marker 

 
Places a chapter marker at the position of the playback marker. This creates a 
chapter entry in the disc menu in case the movie is being burned to disc. 

You can rename the chapter markers by right clicking and selecting "Rename". The 
new name will appear in the chapter menu (view page 214). 

Keyboard shortcut:  Shift + Enter 
 

Marker > Automatic chapter markers 
This option automatically sets chapter markers in the arrangement according to 
specific rules that will then appear in the film menu of a disc as chapters. This is useful 
if a disc should be burned immediately after recording. 
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There is a selection of options available for automatic chapter generation: 

At beginning of movie: The movie only contains one chapter in this case. 

At beginning of object in track: Every object in a track creates a chapter; track 1 is 
preset. 

At position of existing title objects: Subtitles, for instance, as faded-in subheadings, 
give the position of the chapter markers. 

Specified interval (minutes)/Specified amount: If the chapters are separated without 
any particular method and are just needed for quicker navigation, chapter markers 
may also be inserted in pre-defined intervals or as a pre-defined number of chapter 
markers. 

Naming of chapter markers: To title the chapter markers, a user-defined name 
featuring consecutive numbers or the object name or text from the text objects may 
be used. 

Optionally, existing chapter markers may be deleted and the automatic chapter 
marker function may be limited to the area between the start and end markers. 

Keyboard shortcut:  Alt + Shift + Enter 
 

Marker > Delete (all) chapter markers 
Delete one or all chapter markers. This removes chapter entries in the disc menu if 
the film is burned to disc. 

Keyboard shortcut:  Ctrl + Alt + Enter 
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Scene markers 
Scene markers separate a complete video into scenes. You can load any video into 
MAGIX Movie Edit Pro 2013 and have it divided into scenes. 

Simply drag the desired video into the arranger. Then, right click on the video and 
select "Scene recognition". The following dialog appears: 

  

After clicking "Start search", an overview of the detected scenes will be displayed 
underneath the scene control. 

Delete scene markers: Here you can delete individual markers by selecting them from 
a list. 

Delete all markers: Deletes all project markers. 

Action on OK: You have three possibilities: Either MAGIX Movie Edit Pro 2013 splits 
your video into individual scenes ("Cut at all markers"), you select a scene and cut 
only at this position ("Cut at selected marker") or you can save the scenes as "Takes". 

After deciding in favor of one of these options, red scene 
markers will appear on the timeline in the arranger. The 
scenes can then be split according to the selected option and 
edited. 

 

Note: An important difference between a scene and a chapter marker is that a scene 
marker can be set only within a continuous video, while a chapter marker can 
include several videos consecutive videos. 
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Additional information about scene recognition is provided in chapter "Insert objects 
into the project (view page 189)". 
Keyboard shortcut for scene detection: Shift + Z 
 

Multi-cam editing (Plus/Premium version) 
Multicam editing enables easy cutting of various recordings of the same scene from 
different camera perspectives. The program monitor displays footage from two 
sources next to each other. This footage can be cut together in realtime just like in a 
real studio. 

Tip: The program uses audio analysis to synchronize multicam tracks. For this 
reason it is recommended that you deactivate any audio effects such as compressor, 
limiter or leveler. These can effect the quality of the editing in MAGIX Movie Edit 
Pro 2013. Footage that has been "adjusted" can also not be edited further in full 
width. 

 

Note: This function is available only in the Plus/Premium version. 

 

Preparation 
Multicam editing is a special arranger mode. The top two tracks serve as target tracks 
for copying sound and video from two different source tracks. The two top tracks 
must be empty when switching into the multicam mode, otherwise existing objects 
will be moved to a different track. 

Next, load various video recordings of the same scene one under the other starting on 
track 3 in the arranger.  

It is important that the individual sources are synchronized to each other exactly. It is 
best to find a noticeable movement, or an "o" sound, if audio was recorded.  

Hint: To localize the sound in the audio track exactly, you may have to create a wave 
display of the track. Right click on the sound track and choose "Create wave form 
display". 

You can use a clapperboard during filming, since this offers both sound and motion; 
an actor's clapping in front of running camera before the start of the scene is also 
helpful. Set a grid point at this position in the object ("Alt + Shift + P"). You can now 
move the source objects over each other, so that the grid points are aligned. 
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Two video sources with sound tracks can be automatically synchronized using their 
audio material. Move the video and audio objects with the mouse to the right 
position, until the sound of both videos is exactly synchronous. 

It is also important that you make all effect settings for the output material (e.g. video 
or audio cleaning) before the multicam edit on the objects on the source track and on 
the master audio track (view page 106). These effects will be transferred to the 
objects in the target track with the edit. Otherwise, you will have to apply the effects 
from every single object to the target track. 

 
You can activate "Multicam" mode with this button or with the "Multicam" 
command in the "Edit" menu. 

 

Source tracks and preview images 
The assignment of tracks as source tracks for the multicam cut takes place 
automatically. When the multicam mode is activated, the source tracks will be 
assigned to all tracks containing video objects starting from track 3. 

You can also conduct or change the assignment manually. To do so, right click on the 
trackbox of the corresponding track to active or deactivate a track as a source track. In 
this way, you can use more than two tracks for multicam editing, but no more than 
two simultaneously. The source tracks are marked using color. 

 

A preview appears in the program monitor for every assigned track, and the source 
track's color corresponds to the preview images so that you can quickly assign each 
preview image. 

If the objects created using multicam cut are located on the target track, a preview 
image of the corresponding source track highlighted with a yellow frame will be 
shown for length of playback. 
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Multicam edit functions 
You can edit various sources in the the target track during playback in real time or 
during stopped playback. 
 

Real-time Multicam editing 
You can edit various sources together during playback in real time: 

• Start playback. 
• Click on the desired source in the preview monitor. The corresponding video is 

added into the target track starting from this time point. 
• To switch the source, click in the source monitor on another source. A new object 

will be created using the new source from this point in the target track.  

You can repeat this process as often as you like. 

For precise editing in the target track, use the usual edit functions or the Trimmer. 
Keep in mind that as long as you are in Multicam mode, only the object borders are 
moved, and not the objects themselves. Otherwise, gaps or image jumps could form 
while you use the Multicam edit function again later. 
 

Replacing an object's source 
Replacing an object's video material in the target track with another source: 

• Select the object for which the source is to be replaced in the target track. 
• Click the source you want to replace the video material with in the source 

monitor object. 

The video material will now be replaced by the new source. The project length is not 
changed. 
 

Insert cut 
Insert material from one of the sources between any position on the target track and 
the next object. 

• Place the playback marker at the desired position. 
• Click on the desired source in the preview monitor. 

The material from this source will now be inserted into the target track. The new 
object ends at the next object. The portion below an existing object is overwritten in 
the process. 
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Overwrite range 
You can overwrite a selected area of the target track with one of the source videos. 

• At the upper edge of the arranger, select an area to edit by determining the in 
point by clicking with the left mouse button and the out point by right clicking. Or 
use the corresponding buttons in the transport control. 

• Click the desired source in the program monitor. 

The target track will be overwritten with the video material from the selected source 
in the selected area. 
 

Master audio track 
Normally, videos in the source track are edited together with their audio tracks. Since 
the original sound can differentiate from camera to camera due to different camera 
positions, you will probably prefer using either the soundtrack from only one camera 
for all settings, or to replace the soundtrack completely (for music videos, for 
example, you will use the studio version of the original track). 

Right click on the track box of one of the source audio tracks or a different audio track 
and select "Multicam: Master audio track" from the context menu to assign a master 
audio track for multicam editing. The master audio track will be appear in a dark color. 

Now, during every multicam cut, material from the master audio track will be inserted 
on track 2, independent of the source track used.  
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Title 
Titles can be used for many applications: as a running text (ticker), subtitles, speech 
and thought bubbles, to display date and time, and much more. 
 

Creating titles using a template 
The Media Pool includes the tab "Title" with folders filled with additional, thematically 
named title templates. 

• Open one of these entries and select any title template. A simple mouse click 
provides a preview, and double clicking creates a title object using the template. 

Note: Templates may be applied to an existing title object. Settings outside of the 
text will be lost! 

 

Create titles without a template 
1. Position the start marker in the arranger where you would like the title to be 
displayed. You can adjust this position later at any time.  

2. Click on "General" in the "Titles" section of the Media Pool. 

3. Create text fields: 

• If you want to create a text field where the text is automatically adjusted with 
breaks, drag a text field onto the preview monitor. 
The option "Automatically adjust text" is activated and cannot be changed. 

• If you would like to create a text field where the text can automatically be 
adjusted with breaks only where required, click on the preview monitor.  
The option "Automatically adjust text" is activated but can be deactivated at any 
time, e. g. if you want to let the text run through from right to left using 
animation. 
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4. Use the keyboard to enter the text and click on the checkmark in the preview 
monitor to confirm it. You can edit it any time you like in the text field. 

You can format your title later through the title editor in the Media Pool. 

Tips for working with text: 

• Adjust text settings for several text objects simultaneously by selecting them in 
the arranger. The settings will only be applied to the text objects you have 
selected. The individual properties of each text object remain unchanged. 

• Use the slider to adjust the text size. 
• Hold down the Shift key and drag the title field handles to switch from "Adjust 

text field to title field" mode and back. 
• Use the arrow keys in the title editor to move from one title object to the other 

without having to search in the arranger. Captions are not included in this. 

 

Texts can be displayed in all kinds of 
fonts and colors. 

If you want to format individual words 
or letters, select them with the mouse 
and choose a different format or color. 

Without any selection, the entire text in 
the object will be formatted. 

 

 You can open the title editor by pressing "T". A title object will be created 
where you can immediately enter your text. 

 

Edit titles retroactively 
• Double-click on the title in the preview monitor (or the title object in "Timeline" 

mode). Now change the text however you like.  
• Confirm your entry by clicking the check mark next to the positioning frame. 

You can also go to the Media Pool area "Titles > General" and enter your text there. 
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Position titles 
• Click once on the title in the preview monitor and a positioning frame will appear. 

Simply move the positioning frame using drag & drop. 

 

• The size of the positioning frame can be adjusted at the corners. If "Adjust font 
size to title field" is activated, the text size will also change. 

Click once on the button in the Media Pool under "Title > General > Title 
object" to center the title horizontally and vertically. 

 

Advanced settings 

 

Only use visible TV area: The text will be zoomed so that it will always be within the 
TV's limits, which is specified in the Movie effect settings (view page 145). 

Background: Specify here whether the text's background should appear black or 
white. This is only meaningful if no other video or image object is in the background. 

Text effects: Here you can edit different text effects in detail. One color may be set 
for each effect. 

Shadow: The position of the shadow may be set on the horizontal and vertical axes.  

Transparency makes the background "shine through" more or less. 

Soften: Makes the edge of the shadow harder or softer. 
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Outline: A border appears around the letters in the text. 

Width: You can enter the width of the frame in points. 

Color: Clicking on this button opens a color selection dialog, where you can set the 
frame color. 

Filled in: The text will be filled with the color selected in the Title Editor. If the option 
is deactivated, only the frame will be visible, and the background will appear instead 
of the color fill. 

3D: The text appears with a 3D-style outline. The width and thickness of the 3D 
contour (H) can be set in points. 
 

3D text 

Note: This function is available only in the Plus/Premium version. 

3D text can be created directly from the title editor.  

 
• Click the title editor and then press the 3D Title button. 

The title object will now be turned into a MAGIX 3D Maker object. If you have also 
installed MAGIX 3D Maker, the program will open when you want to edit the text. 
Presets are also located in the Media Pool under "Titles -> 3D". You can enter or edit 
text here. 

Note: For more information about MAGIX 3D Maker, try its help file. You can open 
it by pressing "F1" from within the program. 

 

Fade in date as title 
MAGIX Movie Edit Pro 2013 can add a time or date (“time code”) to the picture 
material. To add a time code, right-click the video object and choose the “Fade in date 
as title” option from the context menu. 

If you’re using a DV-AVI file (a digital recording from a camcorder, for instance), the 
recording date will be used from the chosen place. If you’re using a different file, the 
creation date will be used as the time code. The title editor is then opened in order to 
customize the entry. 

In the preview monitor context menu you will also find the "Display play time" option. 
This will create a time code. 
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Effects 
MAGIX Movie Edit Pro 2013 offer a large palette of various video effects. The video 
effects used the most can be found directly in the Media Pool, while others can be 
found in the object context menu or in the "Effects" menu. 
 

Apply effects to objects 
There are various approaches for applying effects: 

• Video and audio effect presets are loaded into the corresponding object from the 
Media Pool using drag & drop. 

• Effects that can be animated (in the Media Pool under "Effects -> Video effects / 
movement effects") will be applied directly to the objects selected beforehand as 
soon as changes are made in Media Pool. 

 
This button resets all of the current effect settings. 

Note: If you animated the effect using keyframes, resetting will affect the entire 
animation. Individual keyframes may be deleted via click + Del (view page 137). 

 

Transfer effects settings 
The items video effects (view page 112), movement effects (view page 119), and 
Stereo 3D (view page 177) on all effects pages provide the option to transfer the 
current effects settings to other objects or to load previously saved settings. Use the 
above right arrow button to open the video effects menu. 

 

Save/load video effects: The current effects settings may be saved for later use in 
other projects or previously saved settings may be loaded. A dialog allows the effects 
to be selected. 

Reset video effects: Resets the effects settings for the selected object. 
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Copy/paste video effects: Copies or inserts the current settings as a new object. Use 
the dialog to select which settings should be copied. 

Apply video effects to all: Copies the current effects settings to all objects in the 
arrangement. Use the dialog to specify which settings should be copied. 

Apply video effects to all the following objects: Copies the current effects settings to 
all of the following objects in the arrangement. Use the dialog to specify which 
settings should be copied. 

Load effects mask (in the Plus version): An effects mask (view page 127) may be 
loaded for a selected object. 
 

Video effects in the Media Pool 
Video effects in the Media Pool can always be opened independently from the 
selection of an object. 

The program monitor displays the starting image of the video. The playback marker 
enables you to jump to a specific position in the video in order to check the results of 
the effects by starting and stopping playback. 
 

Brightness & contrast 

 

Auto-exposure: This button automatically optimizes the exposure, contrast, and color 
with a few clicks. The other settings options in the dialog provide more precise results. 

Brightness/Contrast: Use the sliders to increase or reduce the brightness and the 
contrast of the picture. 

Gamma: "Gamma" specifies the mean gray value provided by the various color 
ranges. In the preset list, select various envelope curves to edit only the dark, median, 
or brightest areas of the image. 
The fader also sets the intensity of the brightening or darkening. 
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Color 

 

White point: An incorrect white balance can lead to an unnatural blue or red hue. 
Instructions: To use the white balance, click on on the button to the right of the label 
"White balance" and then select a point which represents white or a neutral gray to 
the "outside world". The color temperature is then corrected automatically. 

Tip: Interesting color effects can be achieved by setting a color other than white. 
There is definitely room for experimentation! 

Red Eye Removal: Using this photo function you can remove unnatural red eyes that 
are the result of using a flash. Click on the eye symbol and then select the red pupils in 
the preview monitor using the mouse.  

Saturation: Use the saturation slider to increase or reduce the hue proportions in the 
image. A newly developed algorithm is applied which makes color changes related to 
other parameters (for example contrast settings) in order to achieve the most natural 
coloration possible. With some experimenting, you can achieve some amazing results 
– such as turning summer images into autumnal pictures, or creating funky pop art... 

Hue: Select a color for coloring the image from the color chart. 

Red/Green/Blue: Changes the color portion mix using the slide controller. 
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Color correction 

 

Secondary color correction allows individual colors in video and image objects to be 
adjusted. The two layers, the front and background, are separated from each other 
using a mask. Both can be edited separately. The master layer may also be used to 
influence the overall image. 

The foreground layer corresponds with the mask created, and editing in the 
background changes all of the areas outside of this mask. This is how you can create a 
mask for the background: 

• Activate "Add". 
• Place the mouse over the preview monitor. The mouse pointer turns into a 

pipette. 
• Click with the pipette tool on the color in the program monitor that you would like 

to assign to the mask. Unwanted colors can be removed from the selection again 
by selecting "Remove" and clicking the corresponding color. 

MAGIX Movie Edit Pro 2013 displays the mask in black and white stripes to highlight 
the current selection. 

• Adjust the color using the color selection slider until you like it. 
 

Note: This function is available only in the Plus/Premium version. 
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Chroma key 

 

This section contains the effects for chroma keying used to mix together two videos 
into a foreground and background.  

Note: The background video must be placed in the track above the foreground 
object.   E. G.: Track 1: Background, Track 2: Foreground  

Mode 
Stamp: The currently selected object is "stamped" onto the video on the track above 
the object. This is only possible if the bottom video takes up only a part of the image. 
Otherwise only the bottom (currently selected) video would be visible. Normally, the 
object should be reduced or moved first. This is done with the help of "Position/size" 
(view page 119) effect or via the submenu "Section" in "Effects -> Video object 
effects". 

Color: In the preview monitor, drag the cursor over the color that should be 
transparent and select a section. The video is made transparent in the sections with 
this color and the video on the top track will show “through”. 

Mix: This button mixes the two videos together based on the brightness. Brighter 
areas accumulate and quickly appear white; darker areas have less of an effect on the 
result. 

Colors to be hidden 
Green/blue/black/white: All green/blue/black/white areas of the video below 
appear transparent. This makes it possible to "place" a person who has been recorded 
in front of a blue background into any type of landscape.   

Water: Only the contours of the upper video are mixed, which results in something 
like a water effect.. 
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Alpha: This video effect uses the brightness of a video to control a transition effect 
between two other videos on neighboring tracks. The additional videos should be 
situated directly above and below the alpha-keying object. 
In all black parts of the alpha-keying object, the top video is faded in, while in all white 
passages the bottom video is shown. Grey passages are permeable for both videos 
and create a mixture of the two. In the case of colored passages, the brightness of the 
color is used for control purposes. 

You can use the "Threshold value", "Transition area" and "Antispill" controls to fine-
tune your results, e. g. to remove reflections of hidden colors on surfaces or to 
sharpen the transitions to objects.  

Video Level 
Changes the brightness of the video before additional video effects are applied. This 
can have a serious influence on the effects, in particular on Chroma Keying. The level 
setting may be automated so that two videos can be mixed dynamically with each 
other. Read more about this in the chapter "Animating objects" (view page 135). 
 

Art filter 

 

Erosion: The image is broken-up by means of small rectangles and resembles a 
"patchwork". 

Dilate: This works like erosion, but uses light surfaces instead of dark ones to form the 
rectangle. 

Emboss creates a relief of the image edges, in which case strong contrast differences 
are interpreted as edges. 

Substitution: Using the rainbow scale red, green, and blue components are 
exchanged. Quickly create surreal landscapes or a green face! 
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Move: The color values are inverted increasingly. Blue colors turn red, and green 
appears purple. 

Quantize: Depending on the setting, colors are either rounded up or down so that the 
overall number of colors is reduced. This creates interesting grids and patterns. 

Colorize: Using this slider, color in the video with red, green, and blue colors (the 
basic TV colors). 

Contour: The image is reduced to its contours in two sizes (3 x 3 or 5 x 5). It is 
possible to select either vertical or horizontal contours. 
 

Distortion 

 

Motion: Moving parts of the image are enhanced and warped. 

Echo: The moving images create an optical "echo"; previous images stand still and 
gradually turn paler until they completely disappear. 

Whirlpool: The image is twisted into an "S" shape. 

Fisheye: The perspective is distorted as if the image were viewed through a fisheye 
lens. 

Mosaic: The video is depicted as a mosaic. 

Lens: The image is dynamically distorted at the edges. 

Sand: The image is depicted in a granulated manner. 

Kaleidoscope: The left upper corner is mirrored horizontally and vertically. 

Mirror horizontal/vertical center: The object is mirrored vertically or horizontally – it 
appears on its side or upside down. 
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Sharpness 

 

Sharpen: The fader allows you to regulate the level of image sharpness or apply a soft 
filter. 

Apply to: Allows you to set just how much the sharpness settings should be applied 
to surfaces or to edges. This enables you to effectively reduce ongoing image 
distortions (noise). 

Artistic blur: Here you can apply various soft filters. The achieved effects are much 
stronger compared to simply sliding the controller under "Sharpen". 

Tip: Artificial blur achieves good effects when used for transitions. To do so, you can 
animate (view page 135) the first video so that it is strongly blurred and let the 
second video begin with blur and slowly return to normal focus. 

 

Speed 

 

The playing speed can be adjusted with the slider control. The range between 0 and 1 
plays the video slowly; values above 1 accelerate playback. If playing speed is 
increased, the object length in the arranger is automatically shortened. 
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Note: You can also set keyframes (view page 135) in order to adjust the speed of 
certain segments of a video. The corresponding audio material will be adjusted in 
accordance with the video. 

Frame rate: Here you can set the video's frame rate directly. Changing it directly 
affects the speed factor, while moving the slider conversely results in changing video 
frame rate. 

Algorithm: Here you can determine how the soundtrack should be treated. 
"Timestretching" changes the playback speed, without influencing the pitch: 
"Resampling" changes the playback speed together with the pitch (the faster the 
playback, the higher the pitch). 

Reverse: With this button the playback direction will be reversed (with the same 
tempo). 

Interpolate intermediate frames: Activate this option if your video is jerky as a result 
of being slowed down. MAGIX Movie Edit Pro 2013 then automatically fills in missing 
frames so that your video can be played back smoother. 
 

Movement effects in the Media Pool 
Size/Position 

 

Values in: Set whether the values are applied in percent or pixels. 
 

Position 
Left: Enter the start position from the left image border. 

Top: Enter the start position from the top image border. 
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Center: Based on the current image size, the image starting points (left and top) will 
be positioned so that they are centered. 

Note: Negative values can, of course, also be entered. The image borders will then 
be outside of the visible area. 

 

Size 
Width: Enter the width of the image. 

Height: Enter the height of the image here. 

Maximize: The image will be maximized according to the movie's resolution. 

Set original size: The image will be scaled to its original size. 

Keep proportions: This option makes sure that the image will not be stretched or 
distorted. The proportions of width to height will remain the same. 
 

The size and the position of the image can be roughly entered in the program monitor 
by simply moving the image into it and dragging on the handles. The frame of the 
video monitor with handles can also be moved with the keyboard. 

Keyboard shortcuts for moving the edges of the frame that are visible in the video 
monitor: 

Nudge the screen 1 pixel: Arrow keys 
Nudge the screen 5 percent: Shift + arrow keys 
 

For animated movement effects, it often makes sense to zoom out of the video 
monitor and use the resulting workspace to, for example, let a minimized image or 
text object move through the picture. 

Keyboard shortcuts for the preview picture: 

Thumbnail zoom in/out: Ctrl + mouse wheel 
Move thumbnail: Ctrl + left mouse button + drag 

See the "Animation from outside of the image" (view page 140) section for more 
detail. 
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Section 

 

Sections may be used to display only a portion of the image. 

Note: In order to move the section with a movement effect across the image, please 
refer to the following section "Camera/zoom". 

The program monitor enables an image section to be specified. Use the eight handles 
to reduce the frame displayed in the monitor and move it to the desired position. 

 
Preview: With this button you can preview how a segment will look like in 
the movie. Click on this button a second time in order to keep editing this 
segment. 

Keep proportions: In this menu, you can select the format for the section. The format 
of the original picture is used as the default. 

Fill screen: If this check box is selected, the section will be zoomed to fullscreen. If 
this option is deactivated, only the section of the image within the frame will be 
displayed and the edge will remain black or filled with the object behind it. 
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Camera/zoom 
With this effect, you can move a previously selected frame inside the image, creating 
an impression of camera movement or zoom. 

 
 

Movement in direction 
Determine the direction in which the selected section or image will 
move in the process during the time selected under "time period". In 
addition to horizontal and vertical movements, diagonal movements are 
also possible. 

Preview: Displays a preview of the section at the playback marker location. 
 

Zooming 

 

Zoom out: The selected picture section is displayed and is then zoomed 
out to display the entire picture according to the time set in “Length of 
movement”. If no portion is previously set, a central portion of 50% of 
the picture is set. 

 

Zoom in: The entire picture is displayed and then zoomed in to show 
only a smaller picture section according to the time set in “Length of 
movement”. If no portion is previously set, a central portion of 50% of 
the picture is set. 

 

Duration 
The option selected here sets the position where the keyframes of each movement 
effect are set by default. You determine the positions where a movements begins and 
ends. 

Note: Automatically placed keyframes may be edited retroactively, and the option 
will then be set to "Use custom settings". Read the section "Retroactively editing an 
effect's keyframes" (view page 136) in the chapter "Objects". 
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Reset: This option applies a static zoom to show the selected section of the 
picture only. 

 

The size and the position of the image can be roughly entered in the program monitor 
by simply moving the image into it and dragging on the handles. The frame of the 
video monitor with handles can also be moved with the keyboard. 

Keyboard shortcuts for moving the edges of the frame that are visible in the video 
monitor: 

Nudge the screen 1 pixel: Arrow keys 
Nudge the screen 5 percent: Shift + arrow keys 
 

For animated movement effects, it often makes sense to zoom out of the video 
monitor and use the resulting workspace to, for example, let a minimized image or 
text object move through the picture. 

Keyboard shortcuts for the preview picture: 

Thumbnail zoom in/out: Ctrl + mouse wheel 
Move thumbnail: Ctrl + left mouse button + drag 

See the "Animation from outside of the image" (view page 140) section for more 
detail. 
 

Rotation/Mirroring 
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Rotation 

 

Rotates the image on the horizontal axis. 

 

Rotates the image on the vertical axis. 

 

Rotates the image around its center point. 

 

Straighten horizon 
The image can be rotated around the axis using the slider. The image is automatically 
zoomed to avoid black edges. 

Show guidelines: Activating this check box displays a grid in the program monitor for 
orientation during horizontal straightening. 

Zoom automatically: This function is preset to active. Unwanted black borders that 
result from horizon straightening are eliminated by zooming in on the image.  

Note: If the image format does not completely conform to the current movie format 
and already has black borders, these cannot be eliminated with the horizon 
straightening function. 

 

Mirror/Rotate 

 
Mirrors the image on the vertical axis. 

 
Mirrors the image on the horizontal axis. 

 
Rotates the image 90° clockwise. 

 
Rotates the image 90° counterclockwise. 
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3D distortion 
This enables the perspective of images to be distorted and moved. This produces a 
3D impression by causing several components of the image to appear further in front 
of others.  

Enter the individual corner points numerically or move them in the program monitor 
using the mouse here. 

Note: Compared to Stereo3D, this does not involve genuine 3D positioning. The 
image is only distorted so that it appears three-dimensional on a normal two-
dimensional monitor. 

 
 

Stereo3D in the Media Pool 
This accesses the program's Stereo 3D functionality. Please read the corresponding 
chapter "Stereo3D". (view page 177) 
 

Note: This function is available only in the Plus/Premium version. 

 

Audio effects in the Media Pool 
The Media Pool offers various opportunities to add effects to your audio objects. 
Another advantage of this so-called "object-oriented" working method is that 
automations are moved automatically with objects when they are moved, since they 
are attached to the object and not to the track itself. 

See the "Audio effects" (view page 151) section below for more detail. 
 

Another advantage of this so-called "object-oriented" working method is that 
automations are moved automatically with objects when they are moved, since they 
are attached to the object and not to the track itself. 
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General 

 

Under "Effects -> Audio effects -> General", you will find audio effects that can be 
animated using effects curves (view page 135). This means that certain effect settings 
can be changed during playback. 

Effect curves are always object related, i.e. they only apply to one object and are 
moved or copied together with the object. 

Note: The faders AUX 1 and AUX 2 control the volume at which the object's signal is 
sent to the corresponding FX tracks in the mixer. 

Audio Cleaning (view page 152), Echo/Reverb (view page 156), and 
Timestrech/Resample can also be accessed here. 

Note: Volume and balance curves are also present in the track. The set values in the 
curve are also active, respectively. 

 

Audio effect templates 
Here you'll find a broad palette of effects settings which you can add to audio objects 
via drag & drop. 
 

Design elements in the Media Pool 
In this category you will find a large selection of decorative elements: templates for 
image juxtapositions (multiple picture-in-picture) and collages, moving objects 
(balloons flying through the frame, trains moving across the picture, snowfall....), color 
fields for your own backgrounds, intro videos, outro videos, visuals... 

You should first look through all the options and take stock of what there is.  

• Open the categories one after the other to get a general impression. You can see 
a preview of all deco elements. 
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A simple example for use are the frames (Media Pool > Effects > Design elements > 
Image objects > Frames“). These are much like picture-frames that can be modified 
by video mix effects. Simply drag them directly on an object, which will then appear 
as if inside a picture frame. 

The design elements create own objects on a different track. You can use the lower 
handles to adjust the size of the borders to fit any length of the video. You can also 
achieve interesting effects by inserting and discarding borders within a video. 
 

My Presets in the Media Pool 
Your personal effects configurations in the Media Pool can be saved and applied again 
later. You can reach these customized configurations in the Media Pool folder "Effects 
> My Presets". They may be dragged onto objects as usual. 

First, this folder will be empty, of course, because you still have to create your own 
configurations. 
 

Effects masks (Plus/Premium version) 
Effects masks help you to apply effects in different areas of one video image with 
varying intensity. A specific image is used as a mask to determine the specific areas 
where the effect should be applied.  

Typical applications include: 

• Image optimizations. A typical example is a horizontal pan with a horizon, where 
the upper or lower area of the image is brightened or colored in. 

• Eye-catching color gradients, colorations, etc. 
• Special effects such as automatic license plate anonymization. 

Effects masks are regular image objects, and as such may be animated or attached to 
a certain image position to use them as moving video images. 
 

Note: This function is available only in the Plus/Premium version. 

 

Create an effect mask with MAGIX Movie Edit Pro 2013 

 

• Select the object in the arrangement to apply the 
effects mask to. 
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• Open the desired effects page in the 
Media Pool. 

• Click on the down arrow button and 
select the "Load effect mask" entry from 
the menu. 

 

When using color images, the brightness values are used. The lighter the area in 
effect mask is, the stronger will the effect be applied: black means no effect, white 
means full effect strength. 

To apply the mask at a certain position in the video, you must edit it again. There are 
many options available for editing effects masks: 

• You can define the size and the position of the effect mask in such a way, that the 
mask fits exactly over the image element to be edited. Please read more on this in 
the section "Position/size" (view page 119). 

• You can attach the mask to the position in the video so that it moves together 
with the image element. To find out more, read "Attach to picture position in the 
video (view page 141)". 

• Or animate the effect mask object directly. Read more about this in the chapter 
"Animate effects" (view page 135). 

• In the effects overview, the effects mask 
can be deactivated for certain effects. 
The effects are applied to the whole 
image. 

• Click on the down arrow button again 
and select the "Delete effect mask" 
entry from the menu to remove the 
effect mask. 

 
T 

Tip: You can also use your own effect masks. Any image or photo in JPG format can 
be used. You can draw a fitting image in a graphics program, save it as a JPEG and 
load it using the "Load effects mask" option in Movie Edit Pro. 
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All effect masks can easily be inverted so that the light area becomes the dark area 
and vice versa. To do this, click on the arrow on the effect mask object. 

 

This will invert the effect mask. 

 
 

Designing effect masks with Xara Designer 
You can also create animated effect masks in Flash format to adjust the effect 
regulation to the moving video images. To do this you will need to have either Xara 
Photo & Graphics Designer 2013 (or newer) or Xara Designer Pro X (or newer) 
installed on your computer. 

Please proceed as follows: 

1. Select the image or video object for which you would like to create an effect mask. 

2. Open the effects page in the Media Pool that will be used as the effect. Click on the 
down arrow button and select "Create effect mask".  
Here you will also see the option for deleting the effect mask if necessary. 
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Xara Photo & Graphic Designer or Xara Designer Pro X will start with the animation 
document and the opened frame gallery. The first frame will be added automatically 
and will display the selected image or video object from MAGIX Movie Edit Pro 2013.  

3. Create effect mask: 

Note: Be aware that the lighter the effect mask, the stronger the effect will be later in 
MAGIX Movie Edit Pro 2013. Black indicates no effect, and white indicates full 
effect. The best option is to color the object that will be used as the effect mask 
white and to adjust the intensity of the effect yourself in MAGIX Movie Edit Pro 
2013. 

• Use the tools in the editor to create the desired mask form. Add an object that 
marks the area where the effect should later be applied. It will automatically be 
assigned to the first frame.  
With the "Invert mask" function in MAGIX Movie Edit Pro 2013 you can use an 
object to indirectly select the precise area where the effect should not be applied. 

• Color the object white.  
• Give the object a name by clicking on "Names..." in the context menu. Enter the 

name under "Names" and click on "Add" and then "Close". 
• Create additional frames by clicking on "Copy" in the Frame Animation Gallery. 

The object that should move will automatically be added to the new frame. 
With each new frame the video moves to the corresponding position making it 
easier for you to adjust the objects directly on the video image by moving them to 
the right position. 
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Tip: More information about Flash animations is available in the documentation for 
the editor. 

4. Close the document from the external editor. You do not need to save it because it 
is automatically transferred to MAGIX Movie Edit Pro 2013 when it is closed. It will 
then appear as a linked effect mask object under the image or video object.  

    

If you would like to edit the effect mask retroactively, double-click on the effect mask 
object to start the external editor with the opened mask. 
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The next thing to do is set up the effect that will be regulated by the effect mask. 

5. Set up effect:  

• Select the source object for which you just created the mask. 
• Set up the effect parameters in the Media Pool that should be regulated by the 

effect mask. These must be parameters from the "Video effects" area (without 
"speed" and "Chroma Key"). 
The effect will be applied to the whole object. 

6. Activate effect mask: 

In the effect overview click on the mask icon in the bottom edge of the Media Pool for 
every effect the mask will be applied to.  
You can invert the effect mask by clicking on the small arrow on the left of the effect 
mask object. The effects will then be applied to the rest of the image instead of the 
mask. 
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Additional effects in the Media Pool 
Video effects plug-ins are additional programs of third-party manufacturers that can 
be used to add additional video effects to video objects. MAGIX Movie Edit Pro 2013 
supports the plug-in format of the freeware video editing software "VirtualDub", as 
well as the "VitaScene" and "Adorage" program by "proDAD". A selection of tested 
VirtualDub plug-ins (.vdf files, also called VirtualDub filters) and Adorage  plug-ins 
can be downloaded as an installer package directly from within MAGIX Movie Edit 
Pro 2013.  

Important examples of using plug-ins are, for instance, removing channel logos, 
disturbances or adding special effects. 
 

Using video effect plug-ins 
In order to be able to use plug-ins, they must be installed first. MAGIX Movie Edit Pro 
2013 checks whether plug-ins are already available. If not, it will offer to download 
them from the Internet or to set the plug-in path manually. 

In order to use a video effect plug-in, select the video or image object first, then open 
"Effects -> Extra effects -> Plug-in manager" in the Media Pool menu. This lists all 
available plug-ins on the right side of the dialog. 
 

Video plug-ins manager 

 

Effect templates for plug-ins: MAGIX Movie Edit Pro 2013 does not include plug-ins 
due to licensing reasons. 

  You can save your settings by pressing the "Save" button and 
remove them by pressing "Delete". 

Available plug-ins: All available plug-ins are listed here. 
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Add plug-in: The selected plug-in will be added to the editing chain ( "Plug-ins on the 
current object" list on the right side of the dialog).  You can load as many plug-ins as 
you like simultaneously. They are then edited subsequently according to the list 
sequence. The plug-in order can be changed using drag & drop in the list. 

Plug-in settings: Opens the settings dialog for the selected plug-in. All plug-in 
settings for the entire list can be saved together as a preset (effect templates for plug-
ins). 

Advanced...: Opens the dialog with advanced settings. 

Navigation buttons: Switch to the previous or next movie via the navigation buttons 
in the lower part of the dialog of a movie.  

Last used: The settings used for the last videos will be applied. This option is active 
only if you edit one image after the next using navigation buttons (see above). 

OK: Settings will be applied to the current video. 

Apply to all: Effects will be applied to all objects included in the movie.  

Cancel: The dialog will close, settings will not be applied. 
 

Advanced... 

 

In the "Advanced" dialog, you can specify the search path for plug-ins. MAGIX Movie 
Edit Pro 2013 checks these for available plug-in files at program start and adds these 
to the list of available plug-ins. "Add search path" adds new search paths, and 
"Delete searchpath" removes them from the list again. 

Check file extension: Accelerates the search for new plug-ins if a larger number of 
plug-ins are available by not checking if they are valid. 
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Scan subfolders: Extends the search to subfolders below the selected paths. 

Local settings 
Recalculate video effect plug-in on bitmaps for each frame dynamically: If you apply 
a plug-in to a bitmap (image), then this option must be activated in case the plug-in 
creates moving effects. 
 

Animate objects, effect curves 
In the "Effects" tab under "Video effects" and "Movement effects" you can find effects 
that can be animated with the help of keyframes. 

The following objects can be animated: 

• Video objects 
• Image objects (still images) 
• Title objects 
• Audio objects (in the Media Pool under "Effects" > "Audio effects" > "General") 
• MAGIX 3D Maker objects (3D texts) 
 

Preparing animations 
• First, select the object in the arranger to animate. For complex animations, we 

recommend placing a marker beforehand for orientation. 
• In the Media Pool, open the "Effects" tab and click on the effect you would like to 

animate under "Video effects" or "Movement effects". 
• If necessary, set up the effect however you would like it for the start of the 

animation. 

 
• Using this button, at the bottom of the Media Pool, a timeline may be 

shown or hidden. You can see here which animated effects are currently 
applied to the selected object. Keyframes may be placed, selected, moved, 
and deleted. 

  

There are two stippled lines in the timeline to 
help you orientate yourself while you edit 
movement. These lines will help you recognize 
the start or end of the transition. 

 

Place keyframe 
Click the timeline to set the playback marker at the locations where a keyframe 
should be added. 

Note: You can also use the timeline in the arranger for exact positioning. Using 
project markers (view page 98) is recommended in this case. 
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 • This button places keyframes for all parameters required in the animation. 

• Additional keyframes may be added simply by placing the playback marker at the 
next keyframe location and changing the effects parameters directly. 

The positioned keyframes may also be retroactively moved via drag & drop. 
 

Copy keyframe 

 • Select the keyframes to be copied by clicking them and then press the 
"Copy" button. 

 • Next, set the playback marker at the location for insertion and the press 
the "Insert" button. 

 

Display keyframes of individual parameters 
Multiple keyframes are added simultaneously to effects if they include multiple 
parameters. 

 

Click the small arrow beside the name of the animated effect 
to display all of its parameters. 

 

Now all keyframes of the effects parameter can be individually 
moved, deleted, activated, and deactivated. 

Note: Only those parameters are listed which are used for the animation. As soon as 
another parameter is required for editing the effect, it becomes visible to you here. 

 

Retroactively editing an effect's keyframes 
Previously set keyframes can be retroactively and temporarily moved and their values 
edited. 
 

• Keyframes may be moved via drag & drop. Simply click on the keyframe to be 
moved and drag it to the desired position. 

 

• To change an effects setting for an already positioned keyframe, click the 
keyframe and adjust the effect in the Media Pool. 

 

Soft movement 
Normally, a hard, unnatural pan is the result of set keyframes. 
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 This option makes sure that the progression of these movements is executed 
more softly and more naturally.  

It lets you activate the entire parameter group as well as individual parameter curves. 
 

Delete keyframe 

 

Select the keyframe to be deleted by clicking it. 

 

 This button removes the selected keyframe. 
 

Editing an effects curve in the object 
 Activate effects curve: For each of animated effects parameter, a curve is 

created and placed over the object. Click this button to display the effects curve 
on the object. 

 

Edit curve points: The curve point can either be edited with 
the individual curve points (in "Standard" mouse mode) or 
by freely drawing the effect curve (in "Curve" mouse 
mode). 

New curve points can be added to the curve in "Standard" mode via "Ctrl + Shift" and 
clicking; existing ones can be deleted in the same way. Every curve point can be 
moved with the mouse horizontally and vertically. 

Note: The buttons for activating effects curves are first displayed once the first 
keyframe has been placed. 

 

Effects curves - Additional functions 

 

The context menu can also be opened via the small arrow beside the effects indicator. 
 

Delete effects: Removes the selected effect completely. 
 

Delete effects curve: Removes the effects curve to be created again. 
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Copy effects curve: The effects curve is copied to the clipboard to be used at other 
positions. 
 

Insert effects curve: A previously copied effects curve can be inserted elsewhere with 
this function at any time. This may be in the same object or in another object. 

Note: If you would like to insert the curve into a longer or shorter object, then think 
about setting the option "Connect curve length with object length" correctly before 
copying. 

 

Combine effects curve with object length: If this option is set, then changes to object 
length will affect the effects curve accordingly. 
In practice, this behavior is needed rarely, for example if objects are stretched or 
compressed. The option is deactivated by default for this reason. 
 

Load effects curve: A previously saved effects curve may be loaded via this menu 
item. This is useful, for example, if you have added your own default animations. 

Caution! The current effects curve will be overwritten as another one is loaded. 

 

Save effects curve: Effects curves can be saved as a separate file. This is useful, for 
example, if you want to add your own default animations and simply load them again 
at other positions again. 

Tip: Be aware that during saving the setting "Connect curve length with object 
length" is saved as well and applied during loading. 

 

Edit effects curve 
This dialog serves to stretch, compress and move effect curves within an object. The 
info bar of the dialog will display the effect, whose automation curve is currently being 
edited. 

Move position 
Time: With each click on the arrow, you can move the effect curve forward or back by 
the displayed time value. 

Effect: Every click on the arrow up or down moves the effect curve by the entered 
value. Depending on the effect, it is possible to enter exact or percent values. 

Stretch/Compress 
Time: The effect curve will be stretched or compressed by the entered time value. 
Invert reverses the curve on the time axis and reinserts it in "reverse". The entire 
object duration will be considered. 
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Effect: The effect curve is stretched or compressed in its values, no time-related 
editing takes place. The selected option (see table) is decisive in editing. 

Mirror: The entire curve is mirrored along the X-axis, whose position is determined by 
the following option (see table). 

... around object center: 
The X-axis lies exactly at 
the center of the object. 

 

...around curve center: The 
X-axis lies between the 
upper and lower 
automation point.  

...around curve minimum: 
The X-axis lies at the level 
of the lowest automation 
point.  

...around curve maximum: 
The X-axis lies at the level 
of the highest automation 
point.  

 
 

Create overlay graphic/animation 
Create vector graphics or animations in an external editor such as Xara Designer Pro 
in order to use them as overlay objects in MAGIX Movie Edit Pro 2013. A typical use 
scenario would be to draw an object in order to darken certain portions of the video, 
such as a black bar to cover a person's eyes. Overlay objects aren't bound to the 
source material by grouping. They can me moved and edited as you please.  

Note: This menu will appear only when a corresponding graphics program is 
installed on your PC. 

To create an overlay object, proceed as follows: 

1. In the arrangement, select the image or video object, for which an overlay effect 
should be created. 

2. Right-click on this object and in the context menu select "Create overlay 
graphic/animation". 
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The external graphics editor will be launched. Your selected object will be displayed 
to help you get a better idea of how to best design your overlay.  

3. Create the template for the overlay object. You can use all editor functions. 

 

4. Close the editor You don't have to save the project in the editor, as the overlay 
object will automatically be transferred to MAGIX Movie Edit Pro 2013 and placed 
below the image or video object when the program is closed. 

You can continue to edit it in MAGIX Movie Edit Pro 2013 as you wish, for example 
using Animated movement effects (view page 119). 
 

Animation from outside the image 
Animated effects come in handy to let titles or images "fly" through the picture. It is 
recommended to set the in- and out-points of the animation outside the frame of the 
image. 

You will need a video object and a second object to be animated, for example a title or 
a small object that is to fly through the video image. 

Let's roll: 

• Click on the preview monitor and zoom out of the video image (Ctrl + mouse 
wheel). This creates working room on the edge of the minimized preview image.  

• Select the "Position/size (view page 119)" effect. 
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• Move the object to be animated to the work space where the animation should 
start, for example to the left of the preview image:  

 

• Position the playback marker at the position where the animation should start. 
• Create a keyframe for the animation start. 
• Move the object to be animated to the work space where the animation should 

end, for example to the right of the preview image.  
• Position the playback marker at the position where the object to be animated 

should disappear from the image. 
• Create a second keyframe for the animation end and play back the result. 

The object to be animated should now be flying from left to right through the video 
picture! 
 

Attach to picture position in the video 
You can attach a video, picture or text object to moved picture content of another 
video. The attached object automatically completes the movement of a picture 
element from the film, making it appear magnetic. For example, you could use this 
method to insert a hat that stays on someone's head throughout, even if the person 
hops through the picture.  

Let's roll: 

• Place an overlay object (e.g. a photo of a hat) on a track below a video with a 
moving image element (e.g. a walking person). 

• Right click the object and select the "Attach to picture position in the video" 
movie point. 

• Then click "Continue" in the dialog that appears. 
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Note: If you want to attach two objects, e.g. a title and a speech bubble, an 
additional dialog appears, which lets you select the objects you want to attach to 
your video. 

• The next dialog asks you to draw a frame around the image content to be tracked. 
The content should have high contrast to its background. 

• Movement will be automatically calculated and a series of keyframes that control 
the position and size of the effect according to your wishes will be generated. 

 

Image stabilization 
The motion stabilizer reduces unsteady camera motion and helps to smooth pans. 
This option can be accessed from the context menu of a video object or the "Effects" 
menu > "Open video objects". 

Functionality 
Image stabilization balances undesired picture movements. The motion stabilizer 
equalizes inadvertent movements in the image by moving the image in the opposite 
direction in accordance with the wrong movements. This produces unusable edges in 
the footage that are cut off automatically, and black strips, which are then removed 
using a zoom shot. The result: A clearly more stable, almost imperceptibly larger 
picture. 

Application 
First you have to check the movie material for shaky scenes. To do this click on the 
"Stabilize" button. Based on the preset parameters, a relative shift between the 
pictures is calculated. After concluding the analysis, take a look at the suggested 
correction, then use the slider for further adjustments. Once you are happy with the 
final correction click OK. If the first scan did not provide a satisfactory result, try 
changing the parameters below and repeat the process. 
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Image stabilization dialog 

 

Stabilization radius for analysis: To prevent the image stabilizer from recognizing 
every camera movement as unwanted shakiness, you can determine the radius within 
which movement is accepted; the larger the stabilization radius, the more shakiness is 
corrected. Changing this parameter will require re-analysis of the source footage. 

Section of analysis: This area determines the area of the footage that should be 
analyzed. The center of the image is preset. If shaking occurs in one area more than in 
another, then you can move the analysis area (e.g. a foreground element at the edge 
is especially shaky). To do this, use the mouse to “capture” the shaky area. The 
smaller the area, the quicker the analysis will be calculated. Generally, changing this 
parameter will require re-analysis of the source footage. 

Maximum displacement: Correction moves the image accordingly to the shaking 
movements. This means that the edge of the image will be removed. This value 
determines how large the edge area is which may be cut away by the stabilization 
feature; the smaller the value, the less movement correction. Changes to this value 
are immediately applied. 

Temporal smoothing: This value determines the speed of the movements considered 
shaky. This allows you to differentiate between a panning shot and a nervous hand-
held shot. Changes to this value are immediately applied. 

Cancel: Exits the dialog without accepting changes to settings.  

Reset: Resets the current settings. 
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Image improvements for the entire movie 
You can open the effects from the the settings via the "Effects" menu. All of the 
settings made here influence the entire movie. Settings are made separately for each 
individual movie in the project. 

On the right, you'll see a preview of the current setting. Use the position slider to jump 
to different positions in the movie or to various scenes in order to see how the 
selected setting affects the image material. 
 

Brightness/Contrast 
Brightness: Use the sliders to reduce or increase the objects' brightness. 

Selective brightness (gamma): “Gamma” determines the mean gray scale that can be 
calculated from the various color ranges. "Selective brightness" is the most important 
function for image improvement. In the preset list, select the various envelope curves 
to edit only the dark, median, or brightest areas of the image. 

Using the fader you can also set the power of the brightness/darkness adjustments. 

Contrast: You can increase or lower the object's contrast. 

Color space correction: This option is effective against powerful colors that violate TV 
standards and can no longer be displayed correctly on-screen. The color saturation of 
the affected material is thereby reduced until the maximum permitted value is 
reached. 
 

Color 
Saturation: Use the saturation slider to increase or reduce the hue proportions in the 
image. A newly developed algorithm is applied which makes color changes related to 
other parameters (e.g. contrast settings) in order to achieve the most natural 
coloration possible. 

Hue: Use the palette to select a hue for coloring in the picture. 

Red/green/blue: Changes the color mix using the slide controller. 
 

Image sharpness 
You can reduce (soften) or increase (sharpen) the object's focus using this slider.  

"Fine adjustment" allows you to set how sharp surfaces or edges should appear. Using 
it, you can effectively decrease persistent image deficits. 

Anti-flickering filter intensity: The anti-flickering filter affects only still images. It is 
especially intended for zooms in images with many edges and transitions with high 
contrast (e.g. fences, bars, brick walls). High-frequency images such as these begin to 
flicker when they are reduced in size. This filter smoothes these edges somewhat. 
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You should set the intensity of the anti-flickering filter according to your preferences, 
because smoothing is always a compromise between good contrast and fluid image 
sequence during playback.. 
 

TV cropping 
This option provides optimal adjustment of the image size for a real television screen 
(anti-cropping). Without this adjustment, the screen could cut off edges of the image 
in some cases. 

Show TV screen area in preview monitor: This option displays the image borders of 
the television as lines in the preview monitor. The four image borders of the TV area 
may be specified via the four input fields. Of course, the real size of the TV image 
must be familiar for this. The following process is available to determine this: 

The four input fields also enable the borders of the four sides to be adjusted freely in 
percent. In this case, the best approach is to determine a balance between reduction, 
bar formation, and the image section: 

• If all four edges feature the same value, then the image will be reduced 
proportionately. In this case no distortions will occur, but there will be bars along 
the edges. 

• If different values are entered for the 4 fields, the image size is reduced 
disproportionately. This will distort the image. 

Apply border range to: With this option, the entered values for the four borders are 
applied as an image reduction. The result may be checked immediately in the preview 
monitor. 

Determining the visible TV frame size 
To determine the picture properties of your television as well as optimal image size 
editor settings, you should perform a test run:  

• Load the project "Visible TV image" from the folder "My Media -> Projects -> 
Visible TV image" in the Media Pool. 

• Play back the film and read the instructions on the video screen. 
• Burn the project to DVD 
• Place the disc into the player and play the film. Compare the TV picture to the 

picture displayed on your video screen by MAGIX Movie Edit Pro 2013. 
• Determine the proportional value of the borders cropped by the television with 

the four measurement scales along the edges of the test picture. 
• Enter the values in the "Full TV size" editor. 

The image size is now optimized to your TV picture. Please note: Depending on 
device settings and disc media type, the cropping values may vary slightly. 
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Image improvements for individual objects 
The context menu or in "Effects -> Video object effects" features various adjustments 
for selected video and image objects. 

Interpolation for interlace material: Select this option to remove interlace artifacts 
from the (video) image. If, for instance, you extract still shots from a video, interlace 
artifacts appear in sequences which feature movement. 

Anti interface filter: Choose this option for still pictures with detailed structures and 
high contrast. This filter reduces line flickering during TV playback. 

Border crop adjustment: Select this option if the edges are cropped during playback 
on your television. Values stored in "Film effect settings (view page 145)" will be 
applied. 
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Audio editing 
In principle, any track in MAGIX Movie Edit Pro 2013 can be used as a sound track. 
There are no specific track types. But it is easier not to mix object types within one 
track. 
 

Load and edit audio files 
• All importable audio files may be accessed in the Media Pool and previewed via 

the video monitor by a clicking on the file name.  
• The files may be dragged into the arranger by holding down the mouse button 

(drag & drop). Tracks from audio CDs may also be integrated via drag & drop. 
• Edits, fine positioning, volume settings, and fading in and out may all be adjusted 

in the arranger using the object handles directly. 
• Various effect curves (view page 137) may be selected for audio tracks, 

dynamically controlling selectable effects, volume or stereo panorama. 
 

Edit volume curve 
You can use volume curves to easily edit the audio track of an object as you wish. 

1. In a project, select an object, whose volume you would like to adjust. 

2. Open the volume curve by going to "Effects" > "Audio object effects" > "Volume 
curve". 
You will now see an additional line in the audio track, the volume curve. 

3. When you touch this line with your mouse cursor, the cursor is transformed from a 
hand symbol to an arrow. Now if you click on the line, you will create a point 
(keyframe), which you can grab with the mouse cursor and drag to a lower position. 
This lowers the volume of the overall object.  

 

4. Create an additional point and move it down as well, lowering not the entire 
volume curve, but simply a section of it.  
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You can create as many keyframes a you wish, adjusting the volume curve section by 
section, until all segments play at the appropriate volume. Check whether the 
keyframes are positioned right by playing back the track (spacebar starts and stops 
playback) and listening to hear the effect of the keyframes. 

If you would like to move a keyframe to the left or right, grab it with the mouse cursor 
and move it to the right position. 

If you would like to delete keyframes, use the effect overview in the Media Pool under 
"Effects" > "Audio effects" > "General" as described under "Animate objects, effect 
curves" (view page 135). Select the keyframe that you wish to delete and click on the 
Delete button. . 
 

Import audio CD 
Importing an audio CD works the same way as adding other audio files into the 
arrangement: 

• Insert an audio CD into the CD/DVD drive of the PC 
• Go to your CD/DVD drive in the Media Pool (File Manager, Computer). The 

individual CD titles appear in the file list. 
• A simple mouse click starts the playback of the CD title for sampling purposes 
• Drag & drop the track from the CD into a track of the current arrangement and it 

will be digitally scanned and copied to the hard-drive. The files will be saved in 
the import folder (may be specified under File > Settings > Program > Folders 
(More information can be found in the section "Folder" on page 58)). 

• The CD track appears in the track as an audio object and can be played back or 
edited immediately. 

 

CD Manager 
This option opens the CD Manager where you can select tracks from Audio CDs and 
partially or fully import them into the arrangement. You can also select and configure 
the CD-R if you have more than one drive. 

The CD Manager lets you import audio data using most CD and DVD drives. You may 
have to contact your technical support to find out which drive is suitable. Data is 
imported entirely digital. Audio tracks are imported into the arrangement as wave 
files. The files are saved in the import folder. (Program settings -> Folders (More 
information can be found in the section "Folder" on page 58)). 

To import audio tracks you should proceed as follows: 

• Select the desired CD-R drive if you have installed more than one drive. 
• Click on the "Track list" button. 
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• Select the desired title from the track list (using the key combination Shift or Alt 
and the cursor keys). 

• Click on "Save selected tracks... ". The audio material is now copied from the CD 
drive onto hard disk. The progress is displayed. 

• Close the track and drive lists. In your arrangement there are now one or several 
new objects that contaion audio material of the disc. 

 

CD/DVD drive list 

 

Configuration: This button opens the configuration dialog, where various special 
settings can be made. 

Reset: sets drive settings back to default. 

Add: Creates a new drive in the list, which first requires special settings. 

Delete: Deletes selected drive from the list. 

Load setup: Loads the current drive list and all configuration data from a *.cfg file. 

Save setup: Saves the current drive list and all configuration files in a *.cfg file. 
 

The tracklist dialog 
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Tracks can be selected from the list with a mouse click or with the key combination 
Shift + arrow or Ctrl + mouse click. 

Transport control in the dialog activates the preview function. The playback arrow 
starts audio playback of the first selected track. 

Select all tracks: This option selects all audio tracks in order to copy the complete CD.  

Save selected tracks: This button opens dialog to save selected tracks. You can either 
place all files into a single WAV file or create a separate WAV file for each track. A 
new object will be created in the arrangement for each track in either case. 

Options CD drive: With this option you can access the "CD-/DVD drive list". 
 

CD/DVD-ROM configuration 

 

Drive Name: Lets you edit the name of the drive in the list. This is useful if you create 
more than one entry accessing the same physical drive.  

Host Adapter Number: Lets you specify the number of your SCSI adapter - normally 
0. 

Bus ID: Here you can enter the ID of your CD-ROM drive. Be sure to set the correct 
ID, there is no error checking! 

Bus LUN: sets the LUN parameter, normally 0. 

Alias: Lets you select the manufacturer type of your CD ROM drive. 
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Normal copy mode: copies audio files without any software correction. 

Copy mode sector synchronization: copies audio files with a special correction 
algorithm. This is especially useful, since many CD drives have problems finding an 
exact position again and gaps can occur.  

Burst copy mode: optimizes the speed of the copy process, no software correction is 
used.  

Sectors per cycle: defines the audio sector count that should be read from the audio 
CD in one cycle. The higher the number of sectors, the faster the copying process. 
Numerous SCSI systems have problems with more than 27 sectors. 

Sync sectors: sets the count of audio sectors, which should be used for software 
correction. A higher number results in a better synchronization but also in a slower 
copying process. 
 

Scanning CD tracks with the recording dialog 
Some CD-ROM drives do not support this mode (trying digital extraction results in an 
error message), or they only support it with difficulty (results in audio objects with 
crackling noise, skips, etc.). In this case, the CD may be "scanned" by recording it into 
the computer. When recording the CD to the computer, the CD titles are simply 
played back from the CD-ROM drive and are re-recorded as .WAV by the sound card. 
Before recording a CD to your computer, change the program settings in the"File -> 
Audio/Video options" menu. To ensure easy recording of the CD titles via the 
"Recording" dialog, the audio output on the CD-ROM drive must also be connected 
with the sound card input. This connection is usually already set up on modern 
multimedia PCs. If not, this is easily done by installing a cable inside the computer 
case. 
 

Audio effects 
Using audio effects 
Track effects 
Track effects always apply to all audio objects of a track. This sets the mixer (view 
page 151). 
 

Audio effects plug-ins 
MAGIX Movie Edit Pro 2013 supports VST as well as DirectX audio plug-ins. These 
are usually effects modules such as reverb, equalizer, dynamics compression, etc. 

Installation 

Before using audio effect plug-ins, they first have to be installed – this process may be 
different depending on the plug-in. VST plug-ins are typically saved in a certain 
directory, which must be entered in the MAGIX Movie Edit Pro 2013 path settings 
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(view page 58). After the path has been indicated, MAGIX Movie Edit Pro 2013 scans 
it for working plug-ins and offers them to be used. You can also indicated multiple 
locations where VST plug-ins are installed. 

Using plug-ins 

 

Two so-called slots for track effects are located in the channel strip of 
the mixer for the corresponding track as well as in the FX tracks. 

Clicking on the small triangle will let you select an effect from the list. 
Select "No effect" to remove a plug-in from the slot.  

 

Master effects 
Master effects influence the mixed sum of all audio tracks. For this purpose a Master 
Audio Effects Rack and further plug-ins are provided. The Plus/Premium version 
includes the special MAGIX Mastering Suite (view page 160) for perfect sound. 
 

Sound optimization 
This option opens an editor for correcting audio material discrepancies. 

Select the cleaning function you desire from the upper part of the dialog: 

• The equalizer (on page 154) allows you to manipulate the frequency spectrum – 
perfect for cleaning up muffled dialog.  

• The compressor is a dynamic volume control that lends the overall sound a 
deeper, richer quality. 

• The stereo FX processor justifies the position of the sound in the stereo 
panorama. 

• DeNoiser, DeClipper, and DeHisser are professional noise reduction tools that do 
exactly what their titles say they do. 

Presets: You can try out the suitability of a number of presets in the preset menu. 

Temporarily deactivate all effects: Switches all the effects off. 

Apply to all scenes: Applies the selected cleaning settings of all effects to every scene 
of the movie. 
 

Declipper 
Should the input level of an audio recording be too high, overmodulation may result at 
the louder parts (the signal peaks). This digital distortion is also called "clipping": At 
the overmodulated area, the values that are too high are simply cut off, and typical, 
quite unpleasant-sounding crackling and distortion appear. 
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MAGIX Movie Edit Pro 2013 contains a special function for dealing with digital 
clipping and analog distortions. Of course, this only works to a certain degree. 

Using the fader you can set at what level the Declipper should register a signal as 
being overmodulated and, if required, correct it (Clip level). This is important, as 
different sound cards show different clipping methods. The more the fader is turned 
up, the lower the level recognized by the program as overmodulated. If the clip level is 
set too high, unwanted sound modification may occur. 

Get clip level: The clip level is gaged automatically. 
 

Denoiser 
The Denoiser removes persistent background noise like computer hum, hissing, 
noises from sound charts, disturbance from ground circuits, interference from audio 
equipment with high-impedance outputs (such as record players), impact noise, or 
the turntable rumble. 

The Denoiser requires a noise sample. Some typical noise sounds are included in the 
"Preset" selection menu.  

Set the degree to which the noise should be reduced with the fader. It is often better 
to reduce interference signals by 3-6 dB rather than as much as is possible in order to 
keep the sound "natural". 

A different option consists of creating a noise sample yourself. All that's needed is a 
short section from the audio track in which the distortion can be found. To get it, 
switch to the DeNoiser dialog by pressing  "Advanced". 
 

DeNoiser – Advanced settings 
Step 1: Choose a noise sample 
First of all, a sample of the distortion you wish to remove must be selected, i.e. a so-
called "noise sample".  

You have two options to choose from: 

Pick out typical background noise: You can select and use a number of typical 
background noises from the flip menu. Select one and listen to it by pressing the 
"Play" button. If it is similar to the background noise in your sound track, go ahead and 
use it (see "Step 2: Removing background noise"). 

Extract a new noise sample from an audio track: You can also pick out a short 
passage (from the existing sound track) in which you can hear the background noise. 

Automatic search: Searches especially quiet passages in which background noise is 
most noticeable. 
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Previous / Play / Next: These buttons allow you to play all of the passages found for 
easy comparison. 

Save as: Once found, you can save noise samples to the hard drive. They then appear 
as entries in the "Typical background noises" flip menu to be used in other projects. 

If you only wish to use the noise sample in the current project, you don't have to save. 
Instead just go to the "Remove noise" category. 

Step 2: Removing background noise 
Noise level: The level of the noise reduction function should be set as precisely as 
possible. Values that are too low are expressed at a low distortion dampening level 
and in artifacts, like noises or "twittering" (see below). High settings produce dull 
results – useful signals that sound similar to hissing noises are also filtered away. Try 
to find the best setting for the project at hand. 

Reducer: This sets the balance between the original signal and the signal with the 
applied noise reduction. It's often better to reduce interference signals by 3-6 dB 
rather than as much as is possible, so as to keep the sound "natural". In case of 
buzzing, it’s best to apply complete removal. 
 

Dehisser 
The Dehisser eliminates regular "white" noise typically produced by analog tape 
recordings, microphone pre-amplifiers, A/D converters, or transformers. 

Noise reduction can be regulated in decibels with the fader. It is often better to reduce 
interference signals by 3-6 dB rather than as much as possible in order to keep the 
sound "natural". 

Noise level: You can choose between different noise levels. The level of the noise 
reduction function should be set as precisely as possible. Low settings result in 
incomplete deletion of the hissing. Incomplete deleting of hissing produces artifacts 
and should be avoided, since high settings will produce dull results and some useful 
signals (i.e. woodwinds) which are similar to hissing are also filtered away. 
 

Equalizer 
The 10-track equalizer divides the frequency spectrum into 10 areas (tracks) and 
supplies them with separate volume controls to allow you to achieve many impressive 
effects, from the simple rising of the bass to total sound transformation. If you raise 
the low frequencies too much throughout the whole level, it might cause distortions.  

Fader: The volume of each of the 10 frequency bands can be set separately with the 
10 volume controls. 

Link frequency bands: The frequency fields can be bundled together flexibly in order 
to avoid artificial-sounding exaggeration in individual frequency fields. 
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Compressor 

 

The compressor is an automated, dynamic volume controller. Loud passages become 
quieter and the total value is raised. This makes the volume more consistent and 
speech easier to understand. A compressor is mainly useful in case background noise 
or music interferes with speech and simply increasing the volume of the individual 
objects or tracks does not result in any significant improvement. 

Level: Regulates the level of compression applied (the "ratio"). 

Function: Defines the compressor depending upon the sound material. 
 

Stereo FX 
The stereo FX processor provides adjustment of the alignment of the audio material in 
the stereo balance. If the stereo recordings sound weak and undifferentiated, an 
extension of the stereo base width can often provide better transparency. 

Bandwidth control: Adjust the bandwidth between mono (on the extreme left), 
unchanged base width (center) and maximum bandwidth ("wide" on the extreme 
right). 

Reducing the bandwidth can raise the overall level. In extreme cases, when the left 
and the right channels include identical material and the bandwidth control is pushed 
to the extreme left on "mono", the result can be a level increase of 3 decibels. 

Raising the bandwidth (values of 100) diminishes the mono compatibility. 
 

Audio effect dialogs 
Some of the following effects can be opened individually (via the context menu), or as 
part of the track or master effects rack. However, the functionality remains the same. 
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Effect devices controls 
Some effect options open a graphic window, which has the appearance of the studio 
effect device that it simulates (such as the "Echo/reverb" or "Timestretching" effect 
menus).  

These virtual effect devices are controlled either with common sliders, knobs and 
buttons or alternatively with graphic sensor fields. 

 

Sensor fields: Sensor fields can be controlled intuitively with mouse 
movements, with the graphic and the corresponding effect setting 
changing in relation to each other. 

 

 

Power switch: Every effect device in the rack may be switched on or off 
separately. This button allows you to directly compare the neutral, unedited 
sound of the audio object with the effect setting you have chosen. 

 Reset: Every effect has a reset button that restores the effect device’s initial 
default. In this state, the effect is not calculated into the sound, and the 
effect is not rendered. 

 

 Preset selection list: Each effect device has a selection of 
proven presets which can be selected from a drop-down 
menu. 

 

 A/B: The A/B button compares two settings with each other. If you have 
selected a preset for the effect and make manual changes to it later, you can 
compare the original preset sound with the new settings by using the A/B 
button. 

Note: The displayed graphics serve only examples and can differ from device to 
device. 

 

Delay/Reverb 

 

The reverb effect device offers newly developed and very realistic reverb algorithms 
to add more room depth to your recording. 
 

Reverb 
Reverb is probably the most important but also the most difficult effect to generate. 
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Parameters 
The reverb effect has the following parameters: 

Size: defines the size of the room (or the system for the plate and spring). The larger a 
room, the longer the sound travels between walls or objects. With some low "size" 
settings you can also reduce the distance between the individual reflections. This 
allows resonance to develop (accentuated frequency ranges), which can sound 
oppressive if the reverb sustain is too long. 

Time: With this knob you can adjust the echo time and determine how much of it will 
be absorbed and, simultaneously, the reverb's decay. 

Color: You may influence the sound characteristics of the effect within certain limits. 
The effect of this controller depends on the used preset. In rooms, "Color" controls 
the dampening of the highs in the reverb (from dark to bright) as well as pre-filtering 
of the signal. With plate and spring presets, this fader determines the dampening of 
the basses as well. 

Mix: This controller sets the mix ratio between the original and the edited signal. For 
rooms, you can therefore move a signal further into the room by increasing the effect 
share. The last four presets are intended for use in an AUX channel of the mixer and 
are set to 100%. 

Presets 
The presets represent the basic settings for the various room algorithms, which can 
still be varied along with the other parameters. Hence, they are more than just simply 
parameter sets. 
 

Delay 
This effect is like an echo which delays the signal and repeats it. 

Delay: This sets the period of time between the individual echoes. The more the 
control is turned to the left, the faster the echoes will follow each other. 

Feedback: This adjusts the number of echoes. Turn the dial completely to the left, 
there is no echo at all; turn it completely to the right and there are seemingly endless 
repetitions. 

Mix: This fader determines how much of the unprocessed original sound (dry signal) 
is subjected to the echo (wet signal). Application of this effect in an AUX bus requires 
the controller to be set to 100% (all the way to the right). 
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Timestretch/Resample 

 

This effect device changes the object’s speed and/or pitch.  

Pitch: This control changes the pitch independently of the object’s speed (‘pitch-
shifting’). 

Tempo: This control changes the tempo independently of the pitch ("time-
stretching"). The object acts as if it were compressed or stretched on the track. 

Tones/BPM: These fields are used to numerically enter the pitch or speed change. 
Only MAGIX Soundpool files are suitable for numeric entries because they are 
equipped with information regarding pitch and speed. 

Setup: This button opens a setup dialog where you can select various pitchshifting 
and timestretching procedures. 

• Standard: Timestretching and pitchshifting in standard quality. This method is 
suitable for audio material without a pronounced beat. Existing beat markers are 
evaluated to improve audio quality. 

• Smoothed: Timestretching and pitchshifting for audio material without pulsing 
elements. The method is suitable for several voice orchestra instruments, 
surfaces, speech and singing. Beat markers will not be evaluated.  

• Beat marker slicing: Beat-synchronous timestretching and pitchshifting via 
splitting and temporal repositioning. Precisely set beat markers are required at 
the beats or transients. Markers can be generated in real time (automatically) or 
read out from the source file, as long as they are available (patched). In the 
Plus/Premium version's included MAGIX Music Editor, a patching tool is 
provided for users to set the markers themselves. 

• Beat marker stretching: Beat-synchronized timestretching and pitchshifting in 
high audio quality. The material is stretched between beat markers positions so 
that the impacts or attacks at the beat markers positions are not impaired by 
stretching. The markers can be generated in real time from the audio material 
(automatically), provided they are present (patched).  

• Beat marker stretching (smoothed): Beat-synchronized timestretching and 
pitchshifting in high audio quality, even with extreme time extension. Beat 
markers are used at the beats or transients. The markers can be generated in real 
time from the audio material (automatically), or read out from the wave file, 
provided they are present (patched). 

• Universal HQ: Universal method for timestretching and pitchshifting in very high 
audio quality. Suitable for all types of audio material. 



 

Audio editing 159  

 

• Monophonic voice: Time-stretching and pitch-shifting for vocal solos, speech or 
solo instruments. 

• Resampling: Pitch shift and tempo cannot be changed individually. This method 
requires comparably little CPU time.  

 

Audio effects in the mixer 

 

You can open audio effect devices in the mixer using the "FX" 
button found in each track or in the right master area.  
Under "Mastering" you will also find MAGIX Mastering Suite (view 
page 160). 
"Reset" resets all effect settings to original values. 

 

Equalizer 

 

The 10-band equalizer subdivides the frequency spectrum into ten areas ('bands') and 
equips them with separate volume controls. This way it is possible to create many 
impressive effects, from a simple boosting of the bass to complete elimination of a 
certain range of frequencies. Note: If low frequencies are boosted too much, the 
overall sound level is heavily increased which may lead to distortion. In this event, 
adjust the overall volume downward by using the 'master volume' control situated at 
the bottom center of the effect rack. 

Slider control: Each of the ten frequency ranges can be separately boosted or turned 
down with the ten volume controls. 

Link bands: Using this button randomly combines the frequency ranges with each 
other in to avoid artificial-sounding overemphasis of an individual frequency range. 

Touch screen (right EQ section): This is the 'sensor field' of the EQ. Here you can 
draw any type of curve with the mouse. This will be immediately translated into a 
corresponding control setting on the left side of the EQ. 
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Compressor 

 

The compressor is an automated, dynamic volume adjustment controller: louder 
passages become quieter and quiet passages become louder. A compressor is useful 
to make spoken passages more audible against background noise or music in case a 
simple increase of the overall volume is insufficient. Several useful presets are 
included for this purpose, however compression may also be set manually. 

Ratio: This parameter controls the compression level. 

Threshold: This sets the volume threshold below and above which compression is 
applied. 

Attack: Sets the algorithm's reaction time to increasing sound levels. 

Release: Sets the algorithm's reaction time to falling sound levels. 

Gain: The gain controller amplifies the compressed signal. 
 

MAGIX Mastering Suite 
MAGIX Mastering Suite is a special effect rack for use with the mixer master channel. 
Its effects serve the so-called "Mastering" with which the finished mixed music file is 
given its last one-over. 

The On/Off switches can switch the effects on and off individually. Each effect has a 
range of presets that can all be picked from a list along the lower border of the effect. 

 
The settings of all effects can also be 
saved together as one preset so that 
you can use your ideal mastering 
setting again for other arrangements. 

 Each effect can be reset by pressing 
the "Reset" button. You can press the 
"Bypass" button to temporarily 
deactivate the effects. 

 

Note: This function is available only in the Plus/Premium version. 

 

Note: 5.1 Surround mode only provides the compressor (view page 159) and 
parametric equalizer devices in this case. 
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Parametric Equalizer 
The parametric equalizer consists of four filter bands for adjusting the overall sound of 
the music track. Each band is a filter with a typical "bell shape". Within a certain 
frequency range and around an adjustable middle frequency, you can increase or 
reduce the signal level gain. The width of this frequency range is called bandwidth. 
The bandwidth is defined by the Q value. The higher the Q value, the narrower and 
steeper the filter curve. 

You can influence the basic sound of the mix by increasing and decreasing the 
broadband to give it more "depth" (lower center = 200-600 Hz) or more "air" (highs 
= 10Khz). You can also decrease the narrow bandwidth (high Q value) in the 
frequency response, e.g. to remove disruptive frequencies. 

 

 

Graphic: The resulting frequency path of the 
equalizer is displayed in the graphic. The 
frequency is spread out horizontally, the increase 
or decrease of the respective frequency, 
vertically.  

The blue bullets 1-4 symbolize the four wave bands. You can move them around with 
the mouse until you find your desired frequency response. 

 

Peak meter: The peak meter gives you control over the output level of the equalizer. 
The adjacent master gain controller can be used to balance the level with the EQ. 
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 Edit: The "Edit" button opens the fine tuning for the four bands: 

 

Parameter selection: With the buttons on the right you can select the parameter that 
can be adjusted with four faders of each band. Furthermore, there are number keys to 
enter every parameter of the bands. 

Gain dB: These controllers allow you to raise or lower the filter. Setting the controller 
to 0 deactivates the filter and doesn’t use CPU power.  

Freq. Hz: The center frequency of the individual filters can be set between 10 Hz and 
24 kHz with the frequency controllers. Freely choosing the frequency enables multiple 
filters to be set to the same frequency in order to have a greater effect. 

Q (bandwidth): Set the bandwidth of the individual filters between 10 Hz and 10 kHz. 

There is still a peculiarity among bands 1 and 4; The filter curve for these bands can be 

changed from a normal "peaking" EQ filter ( ) to "shelving" ( ) (this is the basic 

setting) and high (band 1) or high-cut (band 4)  . When using the "shelving" filter, 
a soft increase or decrease in all frequencies happens above or below the filter 
frequency, and the Q parameter does not have a function here. With a low-cut or 
high-cut filter, all frequencies below (low-cut) or above (high-cut) the set frequency 
are filtered out. 
 

Multimax 

 

MultiMax is a compressor with three independent frequency bands. The dynamics 
are edited separately for each band. 

The advantage of a multi-band compressor versus a "normal" compressor is that the 
"pumping" tendency and other unwanted side effects are dramatically reduced while 
editing the dynamics. For instance, it can prevent a bass top peak from "reducing" the 
entire signal. 



 

Audio editing 163  

 

Multi-band technology also lets you specifically edit individual frequency ranges. 

Link: When this function is activated, when one slider is moved, all others change in 
the same proportion. However, the way the dynamics are edited is not affected. 

HiQ: When the "HiQ" (High Quality) setting is activated, more precise algorithms are 
used, which raises the processor load. It is recommendable to turn on this setting 
before exporting. 

Frequency band settings: Frequency band settings takes place directly in the graphic. 
Simply click on the separator lines and move them. 

Lo/Mid/Hi: These knobs control the degree of compression for each frequency band. 

Presets: In Multimax you can open various presets for various user cases. For 
example: 

Cassette NR-B decoder: MAGIX Movie Edit Pro 2013 simulates decoding of Dolby B 
+ C noise suppression if a Dolby player is not available. Cassettes recorded with 
Dolby B or C sound more muffled and slurry if played back without corresponding 
Dolby. 

Leveler: This setting automatically sets the entire material to an identical volume 
level. Access to volume control is hidden. This way you can even out steep volume 
differences between songs. To equalize volume variations between different songs, 
the function "Normalize loudness" is also provided in the "Effects" menu. 
 

Enhancer 
The Enhancer enables the justification of the audio material in the stereo panorama to 
be adjusted. If the stereo recordings sound unfocused and undifferentiated, an 
extension of the stereo base-width can often provide better transparency. 

Use the maximize function to move the echo and improve the stereo picture, for 
example, into the foreground. 

 

Volume controller: Adjusts the volume of every single channel to adjust the complete 
panorama. The reduction of left and right levels is displayed under the control 
buttons. 

Pan-direction: Use this controller to move the sound source from the middle into 
stereo panorama. The signals at the outer edges of the sound picture remain 
unchanged. 
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Multiband: This option switches from "Stereo FX" to "Multiband" mode. Stereo 
editing only applies to the middle frequency, the bass and highs remain unchanged. 

Bandwidth/maximize sensor field: Adjusts the base width between mono (extreme 
left), unchanged base width (normal stereo), and maximum base width (wide, 
extreme right). Raising the bandwidth (values over 100) diminishes the mono 
compatibility. This means that recordings edited this way sound hollow when listened 
to in mono. 

Maximize strengthens the spatial component of the recording, which also increases 
the stereo transparency without influencing the mono compatibility. 

Stereo meter (correlation gauge): This provides a graphical display of the phase 
relation of the audio signal. You can use it to review the orientation of the signal in the 
stereo balance and the effect of the stereo enhancer. To maintain mono-compatibility, 
the "cloud" shown should always be higher than it is wide. 
 

Digital Audio Meter 

 

On the lower border of the MAGIX Mastering Suite there is a digital audio meter 
which provides separate control method displays for 10 wave bands on each channel. 
This device is used for orientation purposes, e.g. selective equalizer editing. 
 

Limiter 

 

The Limiter prevents clipping by automatically 
lowering any volume levels that are too high. Quiet 
parts remain unaffected. Unlike the Compressor, this 
feature attempts to preserve the basic sound as 
much as possible.  
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Automatic track damping 
This command from the context menu automatically dampens the volume of other 
audio objects. The volume of the selected object on the track remains unchanged. 

 

Only original sound: Here you can also specify whether you want to dampen the 
original sound of the video or all audio tracks. 

Transition length: In the dialog you can activate and deactivate the value of the 
dampening. You can use this command while recording audio (view page 80) (Audio 
recording, advanced options). 
 

Dubbing with MIDI songs. 
A few words about MIDI: MIDI files do not contain the actual sounds like wave files, 
only the note control information. This data is processed by the synthesizer chip on 
the sound card and played back. This has several advantages: 

• MIDI files need a lot less memory than wave files. 
• MIDI files can be adapted to any tempo (BPM) without affecting the sound. Only 

the playback tempo of the synthesizer (most often the internal software 
synthesizer) is changed. 

• MIDI files are very easy to transpose to another pitch – as a result, a section in a 
song does not have to be saved in several different keys.   The version in C major 
is sufficient – it can then be transposed to any key by simply clicking on the right 
mouse button. 

The disadvantage of MIDI files: The files do not actually contain any audio. The audio 
is only produced when the synthesizer chip on the sound card plays it back. As a 
result, high-quality sound cards or external synthesizers will sound completely 
different and better than standard sound cards. Therefore, it is definitely worth using a 
good sound card or external MIDI-to-sound synthesizer with MAGIX Movie Edit Pro 
2013. 

Arranging MIDI files 

Proceed as follows to integrate MIDI files into an arrangement: 
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Open a directory containing MIDI files using the Media Pool Click on a file – it will be 
played back immediately so you don't need to guess which file you want to load. Now 
drag the desired file into the arrangement. Finished. 

A MIDI object will appear in which the MIDI notes are shown by dots -  the high 
notes are dots in the upper section, and the lower notes are the dots further down in 
the lower section. You can even see the velocity of the notes. The louder the note is 
played, the brighter it appears on the screen. 

MIDI objects can be arranged, the volume may be modified (middle handle), or fades 
(in or out) may be added (top right and left handles) in the same way as audio, video, 
or synthesizer objects. Use the element bar to "stretch out" a single MIDI loop to fit 
onto the whole track. 

If you do not hear anything on the MIDI file, check the MIDI replay device in the 
playback parameters window ("P" or menu “File -> Program settings -> Playback 
parameters”). Your sound card driver or your MIDI interface must be set here!  

MIDI interface and external synthesizer 

Naturally, MIDI objects can also be played back over a MIDI interface onto external 
synthesizers, sound modules, etc.  

The MIDI drivers can be set in the playback parameter window ("P" or menu “File -> 
Settings -> Playback parameters”). 

Convert MIDI files to audio files 

Before exporting (as a video, fo r example) an arrangement, all MIDI objects must 
first be “transformed” into audio objects. They only contain control information for 
sound reproduction. 

Therefore the MIDI data  can now be played before exporting and recorded 
simultaneously via the record function. The result is an audio file that can be edited 
which can be exported together with the multimedia files as usual. 

It's best to activate the solo button in the MIDI track's track box and make a normal 
audio recording. External devices like synthesizers or samplers must have their output 
connected to the input of the sound card.  
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Mixer 

 

The Mixer can be opened by pressing the "M" key or via the button bar in the main 
window (also: "View" > "Mixer").  
 

Mixer channels 
Each arranger track is represented with a corresponding mixer channel in the mixer. 
The mixer channel offers a range of options to regulate objects' audio signals together 
in the track. 

 

FX: Opens (view page 159) the audio effect rack . 

Auto: activates the volume and panautomation (view page 169). 

 
Plug-ins: You can access the audio plug-ins (view page 151) installed on 
the PC using the triangle-shaped button. 
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Volume: You can adjust the track volume using the large slider. 

 

Stereo panorama: You can set the stereo -position for each track using 
the knob.  
 

Note: Double-clicking on the volume or panorama slider sets it back to 
its passive default position, in which no CPU is used. 

 

Solo/mute: The "Solo" switches a track into solo mode, which means 
that all tracks not switched to "solo" will be muted. "Mute" makes  the 
track silent. 

 
 

Effect channels 
In addition to normal mixer channels that correspond to the tracks in the 
arrangement, you can create two separate effect channels. The principle behind them: 
You can take a partial signal from a normal channel into an effect channel, where the 
partial signal is then processed with additional effects. This is a common process used 
in professional audio production. 

 

In each mixer channel there are two FX-Send knobs (FX 1 and FX2 ) 
under plug-in slots.  

Here you can determine the strength of the signal from the track that is routed into 
both available effect channels.  

The FX tracks are usually hidden in the mixer. When an FX-Send is used, they will 
appear to the left next to the master section. 
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An effect channel is a complete additional mixer channel with 
volume and panorama controls, an effect rack and two plug-in 
slots. 

Reverb is activated in the first effect channel by default because 
this is the most important application of send effects. 

The volume control regulates the strength of the effect channel and 
corresponds to an AUX return control. The"Mute" button is used to 
switch the FX function on and off. By activating "solo", you can 
listen to the effect channel separately. Track peakmeters that send 
to the FX track appear greyed out. 

 
 

Master track (Plus/Premium version) 
The FX button and the plug-in slots function exactly like in the tracks. The FX button 
will open the master audio effects rack. The complete mixer settings including the FX 
tracks can be reset with the "Reset" button. 

MAGIX Mastering Suite: Opens the MAGIX Mastering Suite (view page 160). 

5.1 Surround: This button switches the mixer to "Surround (view page 173)" mode. 

Both faders control the total volume. 

Link button: If you deactivate the link button, you can 
control the volume of the right and left channels 
individually. 

 

Note: This function is available only in the Plus/Premium version. 

 

Volume and panorama automation 
You can automate volume and panorama for a track. This means that during playback 
you can record the movements of the sliders on the track. This way, for instance, you 
can simulate the movement of a sound source from left to right and make volume 
adjustment instantly during playback. 
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As long as the autobutton for a track is activated, all movements of the 
volume and panorama sliders will be recorded. 

The automation is displayed as a curve in the arranger and can be edited later with 
the mouse. 

Note: The mixer's automation curves relate to a track, which means that they are 
independent of the objects contained on it. 

 

5.1 Surround 
MAGIX Movie Edit Pro 2013 supports playback and export in authentic 5.1 surround. 
 

Note: This function is available only in the Plus/Premium version. 

 

Requirements 
You will require a sound card or a sound chip which is integrated into the computer's 
motherboard with six individual outputs to playback the individual channels: 

• front left (L) / right (R) 
• centre (C) / subwoofer (LFE) 
• back left (Ls) / right (Rs) 

Surround playback is possible with all audio driver models (see Playback settings 
(view page 56)), (Wave, DirectSound). 

DirectSound is supported by most of the standard sound cards.  

Wave drivers are similarly supported by many standard sound cards; however, 
individual sound cards (for example, Soundblaster) require access to DirectSound.  

Output of the six output signals is achieved in all driver models in the output channels 
in the same (standardized) order: 

Channels 1/2: L-R 
Channels 3/4: C-LFE 
Channels 5/6: Ls-Rs 

When using WAV drivers, the loudspeaker settings normally have to be changed to 
5.1 playback in the control panel. On most systems the program does this 
automatically while using DirectSound. 
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Importing and exporting surround audio files 
Import 
When importing MPEG-2 files with Dolby®Digital sound (e.g. VOB files from DVDs or 
DVB-TV recordings), you can choose from two different applications: 

• Mixdown: Surround sound is displayed as an audio object under the video object, 
playback of the Surround track is reduced and recalculated to stereo playback. 
Use this option if you don't wish to edit the Surround sound, but rather wish to 
export it. You can also use it if you think that a stereo export is enough to meet 
your requirements 

Hint: To import Surround sound as a mix, activation of the Dolby®Digital 2.0 stereo 
codec is required. 

• Surround mix: The individual Surround channel pairs (L-R, C LFE, Ls-Rs) are split 
into three audio tracks as separate objects and the mixer is then set to Surround 
mode. This mode allows you to change the Surround mix. 

Hint: A free activation of the Dolby®Digital 5.1 codec is also required for this. 

In MAGIX Movie Edit Pro 2013 the import of Dolby®Digital Surround is always 
executed as a mixdown.  

MAGIX Movie Edit Pro 2013 can also import interleaved wave files (multi-channel 
wave files), multi-channel Windows Media Audio and MP3 surround files. A surround 
mix is always created 
 

Export 
Surround mix exports can occur in any one of the following formats: 

• 6-channel PCM files (interleaved wave) 
• Windows Media files (as a Surround soundtrack of a Windows Media Video or 

WMV-HD disc) 
• MPEG-2 files with Dolby®Digital sound track (requires activation of the 

Dolby®Digital codec (view page 289)) 

The files created are fully compatible with the normal file formats, this means that 
they can also be played on computers incapable of playing Surround (in normal 
stereo). 

The export is performed via the same menu commands (e.g. "File -> Export movie -> 
Audio as wave") like the normal stereo export. You will then be asked if the export 
should be in stereo or Surround format. 
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Export Dolby Digital Surround via Smart Encoding 
You can also burn material to be exported with surround sound again without the 
need for the Dolby®Digital codec (in MAGIX Movie Edit Pro 2013 or MAGIX Movie 
Edit Pro 2013 without Dolby®Digital encoder activation) to DVD or export the 
corresponding MPEG files while keeping 5.1 Surround Sound. To do so, use the "Smart 
Rendering" option which transfers the unprocessed parts of the output material 
without renewed encoding. Read more on this in the MPEG Encoder Settings annexe, 
General Settings (view page 310) section. 

The import has to be executed as a mixdown, the audio material cannot be changed 
(no fades, no audio cleaning, no volume adjustment). Harder steps, for example, for 
removing commercials are allowed, they may not happen precisely according to the 
frame, but at the GOP (group of pictures) borders. 

 

The mixer in surround mode 

 

To activate surround playback, open the mixer (M key) and click on "5.1 surround" 
button in the master. 

In the master, six peak meters for the individual channels are provided. The normal 
panorama button turns into a representative display of the surround editor (see 
below), which can be opened by clicking on the display.  

The surround sound editor is also available to the effects tracks. For example, you can 
send the original track to the front L/R speakers, the FX track however will remain at 
the rear L/R speakers.  
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The master volume is applied to all channels, here the left controller influences 
channels L and Ls, the right controller; channels R and Rs and the middle value of both 
controller; the channels C and LFE. 

The master plug-ins are only applied to the front channels. 

The full effects palette of the mastering effects rack in MAGIX Mastering Suite is not 
available in 5.1 surround mode, but rather only the compressor and the parametric 
equalizer (from the Mastering Suite) are provided. The settings of these effects have 
the same effect on all six channels.  
 

5.1 Surround editor 

 

The selected mixer track's 5.1 surround editor allows you to arrange the audio signal 
of a track (displayed as two red sound sources) in stereo space. The signal is 
dispersed to the 5 (blue) loudspeakers which represent the individual surround 
channels.  

There are 6 channels: 

L:  front left 
R: front right 

C: center 

Ls: back left/left surround 

Rs: back right / right surround 

LFE subbass (Low Frequency Effect) channel 
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Dispersing the signal to the 5 loudspeakers occurs after the sound source emits a 
sound field of a certain level (displayed as red circles). The further away a 
loudspeaker's source is, the lesser its share of the corresponding loudspeaker channel. 
The position of the loudspeaker can be moved with the mouse. 

The subbass share (LFE) is set directly from the corresponding value table. It can also 
be changed by dragging the mouse. 

There are various modes in which you can use the source signal: 

• Mono: The (stereo) source signal is seen as mono material, the left and right 
channels are mixed together and arranged together. The original stereo 
information is lost here. 

• Stereo 1: Similar to mono mode insofar as the left and right channels are moved 
together, but only a portion of the left source is audible in the loudspeakers L and 
Ls and only a portion of the right source in the right channels R and Rs. The stereo 
information remains as intact as possible. 

• Stereo 2: The left and right channels can be moved individually. The distance 
between the left and right source is retained when you move the left source. You 
can move an individual source by holding down the "Alt" key. 

• Center/LFE: Only the left channel is arranged. In return, the LFE share is drawn 
solely from the right channel. This mode is only important for importing Surround 
material. 

Width determines the level of the sound field of an individual source. 

Automation: 

Panning of the sound source on the loudspeaker can be automated to simulate 
movements in the room.   

For this to happen "Automation" must be activated. There are two methods to create 
automations: record and draw. 

To record (when automation is on), the sound source is moved between the 
loudspeakers during playback. When recording the automation, the "Record" check 
box lights up red. 

The draw function is an alternative to drawing out complex movements. When 
drawing in active mode, all panning movements are transmitted to the time interval 
between the start and end marker (when the mouse button is held). You can thus 
draw the entire movement curve for the selected time range. 

"Reset" deletes surround automation from the track. 
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There is no automation of the parameters for width and LFE, of the distance 
between the left and right source in "Stereo 2" mode, or of the loudspeaker 
positions. 

 

Scrubbing 
The term "scrubbing" originates from the age of cassette players and provides quicker 
monitoring of passages of a film or a piece of music. The function plays short samples 
at the original speed. 

Note: In order to preview individual audio objects completely, use "Preview (view 
page 44)" mouse mode. 

 

Activate scrubbing 

 

Scrubbing can be activated using the small arrow 
next to the speaker button. 

 

Scrubbing: Modes 
No scrubbing: Scrubbing is inactive. If the playback marker is set or moved, then 
sound will not be played. 

Scrubbing (1 frame): Scrubbing is active and samples are only 1 (video) frame in 
length. The speed is 25 fps, i.e. 1/25 second. This mode is suitable for positioning the 
playback marker exactly. 

Scrubbing (long): Scrubbing is active, the sample length amounts to approx. 0.5 
seconds. In this mode, locating specific events is particularly easy. 

Play 1x with scrubbing: If this option is active, the current position will be played one 
time. If it is inactive, then it will be repeated. 
 

Using "Scrubbing" 
If scrubbing mode is selected, set the playback marker to a certain location in the 
timeline using the mouse. Hold the mouse key and move the playback marker to 
various locations in the arrangement. 
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Scrubbing may be used also by employing the jog and shuttle wheel on the video 
monitor, as well as through various hardware controllers, which gives the software the 
feel of an analog video editing system! 
 

MAGIX Soundtrack Maker 
MAGIX Soundtrack Maker automatically generates music tracks that correspond to 
the indicated mood. Even mood changes are possible. 

You can open MAGIX Soundtrack Maker by going to "Edit" > "Assistants (view page 
252)". 
 

Select music style 
Choose a musical style first. The option "Apply only between start and end marker" 
limits the length of the background music you want to create. Start and end markers 
may be set with the left and right mouse button if MAGIX Soundtrack Maker is open. 

 
 

Set mood change: 
You can select a mood from the list. 

 

Preview audio: Preview the selected mood here. 

Position: Use the position slider to skip to a certain position in order to set the mood 
for a certain position. The start marker may be moved instead with the left mouse 
button. The preview will be displayed in the video monitor simultaneously. 

Add emotion: This button inserts the selected mood at the current position. MAGIX 
Soundtrack Maker will then suggest a new position for the next emotion by 
repositioning the position slider. Of course, you may also position this elsewhere to 
insert further moods. 

Delete emotion: Removes the currently set. 
 



 

Audio editing 177  

 

Generate background music 
Clicking "Create soundtrack" creates a new soundtrack. "Progress" shows the current 
status. 

 

Variations 
If the background music that has been created is not suitable, a variation may be 
created. This process may be repeated for the entire background music as well as for 
individual emotions: 

• If you want to vary the entire background music, then simply click on "Create 
variations". 

• If you only want this to apply to a certain emotion, then move to it with the 
position slider first in the dialog (or the play marker on the main screen). Activate 
the option "Vary only selected emotions". Now click "Create variation". 

Automatic cut adjustment: This option re-arranges the video and photo objects in 
your project to match the music. Make sure this option is deactivated in case this 
function is unwanted. 
 

Mixdown of audio objects 
If the arranger becomes too full to manage, the system is out of RAM, or you just 
want to "summarize" your production, use the mix down function to convert the 
entire audio arrangement into a single audio file. Just click on the mix down button in 
the button bar or select the function from the "Processing" menu. 

You can choose a name and a destination for storing the mix down object. The default 
directory is "My audio/video". 

Storage of the audio arrangement will take up a little more space on your hard-drive, 
but it requires less RAM for playback than an unmixed entire arrangement.   

Note: The mix down effect optimizes the volume automatically. Even if the mix 
down function is used various times, you will not lose audio quality. 
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Stereo3D (Plus/Premium version) 
MAGIX Movie Edit Pro 2013 also enables creation and editing of "genuine" 3D videos 
and photos. First, let's create an overview of this complex topic by familiarizing 
ourselves with the most important principles and the golden rules that are involved. 
Next, we'll look at the individual steps of the workflow in more detail. 

Note concerning 3D content: Some people experience unpleasantness (e. g. 
headaches, straining, exhaustion of the eyes, or nausea) when viewing 3D videos. 
We recommend taking regular breaks for this reason. In case of problems, the user 
should immediately stop use and refer to a doctor or optometrist. Incorrect 
production of 3D-content may also produce these symptoms. 

Warning for small children: The sight of small children (especially those younger 
than six years old) is still developing. We recommend referring to a doctor or 
optometrist prior to allowing your child to view 3D-videos. 

 

3D basics 
Human eyes perceive objects from 2 different angles and our brain "calculates" 
images from this information. This way we can tell the distance and position of an 
object. For this reason, 3D material should be shot according to this principle. 

Viewing 3D 
A regular screen or TV can show images only in 2 dimensions, and various 
technologies have been developed to enable perception of images in 3D. To this day, 
all technologies share the following: You need special glasses to deliver different 
information to the left and right eyes. We will examine these technologies in detail 
later. 

The three golden rules 
• Stay within limits during recording: To make a 3D recording (view page 179) with 

realistic depth information, certain limits must be respected. The most important 
rule is not to go below the point of minimum distance. Minimum point is the 
point in the picture, where the camera is the closest. 

• Frame closest point: In order to place the 3D effect behind the imaginary frame, 
both image components must over lay each other exactly at the closest point. At 
the same time, the same objects must be visible at the edges of both partial 
images, for which, if needed, you can use the Cropping function in the Media Pool 
(view page 121). 

Note: The imaginary window is a type of a plane, behind which the 3D movie plays. 
You select the closest, frontmost point. Not keeping up with this rule can result in 
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the object to "jump out" of the imaginary window, which when used too much, can 
cause headaches. 

• Maintain realistic eye angles: Object with a 3D depth effect viewed as a red/cyan 
image (Anaglyph) without glasses will appear displaced. This displacement 
should, if possible, take up less than 1/30 of the entire image. Otherwise, it will 
appear that the eyes are looking in different directions. 

Notice: Displacement may only occur along the horizontal axis. Displacements on 
the vertical axis and rotated portions must be adjusted. 

 

Record 3D 
The distance between eyes in humans is ca. 65 mm, which forms the so-called 
"stereo base width". But because our eyes are dynamic and we can even "cross" our 
eyes, it is possible to focus on objects that are closer. 

Various techniques exist for 3D recording. Each method has its advantages and 
disadvantages: 

• 3D cameras with two lenses: The advantages are obvious; these cameras produce 
3D material without excessive work involved. The disadvantage is that the stereo 
base width (lens distance) cannot be changed. 

• Two cameras on a special mount: This involves a little more work. Two cameras 
are mounted on a special support to record material for the left and the right side 
of the 3D image simultaneously; microphone booms for stereo recordings may 
also be used for this purpose. 
The disadvantage in this case is that the shutter releases have to be pressed at 
exactly the same time if there are moving objects in the picture. In case of video, 
both movies must be synchronized before being edited. 
Advantages: Stereo base width may be changed by adjusting the distance 
between the cameras; larger selection of camera models. 

• Two photos via the same camera: This technique only allows still images. The 
camera is simply used to record two images from different perspectives, and 
these are used as the right and left images. For best results, use a tripod. 

• Consistently fast camera movement, e. g. along a street: Only a single 
conventional camera is required in this case, but the range of applications is very 
limited. This is the most cost-effective method for creating 3D videos. Material is 
filmed at a speed of circa 6-to 15 km/h. During editing, the edited video object is 
duplicated and one of the videos is played back with a time lapse. The movement 
direction determines which is the right and left image. 3D photos may also be 
created using this method. 
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Warning, minimum distance! 
The position of the object closest to the lens is designated as the minimum point. This 
minimum point may not exceed a specific minimum point; this is easy to calculate via 
the following formula: 

Note: Lens focal point (e. g. 25 mm) x stereo base width (e. g. 65 mm) x 1.5* /1 
mm= minimum point (2437.5 mm ~ 2.44 m) 
*1.5 is a factor derived from the cut-off appearing when filming through a lens. 
**1 mm is the so-called "deviation" or "spatial dimension". This only involves a rough 
value in this case. 

Examples for 3D cameras: 
Panasonic HDC-SDT750 ( base width 12 mm): minimum point is approx. 1.5 m. 
Fuji REAL 3D W3 (base width 75 mm): minimum point at approx. 3 m; for long-
distance recordings as much as 8 m. 

This so-called minimum point has an important role in other aspects of 3D editing. 
 

Prepare 3D editing 
3D videos are filmed and saved by different cameras, which means: depending on the 
camera model or recording method, the videos or images vary. 

In one file 
Many cameras, especially for photo recordings, create one single file containing the 
left and the right image next to one another. 

• Drag these files from the Media Pool directly into your arrangement.  
• Select the created objects. 
• Select the "Side-by-Side (left images left/right)" entry in the Media Pool under 

"Effects > Stereo3D > Properties > Create stereo". 

In multiple files 
Some 3D cameras create a file for each the left and the right side. This working 
technique works also if you simply take 2 pictures with a regular photo camera. 

• In the Media Pool, open the folder in which the desired file can be found. 
• Sort the files in increasing order according to the date. This way, all files will lie in 

pairs one below the other. 
• Now, select the files and drag them from the Media Pool directly into your 

arrangement. 
• In the Media Pool select "Side-by-side (left image right/left) under "Effects > 

Stereo 3D > Properties > Create stereo" for material with halved width. 
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Note: If you have created side-by-side material yourself (e.g. placed two photos next 
to each other in an image file), proceed as described, but at the end select the "side-
by-side (left image left/right)" for material with full width. 

 

Note: To load MVC material into MAGIX Movie Edit Pro 2013, you must first 
activate this codec for a fee (view page 291).  

 

Set playback mode for 3D 
There are various techniques available for playback of 3D videos on the computer. 
Depending on the technology used, the corresponding playback mode may be 
activated in MAGIX Movie Edit Pro 2013. 

 

Select the 3D mode you want to work with in the upper left corner of 
the video monitor. 

Here is a list of available techniques and the corresponding requirements: 

3D mode Equipment Requirements 
View partially interlaced Polarizing filter • Polarizing filter glasses 

• Special monitor, typically referred 
to as a 3D monitor or  similar 

Note: You can choose between right or left image first, depending on which type of 
display produces better results on your monitor. 

Shutter export Shutter mode • nVidia 3D Vision Kit 
• 120 Hz monitor/projector 

Side-by-Side- 
Display 

Side-by-side • 3D TV device 

Note: You can choose between right or left image first, depending on which type of 
display produces better results on your monitor. 

Note: These three modes should be set only when the preview image is to be 
exported to a separate monitor or TV device. Shutter mode also requires a 3D-
capable graphics card. 
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Anaglyph display Color anaglyphs • Red/cyan glasses 
 

Align videos and pictures for 3D 
Anaglyph display is recommended for this, which may be set via the video monitor 
(view page 181). Only in this mode is precise geometric alignment of images is 
possible. 

Note: In case you wish to edit 3D-video material, it is recommended to conduct 
scene recognition and split the video into individual scenes. This is necessary 
because the left and right side of each scene must be arranged individually. 

The so-called minimum point is the point in the 3D picture that is closest to the 
lenses. This forms the "center" of the 3D image and must be defined as such in 
MAGIX Movie Edit Pro 2013. 

For this task, go to "Media Pool -> Effects -> Stereo 3D" and access the entry 
"Aligning".  

 

Move both images one over the other, so that the minimum point of both sides is at 
the same location on the screen. 

You should first see whether automations for spatial adjustment and synchronization 
deliver desired results. Click on the button "Automatic". 

If the result isn't what you're looking for, proceed as follows: 

• Find the minimum point in the image. 
• If the images are offset vertically, then these need to be balanced via the lower of 

the two slide controllers under "Spatial alignment". 
• If the images have rotational differences, you have to adjust these with the knob. 
• Try to position the minimum points of both sides precisely one above the other 

using the upper slider. 
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• To test the results, put on the cyan/red glasses. In case the image has an 
exaggerated spatial depth, try to position the left and right sides closer to each 
other using the controls under "Spatial alignment". 

 

Turn camera movements into 3D videos 
Camera movements may be transformed into 3D videos by being duplicated and 
converted via time displacement. To do so, you can simply record on the right or the 
left side while, for example, driving along a street. 

The speed should be set between 6-15 km/h (approx. 4-10 mph) and depends on the 
frame rate, the focal point, and the distance of the objects being filmed (among other 
things). At increased speeds, it may occur that the spatial impression is too strong 
and the filmed material seems unnatural and unpleasant. 

• If the video is in the arrangement, the stereo depth for the 2D object may be set 
in the Media Pool via "Effects -> Stereo 3D --> Properties". 

• Depending on the direction of the recordings, you will have to move the control 
either to the right or the left.  

• Check the results in the anaglyph display with red/cyan glasses 
• Correct any unrealistic effects by adjusting the controller in the opposite 

direction. 
• If the spatial depth is exaggerated, reduce the changed parameters. 

Note: Not only camera movements, but also other 2D materials may be arranged 
spatially. 

3D material may be edited with the same functions as 2D material. 

 

Create titles for 3D videos 
Xara3D title objects (view page 110) automatically have "real" 3D properties and for 
this reason may be used in the arrangement without any problems. 
 

Export and burn 3D videos 
There are no special requirements for export and burning. Only the desired 3D 
technique is specified. 

Anaglyph: This technique is recommended for uncomplicated playback of finished 
videos or playback via conventional TV sets or projectors. Viewers must simply put 
on a pair of red/cyan glasses to be able to enjoy a 3D film. 
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Side-by-side: Create 3D movies for a 3D-capable playback device without having to 
compromise the quality. It doesn't matter initially whether your video is viewed in 
"Shutter" mode or via "Polarized filter". 

• Depending on your playback device, you should set double resolution in order to 
produce full resolution for both the right and the left image. 

• Not all playback devices are capable of double resolution. If this is the case for 
your device, 50 % pinched images will be displayed. The quality is nevertheless 
higher than output via the anaglyph technique. 

Note: When exporting into Side-by-Side-formats, take care that the vertical 
resolution is the sum of both images, but the aspect ratio (such as 16:9) relates to 
the partial image. 

Only left/right side: With these settings, you won't export in 3D, but just one side of 
your 3D -video. 

Flicker image: This way you can view 3D material without 3D glasses. The material 
will be shown in an alternating order, creating an impression of flickering images. 

On top of each other: This export option is similar to the "Side-by-Side" option. The 
images will be exported not next to each other, but one over the other. 

• Depending on the playback device, you should set double resolution to get an 
image in full resolution for the top and bottom partial image. 

• Not all playback devices are capable of double resolution. If this is the case for 
your device, 50 % pinched images will be displayed. The quality is nevertheless 
higher than output via the anaglyph technique.  

Note: When exporting into the one-over-the-other-formats, make sure that the 
vertical resolution is the sum of both images, but that the aspect ration (e. g. 16:9) 
relates to the partial image! 

Export files/upload movies to the Internet 
The standard path for all file exports is via "File -> Export movie or File -> Internet". 
Depending on the export format and destination, the export dialog also allows the 3D 
technique to be used to be selected. 

For direct selection as Windows Media Video 3D, click "Export" and select "3D film" 
from the dialog. 

Burn 
When burning a Blu-ray Disc or DVD, you must first open the encoder settings in the 
burn dialog and set the desired 3D technology. Next, you may proceed to burn the 
disc as usual. 
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Special functions and wizards 
In this chapter, we will introduce you to some of the especially useful special 
functions.  
 

Use movie templates 
Use movie templates in order to tell a whole story using just a few mouse clicks.  

You can open movie menus either in the start dialog or in an already open program in 
Media Pool > Menu templates. Double-clicking on a menu template will open it in 
Storyboard Mode.  
 

Note: This function is available only in the Plus/Premium version. 

 

Insert own material 
You can add your own content everywhere you see a placeholder (indicated with an 
arrow in the illustration). Drag the desired video from the Media Pool in front of the 
placeholder, which it should replace. The placeholders' names indicated which type of 
material should be inserted here (e.g. "Group recording"). 

 

If your video is too long for a placeholder, you will see a green bar in the mini timeline 
below the video monitor. You can grab it using your mouse and move it in such a way 
that just the right section of the video appears in the placeholder. If your inserted 
video is too short, it will be rejected by MAGIX Movie Edit Pro 2013. 
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Audio tracks of inserted material 

 

Menu templates contain audio material. For this reason, the 
audio track of the inserted audio material will be muted. You 
can, however, switch it on again by clicking on the speaker 
symbol in the preview image. 

A speaker slide controller appears, which lets you control the 
volume of the original audio track of the inserted video clip. 

 

Design your own titles 

 

Click on the T symbol in the preview image in order to edit 
the title included with the movie template. 

The Title editor (view page 107) will appear in the video 
monitor. You can enter your own text there. 

 

Further use of movie templates 
Burning  (view page 212)and Export (view page 228) of filled-in menu templates 
takes place as with all other objects, whether with templates or without. In the "Burn" 
screen you will find menu templates that are specially adjusted to menu templates in 
the "Menu templates" (view page 214) categories. 
 

Preview rendering 
With MAGIX Movie Edit Pro 2013 you can pre-render specific sections of your movie. 
This is especially useful if smooth playback is not possible due to the applied effects 
and transitions. The advantage versus the option "Combine audio and video" in the 
"Edit" menu is that all of the objects will be maintained in the arrangement. The 
rendered material will only be played in the background when the playback marker 
reaches the corresponding position. 

 

Preview rendering is available in timeline mode and multicam mode.  

Note about multicam mode: Only the source tracks will be rendered, not the 
target tracks. 
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MAGIX Movie Edit Pro 2013 offers two options: 

• It can automatically indicate all sections that can be rendered. 
• Or, alternatively, you can indicate the section that should be pre-rendered 

manually. 

Note: The format that is used to render can be set through "File -> Settings -> 
Preview rendering (view page 63)". 

 

Automatic preview rendering 
When using automatic preview rendering, you don't have to think about which 
sections could be affected. MAGIX Movie Edit Pro 2013 analyzes your computer's 
performance and determines which sections can be considered for preview rendering. 

To perform automatic preview rendering, proceed as follows: 

 
Step 1: Click on the undo button in the lower toolbar. 

MAGIX Movie Edit Pro 2013 will then analyze which sections should be pre-rendered. 
A dialog will appear, indicating how many areas have been located. 

 

 

These sections will be additionally marked in the MAGIX Movie Edit 
Pro 2013 timeline using red bars. 

Step 2: Select "Yes" in the dialog to start preview rendering. If you choose "No" 
instead, you can still conduct preview rendering later. 

The red bars will appear green after preview rendering is over. If you make changes in 
the pre-rendered section, it will appear red again and will have to be updated (view 
page 188). 
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Manual preview rendering 
In manual preview rendering you first have to identify the problem-prone section. 

 

Step 1: First, place an in and out point 
above the range to be rendered. 

Step 2: Click on the preview rendering button and select "Start preview rendering..." in 
the context menu.  

A preview rendering dialog will appear. 

 

Step 3: Select "Range". 

The preselected range will now be rendered. 

 

After rendering, a green line appears in 
the timeline to symbolize that this range 
has been rendered. 

As with automatic rendering, the section will remain green as long as no further 
changes are made to it. The green line will then turn red and can be updated again. 
 

Update preview rendering 
Preview rendering is effective only as long as no changes are made to the pre-
rendered area. You can recognize a pre-rendered area from the green bars appearing 
above it on the timeline. As soon as an object in the section has been edited, the 
green bar will turn red. You can update this section at any time.  

1. To do so, place the playback marker inside the section to be updated. 
2. Click on the "Preview rendering" button. 
3. In the preview rendering dialog, select "Range" in order to update just the 

section selected by the playback  marker.  If you select "All", all non-rendered 
(red) sections will be rendered. 
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Automatic scene recognition 

 

Automatic scene recognition can be opened via the "Effects" menu. The scene 
recognition function analyzes the film for scene transitions and scans for drastic 
changes in the brightness and color distribution within the picture.  

Automatically created timestamps from digital video devices (the points in time at 
which the device was turned on and off) are also marked as scenes. 

• First, select "Start" from the "Scene change" box. The search for possible scene 
transitions will begin. If you have a large amount of material, then this may take a 
while, but the image analysis has to be done just once for each recording. The 
results are saved together with the video file. 
If the scene recognition is performed again with the same source material, then 
the scene transitions found are immediately displayed. If you are still not happy 
with the resulting scene partitioning simply repeat and correct where necessary. 

• All found scene transitions in the list can be checked in the dialog. Every scene 
marker can be selected or deleted. Select a scene transition from the list of found 
scene transitions and use the preview images to check whether the found 
transition is really a scene change or not. 

Tip: This option is helpful, for example, if a camera flash was captured in the source 
footage. The flash from the camera would cause a sudden brightness modification 
even though there was no actual scene change.  

The preview always displays the end of the previous scene and the beginning of the 
new scene. If the images do not differ except for the brightness, then the scene may 
have been falsely recognized. In this case select "Delete scene marker". 
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Via the zoom +/- buttons you can enlarge the part of the arranger where the selected 
scene begins or previous scene ended.  

You can use the "Sensitivity" controller to change the sensitivity of the scene 
recognition to detect different scene changes, depending on the settings. 

"Action on OK" lets you specify whether the movie should be cut at the selected 
scene transition or at all scene transitions and whether the found scenes should be 
saved as takes.  
 

Travel route animation 
Using the travel route animation, you can quickly create maps with animated travel 
routes. You can start travel route animation with the "Edit" menu > Wizards > Travel 
route animation" or in the Media Pool > Import > MAGIX Tools > Travel route...". 

If you have imported photos with GPS geotags into your movie, you can create a route 
that will appear as transitions between the photos.  

• Position the photos from the start of the trip and the end of the trip directly 
beside each other and select the first photo. 

• Start the travel route animation. The locations will automatically be entered on 
the map. 

• Click on "Animation", save the route as a video and close the travel route 
animation feature. The travel route video will automatically be inserted between 
the photos including transitions. 

If there are no photos with GPS information, the travel route animation will start 
without locations. Select the locations on the map yourself to export a travel route. 
 

Note: This function is available only in the Plus/Premium version. 
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Program interface of the travel route animation 

 

 Map: Displays map material from openstreetmap.org. 

 Selected locations: All locations, searched using geonames.org or selected 
manually on the map, will be shown on the list and marked using pins. 

 Map section + zoom: The map may be moved by pressing the arrows. "Zoom" 
enables you to zoom into the current section (+) to view more details or to zoom 
out (-) for a better overview. 

 Show lines: If at least 2 locations are marked on the map, then this function will 
be available for linking the locations. The line color and thickness may be 
changed. 

 Animation: You can animate your travel route and save as video in WMV 
format. 

 Save as image: The current map section may be saved as an image in the format 
PNG, BMP, JPG, or TIFF. 

 

Select locations on the map 
There are several options for selecting locations on the map for creating a route. 

Note: The map section will adjust itself depending on how many locations you select 
and where they are. If you would like to view details about a location, simply zoom in 
using "+" on the number block or the mouse wheel. 
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Search and select locations: 

 
1. Click on the "+" button below "Edit destinations" to add an entry. This new 
entry will appear blue below existing locations. 

2. Assign a name to the new location and press Enter. The destination will be 
added to the map. An additional marker is set for beginning and end of a tour. 

Note: If multiple locations are possible, a list with possible choices will open. 
You can determine the destination by picking one from the list with your 
mouse.  

 

 

If important intermediate stages of the route should also have a 
marker, click on the marker symbol in the properties (cogwheel) of 
the destination. 

Set destinations manually: 
 1. Move the map boundary by clicking on the map and holding down the mouse 

key so as to make the desired destination visible. 

 
2. Click on this button under "Edit destinations" to activate manual entering of 
locations, or use the keyboard shortcut "M". 

3. Click the target destination on the map. A new entry to the list will be made. 
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Rename destinations: 

 

You can rename destinations by going to its properties (cogwheel 
symbol) without changing it. 

Search destination anew: 
If the destination is incorrect, you can search the location again in 
order to adjust the position of the marker. 

Enter a new name in the entry field and click on the magnifying glass 
or press enter. 

Import GPX file: 

 If you have created a route with a GPS device and saved it as a GPX file, you can 
import it and show the route on the map. 

Note: Depending on the length of the route, it can take some time for the file to be 
imported and displayed. 

 

Adjust & delete locations 
Change the sequence of destinations: 
The order of destinations in the list corresponds to the sequence in which they were 
created. You can edit the order of the destinations by clicking on a location on the list 
and dragging it to a new place with the mouse key held down. The route on the map 
will be adjusted. You can see this especially well if you've activated the line (view 
page 195) in order to optimize the travel route display. 

Adjust the position of the destination: 
You can adjust the position of a destination by grabbing the marker on the map with 
your mouse and dragging it with the depressed mouse key to a new position on the 
map. The marker will be moved, the travel route adjusted and the new name of the 
destination will be automatically changed in the list. 
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Note: If the destination marker doesn't appear, you can activate it 
in the properties (cogwheel) by clicking on the marker symbol. 

Hide destination: 

 

Click on the eye icon below the properties (cogwheel) of a 
destination. The destination will remain in the list, but will be hidden 
on the map and will not appear in the route. Click on the eye again to 
display the location again. 

Remove destination from the list: 

 
To delete a destination from the list and the route, click on this button next to 
the destination. 

 

Save and load routes 
The entire list of marked locations may be saved to load it later - without having to 
search for and select all of the locations again. 

Save as file: 

 • Click on this button under "Edit destinations" or use the keyboard shortcut 
"Ctrl + S". 

• Enter the save location and name of the location list in the dialog that 
appears. 

• Click "Save" to back up the list and quit the dialog. 

Open list: 

 • To load a saved location list, click this button under "Edit destinations" or 
use the keyboard shortcut "Ctrl + O". 

• Navigate to the save location and select the location list in the dialog that 
appears. 

• Clicking on "Open" closes the dialog and opens the list with saved 
destinations. 

 

Adjust map section 

 

Use this button to move the map section upwards (north), to the right 
(east), downwards (south), or to the left (west).  
The arrow keys on the keyboard may also be used to move. 
Click on the point between the arrows to move the map window in order 
to center the selected destination. 
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Use this controller to zoom out of the map (-) or into it (+). The keys "+" and 
"-" on the keyboard or the mouse wheel may also be used to zoom in and out. 

 

If you would like to show all marked locations and reveal as much of the map 
as possible, click this button and the map will be adjusted automatically. 

 If you would like to display only the route without the location markers, click 
here and the pins will be hidden. A repeat click will display them again. 

 

Show lines (connect locations) 
For two or more marked locations, the function "Show lines" will appear. This function 
connects destinations on a map with a line in order to better visualize the route. 

 
Click this symbol to show lines connecting selected locations. The functions 
responsible for line transparency, thickness, and color are to the right. 

Tip: The order of destinations in the list corresponds to the sequence in which they 
were created. You can edit the order of the destinations by clicking on a location on 
the list and dragging it to a new place with the mouse key held down. The route on 
the map will be adjusted and the line will follow a different course. 

Hide line: To hide the line, click on the "Lines" button again. 

 

Transparency and line thickness: Use the controller to change 
the transparency (left controller) and the thickness of the lines 
(right controller). 

 

Line color: Set the desired line color using the color field and 
slider. 

Tip: You can also create animations for the connecting line in the "Animation" (view 
page 195) section and save it as a video. 
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Animation 
For two or more marked locations, the function "Animation" will appear. 

 

This enables you to display your travel route in motion and even save it 
as a WMV format movie, e.g. to integrate it into vacation movies or to 
send it. 

Scroll map: Activate "Scroll map" and the map will move from location to location 
when the animation is played back. 

Animate line: The connecting line slowly connects all selected locations, from the first 
to the last. It is moving at the speed of an animated object. 

Soft animation: The animation starts slower, speeds up, and then slows down before 
each location. 

Animate object: You can select an object to follow the route of the trip, such as a car 
or an airplane. 

Duration (seconds): You can adjust the duration of the animation however you like, 
depending on the length of the route. Enter seconds into the filed and test the results 
via the preview option to see if you like the animation. 

 

Preview: Before you save an animation as a video, test it to see if it looks the 
way you want it to by clicking "Play". 

 

 

Click on this button to save the animation as a video. Enter the 
save location and name of the video in the dialog that appears. 

Note: This button indicates the height and width of the future 
image. These values are adjusted as soon as window sizes are 
adjusted or when the location list is shown (arrow next to 
"Destinations"). 

Close: To leave the animation area, click "Close". 
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Create a picture of a map 
You can create a picture from a section of a map (including location markings), e.g. to 
print it. 

Step 1: Zoom into the map until you have reached the desired level of detail. 

 

Step 2: Click this button (shortcut "Ctrl + E") and enter the save 
location and the name of the image in the dialog that appears. You 
may also select the format for the picture. 

Note: This button indicates the height and width of the future image. These values 
are adjusted as soon as window sizes are adjusted or when the location list is shown 
(arrow next to "Destinations"). 

Step 3:  With one click on "Save", the image is saved and the dialog is closed. 

 
If you want to, you can hide the list of locations to the left to show a larger 
section of the map. 
Another click on this symbol will show the list again. 

 

Keyboard shortcuts 
Manual selection of locations "M" 
Zoom into map "+" on the number block 
Zoom out of map "-" on the number block 
Save location list "Ctrl + S" 
Load location list "Ctrl + O" 
Save map section (with location markings) as 
image 

"Ctrl + E" 

Move map section north (upwards) "Up arrow" 
Move map section east (right) "Right arrow" 
Move map section south (downwards) "Down arrow" 
Move map section west (left) "Left arrow" 
Cancel video export "Esc" 
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Produce panorama pictures 
This special function may be selected for highlighted photos under "Effects > Video 
object effects > Create panorama". Using it, you can combine several photos into a 
wide panorama photo. You don't need to create exclusively "proper" panoramas; Let 
your imagination run wild and put together anything you want to. 

Tip: Optimize you photos beforehand, so that the transitions are not to be seen in 
the finished panorama. 

 

Select pictures for panorama 
Load all necessary images into the film project as usual. The images that should make 
up the panorama should be selected one after the other while holding down the 
"Shift" key. Select the entry "Create panorama" from the context menu "Effects" (view 
page 256) > "Video object effects". 

 
 

Invert image sequence for panorama image 
Sometimes photos are accidentally loaded in the wrong sequence or were created 
from left to right. If you forgot to sort your photos correctly beforehand, then simply 
click "Invert sequence". 
 

Calculating the panorama image 
If you click "Create", the panorama image will be processed. Depending on the 
resolution and number of original images included, this may take some time. The 
original photos are replaced in your slideshow with the panorama image you've 
created, but the original files on the hard drive will remain intact. 
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Hint: You can create a panorama image from a maximum of six images. Click on 
"More options" for more information on the upgrade. 

 

Finished panorama (2 images) 

 

Finished panorama from 2 images 
 

Slideshow Maker 
Slideshow Maker is ideal for converting still images into moving pictures, adding 
background music, and effects. 

• Open Slideshow Maker via "Edit -> Wizards". 

 
 

Style templates 
Select a template that best matches your needs.  
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This button plays a sample slideshow with the selected style template.  

 
 

Save/delete style template 

 
Homemade style templates appear in the list of 
included style templates. 

 
If you like, these can be deleted again. 

 

Intensity 
Controls the portion of video and image objects that feature effects. With "Normal" 
you will see a balanced amount, whereas with "Weak" or "Strong", correspondingly 
fewer or more effects.  
 

Transitions 
The different sliders are used to set the portion of individual fade types. 

3D / Other: You can turn effects and fades belonging to each category on or off using 
the list symbol. The arrow below the preview monitor plays a preview. 

Fade duration: Set the length of the fades in seconds. 

Random fades: The fades are set to random values. 
 

Effects 
The faders enable the respective effects types to be specified. 

Random effects: The faders that control the amount of effects are set randomly. 

Treat special image formats intelligently: Panoramas and portrait photos can be 
treated "intelligently". If this option is activated, then panoramas and portraits will be 
treated with special effects adjusted to the format. These effects can also be selected 
in the detail view. 
If this option is selected, then these images will use the same effects as all other 
images. 

Details activates effects or fades in the corresponding category. The arrow below the 
preview monitor plays a preview. 
 

You can turn effects and fades belonging to each category on or off using the list 
symbol. The arrow below the preview monitor plays a preview. 
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Properties & title 
Film length 
Resulting film length: This is an estimation of how long the film will be after applying 
Slideshow Maker. 

Available music: This is the complete length of the music that is currently selected. 
Background music (view page 202) enables detailed settings for the pieces of music 
to be used. 

Adjust film length to the music: An attempt is made to adjust the length of photo 
objects to the background music. If the film is too short the music will be cut off. If the 
film is too long, the music will repeat. 

Adjust music length to the film: Photo objects have a set length, and the resulting film 
is filled with music. The music at the end of the movie is simply faded out. 
 

Including video objects 
Process videos: If this option is set, then videos will be automatically processed with 
effects and transitions. 

Length: Settings may be made here about whether the original length of the video 
should be maintained or if it should be shortened. 
 

Opening and closing credits 
Set the text for opening and closing credits here. 

Text: Enter the corresponding text for opening and closing credits that should be 
added by Slideshow Maker. 

File: A title template, a video, or an image file may also be used. 

Note: Titles created using Slideshow Maker may also be edited at any time. 

 

Group associated images together 
If this option is active, an attempt is made to detect associated events via their date 
information and to separate them from each other optically. Detection of individual 
events is based on the time span of these events to achieve a sensible separation. 

Begin group with black fade:A black fade is added between the different events. 

Begin group with title and black fade:A black fade is added between the different 
events.A title is also faded in with a suitable duration, e.g. 1st/2nd/3rd day, provided 
the events take place over multiple days. 



 

202   

www.magix.com 

Begin group with title and picture:A black fade is added between the different 
events.A title is also faded in with a suitable duration after the black fade, e.g. 
1st/2nd/3rd day, provided the events take place over multiple days. 
 

Background music 
Specify if and which music should be used for the background here. 

Use background music: Adds background music. 

Load file(s): A file selection dialog will open to choose a folder featuring music; select 
one or multiple files. 

Remove: The selected pieces of music are removed from the list and will not be used. 

Insert random: MAGIX Movie Edit Pro 2013 selects random pieces of music from the 
folder "Import -> My Media -> Slideshow music" in the Media Pool. 

Preview: This button previews the selected piece of music. 

Volume ratio: This slider controls the volume ratio between the original sound and 
the background music. 
 

Tip: Music objects, located on the 5th track will be listed and used together with 
audio objects for background music.  

 

Musical cut adjustment 
Behind this option for audio object is an option to "control" video objects by music. 
This way, you can synchronize image sequences with music to, for example, produce 
video clips. 

• Requisite for this is that as many as possible different video objects lie in track 1, 
separated by "hard cuts", without any special fade effects. To prepare, first create 
a material track with various video clips that should be combined into one video 
clip. 

• Load a fitting song and select "adjust edit according to music" from the context 
menu. 

• Now, the song's audio object already has beat information. Normally, this will not 
be the case.  

• You will then be asked, if the Beat Recognition Assistant should be opened. Click 
on "Open Assistant".  



 

Special functions and wizards 203  

 

• The "MAGIX Remix Agent" dialog will open. This tool will now analyze the song's 
rhythm. Beat markers will be created, forming the base for adjustment according 
to music. 

 

After determining the BPM value of the song, the song will be subdivided into short 
passages of equal length. The individual objects having the duration of exactly one bar 
at first stay grouped, so as not to accidentally "rearrange" the song.  

Tip: (Of course, if you like you can do just that! Choose menu "Ungroup to edit 
graphics". 

When editing according to music, only the resulting object edges are important. 
Because all objects can always latch to each other on their edges, videos can be 
arranged to transition exactly to the beat of the music. 
 

Note: This function is available only in the Plus/Premium version. 

 

Requirements 
• The song must be longer than 15 seconds. 
• The song must be “rhythmic” (danceable). 
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• The song must be in stereo format. 
 

Preparation - Setting the start marker and object end 
Before opening the Auto Remix Assistant, you should set the start marker at the 
position in the song object in the arranger where you want detection to start. If the 
song contains a long intro without beats, set the start marker after the intro. As a rule 
of thumb, the Auto Remix Assistant should always be "fed" dance music.  

• The start marker should be set before a quarter note beat or, better still, briefly 
before a beat at the start of a bar. 

• If the start marker lies before the song object, the object is examined from the 
beginning.  

• If detection is not performed by the end of the song, the object can be shortened 
accordingly with the object handle at the end of the object.  

 

Checking the automatic tempo recognition 
The song has to meet the following three requirements to be successfully analyzed: 

• It must be longer than 15 seconds. 
• It must contain "rhythmic" (danceable) music. 
• It must be in stereo format. 

The analysis takes place in three steps: 

Step 1: Checking the start marker 
Step 2: Tempo recognition 
Step 3: Specifying beat starts 
Step 4: Application of BPM and beat recognition 

Step 1: Start marker check 
Before analysis can begin, you should set the start marker in the project at the 
position where rhythmic material begins. This means, it should be located after the 
intro. If the assistant can't find any rhythmic information, it will ask if the marker is 
located behind the intro. In the dialog, you can move it to the appropriate location. 

If the beginning of the track has no rhythmic information, you will be asked if the start 
marker should be moved. 

Step 2: Checking automatic tempo recognition 
The Remix Agent will begin the audio file analysis and try to determine the tempo. 
The object will be played back while a metronome click will sound and numbered beat 
lines will appear in the waveform display. 

Below the waveform display to the left is an indicator of the found tempo in BPM. A 
small transport control is available in the middle to make navigation easier. The slider 
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enables position control. To control the metronome volume, an additional slider as 
well as a mute button is found to the right. 

Automatic tempo recognition doesn't always work on the first try. If you don't hear 
the metronome clicking in time with the music, click the "No" button in the upper 
section of the dialog in order to access the manual tempo input dialog. 

To correct metronome tempo and move metronome clicks if needed, use the tempo 
correction and "Tap tempo" buttons. 

Tempo correction: The Remix Agent offers you a number of tempos. The tempo, 
which the Remix Agent considers most likely to be the case is already preset. If the 
calculated tempo is incorrect, select one that better fits from the list. When the object 
is played again, metronome clicks should be synchronized. 

On/off beat correction: It can also be the case that the tempo is correct, but the 
beats are shifted. "On/off beat correction" provides a number of alternatives for 
moving the beats according to the complexity of the rhythm. Try out different 
alternatives until you can hear that the metronome clicks are synchronous to the beat. 

Tap tempo: Alternatively to tempo selection under "Tempo correction" you can also 
click on the "Tap tempo" button or the "T" key to the beat of the music. Additional 
blue lines are displayed in the wave display. After at least four taps, the Remix Agent 
attempts to select the correct tempo from the list in "Tempo correction". The display 
next to the "Tap tempo" button displays the current status. Keep tapping until the red 
display showing "Unlocked" changes to the green "Locked" setting. 

Use the "0" key to manually set the quarter beats while the music plays. Placed 
markers will be removed automatically in such a way that the set tempo will be 
maintained.  

You can move the markers with the mouse. If you press the "Ctrl" key at the same 
time, all following markers will be moved. 

If the metronome clicks now correspond with the music, you can continue to the next 
step. 

Step 3: Determining the start of a bar: 
First set the type of beat. 4/4 beat is the default preset. If needed, correct the start of 
the beat. The beat at the start of the beat should always match with the high-pitched 
metronome click or the red line in the waveform display. 

Correction cat take place in just one step: If you can hear the start of the beat, click 
once with the mouse on the"Tap one" or press the "T" key on the keyboard. 

Alternatively, select how many quarter notes the "One" is to be moved back. 
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Use the "0" key to manually tap the position of the beginnings of the bars during 
playback. This offers an efficient option to correct the beat start of longer ranges. 

Continue to the last step if the starts of the bars are now correct. 

Step 4: Apply 
The last step applies the musical information into the audio material.  

Video cuts will now be inserted into the video material on track 1 based on this 
information 
 

Setting the manual and Onbeat/Offbeat 
If the result is incorrect, you can help the Auto Remix Assistant with a few mouse 
clicks on the correction buttons.  

There are two possibilities:  

On the one hand, the "Tempo correction" list offers alternative BPM numbers which 
could also fit with the music. The adjustable BPM values are detected automatically – 
the total BPM can therefore deviate from song to song.  

For more difficult audio material, we recommend using the "Tapping input" mode. 
Either the "T" key must be pressed or the "Tap tempo" button must be clicked with 
the mouse in time with the music. With repeated tapping of the tempo correction 
button, one should keep an eye on the color in the BPM display. In the "unlocked" 
condition (red), the tapping is not in time with the music. One should tap until the 
"locked" condition is displayed. After a short time, you will hear if the result is correct 
via the metronome.  

Subsequently, offbeat correction takes place as required. If the detected quarter note 
beats lie around the length of an eighth note (transferred behind the real positions of 
the quarter note beats), one or more alternatives can be selected from the 
onbeat/offbeat correction list. 
 

Determining the start of a measure 
Next, the starting point of the measure is corrected. The beat at the start of the 
measure must always agree with the high tone of the metronome and/or the red line 
in the wave-shaped display.  

Corrections can be made by tapping; If the start of the measure can be be heard, tap 
with the mouse or press the "T" key. Alternatively, you can also select how many 
quarter notes the "one" is to be pushed to back.  

If the starting marker was set briefly before the first beat of a measure, this correction 
is not necessary.  
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Note: With all corrections, the metronome and visualization react to the lines in the 
wave-shaped display only after a short delay. 

 

Using BPM and beat detection 
Now you may select one of the actions to be adapted to the arrangement song (or 
vice versa) or cut up the songs at the ends of a measure. 
 

Save only Tempo & Beat information 
Only wave file data is stored. This makes sense if some manual post-correction is 
required for determining beat/tempo.  

When the data is stored, tempo & beat regulation can be released for future tempo 
adjustments or to create object remixes. 
 

Tempo adjustment 
Setting the object tempo to the arrangement tempo 
This fits the object length to the existing arrangement. Three different procedures are 
possible: timestretching, resampling, or audio quantization.  

• Timestretching keeps the pitch of the song constant, but sometimes the sound 
quality can suffer.  

• Resampling changes the pitch (similar to changing the speed of a record player), 
and retains the sound quality of the song as much as is possible.  

• During audio quantization, the audio file takes the tempo adjustments into 
consideration as if the first remix object (see below) were created and combined 
immediately into a new audio file. If the recognition is uncertain, extreme tempo 
fluctuation may result. It is particularly important to set the starting marker so 
that the tempo is recognized definitely. The advantage of audio quantization is 
that small tempo fluctuations in the music balance out. The start of the measure 
always agrees with the start of the arrangement measure and never plays out of 
time. 

Setting the arrangement tempo to the object tempo  
The arrangement adopts the detected BPM value. If you would like to use the cut-up 
song as the basis for a new composition (e.g. for remixes), then this option should be 
active. 

Creating remix objects 
The song is cut by beat into individual objects. Some applications may include:  

• To produce loops from complete songs which can then be used with other 
material. Most importantly, not all remix objects are suitable as loops. Ideally, 
less complex material should be used, e.g. drums from an intro. 
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• To remix songs, thus changing the sequence of the objects, cutting or doubling 
beats or to enrich the song with other loops or synth objects.  

• To mix two songs: If percussion and tempo fit perfectly, can you blend the songs 
without "side effects"? 

This option can be activated later from the "Object" menu, provided that the tempo 
data is stored.  

The "Audio quantization" option: Audio quantization fits new objects exactly in time 
with the arrangement.  

With homemade music, tempo fluctuations are common, and therefore different 
measure lengths may result. Nevertheless, so that the objects fit into the rigid timing 
pattern of the VIPs, the time processor is activated automatically and object 
timestretching is used to correct the different lengths.  

Setting resampling for small corrections: If the necessary corrections are very small, 
better quality resampling can be used instead of timestretching. Afterwards, you 
should not change the master tempo any longer, since definite pitch changes may 
arise. 

Remix objects in "Loop" mode: New objects are set in "Loop" mode. When extending 
the object with the right object mouse handle, the original length of the object is 
played again and again. 

Setting the arrangement tempo to the object tempo: (see above) 

Note: Time correction assigned to objects can be subsequently cancelled if the time 
processor is called up and edited ("Timestretch/Resample object", or double click 
on the object to open the FX racks associated with the time processor). 

Cancel: The dialog is closed. 
 

Batch conversion 
Batch conversion makes it is possible to convert multiple video files, movies, objects, 
or whole projects into another format in just one step. 
 

Open batch conversion 
Batch conversion can be opened using different presets. A pre-selection appears only 
if you have loaded a film or a project. 

The following scenarios exist: 

• Batch conversion has been opened from the context menu in the Media Pool 
(view page 22, view page 44): The file selected in the Media Pool beforehand will 
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be transferred to the task list and can be converted to the available formats. In 
case of projects which contain multiple movies, all movies will appear as 
individual tasks. 

• Only one empty movie is open: A dialog opens additionally for batch conversion, 
in which video files that have to be converted to other formats can be selected 
and loaded. 

• A movie with video material and more than one object in the first track is opened. 
A dialog opens, in which you can select which tasks should be created for batch 
conversion. 

- All scenes in the movie: All objects present in the 1st track will be used as 
starting points for the video files to be exported. An application for this could 
be that all scene beginnings of a movie should be exported as bitmap files or 
a backup for a movie is to be created as individual scenes. 

- Multiple movies: The opened movie will be exported as a whole video. 
Additional movies can be added to the list in the dialog. 

• Multiple movies with video material are open: The opened movie will be exported 
as a complete video. This is especially useful for large projects with a lot of 
individual movies, eliminating the need to export each one individually. 

 

Administration 
Save and load your settings here. These include the list of files to be exported and the 
export settings and names of all entries. 

Caution!  Batch conversion references the projects, movies, and the objects 
contained therein directly. Keep in mind that when converting entire movies, the 
source material must also be available. During conversion of individual objects from 
movies, you have to make sure that the movie file has not been changed between 
loading and saving. 

 

Queued entries for batch conversion 
This is the list of all objects that have to be converted into the indicated format. Each 
task can have its own export settings. 

Add files (not during conversion of individual objects from movies): Manually add 
files, including video files and projects. 

Remove selected: The marked tasks will be removed from the list. 

Duplicate selected: If you would like to export tasks in multiple formats, you can 
simply mark and duplicate them and assign individual export settings to them. 
 

Format settings for the selected conversion process 
These are settings for the currently selected tasks, and multiple tasks can be given a 
setting simultaneously. Select one or more tasks from the task list. 
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Note on format setting for multiple tasks: If one of the marked tasks already has an 
individual setting, its will be lost after another format is selected. To prevent this, 
remove the selection for each task using Ctrl + mouse-click. 

Set the target format in the flip menu. Windows Media Video format (*.wmv) is the 
default.  

Advanced settings: This opens the dialog for the advanced format settings. This 
corresponds to the dialog for normal video export of a movie. 

Tip: If you give several tasks the same file name, the files created will be 
documented intelligently. For example, you can easily convert and simultaneously 
line up multiple movies that belong together thematically. 

 

Shut down PC automatically after successful export 
This option is especially useful when you export long movies and are using an 
especially high-quality and resource-demanding export format. You can leave the 
computer to work on the individual tasks and after finishing them it will turn itself off. 
 

Start batch conversion 
Click on "Start conversion" to start the process. After ending conversion processes, a 
list of all export processes with a message informing of its success will appear. 

Hint: During batch conversion, messages that appear during normal file import will 
be for the most part suppressed. This is to enable the smoothest conversion of all 
tasks. Therefore, please make sure that all files to be converted or the project can be 
easily loaded before starting a batch conversion. 

 

Backup copy 
Files must be saved to be able to be easily retrieved in case of a hard drive crash or 
some other error. 
 

Copy movie/project and media to folder 
This menu option allows you to put a complete MAGIX Movie Edit Pro 2013 
arrangement, including all applied multimedia files, into one folder. This is especially 
useful if you want to archive an arrangement for later use or in case the files are on 
multiple data carriers (CDs, DVDs, etc) so that on loading you continually have to 
change them. Effects files used are also saved in a folder together with the other files. 

If the option "Copy disc project, movies, and media in folder" is activated, all movies 
in the current disc project, including all of the related media, are combined and copied 
into the selected folder. 
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Note: MAGIX Movie Edit Pro 2013 also features DV logging. Large DV-AVI and 
audio files no longer need to be backed up, since MAGIX Movie Edit Pro 2013 saves 
the position of this material on the DV tape and imports missing files automatically 
when reloading the DV tape. 

A dialog opens to specify the path and name of the video. 

Shortcut: 

Copy movie and media into folder "Shift + R" 
Copy project and media into folder "Alt + S" 
 

Burn project/film and media onto CD/DVD 
Use this option to burn the film as well as all associated files to disc. To do so, you 
must have a burner installed on your computer and a blank CD must be inserted. 

If you choose the option "Burn project and media", the current project and all of the 
associated media files are grouped together and burned onto disc. 

Even larger projects can be burned straight to disc. The project, if necessary, will be 
split up and burned automatically to multiple discs. A restore program which is 
burned to the first disc of this type of backup guarantees that the backup can be 
restored without any problems. 
 

Restore disc project from (S)VCD/video DVD 
This command restores a project backup that has been saved on a disc. The disc must 
have been burned with the option "Add project backup" (see "Burn disc" dialog 
options). 

Choose which of the movies contained on the disc should be restored by selecting it 
from the list and highlighting and selecting the corresponding directory. You must 
also indicate the directory where the project should be saved. A subfolder 
"Backupxxx" will be created in this folder where all project files from the disc will be 
saved. All of the restored movies will be loaded into MAGIX Movie Edit Pro 2013 for 
editing. 

Select the option "Restore image files only" and only the original image files 
contained on the disc will be restored. 
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Load backup project... 
This option loads an automatically created slideshow backup. This type of automatic 
backup gets the file extension MV_ (underscore). This command is only intended for 
use in emergencies, for example, if you unintentionally saved your change and wish to 
return to the previous version of the movie. 

Keyboard shortcut:  Ctrl + Shift  + O 

Tip: Under "File -> Settings -> Program...", you can determine how often an 
automatic backup will be created in the "System" tab under "Automatic backup". 

 

Clean-up wizard 
The clean-up wizard helps delete projects from the hard drive, including all of the 
media files used. Use this function to free up disk space for future projects. 

Caution: If the files you used in the movie have also been used in other movies (like 
trailers, opening music, etc.), then you should make backup copies of these files 
beforehand. 

Keyboard shortcut:  Ctrl + Shift + Y 
 

Delete specific files 
Choose this option if you would like to select certain files for deletion. In the file 
selection dialog, you can select the desired files. In the next step, the clean-up wizard 
searches for other files which belong to your selection. Using this method, you can 
delete an entire movie with all of its accompanying media, help, project, and backup 
files. Before they are deleted, you will receive relevant information in a dialog and a 
confirmation request.  
 

Search and delete superfluous files 
Choose this option if you would like to find unnecessary files or free up some space 
on your hard drive. The clean-up wizard automatically looks for extraneous files 
created during use of MAGIX Movie Edit Pro 2013. Before they are deleted, you 
receive relevant information in a dialog and a confirmation request.  
 

Advanced 
"Advanced" lets you set which files and folders should be included in the cleaning 
process. 
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Burning 
The "Burn" screen enables you to create a selection menu to burn the entire project 
including all movies and the selection menu to disc later on. 

 
Switch to the "Burn" screen first by pressing the button 
displayed. 

 

Preview and editing 
MAGIX Movie Edit Pro 2013 provides two different modes for designing and 
previewing the disc menu. 

 
"Preview" mode simulates the behavior of a playback device, e.g. 
DVD player or Blu-ray player.  
You can select a template for the menu and burn the disc. 

 
In "Editing" mode, you may adjust many features of the disc menu. 
Templates are also available here that may be flexibly adjusted to 
suit your needs. 

 

Remote control 
The virtual remote control is an important helper when it comes to checking how the 
disc will perform later. 

When the disc featuring the project is inserted into the player, this remote control will 
control the preview picture just like a "real" remote control controls the picture on a 
monitor or TV. The menu navigation may be activated via the arrow keys or the "OK" 
button. Activated buttons are highlighted. 
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The number keys select the corresponding entry on the menu 
page. All menu entries are marked with a corresponding number. 
Within a chapter menu, playback is started from the particular 
scene. In the movie menu, the corresponding chapter menu (if 
available) is changed or movie playback is started.  

Navigation button: Use these buttons to navigate in the menu of 
the disc being burned. The individual entries may be changed and 
confirmed by pressing "OK". The remote control reacts exactly 
like a genuine DVD/Blu-ray player's remote control. 

Skip/move forward/back: This allows you to skip to the next or 
previous scene while playing back your movie. In the menu, you 
can skip forward or back from one menu page to another. 

Play: Starts the first entry in the menu. In case chapter menus are 
available (view page 217), the chapter menu will be displayed 
first. Press the play button again to start playback at the 
beginning of the first scene of the first chapter. 

Stop: Pressing stop halts playback. 

Disc: Switches to the first page of the film menu. 

Sub: Switches to the chapter menu (if available) for the currently selected film. 
 

Menu 
The selection menu is also burned to disc and appears when inserted into your player. 
Just like with a store-bought DVD or Blu-ray Disc, you may easily select your movies 
with the help of preview pictures, or access particular chapters within a movie. 
 

Templates 
You will find the menu templates below. 
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To the left, you will see a tree structure for selecting various menu templates. At the 
top, you should first select whether you would like to use templates in ratio "16"9" or 
"4:3".  

• Animated  (DVD): These templates contain background and introductory videos 
as well as music. The control elements are displayed in various modes. The 
templates can be used only for mini DVDs, DVDs and AVCHD discs.  

• Static (4:3 only, DVD): Here you will find templates made up of regular 
background pictures and control elements. 

• Custom: These templates adjust to your disc project; the movies and scenes you 
use are integrated directly into the menu. 

• HD  static (16:9 only, DVD, Blu-ray, AVCHD, WMV HD): These templates contain 
super-sharp, high-res background images that are particularly noticeable on HD 
TV devices. 

• Movie templates (only 16:9): Here you will find menu templates that are specially 
made for movie templates (view page 185) found in the Media Pool. 

Note: These menus require "Film menu" and "Chapter menu" to be activated in the 
"Edit" screen under "Disc options". 

If you've selected one of the menu templates, you can use the horizontal scroll bar to 
view all the others available. There are lots of options when using the templates: 

• To apply a template to all menu pages, double-click the desired template. The 
complete template will then be applied. 

• You can also combine various elements from different templates with each other. 
To do so, you must first switch into Editing mode. If, for example, you wish to 
combine the text format of a template with the background of another one, 
double-click on the template containing the background first. Then click on the 
"Font" tab and select a template for the font. 

• You can load the layout (or individual layout elements) for the current menu 
(movie or scenes) as well as for all menus. 

 

Note: Some menu templates include intro videos with a smooth transition to the 
menu page! 
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Edit disc menu 

 

To edit individual menu elements and the menu structure, 
activate the "Edit" button. 

 
 

Edit menu elements 
Hold down the left mouse button and drag text boxes or graphical elements to the 
desired position. You can adjust the size by dragging out the corners and edges of the 
frame. 

 

Undo: This command allows you to undo the last changes made.  

 

Redo: This function undoes the previous "Undo" function. 

 

 
Lock aspect ratio: To avoid distortion, use this button to lock the aspect 
ratio for the menu elements.  

 
Group: Menu elements are moved or resized simultaneously as a group, 
including the description text and number. 

 
Fade in TV display area in the preview monitor: This option displays the 
image borders of the television (view page 145) as lines in the preview 
monitor.  

 
Grid: This button shows a grid to help position frames exactly next to 
each other as required. Using the small arrow next to the button you can 
open a dialog to fine tune the grid settings. 

 

Navigation 
Using navigation links above you can reach the structure of the menu entries. 



 

Burning 217  

 

 

• All movies are listed as first entries. The 
corresponding menu level is the film menu. 

• All scenes are listed as second entries next to it to the 
right. The corresponding menu level is the chapter 
menu. 

Removing the red check deactivates the corresponding 
entry in the chapter menu. The scenes are still displayed 
of course, but you can no longer select them directly from 
the menu. 

• You can open the movie menu for further editing by 
clicking on the movie above it.  

• If you click on one of the chapters, the chapter menu 
in the preview will be opened for editing. 

 

Disc options 
Here you can activate or deactivate certain elements or even complete menus. 

Intro video: Press this button to load videos to be used as introductions to your discs. 
The following formats are supported: "*.avi", "*.mpg", "*.mxv", "*.vob". The intro is 
played immediately after the DVD has been inserted into the player. The DVD menu 
will then appear. A check mark "Do not skip" ensures that the intro video must be 
played completely each time the disc is inserted and that it may not be skipped with 
the remote control or otherwise. 
 

Film menu & chapter menu 
The disc menu essentially consists of two layers: 

Film menu: The upper layer includes the film menu, which is only used if a project 
contains multiple movies.  

Chapter menu: This is the lower layer of the disc menu, which utilizes the chapter 
markers in a movie as menu entries. More information about this is available in 
Chapter markers (view page 100). 

Note: A chapter menu cannot contain more than 99 entries. If your movie should 
have more chapters, either burn it without a chapter menu or split your movie into 
multiple parts. 

 



 

218   

www.magix.com 

Preview pictures: Shows/hides the preview pictures in the disc menu. 

Numbering: The numbers beside the menu entries may be selected directly using the 
remote control, but they might be unwanted at times. Use this option to show/hide 
them. 

Frame: A frame borders the preview pictures. If this is unwanted, it may be removed 
easily using this option. 
 

Create your own menu background 
You can edit the existing menu background or create a new one from scratch.  

 
A click on this button switches to the "Edit" interface and 
loads the selected menu background as video.  

Here you can change and design the background as you please. The background 
movie will be set as the menu background automatically after pressing "Save". 

Tip: If you would like to design a new menu background, simply delete all existing 
objects from the menu project and load new ones. 

 

Design page 
Only in the Plus/Premium version: New menu pages may also be added or irrelevant 
pages may be removed. 

 
Adds a new menu page. 

 

 
Removes the selected menu page. 

 

Background: Here you have three options for creating a static background image for 
the menu: 

• You can set a certain color value for the background. 
• You can select an image saved on your hard drive 
• You can select a frame from your project. 
 

Animated selection menus 
Audio-visual animations may also be added to the DVD menus. As required, 
background videos are played as endless loops while the menu is shown on the 
screen. Add background music in various formats or use any background picture for 
each menu. 

Sound/music: Load an audio file into the preview monitor and use it as an animation 
in the menu background. 
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Video: Load a video or graphics file into the preview monitor and use it as an 
animation in the menu background. In addition to the options for the background 
graphic (see above), you may also use a sequence from a loaded slideshow or from a 
different video file. 

Background video options: 
• Create animated menu buttons: The preview images for individual movies in the 

movie menu are shown as small movie samples. Set the start point and length of 
the animation using the sequence options faders. 

• Use video's audio track: The audio track of the background video is used with the 
menu. 

• Play menu animation as a loop: The background video (audio and/or video) is 
played back as a loop. 

• Length of the menu view is set by: Audio/video or whichever medium is longer. 
You can specify how long the background video should be here. The other 
medium will be played as a loop. 

 

Create a button design 
MAGIX Movie Edit Pro 2013 enables easy editing of all buttons together with their 
menu entries. 

 
You can edit menu entries that you created using this 
button or with a double click on the menu. The dialog with 
the properties of the menu entries (view page 220) will 
open. 

 
Edit in MAGIX Photo Designer: You can open MAGIX 
Photo Designer for additional editing of elected menu 
elements. 

 Apply to all objects: Applies the properties of the selected 
button to all remaining buttons. 

 
 

Only in the Plus/Premium version: New menu pages may also be added or irrelevant 
pages may be removed, together with all corresponding buttons. 

 
Adds a new menu entry with button. 

 
Removes the selected menu entry with button. 

Tip: If you would simply like to deactivate unused menu entries, this may be done 
via the Navigation. 
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Note: The chapter menu is formed via chapter markers (view page 100) and can be 
influenced in detail with these. 

 
Pressing this button or double-clicking the menu entries 
allows menu entries you have created to be edited. The 
dialog with the properties of the menu entries (view page 
220) will open. 

 

 
These buttons open MAGIX Photo Designer for 
further editing of your background pictures or 
the selected menu elements. 

 

Jump to linked page 

 
To test the targets of menu entries, select the desired 
menu entry and click the button. 

 

Menu entry/menu page properties 
Double clicking the preview picture or a menu entry opens an editor for you to adjust 
the preview picture or menu entry.  

 
 

Menu text 
In the text input field, you can enter any text to match the chosen menu entry. 
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Set the vertical direction of the text (upwards, centered or 
downward). 

 

Set the horizontal direction of the text (left, centered or 
right). 

Font size: Set the height of the text in pixels. 

Font color: Define the foreground color of the text. 

Font: Set which font and which style (bold, italic, etc.) should be used. 

Shadow: Set the color and size of the shadow that will appear underneath the text. 

3D effect: If you would like to make your text appear three-dimensional, you can set 
the width, height, and color of the 3D effect. 

Apply to all: Except for the text, all settings are applied to all entries in the current 
menu. 
 

Menu image 
Use frame from movie: Use the fader to set which frame should be used in the video 
as a preview picture. The numerical input fields are sorted as follows: 
Hours:Minutes:Seconds:Frames. 

Use different graphic: You can also load your own bitmap images to be used as menu 
pictures. 

Hint: It may be the case that there are no menu pictures in some menu templates, 
so changing the menu picture won't have any noticeable effect. 

 

Actions at the end of the movie (preview images in film menu only) 
Enter which action should be carried out once the film has finished playing here. 
Select from: 

• Stop playback: This option depends on the DVD player being used. Most DVD 
players show the DVD player's own menu (or background picture) after 
playback. 

• Jump to movie menu/chapter menu: Jumps back to the previously displayed 
menu. 

Tip: If one of these two options is not available, please check which menu mode is 
set. 
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• Jump to next movie: The next movie will be played without any additional action. 
• Play movie as endless loop: Any movie may be burned onto a disc as a loop. This 

means that the movie will be played as a endless loop until the next menu entry is 
accessed using the remote control or playback is stopped. This way, you can 
transform your TV into an aquarium, a train journey, a fireplace or anything that 
you could watch over and over again. 

Note: This option only functions for DVDs, Mini DVDs, or Blu-ray Discs. 

 

Edit your own menu entries 

Note: This function is available only in the Plus/Premium version. 

There is another view in this dialog to edit menu entries you have created. Menu links 
can be edited here. This makes it possible to link a menu entry with a certain action, 
menu page, or a certain position in the movie. 

No link: The menu element cannot be selected and has no function other than to 
display menu text. 

Link to page in current menu: Jumps to a menu page in the current movie or chapter 
menu in the current film. 

Link to another menu: Opens another movie or chapter menu. 

Link to chapter in a movie: If this option is selected, enter a film and chapter marker 
where playback should start. 

Note: For DVDs, only chapters within the current movie may be jumped to. 

Link to film start: The movie will play back from the start. 
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Burning wizard 

 

Click "Burn" to open the dialog for creating DVDs, Blu-ray 
discs, AVCHD and other video media, with a menu. 

Under "Other options" you will find other disc formats. 

 

Select what kind of disc you would like to create. 
 

Proceed as follows to burn a disc: 

• Set up burner and burn speed: If multiple burners are installed, you may select 
which device you wish to use in this menu. 

• Encoder settings: Use the "Encoder" button to access the selection dialog to 
specify settings for the MPEG encoder (memory requirements, quality, and 
duration of the MPEG conversion). "Advanced settings" accesses a dialog 
featuring additional options. You can adjust all the fine settings for the MPEG 
encoder here. 

• Burning disc/starting video encoding: The button "Burn disc" starts the disc 
burning process. Every time you burn and every time a simulation is carried out, 
the disc project is encoded. Please note that the MPEG file is not deleted from the 
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hard disk after the burn process has finished. Depending on the length of the 
project, encoding and burning may take some time. The time required can be 
seen in the dialog. 

 

The burn dialog 
Here you can select your burner, the type of disc, the encoder settings. MPEG-2 is 
used for DVDs. Blu-ray discs also use MPEG-2, and higher bitrates are employed in 
order to reach the higher HD resolutions. AVCHD discs use a much more complex 
MPEG-4/H.264 codec, which is documented in detail in the "MPEG-4 encoder 
settings (view page 299) section of the PDF manual and in Help (F1 key). 

 
 

Options 
Simulate first: If you are not sure about the write speed or memory requirements of 
the selected disc, you can simulate the write process before burning.  

Activate buffer underrun protection: Many burners support techniques that prevent 
the much-feared "buffer underrun". Use this option to activate this protective feature 
and burn your files at higher speeds without risking making a coaster out of your blank 
disc. 

Completely format DVD/CD-RW media: This option reformats the RW media and 
deletes all existing file material. 

Shut down computer after burning: Activate this option to automatically turn off the 
computer after encoding and burning has been completed. You could, for instance, 
start the encoding and burning process in the evening, and you don't have to wait for 
the process to finish to switch off your computer. 

Burn standard video DVD onto same disc: You can use this option with a WMV HD 
disc to burn an additional normal DVD video. This ensures that your discs can also be 
played back on standalone DVD players. See Multi disc. 
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Activate the burner's defect management option: If a certain section of the disc is 
defective, then this will be recognized by the burner and labeled as such. No content 
will be saved there as a result. 

Check data after burning disc: The finished disc will be checked for any mistakes after 
burning. 

CD/DVD title: This is the title of the DVD as it will appear on the PC. The disc project 
name is displayed here by default. 
 

Encoder settings 
Use the “Encoder settings...” button to access the selection dialog to specify the 
properties of the MPEG encoder (memory requirements, quality, and duration of the 
MPEG conversion) 

Preset: Here you will find useful presets for the selected disc type. Here are some of 
the presets for a DVD: 

Longplay DVD Video DVD with extra-long playing time. The bit rate is reduced, 
which compromises image quality. 

Longplay music DVD DVD with extra-long playing time for music. The bit rate for 
the soundtrack remains at the highest quality level. 

Standard DVD Normal DVD 
Widescreen DVD Normal DVD in 16:9 format 

Note: For all settings, you can choose between NTSC (USA and Japan) (Europe). 

Bitrate: Bitrate determines the size on the disk that the finished video will take up. The 
greater the bit rate, the larger the file, and the shorter the maximum playing time of 
the movie that fits on a disc. 

Adjust bit rate: The expected file size of the finished video is estimated, depending on 
the set bit rate. If the movie does not fit onto the disc, the bit rate is corrected 
accordingly. 

Quality: Specifies the quality of the encoding process. The higher the quality, the 
better the finished video will look; however, encoding will take considerably longer. 

Smart Rendering: With Smart Rendering you can significantly reduce the encoding 
effort for MPEG files. During the production of MPEG files, only those parts of the 
movie that were changed in the program are re-encoded. Please note: The MPEG files 
contained in the movie must have the same format, i.e. the bit rates (variable or 
constant), audio formats, image resolutions and video formats must match. 

Anti-interlace filter: Activate this option only for playback on a TV screen, where it 
reduces horizontal flickering around fine details. 
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Calculate video effects on GPU: To accelerate exporting, you can let video effects be 
calculated on the graphics card. At this time this applies to brightness, gamma, 
contrast, color, saturation, image size, cropping and position effects as well as various 
fades and mixes. Please note that external effect plugins and elaborate artistic effects 
must be processed on the CPU and for this reason using this function will not yield 
any speed advantage. 

Note: This function is specifically optimized for NVIDIA graphics cards. You can, 
however, experience acceleration with other types of graphics cards, too. 

3D mode: If you have 3D material in your project which has been edited with 
Stereo3D, you can select here in which mode it should be burned to disc here. 3D is 
switched off by default. 

To return to the standard settings, press the Reset button. 

Via "Advanced" you can reach the "Advanced settings" dialog. Here you can make 
changes to all MPEG encoder settings. Read the \ "MPEG-1/2 encoder-settings" 
appendix (view page 309) and "MPEG-4 encoder settings" (view page 299) in the 
PDF manual or program help. 
 

Use Quick Sync Video, Open CL or CUDA for rendering 
MAGIX Movie Edit Pro 2013 supports hardware acceleration for AVCHD exports, 
AVCHD Disc and Blu-ray (H.264) Disc encoding (burning). This can noticeably 
speed up the encoding process. 

The following hardware acceleration technology is supported: Quick Sync Video 
(Intel), OpenCL (AMD) and CUDA (NVIDIA). 

Note: Ask your graphics card manufacturer whether your graphics card supports 
hardware acceleration.  Make sure that all the necessary drivers are installed. 

If your system does support hardware acceleration, you can activate it through 
"Advanced..." > "Hardware acceleration". The program will make the adjustments 
according to the available technology. 
 

Disk space 
Disc type Data carrier Menu Quality Length (optimal quality) 

DVD DVD Yes  *** 98 min. 
Blu-Ray Disc 
(view page 295) 

Blu-Ray Disc Yes ***** 110 min. 

AVCHD (view 
page 295) 

DVD/Blu-ray 
Disc 

Yes ***** 30 min./DVD 
160 min./Blu-ray Disc 
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Multi Disc CD/DVD Yes **** 45 min./DVD 
7min/CD 

* The set duration for some DVD players may be determined by this table. Depending 
on the original size (file size of the images) the number of images that fit on a blank 
CD or DVD differs. 

For the MPEG-2 encoder it can be difficult to supply reliable information relating to 
the required memory space. If the "variable bit rate" of the MPEG-2 encoder is 
activated, encoding will occur according to the movements in the picture. The 
required memory depends on the film material; an action film would need more 
memory than a drama, for instance.  

If you cannot save your disc project on a single disc, you will have to divide it up into 
different sections. 

Further information on MPEG compression and formats can be found in the chapter 
"Annex: digital video and data storage" (view page 292). 

 

Test series with variable encoder settings 
If you would like to know how much memory space you require for various encoder 
settings, you should run some simulations before burning. 

So you don’t waste any blank CDs while testing, you should activate the “Simulate 
first” option. 

Then create, for example, a short (ca. 5 min.) disc project and simulate burning in 
multiple cycles with various settings. 

After every simulation you can access the created file on the hard disk to check how 
large the file has become. 

From the results, you can extrapolate how much disc space your disc project will 
require. The memory requirements of a 5-minute disc project would have to be 
multiplied by 20 in order to estimate the space required for a 100-minute movie. You 
should also add buffer for the selection menu. (view page 214) 
 

Separate project onto multiple discs 
Automatically: If the disc project requires more memory than is available on the CD 
or DVD, a dialog will appear before burning asking whether the disc project should be 
automatically segmented for multiple discs. Confirm this by clicking “Yes”. The disc 
project will then be automatically divided into individual disc projects and burned 
sequentially onto multiple discs. This is the easiest method since everything is 
automatic, and all you have to do is insert a new blank CD when required. 
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Manual 
Case 1: If several movies do not fit onto a single disc... 

In this case, switch back to the “Edit” screen and delete as many movies as is needed 
until the remaining movies fit onto the disc. You can create a new disc project and 
load and burn the other movies afterwards. 

Case 2: When a long film doesn’t fit onto a disc... 

In this case, the movie has to be split into two or more parts that will be burned 
separately onto disc. 

• Switch back to the "Edit" view and place the start marker to the position at which 
you wish to divide the movie. In the "Edit" menu, select "Cut -> Separate movie". 

• All passages behind the start marker will be removed from the movie and made 
into a smaller movie. Both movies can be moved using the "Select to edit" menu 
in the arranger. Save both of them separately to your hard disk (“Save movie” 
menu option, for example, as “Part 1” and “Part 2”). 

• Remove one of the two movies (for example, "Part 2") from the disc project 
("Manage movies -> Remove movie (view page 235)" menu option). 

• Switch to the "Burn" interface and burn the first film ("Part 1") to CD or DVD. 
• Create a new disc project (“New” button), switch to the “Record” view and load it 

into the second film (“Part 2”). 
• Switch to the “Burn” interface and burn the second movie to CD or DVD. 
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Export 
The "Export" button opens the export wizard, which features the most important 
export options for your videos. Please note that you will only export the current 
movie. Other movies in the project and the disc menu will not be included. 
 

Export 3D movie 
With this option you can recalculate a movie including all objects, effects settings, 
fades, text, etc. into a 3D video file and save it to a computer. 

 

• First, select a quality in the dialog. It only makes sense to use HD quality if you 
have high resolution material in your project. 

• Next, choose a 3D mode. Anaglyph videos are suitable for viewing on a standard 
television or monitor and can be viewed with red-cyan glasses. Side-by-Side 
videos deliver a considerably better 3D experience, it does however, require 
special monitors, TV sets and playback devices. 

• Next, click "Save video". 

Note: You will always export Windows Media Video 3D files using this dialog. You 
can use other file formats via "File -> Export movie". 

See the "Stereo 3D" chapter (view page 177) for more information on 3D video.  
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Output as video file 
With this option you can recalculate a movie including all objects, effects settings, 
fades, text, etc. into a video file and save it to a computer. 

 

Select a certain quality (e.g. DVD quality) and a file format (e.g. MPEG -4). The dialog 
provides further information about the properties of your selection. Please note that 
MAGIX Movie Edit Pro 2013 also adjusts the quality when you change file format, if 
this wasn't optimally selected for your chosen format. 
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Upload to Internet 
With this option you can upload your movie directly to YouTube, Vimeo or Facebook. 
YouTube maybe the best-known portal for self-made clips of all kinds. Vimeo is an 
up-and-coming portal for more demanding videos. 

 

Community: Select a platform: YouTube or Video. 

Name: Here you can enter the name of your movie. 

Description: Here you can create a short description of your movie to orient other 
community member as to its contents. 

Category: Select the category for your movie here. 

Send: Here you can select whether the film should be private, accessible only to you 
and authorized persons, or public, meaning freely accessible. 

Export settings: Here you can set various quality settings. 
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Add to the Telekom Media Center 
If you are a Telekom customer and use the Telekom Media Center, you can use this 
export feature to save your movie directly in the Telekom Media Center Online 
Storage. 

Enter the export settings before logging in to the Telekom Media Center and following 
the instructions. 
 

Upload to Internet (MAGIX Online Album) 
This accesses the MAGIX Online Album login dialog directly. Next, present your 
photos together with videos and music in custom-designed online albums. 

 

Note:If you don't have MAGIX Online Album, you can register to this service at "Info 
& Registration"  

After logging in, you can determine the desired quality, file location and status (visible 
to the public or only for you), and then start the transfer. At the end, your material will 
be displayed in your Online Album. 
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Export to device 
You can export your project to mobile devices made by Apple and mobile phones 
with Android operating systems.  

• Click on "Export to mobile device" in the export dialog. 

Then select the mobile device from the list. 

Tip (only for Android phones):  Normally your device will be correctly recognized as 
"Mass storage device by your computer. If this is not the case then change the 
connection detection settings of the device before connecting to your computer, so 
you can select the correct connection type (e.g. "Mass storage drive"). For more 
details, consult your device manual. 

 

Export as Media Player 
To be able to play back your film in an Internet browser or to embed it into web pages, 
you can export it as an HTML-enabled media player. 

Select the desired quality and click on "Save video". In the target folder, an HTM and 
an MP4 file will be created for further use. 
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Menus 
Certain menu items are not available on the "Record" and "Burn" screens. The menu 
reference describes the full menu as found on the "Edit" screen. 
 

File Menu 
New project 

 
Creates a new MAGIX Movie Edit Pro 2013 project. A dialog with settings for a 
new disc project or a new film opens to get started. 

Keyboard shortcut:  Ctrl + N 
 

Open 

 With this option you can load a project or a media file. Please note that all 
media files associated with it must be loaded along with a project. MAGIX 
Movie Edit Pro 2013 will search for all used sounds and video files in the 
folders in which they were located when the move was saved. 

Keyboard shortcut:   Ctrl + O 
 

Save project 

 
The current disc project is saved with the name displayed in the project window. 
If you have not specified a name for your project yet, a dialog will open for you to 
do so. 

Keyboard shortcut:  Ctrl + S 
 

Save project as... 
A dialog opens where you can specify the path and name of the video for saving. 

Keyboard shortcut:  Shift + S 
 

Manage movies 
New movie 
Use this option to create a new movie for your recordings and imported files. Since a 
film is normally already opened, you will have to decide whether the movie should be 
inserted into the existing project or if a new project should be created. 

Keyboard shortcut:  Ctrl + Alt + N 
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Delete movie 
This option lets you remove the current movie from the project. However, it is still 
available on the hard drive and can be loaded again at any time. 
Keyboard shortcut:  Ctrl + F4 
 

Attach movie 
Using this function you can attach a movie to an opened one. This is then attached to 
the end of the movie and automatically takes on the original movie's settings. 
 

Rename movie 
You can enter a new name for your movie here. 
 

Import 
Use this option to load a movie into your disc project. Please note that all media files 
associated with it must be accessible. MAGIX Movie Edit Pro 2013 will search for all 
used sounds and video files in the folders in which they were located when the movie 
was saved. 

 

You can use the tabs to switch from one movie to another. 
 

Export movie file 
A dialog will open to enter a file name for the movie to be exported. The movie may 
then be imported into other projects again. 

Note: The movie file (*.mvd) includes all information about the media files used, 
cuts, effects, and titles, but not about the image and sound material itself. This is 
always contained in the recorded or imported media files, which remains unchanged 
during editing with MAGIX Movie Edit Pro 2013. In order to save a movie in its own 
folder, e.g. for use on another PC, use the function "Copy film and media to folder". 

Keyboard shortcut:  Ctrl + Alt + L 
 

Export movie 
A movie may be exported in different video formats via "File -> Export movie". The 
options available vary according to the selected format. 

Presets: These are typical settings for the selected format for the most important 
applications.  
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  Click "Save" to save your own settings and "Delete" to remove them 
from the list. 

Export settings: Specify general export parameters like resolution, aspect ratio, and 
frame rate here. Select the most frequently used values from the list fields; to set your 
own values click on the "..." button. The "Advanced" button opens the specific 
settings for the selected video format. "File" enables you to export your file to another 
folder than the preset (More information can be found in the section "Folder" on page 
58) one. The option "Overwrite file without confirmation" option allows you to 
execute multiple exports in the same file.  

Other: "Other" also provides the option to switch off your computer automatically 
after long encoding processes and to limit export to the selected area (between the in 
and out point).  

Output after export: Some formats allow special playback options (e.g. DV-AVI on 
the camera or WMV export with output via Bluetooth to your mobile phone). 
 

Video as AVI 
When exporting to AVI video, you may set and configure the size and frame rate of 
the AVI video and the compression codec for audio (audio compression) and video. 
Please see the general information about AVI video formats (view page 293) as well. 

Keyboard shortcut:  Ctrl + Alt + A 
 

Video as DV-AVI 
This option exports the video as a DV encoded AVI. You will be asked for which video 
standard you want to export DV data. PAL (Europe) or NTSC (USA/Japan). The 
arrangement can be easily transferred to the Digicam via the FireWire interface.  

The window will provide further information on all available options. You can access it 
via the button "Advanced..." in the "Export" dialog. 

Keyboard shortcut:  Ctrl + Alt + D 
 

Video as MPEG video 
MPEG stands for "Motion Picture Experts Group" and is a high-performance 
compression format for audio and video files.   

Details on the settings of the MPEG encoder can be found in the "MPEG encoder 
settings" appendix. 

Keyboard shortcut: Ctrl + Alt + P 
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MAGIX video export 
Exports the movie in MAGIX video format. This format is used for video recording by 
MAGIX video software and is optimized for digitally edited high-quality video 
material. 

Keyboard shortcut:  Ctrl + Alt + M 
 

Video as Quicktime Movie 
Exports the movie in QuickTime movie format. This enables streaming playback of 
audio and video files over the Internet. 

As with RealMedia export, appropriate adjustments can also be made for video site, 
frame rate, and codec settings. However, the export dialog does not permit you to add 
commentary to the video. 

For QuickTime files (*.mov) you have to install the QuickTime library. 

Keyboard shortcut: Ctrl + Alt + Q 
 

Uncompressed movie 
When exporting an uncompressed AVI video file you can adjust the size and frame 
rate of the AVI video you wish to create. The video material will not be compressed 
by a codec. 

Note: This will create very large files! 

Keyboard shortcut:  Ctrl + Alt + U 
 

Video as MotionJPEG AVI 
Opens the export dialog for AVI video in MotionJPEG format. This format is 
supported by digital picture frames, for example. 

Keyboard shortcut:  Ctrl + Alt + O 
 

Movie as a series of individual frames 
This option exports the video as a sequence of single frames in bitmap format. This 
means a graphic file will be created for every frame of the video. The image count may 
be determined in the export dialog under "Frame rate". 

Keyboard shortcut:  Ctrl + Alt + E 
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Windows Media Export 
Exports the arrangement in Windows Media format. This is a universal audio/video 
format from Microsoft. The setting options in the Advanced dialog are 
correspondingly complex. 

Manual configuration 
 
Audio/Video codec: Various codecs corresponding to the many versions of Windows 
Media (7, 8, 9) are possible. If playback compatibility problems arise, try an older 
codec with a lower version number. 

Bit rate mode: Constant and variable bit rate modes are possible; however, most 
devices and streaming applications require a constant bit rate. For VBR two-pass 
modes, the movie is compressed in two passes for optimal use of the bandwidth 
required for highly-compressed movies on the Internet. 

Bit rate/quality/audio format: The bit rate substantially determines the display and 
audio quality. The higher this is, the better your videos will look and the larger the files 
and the required encoding time will be. For variable bit rates, the bit rate is adapted 
dynamically to the requirements of the corresponding picture or sound material. Here, 
either the quality value of between 1-100 can be set or, for two-pass encoding, an 
average or maximum bit rate. For audio, the bit rate is set additionally by the audio 
format. 

Import from system profile (export type): For the most used methods (other than for 
playback on mobile devices; for this you should use the supplied presets), e.g. Internet 
streaming, Microsoft provides a diverse selection of system profiles. If you have the 
Windows Media Encoder 9 installed (available from Microsoft as a free download), 
then you can edit the profiles or create your own. These can be loaded by pressing the 
"Import from profile file" button. 

Go to Clip info to insert title, author name, copyright details, and a description.  

Keyboard shortcut: Ctrl + Alt + V 
 

Video as MPEG-4 video 

Hint: In order to use the MPEG-4 video export feature, you will have to activate this 
function first (view page 289). 

MPEG-4 is the most advanced video format available at the moment. Unlike others, it 
can provide high-quality pictures at the same file size. 

Behind MPEG-4, you'll find a highly complex "academic" standard that operates and 
is supported variably according to make. To go into detail on these differences and 
parameters would be beyond the scope of this documentation. For this reason, 
indications, along with the operational manual of your device, are given that should 
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help create executable MPEG-4 files. For more experimental users, the complete 
setup options of the MPEG-4 codec can be found behind the "Advanced settings..." 
buttons. 

Video/Audio: The MPEG-4 format and the advanced AVC format are also available 
but have, as of yet, only been used in a few devices. MPEG4 video can be combined 
with AAC or AMR sound, the latter mostly in conjunction with mobile phones. The 
combination ACC/AAC doesn't appear very often (Apple iPod Video), ACC with 
AMR in contrast, not at all.  

Multiplexer: Here you can find the so-called container formats and special options for 
Apple iPod and Sony PSP. MPEG-4 is usually used as an output format, mobile 
phones mostly use 3GPP. 

Keyboard shortcut:  Ctrl + Alt + G 
 

Hardware acceleration - CUDA, Quick Sync Video, OpenCL 
MAGIX Movie Edit Pro 2013 supports hardware acceleration for AVCHD exports, 
AVCHD Disc and Blu-ray (H.264) Disc encoding (burning). This can noticeably 
speed up the encoding process. 

The following hardware acceleration technology is supported: Quick Sync Video 
(Intel), OpenCL (AMD) and CUDA (NVIDIA). 

Note: Ask your graphics card manufacturer whether your graphics card supports 
hardware acceleration.  Make sure that all the necessary drivers are installed. 

If your system does support hardware acceleration, you can activate it through 
"Advanced..." > "Hardware acceleration". The program will make the adjustments 
according to the available technology. 
 

Note: To import and export AVC(HD) and MPEG-4 files, the MEPG-4 codec must 
first be activated (view page 289). A dialog will open if the codec is required. 

 

Audio as MP3 
MAGIX Movie Edit Pro 2013 supplies an optional MP3 Encoder for especially fast and 
good-sounding conversions into the popular MP3 audio format. 

Warning: In order to use the MP3 export function, Windows Media Player 10 or 
higher has to be installed to your system. 

Hint: The MP3 Encoder cannot be used as a codec for the audio track of AVI audio 
files.  
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Transmission format 

Here you can specify how you wish to send the audio file to the mobile device. Read 
more on this under Transferring files. 

Options 

In the "Options" section you can set the format and the compression of the audio file. 

Bit rate: The "Bit rate" selection specifies the level of compression: The higher the bit 
rate, the higher the quality of the exported audio file. On the other hand, the bit rate 
determines the final file size: The smaller the bit rate, the smaller the files. 

Mono/Stereo/5.1 Surround: Most mobile devices have only one loudspeaker. To save 
on memory, you can export in mono as well. In 5.1 Surround Mode (see Mixer in 
Surround Mode) you can also export in MP3surround. 

Normalize: This function should always be activated. It guarantees that the music is 
not too loud/overmodulated or too quiet. 
 

Audio as wave 
The movie's audio track is exported in the wave (*.wav) audio format. 

Keyboard shortcut:  Ctrl + Alt + W 
 

Export as transition... 
Please see "Creating custom alpha transitions (view page 94)" 

Keyboard shortcut:  Ctrl + Alt + T 
 

Single frame as BMP 
Exports the image at the position of the start marker and displayed on the video 
screen as a BMP file. 

Keyboard shortcut: Ctrl + Alt + B 
 

Single frame as JPG 
Exports the picture located at the current start marker and displayed in the video 
monitor as a JPG file. 

Keyboard shortcut: Ctrl + Alt + J 
 

Animated GIF 
The video will be exported as an animated GIF file (also called "AniGIF). This file 
format is supported by many mobile phones. 

Keyboard shortcut: Ctrl + Alt + F 
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Record audio / images / video 

 

A selection window will open to choose the desired recording type. This may also be 
accessed via the "Audio or video recording" button in the transport controls. 

Keyboard shortcut:  R 
 

Import Audio CD track(s) 
A CD track may be imported via drag & drop from the Media Pool just like a normal 
file. If this convenient method fails for some reason, then this menu command may be 
accessed via the CD manager to insert tracks from audio CDs directly into the 
arrangement. More about this is available in the section "Import audio CD (view page 
148)". 
 

Scan image 
Select scanner 
The twain interface connects MAGIX Movie Edit Pro 2013 with almost all current 
scanners or digital cameras. Here's how to proceed the first time you scan via the 
twain interface:  

1. Install the twain software for the device.  
2. Restart your computer.  
3. Start MAGIX Movie Edit Pro 2013.  
4. Click on "File -> Twain scanner -> Select source", if the scanner works with 32-

bit software.  
5. Click the device that you want to use in the dialog. This step will no longer be 

necessary as long as the same device is used. 
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Start the scanning process 
The scan window of your scan software will appear. Specify the resolution and color 
depth in this window. Once the scan process is finished, the twain software will 
normally switch off by itself – the scanned image file will be added to MAGIX Movie 
Edit Pro 2013 automatically. If the twain dialog remains open, you will be able to scan 
multiple images in succession.  
 

Export to device 
Open this dialog via "File" > "Export to device". 

 

Here you can transfer your finished video onto external devices. Select the target 
device from the list. 
 

Export to mobile devices 
Most devices require certain format settings (file format, resolution, bit rate, picture 
repeat rate, etc.) to be able to play a video.  

The menu is divided into various device classes to make choosing your device easier. 
The last three selections are saved as favorites in the top part of the device list if you 
have more than one device or want to present your movies to your friends. 

If your device is listed here, you don't have to worry about the format settings, as the 
necessary settings of the export dialog (view page 235) are automatically customized 
to the target device. Simply select your device and click "OK". 
 

Output DV/HDV 
For digital output please select "File" > "Output audio/video" and then select 
Camcorder in the device menu. For DV cameras you can select the device DV 
camera for HDV camcorder HDV1 or HDV 2 Camcorder. 

With Settings you can open the respective export settings dialog (DV-AVI export for 
DV camcorder, MPEG export for HDV camcorder). For most applications you should 
use the settings defined here. Advanced takes you to the DV export settings (More 
information can be found in the section "DV export settings" on page 243). 
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Now connect your camera and follow the displayed instructions. 

If you want to export a rendered (already edited) movie to DV, there’s no need to 
render it again. Simply activate the “Play own DV file” option and select your DV 
video from the “My audio video” directory.  

Tip: Digital cameras that can digitally record via a PC connection are usually more 
expensive. You may be able to reduce your purchase costs considerably by buying a 
digital camera that cannot transfer digitally and have the function activated by a 
camera specialist. You should enquire about this option before making your 
purchase. 

 
DV export settings 

 

PAL/NTSC: The PAL format is used in Europe, and the US and Japan use NTSC. This 
option usually does not require changing. 

Render changed parts...: Non-edited original files are simply copied into a completed 
DV AVI. Normally, you have to decompress the DV data, add the set effects 
calculations, and recompress it. If no effects processing is pending, then these steps 
may not be necessary. This option can be permanently activated. 

Use references to original material...: Unedited original files are exported directly to 
the device. Effects are rendered in real time. Use this option for finished movies 
without edits and effects, since real-time effects processing of DV data causes high 
processor loads that often result in output errors. 
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Transfer DV back to device after export...: Deactivate this option if you are only 
rendering your movie but do not want to export it. You can export your movie later by 
clicking "Export own DV file" from the "Export" dialog. 
 

My device is not in the list, what should I do? 
User-defined: 
If your device does not appear in the list after the online update, you can set up the 
export settings manually. No need to worry though; you only have to do it once, since 
these settings can be saved as a preset.  

Read the instruction manual of your mobile device to find out which file format is 
required for this. If your device supports multiple formats, then you can experiment 
with the formats to get the best results. 

Specify the file format by opening the target device's menu and selecting "User-
defined -> Video -> ...Format". If you then click on "Export", you arrive at the Export 
dialog (view page 235) of the selected file format where you can set all the advanced 
settings. 

For details on these settings, please consult your device manual. Explanations for the 
file format's settings can be found in the Overview of the device classes chapter, for 
the special settings of the export dialogs see "Export movie" in the "File menu" 
chapter. 

Tip: If the format settings for your device are not accessible, then you can try out a 
different device from the same manufacturer and, using it as a template, make 
adjustments accordingly. 

If you find settings you like, we recommend saving these as a preset 
for further use. 

 
 

Transfer with Bluetooth 

Warning! The procedure described here refers to Windows XP with Service Pack 2!  
Dialogs may be different depending on the Bluetooth driver and operating system 
version, or their order may vary (e.g. for password allocation) when transferring to 
your mobile phone. However, the process is usually similar if other drivers are used. 
Read more on this in the help file or the corresponding chapters of your operating 
system's manual and Bluetooth adapter. 

• If you own a Bluetooth device, you can export the movie straight to your device. 
To do so, your device and your PC must both have Bluetooth interfaces. If your 
system has a Bluetooth device, you can activate the "Transfer via Bluetooth" 
option. 
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• After converting the movie into the desired format, the Bluetooth file transfer 
assistant opens. 

• The first time you try to transfer files to your device via Bluetooth, you have to 
specify your device as the receiver in the dialog by clicking on "Search...", 
selecting your device and then pressing "OK". The name of your device in the 
Bluetooth network is specified in the Bluetooth settings of the device. Check your 
device manual for this. Select your device and confirm your choice by pressing 
"OK". 

• Now enter a password of your choice, which you will later have to confirm on 
your device and click on the "Continue" button in the assistant. Since connections 
between multiple Bluetooth devices can be set up simultaneously in a room, the 
password serves to identify certain connections as well as to safeguard your data. 

The order may be the other way around, depending on the Bluetooth device driver, 
i.e. the mobile phone will request a password which must be confirmed on your PC. 
It's important that you use the same password in each case. 

• You may be asked once again to enter the file name and path of the movie. In this 
case, we recommend using a folder that you will be able to find again quickly to 
export the file (e.g. "...My Files/My Videos"). 

• Click the "Scan..." button, open the set up folder, and select your video file by 
double clicking it. Now, in the wizard, click the "Continue" button. 

• Next, you may have to activate the reception of files on the device and re-enter 
the password. Afterwards, the transfer of the videos will begin automatically. 

• Once the transfer has been completed successfully, "1 new message" will display 
on your device. Read more on how to save and play videos in the corresponding 
device manual. 

Warning! We only recommend activating data reception via Bluetooth on your 
device once this function is actually required, e.g. for transferring files. Once you 
have completed the uploading process, you should deactivate Bluetooth again, since 
permanently activated Bluetooth reception constitutes a security risk! 

 

Burn CD/DVD 
Manually compile files 
Opens MAGIX Speed burnR to burn videos or other files onto CD/DVD. File selection 
is done via drag & drop from MAGIX Speed burnR's Explorer. 

Keyboard shortcut:  Ctrl + B 
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Copy CD/DVD direct 
The dialog provides several options for creating a copy: 

• Copy: Here you can directly copy a non copy-protected CD or DVD.  
• Shrink: Compresses a DVD to the size of a regular single layer DVD+/-R/RW. All 

files of the original DVD have to be on the hard drive. 
• Analog copy: Copies your video onto a disc via analog recording. 

Read more about this in the chapter "Record (view page 64)". 
 

Burn an already created (S)VCD/Video DVD 
All necessary files, menus, and encoded video files needed to burn a CD/DVD will be 
temporarily stored on your hard drive. After your disc is burned, these are not 
automatically deleted. Using "Disc image" multi-copy, you can uses these images to 
burn as many discs as you would like without having to encode the files again. 

In the dialog, choose the image you want. All necessary files are then transferred to 
the MAGIX Speed burnR burning tool. 

For more information on using MAGIX Speed burnR, read the program's help file. 

 

Internet 
Quack access to MAGIX Online World. Find out more about the Services, manage 
your access data, download media from your Online Album, etc. 
 

MAGIX Online Album / Catooh 

Note: For more information about MAGIX Online World please read here „Share“. 

 

Online login details 
In this dialog, you can save your login information (login and password) for MAGIX 
Online Album and all other MAGIX Online World as well as for Catooh, making it 
unnecessary to login each time you access MAGIX Online World. 

The saved data are valid for all other MAGIX programs for the corresponding 
computer user. 
 

Backup copy 
Files must be saved to be able to be easily retrieved in case of a hard drive crash or 
some other error. 

For detailed information, read the Backup (view page 210) section in the "Video 
project management" chapter. 
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Load backup project 
This option loads an automatically created slideshow backup. This type of automatic 
backup gets the file extension MV_ (underscore). This command is only intended for 
use in emergencies, for example, if you unintentionally saved your change and wish to 
return to the previous version of the movie. 

Keyboard shortcut:  Ctrl + Shift  + O 
 

Clean-up wizard 
The clean-up wizard helps delete projects from the hard drive, including all of the 
media files used. Use this function to free up disk space for future projects. 

Caution: If the files you used in the movie have also been used in other movies (like 
trailers, opening music, etc.), then you should make backup copies of these files 
beforehand. 

Keyboard shortcut:  Ctrl + Shift + Y 

For detailed information, read the clean-up wizard (view page 212) section in the 
"Video project management" chapter. 
 

Settings 
Movie settings 
Opens the movie settings of the currently selected movie. 
 

Program settings 

 
Opens the program settings (view page 56). 

Keyboard shortcut: Y 
 

Keyboard shortcuts... 
This menu entry opens a dialog for editing keyboard shortcuts (view page 286); this 
enables you to adjust MAGIX Movie Edit Pro 2013 however you like. 

Keyboard shortcut:  Ctrl + Shift + U 
 

Preview rendering 
This menu opens the dialog for the preview rendering (view page 63) settings 

Keyboard shortcut:  Alt + R 
 

Language 
Here you can change the language used in MAGIX Movie Edit Pro 2013. Normally the 
language that is used for installation is set as the program language. 
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Reset Program Settings to Default... 
Use this function to reset all program settings you made in MAGIX Movie Edit Pro 
2013 to their original settings. 
 

Exit 
Closes MAGIX Movie Edit Pro 2013. 

Keyboard shortcut: Alt + F4 
 

Edit Menu 
Undo 

With this command you can undo the last changes you made. This way, it's no 
problem if you want to try out critical operations. If you don't like the result, 
then you can always revert to the previous state by using "Undo". 

Clicking on the arrow next to the button opens a list of changes made until now, 
allowing you to undo several changes made in sequence. 

Note: You can adjust the length of the list to your needs in program settings (view 
page 56). In general: The longer the list, the more RAM is used. 

Keyboard shortcut:  Ctrl + Z 
 

Redo 

 

This function undoes the previous "Undo" function. 

Clicking on the arrow next to the button opens a list of changes made until now, 
allowing you to undo several changes made in sequence. 

Note: You can adjust the length of the list to your needs in program settings (view 
page 56). In general: The longer the list, the more RAM is used. 

Keyboard shortcut:   Shift + Y 
 

Empty undo and cache memory 
This option deletes the memory for undo commands and clipboard (cache). 
 

Cut objects 

 

This function extracts the marked scene and copies it to the clipboard. You 
can then use the "Paste" command to copy it into any movie. 
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Copy objects 

 

This function copies the selected scene (or the selected object in the Timeline 
mode) to the clipboard. You can then use the "Paste" command to place it into 
any movie. 

 

Paste objects 

 
This command inserts the clipboard material (photo or object) at the current 
position of the start marker.  

Keyboard shortcut: Ctrl + V 
 

Duplicate objects 
This command duplicates all selected objects. The copies appear beside the original 
and can be placed in the correct position using drag & drop. 

Keyboard shortcut:  D 
 

Delete items 

 

This function deletes the selected scene (or the selected object in the Timeline 
mode). 

Keyboard shortcut:  Del 
 

Select all objects 
All objects in the arrangement will be selected. 

Keyboard shortcut: Ctrl + A 
 

Save objects as takes 
The selected objects are saved in the takes directory. To use takes, please read the 
chapter "Saving objects separately" in the PDF manual. 

Keyboard shortcut:   Strg + F 
 

Cut 
Editing functions are also accessible using the toolbar. The last selected function will 
appear in the toolbar as a button. 
 

Split scene 

 This command cuts a scene at the point where the playback marker is 
positioned. This way, two free-standing objects are created. 

Keyboard shortcut:   T 
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Remove scene start 

 
This command cuts a scene at the point where the start marker is positioned, 
and deletes all material that precedes the start position simultaneously. 

Keyboard shortcut:  Z 
 

Remove scene end 

  

This command cuts a scene at the point where the start marker is positioned, 
and deletes all material behind the start position simultaneously. 

Keyboard shortcut:  U 
 

Remove scene 

 
If you want to cut a scene out of a movie retroactively, this option 
automatically moves all objects, titles, and transitions on all tracks forwards 
so that no gaps result. 

Objects on other tracks which project into the area of the selected scene will not be 
moved automatically; they will remain at the current position. 

Keyboard shortcut:  Ctrl + Del 
 

Split movie 

 
This command divides the movie into two individual movies at the position of 
the playback marker. 

The current arranger retains the portion that is located in front of the playback 
marker. The latter part will be removed from the current arranger and placed as a new 
film. You can find this movie by going to the "Window" menu. 

Shortcut: Alt + Y 
 

Musical editing 
If your background music is edited using the beat recognition assistant (view page 
202), you can automatically adapt your cuts to the tempo with this option. All hard 
cuts (no crossfaded objects) are shifted across the musical quarter note positions. 

Keyboard shortcut: Ctrl + Shift + M 
 

Range 
MAGIX Movie Edit Pro 2013 provides object-based functions as well as "band-
oriented" editing functions. These always refer to the whole arrangement from the 
first to the last track as well as to the area between the start and end marker. 
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Cut range 
The section between the in and out points is cut from the current arrangement and 
placed on the clipboard. This section can be reinserted elsewhere. 

Shortcut:  Ctrl + Alt + X 
 

Copy range 
The section between the in and out points is copied from the current arrangement to 
the clipboard. This section can be reinserted elsewhere.  

Shortcut:   Ctrl + Alt + X 
 

Delete 
The section between the in and out points is deleted from the current arrangement 
and not copied to the clipboard. 

Keyboard shortcut:   Alt + Del 
 

Insert range 
The contents of the clipboard are inserted at the current arrangement's position of the 
in point.  

Shortcut:  Ctrl + Alt + V 
 

Extract 
The section between the in and out points is preserved, and all of the material in front 
and behind it are deleted. Use this option to isolate a specific part of an arrangement 
for further individual editing. 

Shortcut:   Ctrl + Alt + P 
 

Insert blank space 
An empty section the length of the period between the in and out point will be added 
to the first track. The objects following this will be moved. 

Keyboard shortcut:  C 
 

Form group 

 
Orders all selected objects into groups. As soon as an object from the group is 
selected, all other objects in the group will be highlighted as well so that you 
can work on them collectively. 

Keyboard shortcut:  G 
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Ungroup objects 
This turns all selected objects into free-standing objects again. 

Keyboard shortcut:  Shift + G 
 

Wizards 
Slideshow Maker 
Opens the Slideshow Maker (view page 199) 

Keyboard shortcut:  Ctrl + M 
 

Soundtrack Maker 
This command opens MAGIX Soundtrack Maker (view page 176). 

Keyboard shortcut:   Ctrl + Shift + S 
 

Travel route animation 
This menu entry opens the separate Travel route animation program. This enables 
simple creation of animated travel routes with the help of online maps. 

Note: In order to be able to use current map data, maps are fetched by Travel route 
animation directly from the Internet. This requires an active Internet connection. 

 

Mixdown Audio 
This option joins all audio objects in one audio file. The sound material will only 
occupy one track of the arranger and will hardly affect the RAM, but it will occupy 
approximately 10 MB (in stereo) on the hard drive. This will give you more control 
over the arranger and more space for additional objects. 
MAGIX Movie Edit Pro 2013 automatically normalizes the audio file, i.e. the loudest 
part of the wave audio object is identical with the highest figure of the 16-bit 
resolution ceiling. This guarantees the same sound quality, even if you repeat the mix 
down procedure or you combine the mix down file with other wave audio objects 
again and again. 
The mix function is very helpful if you want to go on using the mixdown object. For 
the final AVI or WAV (or any other multi-media) file, which is designed for burning a 
CD or for use on other PCs, use the "Export arrangement" submenu options from the 
file menu instead of the mixdown function. 

Tip: Instead of using the mixdown function, you can use the various options of the 
submenu "Export movie" in the File menu to create a final  final *.avi or *.wav (or any 
other multimedia) file. 

Keyboard shortcut: Shift + D 
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Audio and video mixdown 
In addition to the "Combine audio" function (see above), all video objects including 
effects, fades, and edits are combined in a single MAGIX video file (view page 237). If 
your computer starts to approach its limits, this enables you to free resources for 
further editing. 

Keyboard shortcut:  Shift + M 
 

Start preview rendering... 
Starts Preview rendering. 

Shortcut:  Ctrl + R 
 

Remove range(s) for preview rendering... 
Removes preview rendering ranges. If multiple sections were defined and the 
playback marker is placed over one of these sections, you will be asked whether you 
would like to remove only this "Secton" or "All. 
 

Edit snap point 
Objects, object edges, markers or the playback marker will spring automatically to 
particular "Key positions", when you move them close enough with the mouse. This is 
called "snapping". This helps to position objects exactly, even if the project is zoomed 
out. Per object, one snap point may now be placed within an object to mark positions 
where other objects should snap to. This can be helpful, for example, in case a title 
should be shown at a specific position of a video object. 

• To set a snap point, select an object and place the playback marker at the 
position where you would like the snap point to be. 

• With the "Set snap point" option, which you can find in the menu "Edit" >"Edit 
snap points", a snap point will be set. "Delete snap point" deletes a snap point. If 
in the object the "Set snap point" option is selected at another position, the snap 
point will be moved. 

• "Delete all snap points" deletes all snap points for all objects in a film. 

Shortcut for "Set snap point":  Ctrl + P 
 

Marker 
Set project marker 
This option places a project marker at the current playback position. More 
information about project markers is available in the chapter "Markers" under "Set 
project marker (view page 98)". 

Keyboard shortcut:  Ctrl + Enter 
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Delete project marker 
Deletes the selected project marker (view page 98). Project markers can be deleted 
and renamed via the context menu. 
 

Set chapter markers 

 
Places a chapter marker at the position of the playback marker. This creates a 
chapter entry in the disc menu in case the movie is being burned to disc. 

You can rename the chapter markers by right clicking and selecting "Rename". The 
new name will appear in the chapter menu (view page 214). 

Keyboard shortcut:  Shift + Enter 
 

Set chapter markers automatically 
This option automatically sets chapter markers in the arrangement according to 
specific rules that will then appear in the film menu of a disc as chapters. This is useful 
if a disc should be burned immediately after recording. 

 

There is a selection of options available for automatic chapter generation: 

At beginning of movie: The movie only contains one chapter in this case. 

At beginning of object in track: Every object in a track creates a chapter; track 1 is 
preset. 
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At position of existing title objects: Subtitles, for instance, as faded-in subheadings, 
give the position of the chapter markers. 

Specified interval (minutes)/Specified amount: If the chapters are separated without 
any particular method and are just needed for quicker navigation, chapter markers 
may also be inserted in pre-defined intervals or as a pre-defined number of chapter 
markers. 

Naming of chapter markers: To title the chapter markers, a user-defined name 
featuring consecutive numbers or the object name or text from the text objects may 
be used. 

Optionally, existing chapter markers may be deleted and the automatic chapter 
marker function may be limited to the area between the start and end markers. 

Keyboard shortcut:  Alt + Shift + Enter 
 

Delete chapter markers/delete all chapter markers 
Delete one or all chapter markers. This removes chapter entries in the disc menu if 
the film is burned to disc. 

Keyboard shortcut:  Ctrl + Alt + Enter 
 

Marker -> Set range start/end 
Sets a range start/end marker at the position of the playback marker. 

Keyboard shortcut:  I/O 
 

Marker -> Jump to range start/end 
Sets the playback marker at the position of the range start/end. 

Keyboard shortcut:   Shift + I/O 
 

Marker -> Reset selected range 
Deletes the range start and the range end. 
 

Move screen view 
Using these commands, a viewable portion together with the start marker will be 
moved in the timeline. You can quickly skip between different markers (skip, chapter, 
scene, ad-marker) and object edges. 

Keyboard shortcut: See "Keyboard shortcuts", "Arranger". (view page 281)  
 

Multicam 
This command switches to Multicam mode (view page 103). 
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Mute audio tracks (Multicam) 
To avoid the interference of several multicam audio tracks being played at the same 
time, you can mute all of the audio tracks. 

Keyboard shortcut:  Alt + Shift + M 
 

Effects Menu 
Master effects 
This menu item accesses the movie's effect settings (view page 144). The settings 
affected here apply to the entire movie. 

Keyboard shortcut:  Ctrl + Shift + H 
 

Video object effects 
Scene recognition 
Calls up the automatic scene recognition, which "cuts up" longer videos into scenes 
for storage in the "Takes" directory.  

Keyboard shortcut:  Shift + Z 
 

Image stabilization 
Opens the image stabilization dialog to correct "wobbly" recordings. Read more about 
this in the chapter "Image stabilization (view page 142)". 

Keyboard shortcut:  Ctrl + L 
 

In MAGIX Photo Designer bearbeiten 
Graphic files (BMPs or JPEGs) from the arranger can be post-edited in an external 
graphics program. The selected image file is loaded automatically and, once editing 
has been completed, is used in the MAGIX Movie Edit Pro 2013 instead of the original 
material. For this, MAGIX Movie Edit Pro 2013 offers the high-performance photo 
editing program MAGIX Photo Designer. 
 

Save photos with effects 
This allows you to save photos used in the movie and add the object effects used in 
MAGIX Movie Edit Pro 2013 (e.g. StoryMaker) to the photo. 
 

Create panorama... 
Opens the dialog for setting a panorama. Place as many photos in the correct order as 
you like, and align brightness and color settings to get the best results. You should 
make sure that the photos harmonize at the transitions. 
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Video effects 
Here you can find adjustable effects for video and photo objects. The effects can be 
set only after selecting an object in the respective effects dialog. For more 
information, go to the "Video effects in the Media Pool" (view page 112) section in the 
"Effects" chapter. 
 

Video effect templates 
This features general templates that can be added to the video objects via drag & 
drop and several video mix effects that can be quickly and easily applied, e.g. 
bluescreen. 
 

Movement effects 
These are movement effects you can use to animate the frame by using zoom or 
camera movements. For more information go to the "Effects" chapter, section 
"Movement effects in Media Pool" (view page 119). 
 

Movement effect templates 
These are templates for movement effects. These can be added from the Media Pool 
into the arrangement by double-clicking or via drag & drop. 
 

Section 
Places video objects in a particular part of the screen. Please read the "Video effects" 
chapter for more details. 
 

Stereo3D 
This accesses the program's Stereo 3D functionality. Please read the corresponding 
chapter "Stereo 3D". (view page 177) 
 

Background design 
Select a color, a picture, or any video on your hard disk which you would like to serve 
as the background for the photo displayed. This function is especially useful when 
photos have black bars around them, or if they are reduced in size. 
 

Reset background 
Resets the background design (view page 257) settings to default settings. 
 

Set as background 
Uses the selected photo or video as the background. 
 

Load video effects 
This command enables a saved effects combination to be loaded for the currently 
loaded object. If multiple objects are selected, then the effects combination will be 
applied to each selected object. 
Shortcut:   Alt + Shift + O 
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Save video effects 
This command saves the current effects combination for each object separately. 

Shortcut:   Alt + Shift + S 
 

Reset video effects 
This option allows you to deactivate all currently used effects. The material will be 
reset to the state it was in before you applied the effect.  

Shortcut:   Alt + Shift + H 
 

Copy video effects 
Effects settings for an object may be copied to the clipboard to add (view page 258) 
them to other objects. 

Keyboard shortcut:  - 
 

Insert video effects 
Video effects may be inserted into the selected object from other objects. The 
settings must be copied (view page 258) beforehand into the clipboard. 

Keyboard shortcut:  Shift + - 
 

Apply video effects to all 
The current effects settings will be applied to all scenes and photos in your movie. 
 

Apply video effects to all of the following 
The current effects settings will be applied to all scenes and photos in your movie 
which lie behind the selected object. 
 

Audio object effects 
Normalize 
The function "Normalize" raises the level of an audio object to the maximum possible 
level without clipping the material. This searches for the largest signal peak in the 
audio material and raises the level of the object so that this position matches exactly 
0 dB (maximum overdrive). 

Shortcut:  Alt + N 
 

Automatic track damping 
Please see Reduce volume (view page 165) in the audio effects chapter. 

Keyboard shortcut:  Alt + L 
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Set volume 
This function, located in both the effects menu and the context menu, controls the 
sound volume for individual objects, just like the object handles in the arranger. 
 

Audio cleaning 
Opens the "Audio Cleaning (More information can be found in the section "Sound 
optimization" on page 152)" dialog. 

Keyboard shortcut:  Alt + A 
 

Echo/Hall 
Please see "Reverb/Echo" in the chapter "Audio effects". 

Keyboard shortcut: Shift + H 
 

Timestretch/resample 
Read more about this in Timestretch/resample. 

Keyboard shortcut:  Ctrl + Q 
 

Audio effects 
These options open the individual effects from the audio effects folder in the Media 
Pool. 
 

Audio effect presets 
This option opens the audio effect presets in the Media Pool. 
 

Load audio effects 
This command enables a saved effects combination to be loaded for the currently 
loaded object. If multiple objects are selected, then the effects combination will be 
applied to each selected object. 

Keyboard shortcut:  Ctrl + + 
 

Save audio effects 
This command saves the current effects combination for each object separately. 

Keyboard shortcut:  Shift + + 
 

Reset audio effects 
This option allows you to deactivate all currently used effects entirely if you want to 
undo the changes. 

Keyboard shortcut:  Ctrl + Alt + + 
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BPM Wizard 
Read the section concerning the Tempo and beat recognition (view page 202) in the 
chapter "Audio" for more about this. 

Keyboard shortcut:  Alt + Shift + K 
 

Edit wave files externally 
This opens the audio track or audio object in the included audio editor MAGIX Music 
Editor. 
 

Volume curve 
The most important effect, the volume, is available here directly. The volume is also 
available via the Media Pool under "Effects -> Audio effects -> General (view page 
125)", where it may also be animated. 

Keyboard shortcut:  Ctrl + Shift + V 
 

Title Effects 
Title Editor 

 Opens the Title editor for the selected photo, video, or title object. 

Keyboard shortcut:  Ctrl + T 
 

Load title template 
Use this command to load previously saved title effects for the current object.  

Shortcut:   Alt + Shift + T 
 

Save title template 
You can save the current effect combination for each title object separately and apply 
it to other title objects later. 

Shortcut: Alt + T 
 

Design elements 
Multi picture-in-picture: Various effects presets for image stacking. 

Collages: These work similarly to normal picture-in-picture effects, but more objects 
are used. Depending on the collage, arrange the selected objects one after the other 
and drag the collage onto the first object. 

Color spaces: The color spaces are a collection of various backgrounds. Professional 
test images are included for calibrating your system. You can also use the colored 
backgrounds for your own color transitions, for instance. The special "User" template 
opens a color selection dialog where you can choose the desired color. 
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Backgrounds: Here you can find static and animated photo and video backgrounds. 
Video backgrounds are capable of being looped, meaning that their length can be 
extended by duplication. 

Image objects: Here you will find various image objects like black bars, thought 
bubbles for cartoons, etc. 

Intros/Outros: These are beginning and end scenes for films with various themes. 

You can find additional information in the "Effects (view page 126)" chapter, in the 
section "Design element in Media Pool". 
 

Effects library 
Using these menu choices, you can control the corresponding directories in the Media 
Pool (view page 22, view page 44). 
 

Windows Menu 
Window arrangement 
Standard 
This option switches from the multiple monitor setting (see below) back to the 
standard single monitor setting. 
 

Multi-monitor with maximized preview monitor 
This option can be used when several computer monitors are connected. It enlarges 
the preview monitor for a fullscreen display on one of the connected monitors. The 
other elements are displayed on a second monitor. 
 

Reset window arrangement 
If you have moved the windows around in MAGIX Movie Edit Pro 2013, you can put 
them back to the original position using this command. 

Keyboard shortcut:  F9 
 

Cut Trimmer 
Shows or hides the "Cut trimmer" window. This allows you to make fine adjustments 
to the position of the selected video or image objects and their handles – as well as 
the transition characteristics (transition type, length). Please read the "Fine 
adjustment of video ("Trimming")" chapter for more details.  

Keyboard shortcut: N 
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Object trimmer 
Shows or hides the trim window. This enables the position of the selected video or 
image object and its handles to be adjusted more finely. Read the chapter "Adjusting 
videos precisely" ("Trimming"). 

Keyboard shortcut:  Shift + N 
 

Mixer 
With this option you can open and close the real-time mixer. Further information can 
be found in the Mixer (view page 167) chapter. 

Shortcut:  M 
 

Master audio effect rack 
Opens or closes the master effects rack; you can also use the "Master FX" button in 
the mixer window for this. 

Shortcut:  B 
 

Mastering Suite 
This opens the Mastering Suite (view page 160). 
 

Program monitor 
Opens and closes the video window. If the standard layout is chosen the Mediapool 
can be shown in a freely scalable and moveable window. 

Keyboard shortcut:  Shift + V 
 

Media Pool 
With this option you can hide the Media Pool or make it visible again. 

Shortcut:  F 
 

Project 
Shows/Hides the arranger 
 

Activate next window 
This option activates the next window respectively and allows better control with 
keyboard shortcuts in MAGIX Movie Edit Pro 2013. 
 

Show movie overview 
With this option, you can display an overview of the entire arrangement on the video 
screen. It is particularly suitable for long and complex arrangements to prevent you 
from losing track. You can view the whole movie and you are, despite this, able to 
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access the object you're looking for in a split second – you can zoom in directly on the 
video monitor or move around the clip displayed in the arranger. 

Keyboard shortcut:   Shift + A 
 

Optimize movie view 

  The zoom level is set to 100% so that you can see every object and the entire 
film.   

The start and end markers are set to the beginning or end, so that the entire movie 
can be played. 

Keyboard shortcut:  Ctrl + F 
 

Zoom horizontal 
Here you will find a range of functions for altering the visible time axis section. 
 

Zoom vertical 
The number of simultaneously visible tracks can be changed here. The more tracks 
are visible, the smaller they will appear. 
 

Remove all movies from project 
Closes all opened movies. 
 

Share Menu 
Here you will find many options for for quickly and easily publishing your data from 
the program on the web. Additionally, data transfer into other programs for 
specialized editing, if you have such programs installed, is enabled. 
 

Youtube / Vimeo / Facebook 
This is the direct link to YouTube, Vimeo or Facebook. 
 

Youtube / Facebook 
Uploads the current film to the selected portal or to the selected community. Enter 
the data for video into the fields provided, so that the search function for this portal 
can also find this video. 

MAGIX Movie Edit Pro 2013 partially uses the H.264 format for this, which is a 
component of the MPEG-4 codec. Since Flash supports this format directly and most 
communities and portals use the format, the film does not need to be re-rendered on 
the corresponding server. This avoids loss of quality. 

When HD material is uploaded, a resolution of 720p is used for the HD format. 
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Upload all selected media in Media Pool 
Uploads the media selected in the Media Pool to the corresponding portal or the 
selective community. 
 

Note: To import and export AVC(HD) and MPEG-4 files, the MEPG-4 codec must 
first be activated (view page 289). A dialog will open if the codec is required. 

 

MAGIX Online Album 
Here you have the option of uploading media from a movie or the complete movie to 
your MAGIX Online Album. 
 

Back up to CD or DVD 
This option opens MAGIX Speed burnR for burning files directly to CD or DVD. 
 

Additional options 
The additional options in the "Share" menu vary depending on the installed software. 
For example, you can edit photos or graphics in Xara Web Designer, Xara Photo & 
Graphic Designer or Xara Designer Pro, and the audio can be improved in MAGIX 
Audio Cleaning Lab. 
 

Help Menu 
Help 
This command is available for almost every feature of the program, and it opens the 
"Help" file for the corresponding topic. Use this command to get help on any of 
MAGIX Movie Edit Pro 2013's functions. 

Keyboard shortcut: F1 
 

Context help 
The mouse cursor will turn into an arrow with a question mark.  

Click on any button of the main screen, to open program help which will describe the 
control element in question. 

Shortcut:  Alt + F1 
 

PDF manual 
Opens the manual in PDF format. Similar to the Help feature that can be accessed by 
pressing F1, this manual contains all of the important information about the program. 
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Display tooltips 
Tooltips are small information windows that open up automatically if the mouse 
pointer stops briefly on a button or some other area. They provide information about 
the function of the button. These information boxes can be switched on or off with 
this option. 
 

magix.info 
Ask magix.info a question. 

You can also present your own videos on magix.info.  
 

Online video tutorials 
There is a series of video tutorials about MAGIX Movie Edit Pro 2013 on the MAGIX 
Website that provide clear, descriptive explanations for many of the features. 

Note: An Internet connection is required. 

 

Online tutorials 
Interesting tutorials and useful tips for working with MAGIX Movie Edit Pro 2013 can 
be found on the MAGIX website.  
An online connection is required. 
 

Register online 
This option opens the MAGIX homepage for online registration where you can 
register yourself as a MAGIX user.  

Registration grants you access to the MAGIX support website 
http://support.magix.net (see support) where various program updates and help 
programs can be downloaded.  

With the registration form supplied (start menu under "MAGIX Movie Edit Pro 2013 -
> Service and support -> Register") you can register via post or fax. Simply print it out, 
fill it in, and send it off! 

Keyboard shortcut: F12 
 

Online Update 
Connects directly to the online update page where you can get the latest version of 
your program. 
 

Download video effects plug-ins 
This command lets you download new video effects plug-ins (view page 132). 
 

http://support.magix.net/�
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About MAGIX Movie Edit Pro 2013 
Displays copyright info and version number of MAGIX Movie Edit Pro 2013. 
 

Context menu (right click) 
Context menu can be reached by right clicking on a selected object. It offers functions 
which are available and can be expected in the given context. 
 

Video objects 
Audio and waveform display 
Here you'll find various options for editing the audio track. These correspond to the 
menu options "Effects" > "Audio object effects" with the following exceptions: 
 

Remove/restore audio object 
This option allows you to remove or restore and audio object to simplify the display. 
The audio itself is not affected or deleted. 
 

Align other audio objects with this track 
With this option the objects on the current track are used as reference points for 
aligning other objects. 
 

Scene recognition 
Calls up the automatic scene recognition, which "cuts up" longer videos into scenes 
for storage in the "Takes" directory.  

Keyboard shortcut:  Shift + Z 
 

Image stabilization 
Opens the image stabilization dialog to correct "wobbly" recordings. Read more about 
this in the chapter "Image stabilization (view page 142)". 

Keyboard shortcut:  Ctrl + L 
 

Cut Trimmer 
Shows or hides the "Cut trimmer" window. This allows you to make fine adjustments 
to the position of the selected video or image objects and their handles – as well as 
the transition characteristics (transition type, length). Please read the "Fine 
adjustment of video ("Trimming")" chapter for more details.  

Keyboard shortcut: N 
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Object trimmer 
Shows or hides the trim window. This enables the position of the selected video or 
image object and its handles to be adjusted more finely. Read the chapter "Adjusting 
videos precisely" ("Trimming"). 

Keyboard shortcut:  Shift + N 
 

Edit snap point 
Objects, object edges, markers or the playback marker will spring automatically to 
particular "Key positions", when you move them close enough with the mouse. This is 
called "snapping". This helps to position objects exactly, even if the project is zoomed 
out. Per object, one snap point may now be placed within an object to mark positions 
where other objects should snap to. This can be helpful, for example, in case a title 
should be shown at a specific position of a video object. 

• To set a snap point, select an object and place the playback marker at the 
position where you would like the snap point to be. 

• With the "Set snap point" option, which you can find in the menu "Edit" >"Edit 
snap points", a snap point will be set. "Delete snap point" deletes a snap point. If 
in the object the "Set snap point" option is selected at another position, the snap 
point will be moved. 

• "Delete all snap points" deletes all snap points for all objects in a film. 

Shortcut for "Set snap point":  Ctrl + P 
 

Create still frame 
MAGIX Movie Edit Pro 2013 can create a still frame of an object at the position of the 
start marker. 
 

Motion 
Lets you move video objects on the screen. See "Movement" in the "Video effects" 
chapter. 
 

Section 
Places video objects in a particular part of the screen. Please read the "Video effects" 
chapter for more details. 
 

Attach to picture position in the video 
This can be used to attach the current video, image, or (3D) text object to a 
movement path in another video object. Read more about this in the chapter 
"Magnetic objects (view page 141)". 
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Interpolation for interlace material 
Choose this option to remove interlace artifacts from your video image. If, for 
instance, you extract freeze frames from a video, ridge structures appear in sequences 
which feature movement. 
 

Anti-flicker filter 
Choose this option for still pictures with detailed structures and high contrast. This 
filter reduces line flickering during TV playback. 
 

Border cropping adjustment: 
Select this option if the edges are cropped during playback on your television. Values 
stored in "Movie effects settings (view page 145)" ("Effects" menu) will be applied. 
 

Background design 
These options allow you to design the background of an image using a simple editor. 
You can use a color or an image or video file. 
 

Video effects 
The entries for this submenu are directly available in the Media Pool. 

 
 

Copy/insert/cut/delete object 
These options correspond to the menu options under "Edit". 
 

Save objects as takes 
The selected objects are saved in the takes directory. To use takes, please read the 
chapter "Saving objects separately" in the PDF manual. 

Keyboard shortcut:   Strg + F 
 

Fade in date as title 
MAGIX Movie Edit Pro 2013 can add a time or date (“time code”) to the picture 
material. To add a time code, right-click the video object and choose the “Fade in date 
as title” option from the context menu. 
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If you’re using a DV-AVI file (a digital recording from a camcorder, for instance), the 
recording date will be used from the chosen place. If you’re using a different file, the 
creation date will be used as the time code. The title editor is then opened in order to 
customize the entry. 

In the preview monitor context menu you will also find the "Display play time" option. 
This will create a time code. 
 

Object properties 
This function displays all the information about the currently selected objects such as 
file name, position on the hard-drive, tempo, etc. The Object Editor also defines the 
foreground and background color of every object in the arrangement. Depending on 
the type of object, the elements displayed will vary. 

General information 

The name of the selected object, the fore/background color and aspect ratio for the 
object in unselected status can be changed here. Additional information is also 
displayed about which file the selected object points to. 

Calculation of intermediate images 

Interlace/Deinterlace (only for video objects) 

The tab "Interlace/Deinterlace" lets you specify the interlace editing of the video 
material. 

Interlace properties:  Normally, MAGIX Movie Edit Pro 2013 automatically makes 
suitable settings for this. Adjustments still need to be made to faulty video footage. If 
playback of the exported movie is very jittery, if flickering occurs, or if some effects do 
not look how they should, you can reverse the source material frames. 

Deinterlace options: Normally, the setting "Automatic interlace processing" does not 
have to be changed. The frames are processed separately and passed to the encoder 
when exported. If necessary, MAGIX Movie Edit Pro 2013 will perform high-quality 
interlacing. If "No interlace processing" is set, then it is assumed that the source 
material contains full frames. 

For more information on interlacing, please see "Interlace" (view page 317). 

Interpolate intermediate frames: Activate this function in order to smoothen motion 
during playback in order to get a more fluid image. 

Tempo/Pitch (audio objects only) 

If there is information about the tempo, then the tempo can be doubled or halved 
here. You set the tempo with the  BPM wizard. 
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Metadata (only when metadata is found in the object): 

If you open object properties of images or AVCHD video with metadata, they will 
appear here. In this way you can find additional information about the object. 
 

Image objects 
Change photo length 
This dialog gives exact values regarding the display duration for the selected photo. 
You may select multiple photos beforehand to change their display duration at once. 
 

Edit in Xtreme Photo Designer 
This loads the image in MAGIX Xtreme Photo Designer for detailed editing. 
 

Save photos with effects 
This option enables you to save photos with effects from MAGIX Movie Edit Pro 2013 
as a new image file. 
 

Create panorama... 
Opens the dialog for setting a panorama. Place as many photos in the correct order as 
you like, and align brightness and color settings to get the best results. You should 
make sure that the photos harmonize at the transitions. 
 

Motion 
Lets you move video objects on the screen. See "Movement" in the "Video effects" 
chapter. 
 

Section 
Places video objects in a particular part of the screen. Please read the "Video effects" 
chapter for more details. 
 

Attach to picture position in the video 
This can be used to attach the current video, image, or (3D) text object to a 
movement path in another video object. Read more about this in the chapter 
"Magnetic objects (view page 141)". 
 

Cut automatically to fit screen 
This function ensures that images don't have black edges (in case they don't fit into 
the given format). 
 

Export to MAGIX Online Album 
Log in to the MAGIX Online Album service and load images and music into the album 
to share them with your friends and acquaintances in the Internet. The assistant will 
lead you step-by-step through the uploading process. After the process is finished, 
you can access your updated MAGIX Online Album. 
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Export to MAGIX Online Print Service 
Use MAGIX Online Print Service to order high-quality photo prints or fantastic printed 
photo gifts of your valuable digital photos simply with one click. 
 

Transitions 
Cut Trimmer 
Shows or hides the "Cut trimmer" window. This allows you to make fine adjustments 
to the position of the selected video or image objects and their handles – as well as 
the transition characteristics (transition type, length). Please read the "Fine 
adjustment of video ("Trimming")" chapter for more details.  

Keyboard shortcut: N 
 

Settings... 
A dialog with the settings for the corresponding transition will be displayed. 
Depending on the transition, different settings are available. 
 

Audio objects 
The options in the context menu for audio objects correspond to the menu options 
"Effects" > "Audio effects" and the "Edit" menu with the following exceptions: 
 

Edit snap point 
Objects, object edges, markers or the playback marker will spring automatically to 
particular "Key positions", when you move them close enough with the mouse. This is 
called "snapping". This helps to position objects exactly, even if the project is zoomed 
out. Per object, one snap point may now be placed within an object to mark positions 
where other objects should snap to. This can be helpful, for example, in case a title 
should be shown at a specific position of a video object. 

• To set a snap point, select an object and place the playback marker at the 
position where you would like the snap point to be. 

• With the "Set snap point" option, which you can find in the menu "Edit" >"Edit 
snap points", a snap point will be set. "Delete snap point" deletes a snap point. If 
in the object the "Set snap point" option is selected at another position, the snap 
point will be moved. 

• "Delete all snap points" deletes all snap points for all objects in a film. 

Shortcut for "Set snap point":  Ctrl + P 
 

Audio effects curves 
This feature provides direct access to diverse object effects, and these can be 
automated using a curve. All of the audio effects listed here are found in the Media 
Pool under "Effects -> Audio effects -> General". 
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Display track curves 
The most recently selected track curve is displayed on the object for editing. Use of a 
curve causes the parameters set in the mixer to be disregarded. 

Note: The track curves of audio objects can be animated in the same way as video 
effects. Read more about this in the chapter "Animating objects (view page 135)". 

 

Reset track curves 
All track curves can be reset with this function. The settings made in the mixer will be 
applied to the track again. 

Caution! Before applying this function, make sure none of the track curves will be 
need in the future.  

 

Export to MAGIX Online Album 
Log in to the MAGIX Online Album service and load images and music into the album 
to share them with your friends and acquaintances in the Internet. The assistant will 
lead you step-by-step through the uploading process. After the process is finished, 
you can access your updated MAGIX Online Album. 
 

Align other audio objects with this track 
With this option the objects on the current track are used as reference points for 
aligning other objects. 
 

Text objects 
Title Editor 

 Opens the Title editor for the selected photo, video, or title object. 

Keyboard shortcut:  Ctrl + T 
 

Disable effects 
All effects applied to the text will be deactivated. 
 

Edit snap point 
Objects, object edges, markers or the playback marker will spring automatically to 
particular "Key positions", when you move them close enough with the mouse. This is 
called "snapping". This helps to position objects exactly, even if the project is zoomed 
out. Per object, one snap point may now be placed within an object to mark positions 
where other objects should snap to. This can be helpful, for example, in case a title 
should be shown at a specific position of a video object. 

• To set a snap point, select an object and place the playback marker at the 
position where you would like the snap point to be. 
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• With the "Set snap point" option, which you can find in the menu "Edit" >"Edit 
snap points", a snap point will be set. "Delete snap point" deletes a snap point. If 
in the object the "Set snap point" option is selected at another position, the snap 
point will be moved. 

• "Delete all snap points" deletes all snap points for all objects in a film. 

Shortcut for "Set snap point":  Ctrl + P 
 

Load title template 
A dialog for loading a title template will open. 
 

Save as title template 
This allows you to create your own templates using your title creations. The function 
"Load title template" enables these templates to be used again quickly. 
 

Save as special effect 
This function saves the title with all objects that have been grouped (view page 251) 
with the title object. This enables you to create title templates that contain all 
required overlay objects. 
 

Convert to 3D title 
The title object will now be turned into a MAGIX 3D Maker object, and a limited 
version of MAGIX 3D Maker will open. 
 

Attach to picture position in the video 
This can be used to attach the current video, image, or (3D) text object to a 
movement path in another video object. Read more about this in the chapter 
"Magnetic objects (view page 141)". 
 

Border cropping adjustment: 
Select this option if the edges are cropped during playback on your television. Values 
stored in "Movie effects settings (view page 145)" ("Effects" menu) will be applied. 
 

Object properties 
This function displays all the information about the currently selected objects such as 
file name, position on the hard-drive, tempo, etc. The Object Editor also defines the 
foreground and background color of every object in the arrangement. Depending on 
the type of object, the elements displayed will vary. 

General information 

The name of the selected object, the fore/background color and aspect ratio for the 
object in unselected status can be changed here. Additional information is also 
displayed about which file the selected object points to. 
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Calculation of intermediate images 

Interlace/Deinterlace (only for video objects) 

The tab "Interlace/Deinterlace" lets you specify the interlace editing of the video 
material. 

Interlace properties:  Normally, MAGIX Movie Edit Pro 2013 automatically makes 
suitable settings for this. Adjustments still need to be made to faulty video footage. If 
playback of the exported movie is very jittery, if flickering occurs, or if some effects do 
not look how they should, you can reverse the source material frames. 

Deinterlace options: Normally, the setting "Automatic interlace processing" does not 
have to be changed. The frames are processed separately and passed to the encoder 
when exported. If necessary, MAGIX Movie Edit Pro 2013 will perform high-quality 
interlacing. If "No interlace processing" is set, then it is assumed that the source 
material contains full frames. 

For more information on interlacing, please see "Interlace" (view page 317). 

Interpolate intermediate frames: Activate this function in order to smoothen motion 
during playback in order to get a more fluid image. 

Tempo/Pitch (audio objects only) 

If there is information about the tempo, then the tempo can be doubled or halved 
here. You set the tempo with the  BPM wizard. 

Metadata (only when metadata is found in the object): 

If you open object properties of images or AVCHD video with metadata, they will 
appear here. In this way you can find additional information about the object. 
 

MAGIX 3D Maker objects 
Edit settings... 
A limited MAGIX 3D Maker version is opened to edit the selected object. 
 

Edit snap point 
Objects, object edges, markers or the playback marker will spring automatically to 
particular "Key positions", when you move them close enough with the mouse. This is 
called "snapping". This helps to position objects exactly, even if the project is zoomed 
out. Per object, one snap point may now be placed within an object to mark positions 
where other objects should snap to. This can be helpful, for example, in case a title 
should be shown at a specific position of a video object. 

• To set a snap point, select an object and place the playback marker at the 
position where you would like the snap point to be. 
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• With the "Set snap point" option, which you can find in the menu "Edit" >"Edit 
snap points", a snap point will be set. "Delete snap point" deletes a snap point. If 
in the object the "Set snap point" option is selected at another position, the snap 
point will be moved. 

• "Delete all snap points" deletes all snap points for all objects in a film. 

Shortcut for "Set snap point":  Ctrl + P 
 

Create still frame 
MAGIX Movie Edit Pro 2013 can create a still frame of an object at the position of the 
start marker. 
 

Motion 
Lets you move video objects on the screen. See "Movement" in the "Video effects" 
chapter. 
 

Section 
Places video objects in a particular part of the screen. Please read the "Video effects" 
chapter for more details. 
 

Attach to picture position in the video 
This can be used to attach the current video, image, or (3D) text object to a 
movement path in another video object. Read more about this in the chapter 
"Magnetic objects (view page 141)". 
 

Video effects 
The entries for this submenu are directly available in the Media Pool. 

 
 

Object properties 
This function displays all the information about the currently selected objects such as 
file name, position on the hard-drive, tempo, etc. The Object Editor also defines the 
foreground and background color of every object in the arrangement. Depending on 
the type of object, the elements displayed will vary. 
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General information 

The name of the selected object, the fore/background color and aspect ratio for the 
object in unselected status can be changed here. Additional information is also 
displayed about which file the selected object points to. 

Calculation of intermediate images 

Interlace/Deinterlace (only for video objects) 

The tab "Interlace/Deinterlace" lets you specify the interlace editing of the video 
material. 

Interlace properties:  Normally, MAGIX Movie Edit Pro 2013 automatically makes 
suitable settings for this. Adjustments still need to be made to faulty video footage. If 
playback of the exported movie is very jittery, if flickering occurs, or if some effects do 
not look how they should, you can reverse the source material frames. 

Deinterlace options: Normally, the setting "Automatic interlace processing" does not 
have to be changed. The frames are processed separately and passed to the encoder 
when exported. If necessary, MAGIX Movie Edit Pro 2013 will perform high-quality 
interlacing. If "No interlace processing" is set, then it is assumed that the source 
material contains full frames. 

For more information on interlacing, please see "Interlace" (view page 317). 

Interpolate intermediate frames: Activate this function in order to smoothen motion 
during playback in order to get a more fluid image. 

Tempo/Pitch (audio objects only) 

If there is information about the tempo, then the tempo can be doubled or halved 
here. You set the tempo with the  BPM wizard. 

Metadata (only when metadata is found in the object): 

If you open object properties of images or AVCHD video with metadata, they will 
appear here. In this way you can find additional information about the object. 
 

Timeline 
Marker -> Reset selected range 
Deletes the range start and the range end. 
 

Edit range 
Choose whether the selected area, bordered by the start and end marker in the 
timeline, should be cut, copied, deleted, inserted or extracted, or do you wish that an 
empty space is inserted. 
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Start preview rendering... 
Starts Preview rendering. 

Shortcut:  Ctrl + R 
 

Remove range(s) for preview rendering... 
Removes preview rendering ranges. If multiple sections were defined and the 
playback marker is placed over one of these sections, you will be asked whether you 
would like to remove only this "Secton" or "All. 
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Problems and solutions 

File will not load 
If files cannot be loaded, this means that the format is either not supported by MAGIX 
Movie Edit Pro 2013, or the corresponding codec must be activated first. Read the 
section "Import formats (view page 14)" for more information. 

In case of AVI files, it is possible that the necessary codec in not installed. For more, 
please refer to "General tips for AVI videos (view page 293)" in the appendix "Digital 
video and storage devices". 
 

Choppy or uneven playback 
Don't panic if the picture on your screen is choppy or uneven. The finished product 
will look perfect and play smoothly. Don't forget that MAGIX Movie Edit Pro 2013 
calculates all effects in real time. This lets you see for yourself what sort of influence 
each of the effects will have on your video footage. Some effects make even today's 
high-performance PCs work quite hard, and often, a steady, continuous video stream 
is simply not possible on your PC. The final product, free from previous choppiness, is 
only available after rendering it to DVD or exporting it. For that reason, you should 
first edit the movie in its raw version without effects. The preview generally delivers a 
steady picture, allowing you to work quickly and quietly. Towards the end, you can 
add effects to your movies to give them a special touch of Hollywood! 
 

Problems and Remedies regarding the Auto 
Remix Assistant 
Problem: The playback stutters, the metronome is suspended, the computer is 
overloaded... (on older computers.)  

Remedy: We recommend changing to wave drivers ("P" key, "Playback parameter" 
dialog) instead of DirectSound.  

Problem: The metronome does not work and there are no lines on the the wave-
shaped display.  

Probable cause: The material does not contain beats or the song contains a passage 
without beats.  

Remedy: The song should be limited in such a way that only rhythmic passages are 
contained.  

Possible 2nd reason: Inaccurate tapping or a false BPM value has been entered.  
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Remedy: Try the tempo correction buttons or tap until the "locked" condition is 
attained.  

Problem: The metronome sounds inaccurately or is jerky, the lines in the wave-
shaped display are irregular and thinly drawn.  
 

Activation problems 
Problem: The entered code is incorrect (telephone activation) 

Make sure your entry is correct; in most cases a typo is to blame. 
If the code is entered correctly, dial the number of our Call Center. Our support staff 
will help you personally. 

The MAGIX website won't open 

Check your Internet connection; you may have to use manual dial-up. 

The form for ordering via post/fax won't open 

• Check that an adequate text editing program is installed and activated (for 
example, MS Word). 

I still haven't received an email with the activation code 

• Check that your inbox isn't full. 
• Have a look in your spam folder. 

You can always send questions via email to our support whenever you like. Please 
have the following information at hand so that we can assist you as quickly and as 
specifically as possible. 

• Complete product name 
• Exact version number (to be found in the about box in the "About" menu item of 

the "Help" menu) 
• Encoder/Decoder name 
• Your user code (accessible via the "Activate via post/fax" dialog) 

Problem: I have installed MAGIX Movie Edit Pro 2013 on a new computer, installed a 
new hard drive in my old computer (sound card, memory...), or installed it multiple 
times on the same computer. My activation code is no longer accepted! 

If the program cannot be activated again after it has been activated multiple times, 
please contact the MAGIX customer service (view page 10). 
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Keyboard shortcuts 

Tip: In Windows, keyboard settings are changed using the Alt + Shift key 
combination. Those who often use keyboard shortcuts can accidentally change their 
keyboard settings, so that they keys don't correspond to the pictured symbols. To 
prevent this, you can remove the check mark found by going to "Control panel" > 
"Regional and language options" > "Languages" tab > "Details" > "Keyboard" > 
"Change keyboard combination" under "Change input layout". 

 

Playback functions 
Start/stop Space bar 
Increase playback speed in stages L 

Shift + L 
Stop playback K 
Reduce playback speed in stages until negative 
direction  

J 
Shift + J 

Accelerate playback speed in positive direction Shift + left arrow 
Accelerate playback speed in negative 
direction 

Shift + right arrow 

Stop (playback marker is stopped at the 
current position) 

K 

Restart beginning at playback marker Back 
Playback marker back to the beginning Home 
Playback marker to end End 
1 frame back Left arrow 
1 frame forward Right arrow 
5 frames back Ctrl + left arrow 
5 frames forward Ctrl + right arrow 
Set project marker  Ctrl + enter 
Play from range start to range end # 
Playback at current frame + 
 
 

Monitore 
Video monitor Fullscreen Alt + Enter 
Other resolution Alt + G 
Adjust video monitor to movie settings Ctrl + G 
Adjust video monitor to selected video Ctrl + Shift + G 
Show/hide playing time Alt + I 
Time background transparent Ctrl + Alt + I 
Anaglyph view      Ctrl + . 
View partially interlaced Alt + . 
Standard (2D) . 
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Side-by-side display Shift + . 
 

Arranger view 
Zoom in Ctrl + up cursor key 
Zoom out Ctrl + down cursor key 
Full screen playback Alt + Enter 
Movie overview Shift + A 
Optimize view Shift + B 
Zoom 1 frame / 5 frames Ctrl + 1/2 
Zoom 1s / 5s / 1min/ 10min Ctrl + 3/4/5/6 
Zoom between red area markers Ctrl + 7 
Entire movie Ctrl + 8 
 

Move view 
To next object edge Alt + W 
To previous object edge Alt + Q 
To movie start Home 
To movie end end cap 
To beginning of range Ctrl + Home 
To end of range Ctrl+End.   
Page to right/left  Page Up/Down 
Grid unit to right/left Ctrl+PgDn/PgUp 
To next/ 
previous project marker 

Ctrl + Shift + PgDn/PgUp 

To next/ 
previous scene marker   

Shift + PgDn/PgUp 

To next/ 
previous chapter marker   

Alt + PgDn/PgUp 

Go to previous/next marker Q/W 
Go to next empty range > 
Go to previous empty range Shift + > 

To next/previously selected object Shift + W 
Shift + Q 

To next/previously object Ctrl + W 
Ctrl + Q 
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Transport control in the Media Pool 
Set start of range I 
Set end of range O 
Go to the start marker Shift + I 
Go to the end marker Shift + O 
Select range above blank space  X 
Play from start to end marker # 
 

Mouse modes 
Mouse mode for individual objects 6 
All tracks mouse mode 7 
Single track mouse mode 8 
Curve mode 9 
Object stretch mode 0 
Preview audio objects Alt + 6 
Context help Alt + F1 
 

File menu 
New project Ctrl + N 
Open project Ctrl + O 
Save project   Ctrl + S 
Save project as... Shift + S 
Project folder -> Clean up project folder Alt + Shift + X 
Record audio/images/video... R 
Export to device... H 
Batch conversion... S 
Burn CD/DVD -> Manually compile files... Ctrl + B 
Clean-up wizard Ctrl + Shift + Y 
Load backup project Ctrl + Shift + O 
Exit  Alt + F4 
 

Manage movies 
New Ctrl + Alt + N 
Remove from project Ctrl + F4 
Export Ctrl + Alt + L 
 

Film exportieren 
Export as AVI  Ctrl + Alt + A 
Export as DV AVI Ctrl + Alt+ D 
Export movie as an MPEG Ctrl + Alt + P 
Video as MAGIX video Ctrl + Alt + M 
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Video as QuickTime movie Ctrl + Alt + Q 
Uncompressed movie Ctrl + Alt + U 
Movie as a series of individual frames Ctrl + Alt + E 
Windows Media Export  Ctrl + Alt + V 
Video as MPEG 4 video Ctrl + Alt + G 
Audio as wave  Ctrl + Alt + W 
Export as transition Ctrl + Alt + T 
Single frame as BMP file Ctrl + Alt + B 
Single frame as JPEG Ctrl + Alt + J 
Animated GIF Ctrl + Alt + F 

 
 

Backup copy 
Copy project and media into folder Alt + S 
Copy movie and media into folder Shift + R 
 

Settings 
Movie E 
Program  Y 
Keyboard shortcuts Ctrl + Shift + U 
 

Edit menu 
Back Ctrl + Z 
Restore Ctrl + Y 
Cut objects Ctrl + X 
Copy objects Ctrl + C 
Insert objects Ctrl + V 
Duplicate objects D 
Delete objects  Del 
Select all objects Ctrl + A 
Save object groups Ctrl + Alt + Shift + F 

Cut  
Cut scene T 
Remove scene start Z 
Remove scene end U 
Remove scene Ctrl + Del 
Split movie Alt + Y 

Musical cut adjustment Ctrl + Shift + M 

Edit range  
Cut range Shift + Del; Alt + X 
Copy range Alt + C 
Delete range  Alt + Del 
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Insert range Alt + V 
Extract range Shift + X 
Insert empty space into selected range C 

Group G 
Ungroup  Shift + G 

Wizards  
Slideshow Maker Ctrl + M 
Soundtrack Maker Ctrl + Shift + S 

Mixdown audio  Shift + D 
Audio and video mixdown Shift + M 
Start preview rendering Ctrl+R 
Set snap point Ctrl + P 

Markers  
Set project marker Ctrl + Enter 
Set chapter markers Shift + Enter 
Set chapter markers automatically Alt + Shift + Enter 
Delete chapter markers Ctrl + Shift + Enter 
Delete all chapter markers Ctrl + Alt + Enter 
Set range start I 
Set range end O 
Jump to range start Shift + I 
Jump to range end Shift + O 
Select range above blank space X 

Move view see "Move view" (view page 281) 

Search for gaps Ctrl + Shift + C 
Mute audio track Alt + Shift + M 
 
 

Effects menu 
Movie effects settings Ctrl + Shift + H 
 

Video object effects 
Scene recognition Shift + Z 
Image stabilization Ctrl + L 
Edit with MAGIX Photo Designer Alt + Shift + D 
 

Video effects 
Brightness/contrast Alt + Shift + H 
Color Alt + Shift + F 
Color correction Alt + Shift + C 
Sharpness Ctrl + Alt + S 
Video effects plug-ins Ctrl + Shift + P 
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Video mix effects Ctrl + Alt + X 
 

Movement effects 
Position/size Alt + Shift + I 
Section Alt + Shift + P 
Camera/zoom Ctrl + Alt + Z 
Rotation/mirror Alt + Shift + R 
 

Audio object effects 
Normalize Alt + N 
Volume reduction Alt + L 
Audio cleaning Alt + A 
Echo/reverb Shift + H 
Timestretch/resample Ctrl + Shift + Q 
Load audio effects Ctrl + + 
Save audio effects Shift + +  
Reset audio effects Ctrl + Alt + + 
BPM wizard Alt + Shift + K 
Edit wave files externally Alt + Z 
Volume curve Ctrl + Shift + V 
 

Title effects 
Title editor Ctrl + T 
Load title effects Alt + T 
Save title effects Ctrl + Shift + T 
 

Effects libraries 
Audio and video effects Ctrl + Shift + E 
Transition effects Ctrl + Shift + B 
Title effects Alt + Shift + L 
 

Windows menu 
Edit trimmer N 
Object trimmer Shift + N 
Mixer M 
Master audio effect rack B 
Video Monitor Shift + V 
Media Pool Shift + P 
Reset window arrangement    F9 
Display settings Alt + Shift + V 
Switch to next window Tab 
Film overview  Shift + A 
Optimize movie view Ctrl + F 



 

286   

www.magix.com 

Zoom horizontally/vertically see Arranger view (view page 281) 
  

Help menu 
Help F1 
Context help Alt + F1 
Display tooltips Ctrl + Shift + F1 
About MAGIX Movie Edit Pro 2013 Alt + Shift + F1 
 

Edit keyboard shortcut 
In this dialog you can specify keyboard shortcuts for all menu function of MAGIX 
Movie Edit Pro 2013. This allows you to adapt existing shortcuts to your requirements 
or to add new ones. 

The settings are automatically saved in a file upon closing the program, i.e. they will 
be available the next time the program is used. 

The display of the entire menu tree is the key function of MAGIX Movie Edit Pro 2013. 
 

Add keyboard shortcut 
To add a keyboard shortcut, proceed as follows: 

• Look for the required menu point and select it with a simple mouse click. Under 
"Current menu point" the currently selected menu point will be displayed. 

• Then, click on the "New keyboard shortcut" field. 
• Type in the keyboard shortcut. You can also use combinations of any key with 

"Shift", "Alt", and "Ctrl". 
• Then click on "Assign shortcut". If the shortcut should already have been 

assigned a corresponding warning will be displayed. 

Note!  Please do not use the space bar, "Esc", or "Insert" key ("0" in the number 
block), since the functions of these keys are permanently assigned in MAGIX Movie 
Edit Pro 2013 and can not be changed. 

 

Keyboard shortcut list 
Reset: Activates all preset shortcuts again. 

Load: Previously saved shortcuts are loaded and activated again. 

Tip: MAGIX Movie Edit Pro 2013 offers additional presets for those switching from 
other programs. These settings make it considerably easier to switch to MAGIX 
Movie Edit Pro 2013. 
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If you have used MAGIX Video Pro X3 and want to use its keyboard shortcuts, load 
Video_Pro_X3.ssc. 

Warning:  The current settings will be overwritten during loading! Save your current 
keyboard shortcuts in advance if you would like to keep them. 

Save: The current keyboard shortcuts can be saved after naming the file appropriately. 

List: This button opens a window where a complete list of current keyboard shortcuts 
appears. The included Copy button can be used to copy this list to the Windows 
clipboard and then edit and print it using a text editor. 
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Integrated browser 
The integrated browser offers many useful functions that help you collect material for 
using in your project. All kinds of media can be collected – images, videos, sound or 
simply text can be all integrated using the built-in browser with great results. 

Tip: You must have an Internet connection to use the full range of options offered by 
the integrated browser. 

 

Open browser 

 

The integrated browser is opened by clicking on 
the "Internet media" button in the Media Pool 
(see Media). 

 

Navigation in the browser 

 
One page back: Switches to the previous page. 

 
One page forward: Switches back to the page before the "One page back" 
button was pressed. 

 
Stop: Stops loading the selected page. 

 
Reload: The current page will be reloaded. 

 
Home: Returns to the home page. 

In the address header, next to the navigation buttons, you can simply enter an 
Internet address like http://www.magix.com. Press the enter button and the 
corresponding page will be loaded. 
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Loading Internet media 
The buttons described here are used to collect and load media directly from the 
Internet into the current film. The corresponding functions can be found in the context 
menu of the browser. 

 
Save selected text: The selected text will be saved. It can then be edited using 
the title editor. 

 
Start screen capture: Opens the capture dialog for starting screen capture. 

 
Download selected images: The selected images will be saved to your 
computer. 

 
Import screen capture of the opened Internet page: The loaded Internet page 
will be saved as an image file. 

 
Start audio recording: A dialog for audio recording opens. 

Hint: For recording from the Internet, it is important that the sound card is 
selected as the sound source. 

 

Accept media after download 
This option makes sure that the downloaded media are loaded into the current movie 
right away. 
 

Define the path for saving Internet media. 
To define the path for saving Internet media, simply click on the folder symbol and 
navigate to the desired folder. Confirm your selection with OK. 
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Activate codecs 
You may activate encoders/decoders for various file formats as required. The 
corresponding activation dialog will appear automatically when the codec is used for 
the first time, e g. when a DVD is burned and the MPEG-2 codec is used. 

Why does it have to be "activated"? 
To import (decode) or export (encode) certain video and audio formats, you will 
require a specific codec. MAGIX Movie Edit Pro 2013 will ask you if you want to 
activate the codec as soon as you need it. The integration of decoders and encoders 
from third parties into programs usually costs money. These codecs are integrated via 
additional, voluntary activation in MAGIX programs which, according to usage and 
degree of prevalence, can be free or fee-based for special high-quality codecs. This 
way, MAGIX can continue to offer you good value for your money. 
 

Free activation of codecs 
To be able to use MPEG-2, MPEG-4, Dolby®Digital stereo import (view page 171), and 
Dolby®Digital 5.1, you will have to activate the codecs for free. 

Activation can be done online via telephone or via post/fax. The quickest and easiest 
way to order an activation code is via the Internet. 

Order activation code online 
Click on "Order online..." (Field 1). MAGIX Movie Edit Pro 2013 will automatically 
contact the MAGIX server and load the corresponding codec. 

Note: Activation of the codec checks the registration data as required. Activation of 
the codec only functions if your version of the program has already been registered 
in your name. If you haven't registered MAGIX Movie Edit Pro 2013, then you can do 
this at any time.  

If your computer has no Internet access, you have the following options for activation: 

Order activation code in MAGIX Service Center 
Use this option to conduct activation from a different computer which has Internet 
access. 

Order activation code via post/fax 
After clicking on "Order via post/fax" (field 2), your user code will appear. This 
automatically assigns your personal activation code to your PC. Click on "Continue to 
order form" to transfer your user code automatically to the post/fax form. Now send 
the completed form as a print out to the address/fax no. mentioned.  Your activation 
code will be sent to you in just a few days via post or fax. It can also be sent by mail if 
an email address is stated. 
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Enter activation code 
After receiving your personal activation code, use the export or burn function to 
reopen the activation dialog for the corresponding file format. Type or copy the 
activation code into the input field in the dialog and click on "Activate...". 
 

Fee-based activation of MVC codec 
MVC codec for loading some Stereo3D videos (view page 177) must be activated for 
a fee. 

Activation is fee-based and can be done online or via post/fax. The quickest and 
easiest way to order an activation code is via the Internet. Ordering the activation 
code takes just a few minutes via email. The order of your activation code via post/fax 
takes a few days.  

Order activation code online 
Click on "Order online..." (Field 1). The web browser will open for you to register 
MAGIX Movie Edit Pro 2013 first (if you have not already done so). You will then be 
forwarded to a website where you can request the corresponding activation. 

If your computer has no Internet access, then you have the following options for 
activation: 

Order activation code in MAGIX Service Center 
Use this option to conduct activation from a different computer which has Internet 
access. 

Order activation code via post/fax 
After clicking on "Order via post/fax" (field 2) your user code will appear. This 
automatically assigns your personal activation code to your PC. Click on "Continue to 
order form" to transfer your user code automatically to the post/fax form. Now send 
the completed form as a printout to the address/fax no. mentioned.  Once payment 
has been processed successfully, your activation code will be sent to you in the 
post/via fax in just a few days. Optionally, it can also be sent by email if an email 
address is stated. 

Enter activation code 
After receiving your personal activation code use the export or burn function to 
reopen the activation dialog for the corresponding file format. Type or copy the 
activation code into the input field in the dialog and click on "Activate...". 
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Annex: Digital Video and Data Storage 

Video Editing on the PC 
Digital video processing with the PC is comparable to audio processing. The analog 
medium that is video must first be digitized before it can be processed by the 
computer. 

Digital video processing functions quite similar to recording via a sound card. The 
signal flow is measured in very short, regular intervals, and the values resulting from it 
can then be processed by the computer. The accuracy of each individual 
measurement results in the resolution, and the frequency of the measurements 
results in the frame rate. The more precise and frequent the signal is measured, the 
higher the quality of the digitized video, but also the higher demands on the capture 
performance and the required storage space. The Windows standard format for video 
files is AVI (audio and video Interleaved). 

Digitizing video adopts either the camera or the graphics card, a TV card (e.g. Miro 
PCTV), or a video card (e.g. Fast AV Master). However, video handling makes much 
higher demands upon the hardware if good image quality is required. In order to be 
able to reasonably process video files on today’s PCs, they must be compressed. 
Digital audio, on the other hand only uses compression for saving storage space.  
 

MPEG Compression 
MPEG means "Moving Picture Experts Group" and defines a workgroup which 
cooperates with the International Standards Organization (ISO) as well as the 
international Electro Technical Commission (ETC) to develop standards for video and 
audio coding.  

Generally, the graphic data rate of the digital video standard is 167 megabits per 
second, which, when not compressed, requires a far higher storage capacity than a 
DVD can offer. A one-sided DVD 5 with 4.7 GB storage capacity is enough for 4 
Minutes. For this reason, the available pictorial material must be effectively 
compressed – a function which is achieved with the MPEG procedure. 

This procedure is based on the simple fact that up to 96% of digital video data 
consists of repetition and can be compressed without visible degradation of the 
pictorial quality.  

Each MPEG compression is, however, a data reduction and as such connected with 
information loss. If the video consists of very extensive details, or if the content 
changes very fast, then the picture may blur (dependent on the strength of the 
compression and the quality of the encoder). 
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Errors can also result from so-called compression artifacts such as small color defects 
or images that are too dark.  

At average compression rates under 3 megabits per second it is probable that you will 
notice reduced quality. At rates around 6 megabit per second the degradation in 
quality becomes almost invisible.  
 

General notes on AVI videos 
The AVI format (Audio Video Interleaved) isn't actually a proper video format! 
Rather, it is a so-called "container", where the conventions for transferring audio and 
video files to the program are only loosely defined. The codec (coder/decoder) 
actually defines what storage format is used. A codec compresses audio/video data 
into its own unique format which can only be read by the codec itself and is decoded 
when the film is played.  

In concrete terms, a computer-generated AVI file can only be loaded by and played 
on a different computer if the same codec is installed on it. 

Many codecs (e.g. Intel Indeo® video) have now become standard components of the 
Windows™ installation. Others like the popular DivX codec are not standard. If you 
are generating an AVI file for future play on another computer using one of these 
codecs, you should first install this codec on the other PC. The best method available 
is to copy the codec installer to your export directory and burn it every time you 
create a video disc (slideshow disc) for play on computers. 

You may encounter some problems when using older video editing cards with codecs 
which only function with the card’s hardware. Such AVIs can only be used on the 
computer which was used to create them. Try to avoid using this kind of codec. 
 

Overview of the different disc types 
MAGIX Movie Edit Pro 2013 supports numerous disc types, and these depend on 
whether you want to burn a movie or slideshow and which disc type you are using 
(CD, DVD, or Blu-ray DiscTM), or the type of playback device or quality required.  

The table below will explain which disc types are best for different cases, the 
differences in quality, and how much storage space each format requires. 

More detailed information, consult the chapters concerning the individual disc types. 
 

Disc type Data carrier Menu Quality Length (optimal quality) 

DVD DVD Yes  *** 98 min. 
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Blu-Ray Disc 
(view page 295) 

Blu-Ray Disc Yes ***** 110 min. 

AVCHD (view 
page 295) 

DVD/Blu-ray 
Disc 

Yes ***** 30 min./DVD 
160 min./Blu-ray Disc 

Multi Disc CD/DVD Yes **** 45 min./DVD 
7min/CD 

* The set duration for some DVD players may be determined by this table. Depending 
on the original size (file size of the images) the number of images that fit on a blank 
CD or DVD differs. 
 

Digital Versatile Disc (DVD) 
Quality 
Featuring a resolution of 720 x 576 (PAL) and encoded with MPEG-2, 25 frames per 
second provides very good results. 

Writable data storage formats 
The recordable DVD market is currently split into three types: "DVD-RAM", 
"DVD+RW", and "DVD-RW". 

DVD-R/+R: This medium may only be written to once. The DVD-R may be specified 
with file structures for DVD video, DVD audio, or DVD-ROM. 

DVD +RW: +RW drives allow re-writable DVDs to be created which may be read by 
almost any commercial DVD-ROM or DVD player. The companies involved are 
mainly Philips, Sony, HEWLETT PACKARD (as well as Ricoh, Yamaha and 
Mitsubishi). 

DVD-RW: This is a write/erase DVD technology promoted by Pioneer and Sharp. 
This format was developed by the Pioneer company and should be compatible with 
existing DVD players. 

DVD-RAM: DVD-RAM technology is based on either Phase Change, MOs, or hard 
disks, etc. and is now almost 100% incompatible with all available players. 

Due to the small storage capacity and incompatibility with DVD players, setting on 
this standard is not recommended. 

Note: MAGIX Movie Edit Pro 2013 supports DVD±R and DVD±RW, but not 
DVD-RAM. 

Blank discs: Single-sided recordable blank discs featuring a capacity of 4.7 GB and a 
duration of approx. 2 hours. 
 

Copy Protection 
Macrovision (APS): The movie industry claims that even DVD-ROM drives and 
decoders or diagram cards with composite outputs or s-video outputs must support 
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the Macrovision analog copy protection (APS). Only some older DVD players do not 
possess APS.  

APS adds additional signals to a DVD’s stored graphical data. The data is almost 
unchanged. These supplementary signals disturb the synchronization and the 
automatic recording regulation of most video recorders to prevent recording of the 
video. They are not noticeable on the television or the monitor, however. 

Content Scrambling System (CSS): CSS prevents saving and duplication of DVD 
video tracks to hard disk. The VOB streams of DVDs without CSS can otherwise (like 
other video files) be loaded via the Import Video button 

There are further types of copy protection besides APS and CSS which ensure that 
retail DVDs cannot be copied without distortion 

 

Blu-ray Disc 
Since early 2008, Blu-ray Discs are viewed as successors to DVDs and offer 
especially high storage capacity of up to 27 GB in a single layer (double-layer up to 54 
GB) with very few write errors. 

The term Blu-ray Disc comes from the blue color of the laser. Because a color cannot 
be registered as a trademark, the letter "e" was removed from the word "blue". 

The high storage capacity of the Blu-ray Disc suits high definition videos and 
slideshows in high quality perfectly, since these are characterized by large file sizes 
(depending on material approximately 40 MB/sec) and very high memory use. The 
MPEG-2 codec is used to create video. 

Companies that were involved in developing Blu-ray technology have united 
themselves into the Blu-ray Disc Association (BDA). 

Blu-ray Discs come in three varieties: 
• Only readable BD ROM (comparable to DVD video), 
• rewritable BD-RE (comparable to DVD±RW or DVD-RAM),  
• and as a disc that can be written to only once BD-R (comparable to DVD±R). 
 

AVCHD disc 
Use this format to create a high-resolution video. You can burn Blu-ray (BD-R/RE) 
blanks as well as conventional DVD±R/RWs. In contrast to Blu-ray Discs (view page 
295), MPEG-4/AVC codec (view page 299) is applied as the video format, which 
requires less memory at a comparable image quality. 

Compatibility 
AVCHD disc on Blu-ray blank: Since this is a BD-conformant format, the disc created 
can be played back in any conventional Blu-ray player. Playback problems can almost 
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always be traced to incompatibilities between Blu-ray blanks and Blu-ray players. In 
this case, consult the instructions for your Blu-ray player or ask the manufacturer 
which blanks are compatible with the device. 

AVCHD disc on DVD blank: The DVDs created with AVCHD video are not supported 
by all Blu-ray players. The behavior of the devices is quite different. Normal DVD 
players cannot replay AVCHD discs, since the AVC format is not supported. 
 

Note: To import and export AVC(HD) and MPEG-4 files, the MEPG-4 codec must 
first be activated (view page 289). A dialog will open if the codec is required. 

 

Super Video CD (SVCD) 
The Super Video CD (SVCD) is a technological advancement of the video CD. SVCDs 
are also like VCD-specified CD-ROMs which can be played using either a Super 
Video CD player (connected to the television), or directly with the CD-ROM drive of a 
computer. Many DVD players can also play SVCDs. MPEG-2 and the increase of the 
data transfer rate  makes it hard to tell videos from videos in DVD quality apart. 

Resolution: SVCDs use the better MPEG-2 encoder in a standardized resolution of 
480 x 576 (PAL). The MPEG-2 format offers a maximum resolution of up to 720 x 
576 points and improved compression methods characterized by excellent image 
definition and homogeneity. 

Hard disk capacity: An average 90-minute movie must be spread across 3 CDs. On 
one SVCD you can get about 30 minutes of good-quality movie. 

Encoder setting: Compared to the VCD with 1.3, the data transfer rate is doubled to 
2.6 Mbit/s. 

MPEG-2 format introduces the so-called variable bit rate (VBR). In contrast to the 
constant bit rate (CBR) of the MPEG-1 encoders, this encoder has the option of using 
more bits for movement-intensive sections, as well as saving bits if picture content 
remains the same. 
 

Video CD (VCD) 
Video CDs are specific CD-ROMs for storing videos in certain forms. Compression 
takes place using the MPEG-1 codec. VCDs can be played on either a video CD player 
attached to a television or directly via the computer's CD-ROM drive. Most DVD 
players can play VCDs. 

Resolution: VCDs can play movies with a maximum resolution of 352 x 288 pixels 
(PAL) or 352 x 240 (NTSC) at 25 pictures per second. The resolution of a VHS 
cassette offers for instance 300 x 360 pixels. More important than the resolution is 
the use of a good MPEG-1 encoder. Since video images constantly change, errors 
cannot always be perceived by the viewer. 
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Hard disk capacity: A VCD can store about 70 minutes of video. A typical motion 
picture must therefore be stored on two VCDs. In order to get as much video data on 
a normal CD as possible, one must forego correction information on VCD/SVCD 
formats within the individual sectors (sub-ranges) of a CD. You can therefore fit 720 
MB of video data on a 650 MB blank CD. Due to improved burning and scanning 
technology it is now possible to burn up to 985 MB video data on a 99min blank CD. 

Encoder settings: Normally the video CD data is played at a data rate of 1150 kBits 
video and 224 kBits audio. By increasing the video bit rate to 3000kBits you can get 
the same resolution and an better-quality audio bit rate. Movement artifacts 
disappear almost completely at approx. 2000 kBits with the picture appearing a little 
less sharp. This pre-supposes, however, that the player can also play back such a bit 
rate. The fact that many DVD players can handle an increased data rate is due to well 
written player software.  

Experiment with higher data rates: If you do not need the full running time of the 
VCD, then you can experiment with space to improve the quality of the video! 
 

miniDVD 
The miniDVD is nothing more than the DVD data format burned onto a CD-ROM. 
Thus the MPEG-2 encoder and all other specifications of the DVD data format are 
used, and only the data carriers are different. Because the CD-ROM can only save 
about a sixth of the quantity of data a DVD can hold, the capacity of a miniDVD is 
accordingly limited to approx. 20 minutes of movie.  

MiniDVDs are particularly suitable for playing on the computer. For stand-alone 
devices they must be tested on an individual basis as to whether the device can 
handle the DVD format on a CD-ROM. 
 

Slideshow disc 
All slideshow image and audio files will be burned onto CD or DVD, together with any 
effect settings and the MAGIX Media Manager CDR player program. A MAGIX 
Media Manager CD is designed especially for photo projects (slideshows).  

The original photos are burned onto CD; Ideal for backing up valuable recordings. 
During playback on your PC, the highest possible picture quality is made possible. The 
following photo effects can be played by Media Manager. 

• Brightness, contrast, gamma 
• Cropping and rotation 
• Title text (without text effects) 

If your project uses more effects, they won’t be visible on the Media Manager CD. A 
VCD or DVD is more suitable for such projects. 

The MAGIX Media Manager CDR ensures that the CD-ROM can be played back on 
any Windows PC regardless of the software installed. The disc will automatically 
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begin playing the slideshow after the CD-ROM has been inserted into the drive, 
provided the auto-play feature is enabled on your PC. To enable the auto-play feature 
on your PC, select the "Auto Insert Notification" option for your CD-ROM drive from 
the Windows Control Panel. 

If deactivated, you can also start your CD-ROM slideshow manually: 

1. Place your home-burned CD-ROM into your CD-ROM drive. 
2. Open Explorer and click on the drive letter of the CD-ROM drive (usually D:\). 
3. Double-click "MediaManager.exe" to start the MAGIX Media Manager CDR. 
4. In the Explorer window of MAGIX Media Manager CDR, open the slideshow 

playlist file ending with *.PLR and start the slideshow. 
 

Additional information can be found in the help feature of MAGIX Media Manager 
CDR (F1 key). 

 

WMV HD (Windows Media High Definition Disc) 
WMV WMV HD (Windows Media High Definition Disc) is a type of disc optimized 
for playback of slideshows on PC. The movies are converted into high-resolution 
Windows Media 9 format and a menu is added, like with DVDs. You must have 
Windows Media Player 9 or higher installed on your PC. 

Video encoding will be preset for HDTV resolution (1280 x 720, also known as 
"720p"). To select different resolutions, click on the button “Encoder settings” and in 
“Presets” choose the following: 

• Standard PAL (720x576) or NTSC (720 x 480) 
• Standard PC resolutions (1024 x 768 or 1280 x 1024) 
• HDTV 720p (1280x720) or 1080i (1920x1080) 
 

Multi Disc 
A multidisc is a combination of different disc formats on one DVD. It consists of 3 
parts and offers the following advantages: 

• Maximum quality when played on a PC with WMV HD (Windows Media High 
Definition Disc) 

• Fully compatible with DVD players due to a DVD part (Digital Versatile Disc) 
(view page 294) 

• Greatest possible safety as a data backup of the project is added (burn option 
(view page 224)). 

 

Backup disc 
Use this option to compile all movies in the current disc project, including all 
connected media and burn them to disc. 
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Even larger projects can be burned straight to disc. The project, if necessary, will be 
split up and burned automatically to multiple discs. A restore program which is 
burned to the first disc of such a backup, guarantees easy re-recording of the backup. 
 

MPEG-4 encoder 
MPEG-4 is actually a collection of highly efficient codecs for video and audio based on 
the MPEG standard. Compared to MPEG-2, the same quality can be achieved with 
smaller file size. 

Recommendation: Check the presets that the program offers to find the right preset 
for each application and the right playback device. These presets are optimized for 
typical applications. 

The advanced settings in "Advanced" are divided into "Video", "Audio", and 
"Multiplexer".   

Under „Video“ there is a choice between „MPEG-4 Simple“ (MPEG-4 Visual/MPEG-
4 Part 2)  (view page 304)and „MPEG-4 H.264“ (AVC/MPEG-4 Part 10) (view page 
300).  

Depending on the purpose of application of the material to be exported, either one of 
these encoder settings can be selected for compressing the video material. Refer to 
the manual for the playback device to find out which encoder is supported. 

Under „Audio“, „AAC“ (view page 307) is preset. If you have chosen an AVCHD 
transport stream from the presets, "AC3 (Dolby Digital)" will be available.  

Under „Multiplexer“ you can adjust certain presets, e.g. container format and 
streaming properties. This is only recommended for experts. 

The option "Export as website" also creates an HTML page in an integrated Flash 
player that can play back the video created. Read the topic "Embed Flash videos into 
your own web site". 

Tip: First, check if there is a suitable preset in the export dialog for your purposes. 
Advanced users can make specific adjustments to these three areas using the 
advanced settings. 
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Video codec 
MPEG-4 H.264 
The MPEG-4 H.264/AVC codec is suitable for all types of material; however, it 
requires relatively higher CPU power for later decoding. 

In the advanced encoder settings of the AVC encoder the "Generic" options in "Main 
Settings" are mainly interesting. 

The AVC preset and video format can be adjusted here. For instance, if DVD quality is 
desired you should select "DVD". The video format should be selected specific to the 
country so that the material can be played on the devices most commonly available in 
these countries. For instance, you should select PAL for Germany, SECAM for France 
and NTSC for the US. 
 

MVC 
MVC: Multiview Video Coding (MVC) is an expansion for stereoscopic applications. 
Activate this to export MVC files.  

Note: MVC is only available in the Video deluxe Pro versions. 

 

2-pass 
The video to be exported will be encoded twice. The first run-through serves to 
calculate the streaming rate for each section (for video this is per frame). The second 
run-through is when the actual video is created with the streaming rates that were 
calculated in the first run-through. The result is an improved image quality, but 
encoding takes place approximately twice as long. 
 

Smart Render and Smart Copy 
Smart Render lowers the demand on the encoder for AVCHD material. In the 
production of AVCHD files, only those parts of the movie that were changed in the 
program (e.g. by video cleaning or effects) are re-encoded. Please note: The AVCHD 
files contained in the movie must have the same format, i.e. the bit rates (variable or 
constant), audio formats, image resolutions and video formats must match. 

The Smart Rendering special mode „Smart Copy“ enables AVCHD material to be 
transferred without having to encode it for the target medium which greatly increases 
the encoding speed. The video material cannot appear to have been altered in any 
way, only hard cuts (without fades) are permitted. These won't be executed precisely 
to the frame, but rather take place at the next GOP borders. For this reason, cuts 
should be set somewhat more generously. 
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Hardware acceleration - CUDA, Quick Sync Video, OpenCL 
MAGIX Movie Edit Pro 2013 supports hardware acceleration for AVCHD exports, 
AVCHD Disc and Blu-ray (H.264) Disc encoding (burning). This can noticeably 
speed up the encoding process. 

The following hardware acceleration technology is supported: Quick Sync Video 
(Intel), OpenCL (AMD) and CUDA (NVIDIA). 

Note: Ask your graphics card manufacturer whether your graphics card supports 
hardware acceleration.  Make sure that all the necessary drivers are installed. 

If your system does support hardware acceleration, you can activate it through 
"Advanced..." > "Hardware acceleration". The program will make the adjustments 
according to the available technology. 
 

Advanced video settings 
Generic 

AVC preset 
This is where the actual video stream that will be exported is selected. 

• Baseline: According to ISO/ICE 11172-1/2 standard 
• Main: Corresponds with ISO/ICE 13818-1/2 standard 
• High: High Profile 

• SVCD: Corresponds with MPEG-2 Super VideoCD 
• D1: Corresponds with MPEG-2 DVD 
• DVD: DVD video 
• Blu-ray: Blu-ray-Disc 
• Blu-ray HD: Blu-ray-Disc in High Definition 
• Sony PSP: Sony PSP-compatible format 
• HD 1280x720p: High Profile with a resolution of 1280x720p (progressive) 
• HD 1440 x 1080i: High profile with a resolution of 1440 x 1080i (interlaced) 
• Apple iPod: Apple iPod-compatible stream. 
 

Profiles 
Profiles 

Profiles define the encoder properties that are supported. 

• Baseline profile: The basis of applications with limited computing performance, 
especially for video conferences or videos on mobile telephones. 
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• Main profile: This profile was originally intended for the broadcast industry and 
for backup purposes. It has become less popular since the development of the 
"High Profile" for this purpose. 

• High profile: This profile is used for broadcast and backup applications, and it is 
also used sometimes in the HDTV industry (High Definition Television). This 
profile is used for HD-DVD and Blu-ray Discs, for example. 

Level 

H.264 defines different levels. The level determines which bit rate and resolution are 
possible for the video.  

With the "Auto level" option, the encoder determines the level automatically on the 
basis of the resolution of "AVC preset" video formats, the set bit rate and the profile. 
 

Frame type 
"Picture type" specifies which parts of a frame should be used as the basis for the 
encoding: 

• Progressive Frame: A single image from a video sequence, also called a fullscreen. 
• Interlaced Field:  This is half an image. Two of these are combined to produce a 

frame. Read more about this explanation regarding "Interlace (view page 317)". 
• Interlace Frame: The encoder creates a „Frame field“ which is the basis for the 

encoding. 
 

Field order 

Note: This parameter is only available if the setting "Field" is selected for "Frame 
type". 

In case of interlaced streams, the half-image sequence is set. Read more about this 
explanation regarding "Interlace (view page 317)". 
 

Slice count 
A frame can be divided into multiple slices for encoding. Specify the maximum 
number of slices are permitted. If set to "0", then the number will be determined 
automatically. 
 

Rate control 
The bit rate indicates how much data per second is saved in the video (playback 
speed). This makes the bit rate the deciding parameter with regard to the file size and 
quality of the video to be encoded. A higher bit rate means more quality but also a 
larger file size. 
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Mode 
• Constant bit rate: The constant bit rate should only be used if the device used to 

play the video supports constant bit rates. 
• Constant quantizer:  
• Variable bit rate: The bit rate varies. For faster movements in the video, the bit 

rate increases, and for still images or slow pans, a lower bit rate is sufficient for 
creating the video in constant quality. 

 

Pass 
Here you can choose whether you want to manually perform one-pass or multi-pass 
encodings (2-pass, multi-pass) 

Note: The 2-pass option in the main dialog of the MPEG-4 export is recommended. 
This automatically performs two encoder passes. 

If you want to perform 2-pass encoding manually, you must select "Multi-pass 
analysis" in the first pass and "Multi-pass encode" in the second pass. 

• Single pass: The encoder process takes place without prior analysis. This requires 
the least amount of time.  

• Multi-pass analysis: Analysis data is calculated during encoding and used for 
multi-pass encoding. 

• Multi-pass encode: Assumes that an analysis has already been performed The 
analysis data is used during encoding to optimize the results. 

 

Bit rate (Bits/s) 
• In "Constant bit rate" mode: Exactly those values entered are applied to be able 

to calculate the size of the video precisely.  
• In "Variable bit rate" mode: The values entered here are applied to the video as 

an average as a guideline. The size of the video to be exported can only be 
approximated. 

 

HSS rate 
This is the maximum bit rate that should be present in the video stream, i.e. maximum 
number of bits that may be transferred to the decoder. 

Note: This option is only available in "Variable bit rate" mode. "Use HRD" must also 
be activated. 

 

Aspect ratio 
In the film industry, this is an indication of the ratio between width and height of a 
rectangle, monitor, or screen.  
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There are 3 different sizes available: 

• Picture Aspect Ratio (also Display Aspect Ratio, DAR): This indicates the desired 
aspect ratio of the video to be exported. Here are some examples of typical 
aspect ratios: at home 4:3, 16:9 (typical for TV sets) or 16:10 (widescreen-
flatscreens, widescreen notebooks), 3:2 for 35mm films and photos. In cinemas 
you mostly find 1.85:1. 

• Pixel Aspect Ratio (PAR, pixel aspect ratio: Indicates the aspect ratio of individual 
pixels. The majority of computer monitors have quadratic pixels (PAR=1:1), for 
analog television monitors (PAL at 4:3) 128:117. 

• Sample Aspect Ratio (SAR, also Storage Aspect Ratio): Aspect ratio of the saved 
resolution (number of pixels), e.g. 720:576 at PAL. It also calculates picture 
aspect ratio and pixel aspect ratio: SAR = DAR / PAR. 

Note: In the standard case, the "Aspect ratio" remains set the way it is. You should 
only change the settings if the resulting video is exported distorted or stretched or if 
you need to correct the video because it is in the wrong aspect ratio. 

 

GOP structure 

Max GOP length 
Determines the maximum GOP (view page 317) length. High values mean improved 
compression. Lower values create stronger security protection and enable improved 
access to individual frames for processing the video. 
 

Max b-frames count 
The maximum number of b-frames (view page 319). Several cases of application, e.g. 
video conferences require "no b-frames" in order to achieve the shortest possible 
reaction times during transfer. 
 

Scene change detection 
If this option is activated the scenes will be detected during encoding, thus allowing 
you to insert an I frame (view page 317) after a scene change.  
 

MPEG-4 simple 
If MPEG-4 H.264 cannot be played back on your device, use MPEG-4 Simple. 

Note: We recommend that only advanced users make adjustments to the advanced 
settings. You can use the technical specifications of your playback device to help 
with this. 
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Advanced video settings 
Generic 

MPEG-4 preset 
Different presets located within the encoder. 

(A)SP@L0-L5: (Advanced) Simple Profile in Level 0-5 

(Q)CIF (Common Intermediate Format): CIF is a video format produced as soon as 
1990 with the video compression format H.261. At that time, the format was used for 
video telephone conferences. 
The "Q" in QCIF stands for "Quarter", and since resolution is halved in terms of height 
and width compared to CIF, the entire size is only a quarter of CIF. 
QCIF was popular with mobile telephone manufacturers, since the resolution of 176 x 
144 pixels was sensible for the first affordable SmartPhones (144 x 176). 

(Half)D1: D1 corresponds with MPEG-2 DVD. HalfD1 has exactly half of the entire 
number of pixels, meaning that the pixel number of the height and weight is 2/3 of D1. 

720p: Video stream with a resolution of 1280 x 720p (progressive). 

Apple iPod: Apple iPod-compatible stream. 

Sony PSP: Sony PSP-compatibler stream. 
 

Profile/Level 
Profiles: Profiles define the encoder properties that are supported. 

Level: The level determines which bit rate and resolution are possible for the video.  
 

Picture type 
"Picture type" specifies which parts of a frame should be used as the basis for the 
encoding: 

• Frame: A frame is a single image from a video sequence, also called a full image. 
• Field: A half-image, two of which combine to produce a frame. Read more about 

this explanation regarding "Interlace (view page 317)". 
 

Field order 

Note: This parameter is only available if the setting "Field" is selected for "Frame 
type". 

In case of interlaced streams, the half-image sequence is set. Read more about this 
explanation regarding "Interlace (view page 317)". 
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Slice count 
A frame can be divided into multiple slices for encoding. Specify the maximum 
number of slices are permitted. If set to "0", then the number will be determined 
automatically. 
 

Rate control 
The bit rate indicates how much data per second is saved in the video (playback 
speed). This makes the bit rate the deciding parameter with regard to the file size and 
quality of the video to be encoded. A higher bit rate means more quality but also a 
larger file size. 
 

Mode 
• Constant bit rate: The constant bit rate should only be used if the device used to 

play the video supports constant bit rates. 
• Variable bit rate: The bit rate varies. For faster movements in the video, the bit 

rate increases, and for still images or slow pans, a lower bit rate is sufficient for 
creating the video in constant quality. 

• Constant quality: Similar to the "Variable bit rate" mode, the bit rate varies 
according to the video material. The quality depends on the selected profile and 
can be changed. 

• Constant quantizer: In this mode, a fixed colour quantization is used for the 
macro blocks. Under Advanced settings, a value between 1 and 32 can be set 
independent of the respective frame (I-Frame (view page 317), P-Frame, or B-
Frame (view page 319)). The higher the value, the stronger the quantization: 
small values produce qualitatively high-quality images and the data rate 
increases, and larger values produce a reduction in data, but the quality suffers. 

 

Bit rate (Bits/s) 
• In "Constant bit rate" mode: Exactly those values entered are applied to be able 

to calculate the size of the video precisely.  
• In "Variable bit rate" mode: The values entered here are applied to the video as 

an average as a guideline. The size of the video to be exported can only be 
approximated. 

 

Max. rate 
This is the maximum bit rate that should be present in the video stream, i.e. maximum 
number of bits that may be transferred to the decoder. 

Note: This option is only available in "Variable bit rate" mode. 

 

Pixel aspect ratio 
Specifies the page ratio of the individual image points (pixels). 
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Meaning: Different television norms and the standard pixel ratio. Select a setting and 
the results are displayed as "X" and "Y". 

X/Y: The actual pixel ratio. If under "Meaning" the setting "Custom" is selected, then 
a custom ratio can be set. 
 

GOP structure 

Max key interval 
Determines the maximum GOP (view page 317) length. High values mean improved 
compression. Lower values create stronger security protection and enable improved 
access to individual frames for processing the video. 
 

B-frames count 
The number of B-Frames (view page 319). Several applications, e.g. video 
conferences, require a setting of "0" for this, i.e. no B-Frames, in order to enable the 
shortest possible reaction times for transfer. 
 

Scene change detection 
If this option is activated the scenes will be detected during encoding, thus allowing 
you to insert an I frame (view page 317) after a scene change.  
 

Audio codec 
Under „Audio“, „AAC“ (view page 307) is preset. If you have chosen an AVCHD 
transport stream from the presets, "AC3 (Dolby Digital)" will be available. 
 

AAC 
AAC was developed by MPEG, the Moving Picture Experts Group (Dolby, Fraunhofer 
Institut für Integrierte Schaltungen in Erlangen, AT&T, Nokia, Sony) as an audio data 
compression process that was specified as a further development of MPEG-2 
Multichannel in the MPEG-2 standard.  

AAC is equally suitable for encoding general audio information and not especially 
optimized for certain types of audio material.  

AAC audio can be encoded with a sample rate of 8000, 16000, 24000, 32000 or 
48000 Hz in either mono or stereo. By default, the sound is set to 48000 Hz stereo. 
The higher the sample rate is, the larger the resulting file and higher the audio quality. 
You can use the technical specifications of your playback device to help with this. 

Advanced audio settings: 

• The bit rate can be set between 6 and 512 kbit/s. 160 kbits/s is active by default. 
The higher the value is, the larger the resulting file and higher the audio quality. 
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After a certain limit, additional improvements to audio quality will not be 
perceived. Bit rates under 64 kb/s are not recommended. 

• As an MPEG version, set MPEG-4 or the older, proven MPEG-2 format. 
• For the File Header Type, choose either RAW or ADTS. The "Header" indicates 

an explanatory head for the beginning of the file segment, which in fact takes up 
extra space, but is required for decoding under circumstances. 

- RAW indicates material which does not include a file header in audio format. 
The audio material is therefore transferred directly without any special 
additional information (raw). 
This requires that decoding routines are able to process the material without 
the explanatory file header. Especially in case "exotic" sample rates are set, 
this can lead to problems during RAW encoding. 

- ADTS indicates a file header type which contains information for encoded 
audio material. In case of doubt, select this file header type, since fewer 
problems can be expected in this case. 

 
Profiles:  

• Low complexity: Data is present in a form that hinders different decoding 
algorithms (noise replacement), but enables others (temporal adjustment noise 
formation). 

Note: For example, Apple iPod requires "low complexity encoding". However, you 
don't need to worry if you select the right preset for Apple iPod in the export dialog. 

 

AC3 
If you have chosen an AVCHD, AVCHD transport stream or Blu-ray (H.264) from the 
presets, "AC3 (Dolby Digital)" will be available. 

Note: AC3 (Dolby Digital) Surround is only available in the PLUS and Pro versions of 
Video deluxe. 
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Multiplexer 
The Multiplexer combines audio and video streams so they can be played back 
together on playback devices. 
 

Output format 
MPEG-4 file: This is an MPEG standard (ISO/IEC-14496) with the original goal of 
supporting devices with less computing performance. Currently, MPEG-4 has reached 
a wide bandwidth of application, from HD video to support for mobile telephones. 

JPEG2000 file: DCI (Digital Cinema Initiative) has been replaced by the JPEG2000 
format for encoding movies. The current distribution and presentation of films has 
been taken over by digital projectors that play back high-resolution Mj2 streams in 
outstanding image and sound quality. 

3GPP file: A standard supported by plenty GSM and UMTS mobile telephones. 3GPP 
is very similar to the MPEG-4 standard, but also supports formats that are not 
permitted by MPEG-4. 
 

Streamable format 
Activate this option if you would like to create files that can be integrated into and 
played back on websites. This way the file can be played back without having to be 
completely preloaded. 

Note: This setting is recommended if you choose the option "Export as website". 

 

For Sony PSP 
Switch on this option if the video should be played back with the Sony PSP. 
 

For iPod 
Switch on this option, if the video should be played back with the Apple iPod. 
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Appendix: MPEG Encoder Settings 

General settings 
MPEG type: Set the output type of the created MPEG file. You can adjust the encoder 
settings freely (to export your video in the corresponding format, for instance) for 
further use in other programs or on your own website. 

If you open the encoder from a burn dialog, or intend to use the exported material for 
VCDs, SVCDs or DVDs, then select the corresponding option. This will adjust the 
settings of the encoder according to the standards required for the corresponding 
discs to be played in a compatible player.   

Video format: Automatically specifies the video format, aspect ratio, and frame rate 
(see video settings (view page 311)). You can choose between PAL or NTSC. 

Interlace mode: The movie is encoded interlaced (i.e. in two half-screens, so-called 
fields). This is essential for later playback on TV screens. If you want to view the 
exported movie on your PC only and like a "cinemascope" view, you can also encode 
by frame (progressively). Some video projectors also support playback of 
progressively encoded image material. See Interlace (view page 317). 

Bit rate: The bit rate determines the memory requirement by the completed video. 
The amount of data available can be used differently for different display modes. 20 
MB can be 4 seconds of DVD video, or 5 minutes of Internet streaming at the 
thumbnail size. The quality of an MPEG video is measured by the width of the created 
data stream, i.e. the bit rate. This is the amount of transmitted data per time unit and 
is indicated in kBit/s or bit per second.  

Quality: Determines the quality of the encoding process, or the quality of the 
movement (view page 315) to be more precise. The higher the quality, the better the 
finished video will look, but encoding will take considerably longer. The preset value 
"10" is a good compromise between speed and quality. 

Smart Rendering: Smart Rendering can considerably reduce the encoding/processing 
strain of MPEG files. The production of MPEG files re-encodes only those parts of the 
movie that were changed in the program (e.g. by video cleaning or effects). Please 
note: The MPEG files contained in the movie must have the same format, i.e. the bit 
rates (variable or constant), audio formats, image resolutions, and video formats must 
match. 

Quick, GOP-precise copying: This special Smart Rendering mode enables MPEG 
material to be transferred without having to encode it for the target medium, thereby 
greatly increasing the encoding speed. The video material cannot appear to have been 
altered in any way; only hard cuts (without fades) are permitted. These won't be 
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executed precisely to the frame, but will rather take place at the next GOP borders. 
For this reason, cuts should be set somewhat more generously. 

To burn DVDs in original 5.1 Surround Sound (Dolby Digital Audio) without having to 
re-encode, this option has to be activated. 

Allows you to rip the necessary settings from an existing MPEG file. This can be 
useful if you want to merge MPEG files together without re-rendering via Smart 
Rendering. 
 

Video settings 
Frame rate: PAL requires 25 frames/sec, NTSC 29.97 frames/sec. Please note: 
encoding NTSC material as PAL or vice versa may be possible; however, it will result 
in jittery images. 

Aspect ratio: Lets you set the image side or pixel ratio. With MPEG 2 the image 
format is displayed as image ratio; correspondingly there is 1:1 (square screen, not 
recommended), 4:3 (regular video) an 2.21:1 (cinemascope). This applies 
irrespectively of the selected video format. 

With MPEG 1 the pixel format is specified instead. There is 1:1, CIR601 (corresponds 
to regular video) for 625 lines = PAL and 525 lines = NTSC and the same in 16:9. 
When selecting the output format Video CD the pixel format is automatically 
adjusted to the selected video format. Use with caution, even if you only want to 
export MPEG 1. 

The option Auto is set as default. Here you can adjust the Movie settings (view page 
252) accordingly.   

Resolution: Width and height of the video corresponds with the settings in the export 
dialog. 

GOP structure: Here you can change the settings of the GOP (view page 317) 
sequence, i.e. the number of P frames per I frame within a GOP. Please note that the 
total length of the GOP must not exceed 15 frames, which corresponds to the default 
setting (1 I frame + 4 P frames + 5*2 B frames = 15 frames).   

However, you can reduce the length of the GOP sequence (while compromising the 
image quality at the same bit rate). This speeds up the encoding process considerably 
as the motion estimation while encoding P and B frames requires high CPU 
performance. The speed of decoding, i.e. playback, is also increased. 

If I frame is set to 1, each frame is an I frame. If the value is set larger, the setting 
describes the total length of the GOP. 

Auto GOP: Closed GOPs do not contain relations to frames from subsequent GOPs. 
MPEGs where all GOPs are closed, make MPEG editing easier as the I frames only can 
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be edited alone if the GOP is closed. Auto GOP closes GOPs at scene changes, 
whereby two different and complex procedures ("fast" and "VSCD") are used. 

Bit rate mode 

In "constant bit rate" mode a bit rate that constantly remains the same is used. This 
option should be used for Video CDs, as it is only required here. With a constant bit 
rate the full power of MPEG compression can not be used properly as bandwidth for 
non-moving scenes is lost. 

"Variable bit rate" mode attempts to adjust the available storage space to the 
requirements of the video you want to encode. The actual bit rate fluctuates around a 
mean value. During calm sections of the video it may drop to a minimum value, if 
there are movements in the scene it may rise to the maximum value. There are two 
different regulation processes (mode 1 and mode 128). 
 

Advanced video settings 
MPEG profile and level: The MPEG-2 standard defines so-called "profiles" and 
"levels". For creating SVCDs and DVDs you can use "Main profile and Main level". 
The high profile adds additional properties to the data stream like the option to 
display an image at a reduced resolution for restricted transmission quality (SNR-
scalable profile), or locally scaled, for instance an HDTV data stream on a standard 
TV set. The 4:2:2 profile is used if the image data is to be encoded for alternative 
chroma scanning. However, these profiles are supported by very few encoders, and 
mainly only for professional use.  

These levels define the restrictions to the image resolution and the maximum data 
rate. Low level can only reach a reduced resolution (352x2888 = CIF); high level, or 
High 1440, enables encoding in HDTV format. 

Estimate movement: These parameters are controlled via the quality controller (see 
General Settings). 

Other 

Noise sensitivity: This factor defines how sensitive the encoder will react to noise in 
the source material. If the source material only contains a little noise (digital 
recordings, computer animations, or material already de-noised by video cleaning), 
then you don't have to change the default value 4, or you can even reduce to increase 
the quality further. However, if you want to encode noisy material, then too low of a 
factor will considerably increase the encoding time at the cost of quality. For an 
unedited analog video you can increase the factor to 8-14. 

Noise reduction (click on noise sensitivity): A noise filter is used with adjustable 
settings from 1-31. 
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Advanced parameters 

Additional expert settings are available in the tree to the right of the window. These 
should only be changed by experienced users. They have been optimized for general 
applications to such an extent that changes are only necessary in exceptional cases.  
 

Audio settings 
Audio Type: You can use MPEG -1/-2, PCM (WAV), or Dolby® Digital. You can also 
select "No audio" in the export dialog.   

Sample rate: You can set a sample rate of 32, 44.1 or 48 kHz for the audio track. 
VCDs and SVCDs require 44.1 kHz, DVDs require 48 kHz. To reduce the size of audio 
data it is recommended to lower the bit rate instead of the sample rate. 

Mode: You can use mono, stereo, joint stereo, or dual channel. If audio type "Dolby® 
Digital" is  used, then "5.1 Surround" mode may also be selected.  

• Dual channel enables encoding of two mono tracks (e.g. different language sound 
tracks) that can be switched during playback.  

• Joint stereo is an optimized stereo encoder which takes advantage of the fact that 
the signal of both stereo channels is largely identical. Use joint stereo if you can 
only use small audio bit rates, but still require a stereo signal. 

• 5.1 Surround is available only for surround projects for burning DVDs. During this 
process, all 6 surround channels in the audio stream are encoded. 

Note!  For Surround projects "Dolby® Digital" should be selected under "Audio type", 
and "5.1 Surround" under "Mode".  

Bit rate: Here you can set the audio signal bit rate. The higher the bit rate, the better 
the playback quality. VCD requires 224 kBit/s, and for SVCDs and DVDs select a 
value between 384 kBit/s and 448 kBit/s. 
 

Dolby® Digital Details 

Hint: These functions are available only in the "5.1 Surround" mode. 

Dialog normalization: Set the dB level of spoken dialog. This value will be used to 
adjust the total volume of DVD movies and different programs that can be received 
by the DVB. To do this, you must first measure the volume of spoken dialogs in your 
movies. The values 1-31 correspond to volume levels of -1 to -31 dB.  
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Hint: Use the mixer's peakmeter to set the volume level. This process produces only 
approximate results, because the exact measurement requires a mean value and 
this cannot be easily measured with MAGIX Movie Edit Pro 2013. 

The displayed value serves also as a reference value for "Dynamic Range Control". 
Some areas are softer so that speech can be made louder, and louder areas will be 
made softer to avoid overmodulations. 

Background: Action-filled movies have larger volume differences between spoken 
dialogs and loud scenes (during explosions, for example). Because of this dialogs are 
softer than in quieter films which can be modulated higher. 

Surround mix level / Center mix level:  These settings lead to an additional damping 
of the surround channels and the central channel. Usually both settings are set to -3 
dB. 

LFE channel: Switch off the LFE channel (Low Frequency Effect), e.g. if you want to 
eliminate undesirable rumbling sounds in the low frequency range. Normally, you 
should leave this option activated. 

LFE filter: The LFE filter is a low pass filter, which lets through only the lowest 
frequencies. If you are dubbing a project in Samplitude/Sequoia, and have applied the 
LFE filter, you can switch off this function here, since this filtering has already been 
accomplished. 
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MPEG glossary 

Motion estimation 
Motion estimation is a further element for reducing data used in MPEG encoding.  

Motion estimation also occurs in the B and P frames. The image difference that still 
exist after prediction (view page 319) are examined. Complex algorithms are used to 
search for an original occurrence of the macro block in the reference frame of each 
macro block of the P or B frame (these are units of 2x2 blocks specially combined for 
this purpose), which have been moved either by movement or by camera pan. They 
can then be left out in the P and B frame. Only the information by how far and to 
where the macro block has been moved is saved instead. This vector is called the 
motion detector. 

In the General encoder settings (view page 310), you can specify the quality of the 
final MPEG video. This factor also influences the time required for encoding. The 
longer it takes, the better the quality. 
 

Bit rate 
MPEG is a format used for storage and transferring. With older formats (e.g. AVI) you 
could predict that 20 seconds of movie would result in 20 MB of data. The file size is 
this a direct measurement of quality.  

This is different for MPEG: The amount of data available can be used differently for 
different display modes. 20 MB can be 4 seconds of DVD Video or 5 minutes Internet 
streaming in thumbnail format. The quality of an MPEG video is measured by the 
width of the created data stream, the bit rate. This is the amount of the transmitted 
data per time unit; it is stated in kBit/s or bit per second. 

Bits, not bytes are used, since the data word width has to address the transmission 
restrictions. 

The file size can be calculated from the average bit rate, if its length is known: 

F = (BRV + BRA) * t 

F=File size BRV= 
Video bit rate 

BRA= 
Audio bit rate 

t=Length in s 
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Block 
For almost all image file editing techniques the image is subdivided into 8 x 8 pixel 
blocks (image points). This should be noted if you would like to used user-defined 
image resolutions (width/height), and they should always be a multiple of 8. 
 

Chroma format 
The color value of each image point consists of the color values for the primary colors 
red, green, and blue (RGB), and for traditional and technical reasons it is transformed 
into one brightness value (Y = 0.299*R = 0.587*G + 0.114*B) and two color 
difference values (U = R - Y, V = G -Y). 

The Y value alone produces the black and white picture. These signal components 
allow brightness and color information to be handled separately. The first data 
reduction occurs  when single rows comprising a picture are read. Because the human 
eye has a lower color resolution than a brightness resolution, the color components 
are recorded only for every other point of a row (4:2:2) for each four pixels grouped 
(4:1:0), i.e. color signal under-reading. 

4:2:2 This corresponds to the established TV standard. One piece of color information 
is transmitted per row for two pixels which corresponds to a 2/3 compression of the 
output data. 

4:1:0  This is the color coding used for DVDs and most other consumer video 
applications. For each 4 pixels grouped together on two rows, one unit of color 
information is saved. This corresponds to a output data compression of 1/2. 
 

Field 
A half-image, i.e. two halves which combine to produce a frame (see de-interlacing 
(view page 317)).  
 

Frame 
A frame is a single image from a video sequence which also called a full image. PAL 
video, for example, contains 25 frames per second, NTSC 29.97 frames.  

Video recordings, with the exception of computer animations and still frames, don't 
contain full images. Instead, they have double numbers of half-images (fields) which 
are transmitted in an interlaced state. However, we still refer to frames, since many 
predecessors of MPEG compression are based on such frames. Video editing 
literature usually refers to frames. 
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GOP 
Group of Pictures: The sequence of I frames and the P and B frames that belong to 
them. 

e.g. I B B P B B P B B I ... 

(This GOP has a length of 9, with 2 P frames and 2 B frames) 

I frames contain the entire image information of a frame, while P and B have part of 
the information. So-called prediction (view page 319) and movement approximation 
are methods used for reduction. 

The combination P B B is called a subgroup. 

I frames must appear in regular intervals in the data stream for image and sound to be 
synchronized. Between the I frames only a limited count of P and B frames is allowed. 
This explains a few things: Since P and B frames contain only differential information, 
these differences will be larger with time, since more and more changes takes place 
from frame to frame. A large count does not make much sense, since GOP has a 
maximum length of 15 (4P, 2B) in PAL and 18 (5P, 2B) in NTSC. (More than 2 B 
frames between P frames is not allowed). 

In a closed GOP, B frames of the last subgroup may contain only backward 
predictions or references to the preceding P frame, but no references to the following I 
frame, since it belongs to the next GOP. 
 

I frames 
Intra-frames: In these pictures, the entire image information of a frame is saved and 
only information from this frame is used ("intra-frame encoded"). In contrast to the I 
frame, P and B frames save only the differences between the current frame, and 
preceding and/or following frame are also found in MPEG video (P frame = "predicted 
frame", B frame = "bidirectional frame", see Prediction (view page 319)). 
 

Interlace 
For historical reasons, pictures in a movie are always recorded and transmitted in the 
form of two fields, first the lines with even numbers and then those with odd 
numbers. These fields are alternatively displayed with a double-frame rate. The (lazy) 
eye of the viewer or the processing of the TV tube puts the two frames together to 
form one. 
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The output image First field Second field 

You normally don’t have to worry about field processing. The video material goes 
through the entire processing chain as fields and is exported again as fields or burned 
onto DVD or shown on TV when played back on a DVD as a full picture. Only in 
certain rare conditions is it necessary to delve deeper into this process. Two problems 
can occur: 

Interlace artifacts 
To be displayed on a computer monitor the two fields must be combined to form a 
full screen.  

These two fields are not the same, since two fields are created during the recording 
(between which a 1/50 of a second gap is evident). Moving objects can therefore 
produce artifacts at the vertical edges. 

  

Typical interlacing errors 

You can use so-called "de-interlacing" to avoid these artifacts. A picture in between 
the two fields is created (interpolated). So if you want to create stationary pictures 
from movies, then you should definitely use a de-interlace filter. 

In the system settings (File menu-> Program settings (More information can be found 
in the section "Folder" on page 58)) you can set the preview monitor display to use 
hardware de-interlacing during video recordings, for the video recorder, and for 
display in the arranger. 

Incorrect field rate 
If you move around the series of fields in a movie data stream you can see strong jitter 
and flicker effects. Picture objects move in a backward movement - two steps 
forwards, one back - since a delayed field is shown before the previous one. This can 
happen in the processing chain if you export video material improperly with the wrong 
field order and then import it into different material.  

We use MXV or MPEG "Top field first" format for all analog recordings ("odd" in 
other programs). DV-AVI on the other hand is saved with “Bottom Field First”.  
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You can correct the field series for each video object in its object settings. See: Menu 
-> Effects -> Object properties 
 

P frames and B frames 
P frames save only the difference between the current picture and the preceding I 
frame. The "P" comes from the term "prediction" which describes this process. 

B frames save the differences between the current picture and the I or P frame 
preceding and following. This includes the information that was the same before and 
remained the same after the current frame. Both directions are analyzed (indicates 
the "B" in the name, i.e. "bidirectional-predicted"). You can read more under 
prediction (view page 319). 
 

Prediction 
Prediction is a method of data reduction used by the MPEG format. The image 
elements already known from the previous or following frames are removed from the 
data stream. 

How does it work? 
The encoder has a precisely defined GOP, for example IBBPBBPBB. This sequence is 
transmitted together with the encoder, which always knows exactly which kind of 
frame comes next. I, P, and B frames are differentiated. 

Hint: When we talk about pictures, we mean frames of the video output, and I, P an 
dB frames are the frames of the encoded video. Just as in movement approximation, 
blocks (8x8 pixels) are united into macroblocks (16x16 pixels) during prediction. 

The first frame is always the I frame. It is completely encoded from the first picture. 
Afterwards, the 4th picture is analyzed for the creation of the first P frame. (As 
already said, the encoder, and later the decoder, will know that two B frames belong 
between them.) This image will also be completely encoded, and afterwards all 
macroblocks that haven't changed in comparison to the I frame will be deleted. They 
will be replaced by corresponding references for the decoder that tell it "you already 
know what should be shown here, and you can get it from the last I frame". 

Now, the 2nd will be completely encoded, and all macroblocks identical to the first I 
frame and the following P frame will be removed. References to previous frames  are 
called backward predictions, and references to following frames are called forward 
predictions. The third picture will be edited in exactly the same fashion. 

The fourth picture we have already explained, and now we need the next P frame, or 
picture number 7. Pictures 5 and 6 are B frames again, which are compared to P 
frames to both sides of them (picture 4 and 7); these are followed by the last two B 
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frames. These have a special place, since in closed GOPs, they may contain only 
backward predictions, and no references to the next I frame, because it belongs to 
the next GOP. 

Something else: Since the decoder is no prophet, the P frames are always transmitted 
before the B frames! The GOP explained above will be encoded and transmitted in the 
order it is written. 

Original 
GOP 

I0 B01 B02 P01 B11 B12 P02 B21 B22 I1  

Data stream I0 P01 B01 B02 P02 B11 B12 B21 B22 I1 ...  for closed GOPs 

 I0 P01 B01 B02 P02 B11 B12 I1 B21 B22 P11...  For open GOPs 

Due to this nested structure, it is easy to see that during direct editing of MPEG 
material, complicated computations have to take place! These are made easier using 
a frame table. A frame table contains a list, where the information of every frame in 
the data stream is found, identifying the type of frame it is.  

Using Movement prediction (view page 315) P and B frames are likewise reduced. 
 

Quantization scaling 
The single pictures in MPEG are saved using a compression method comparable to 
JPEG with bitmaps and associated with quality loss. For this single images are divided 
into 8 x 8 blocks (view page 316). 

Each one of these blocks is then transformed into an 8 x 8 matrix (a table with rows 
and columns) using a DCT (discreet cosinus transformation) mathematical method. 
Each of these values is produced using all 64 individual pixels of the block, but the 
values in the matrix are ordered in such a way that the image information is ordered 
according to its importance. 

This matrix will then be multiplied by another matrix, i.e. the quantization matrix. 
Exactly how and why this matrix must be created is the biggest secret of encoder 
programmers, since this determines the quality of the whole encoding process. What 
is known is that the result should contain as many zeros as possible! These zeros 
correspond to the "unimportant" image elements mentioned and will not be 
transmitted in the data stream. 

Depending on the encoder parameters regarding the target bit rate, fewer or more 
values of the matrix will be declared unimportant by dividing the quantization matrix 
by the quantization scaling factor. Since only whole numbers are used, a division can 
produce a zero is the remainder is discarded. 

This factor is also a direct measure of the sought image quality of the MPEG data 
stream, since the "Q" in "Q" factor stands for quantization and quality. 
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Glossary 

Symbols & Numeric 
720p 
This is the "small" HD resolution, which is sized at 1280 pixels x 720 pixels. The "p" 
stands for "progressive", i.e. full images are always displayed. 
 

A 
Aliasing 
Aliasing, or alias effects, are mistakes that appear during digital scanning of sounds, 
videos or images when the sample frequency (in audio editing) or resolution (in video 
editing) used are too low. 
 

ATN: 
This abbreviation stands for "Absolute Track Number". Which is the actual time code 
of DV and HDV recordings recorded using the helical scan method.   
 

Audio 
This is then referred to as "audio" when the sound signal is saved directly as such on 
the PC. The actual sound is recorded or played back here. 
 

audioid 
audioid is a process used to determine the title and artist name base on musical 
properties. An Internet connection is required to access the audioid database. 
 

AVCHD 
Stands for "Advanced Video Codec Definition". It is an HD format for video cameras 
which has been developed by Panasonic and SONY. In comparison to the HDV 
format, a meaningful quality improvement can be seen here. 

For the video recording MPEG 4 AVC/H.264, and for audio recording Dolby® Digital 
or Linear PCM are used. The maximum bit rate is 25 Megabits/sec. 
 

AVI 
The AVI format (Audio Video Interleaved) isn't actually a proper video format! 
Rather, it is a so-called "container" for which the conventions for transferring audio 
and video files to the program are only loosely defined. More in this topic can be 
found in General notes on AVI videos. (view page 293) 
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B 
Backup disc 
Copying of files to a different file storage medium to secure these files is called 
backing up, or creating a backup. 
 

Browser 
A browser (also known as web browser, or Internet browser) is a computer program 
that displays websites. The best-known browsers are Internet Explorer, Firefox, Safari, 
and Opera. 
 

Button 
Refers to an element of the graphic user interface of a program. The button initiates 
an action in the program via left mouse click. 
 

Button 
Refers to an element of the graphic user interface of a program. The button initiates 
an action in the program via left mouse click. 
 

C 
Cache 
Simply stated, this is a temporary folder where frequently accessed files are saved so 
that they can be quickly launched while you are working. 
 

CC 
CC stands for "Connectivity Co-ordination" and describes how the change of a 
domain name from one provider to another occurs (domain transfer). 
 

Clip level 
Signifies the volume level at which the recorded signal is overmodulated, or "clipped". 
 

Clipboard 
The clipboard is used to temporarily store objects during execution of commands like 
"copy" and "cut". 
 

Clipboard 
The clipboard is used to temporarily store objects during execution of commands like 
"copy" and "cut". 
 

Compatible 
Different devices are compatible with each other if they operate together without any 
errors occurring. 
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Context menu 
Context menu can be reached by right clicking on a selected object. It offers functions 
which are available and can be expected in the given context. 
 

Copyright 
Protection of intellectual and creative property against unauthorized copying. 
 

Copyright 
Protection of intellectual and creative property against unauthorized copying. 
 

CPU 
Central processing unit: The name for the main processor of the computer (CPU). 
Modern computers have even two or more processors, or one processor with several 
cores.  
 

Crossfade 
Transitions, crossfades. Can be used to fade between objects. 
 

D 
Dialog 
A dialog opens in a new window and lets the user interact with the program. This 
means that the dialog can present information to the user and/or expects to receive 
input from the user. 

A dialog can contain various user elements which can be manipulated by a simple 
mouse click. Keyboard entries are also possible. 
 

Disc project 
A "Disc project" includes everything that you want to put on your CD and DVD.  

This normally contains one or more movies and includes a menu structure/menu 
design which allows you to choose a movie later on the CD or DVD. 
 

Disc types 
The disc types determines the format and medium (CD, DVD, Blu-ray disc, etc.) to 
which the current project will be burned. 
 

DNS 
The abbreviation DNS stands for Domain Name Service and refers to a provider of 
Internet services that registers domain names for customers. 
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Domain 
A domain is the website's Internet address. It consists of the name of the Internet 
protocol (usually http://), the computer or network name (such as www), the 
second-level domain (such as magix), and the top level domain (like .com, .net). 

Altogether we have: protocol://networkname.second-level-domain.top-level-domain 
(such as "http://www.magix.com"). 

Domains are allocated by a country's so-called NIC (Network Information Center). In 
Germany the DENIC is responsible for the release of domains. 
 

Domain transfer 
See CC. If you already have a domain, you can move it from your previous provider to 
another provider. 
 

Downmix 
A method developed for audio technology to turn a Surround Sound recording into a 
version with fewer channels. Most often (as is the case with MAGIX Movie Edit Pro 
2013) this will be a stereo version. 
 

Drag & drop 
Enables files and objects to be moved freely between various applications (or within 
an application) by dragging the object and letting it drop using the mouse cursor. 
 

F 
Fader 
Used for visual input of values. Similar to volume control on a mixing board, you can 
control various parameters by sliding the fader. A very common example for this is 
the zoom slider that lets you see a picture in more detail. 
 

Field 
A half-image, two of which combine to produce a frame (see interlace). 
 

Flip menu 
Drop down menus create menus consisting of lists of selectable choices. They look 
very similar to text input fields, but have a button with a downward-pointing symbol 
on the right-hand side. 
 

Frame 
A frame is a single image from a video sequence which also called a full image. 

A PAL video contains 25 frames per second; NTSC contains 29.97 frames. 
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H 
Handles 
Handles are the five little rectangles at the edges of selected objects. All curve points 
can be moved by holding down the left mouse button. 

Length handles: Bottom right and bottom left. You can use them to change the length 
of an object. 

Fade handles: Top right and top left. These can be used to softly fade an object in or 
out. 

Volume/Brightness handle: Above-center. You can use it to adjust the volume or the 
brightness. 
 

Hard disk 
Storage medium with the largest storage capacity where the operating system(s), 
programs, and files are saved. A hard disk can be built into the computer, but there 
are also external hard disks which can be used with different computers via a USB 
connection (portable drives or external hard disk). 
 

Hard disk drive 
Storage medium with the largest storage capacity where the operating system(s), 
programs, and files are saved. A hard disk can be built into the computer, but there 
are also external hard disks which can be used with different computers via a USB 
connection (portable drives or external hard disk). 
 

Hardware 
The all-encompassing name for all internal components of a computer. For example 
hard disk, graphics card, mainboard, etc. External peripheral devices are also 
considered hardware, i.e. printer, scanner, monitor, etc. The synchronization of single 
hardware components is coordinated by the software. 
 

HDD 
Storage medium with the largest storage capacity where the operating system(s), 
programs, and files are saved. A hard disk can be built into the computer, but there 
are also external hard disks which can be used with different computers via a USB 
connection (portable drives or external hard disk). 
 

HDTV 
This acronym stands for "High Definition Television. 
 

HTTP 
Stands for Hyper Text Transfer Protocol and is used for transferring websites onto the 
Internet (from web server to the browser). For this reason, the abbreviation http:// 
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always comes before the Internet address. This is automatically inserted and does not 
have to be entered when entering the Internet address. 
 

Hyperlink 
Hyperlinks (or in short "links") are references to other websites/online documents (or 
other computer networks). They build the base of the World Wide Web (WWW) as 
it is only via these hyperlinks that networking or interlinking between the billions of 
website out there is actually possible. 
 

I 
ID3 tags 
ID3 tags contain title information that can be added to a music title. This includes the 
title, artist, album, as well as the genre, year of release, and other criteria that can help 
searching through a database. The database is created using this information. 

Info: Title information will only be saved for MP3s in the so-called ID3 tags (Identify 
an MP3), but other formats offer similar possibilities, like "Vorbis comment" for the 
OGG Vorbis format, for example. 

 

Image 
An image is a representation of a CD, DVD, hard drive, or another storage medium 
that is saved as a file. 

The difference from a copy or backup is that an image contains information about the 
structure of the original storage medium, and not just individual files. This enables 
01:01 copies of complete storage media to be created. 

Caution! Copyright laws forbid copying of commercial CDs/DVDs, and for this 
reason, this process can be prohibited by copy protection. 

 

IMAP 
Stands for Internet Message Access Protocol and is an advanced process of receiving 
emails. 
 

Interlace 
Describes the creation of a full image from 2 half-images (fields). 

In this process, even and odd lines are alternately assigned to one of the two fields. 

The human eye perceives both of the projected half-images as a single full image, so 
that despite the slow image repetition rate (25 Hz for PAL, 29.97 for NTSC) a 
subjectively fluid image is seen. 
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Intro 
"Intro" means the introduction or opening credits of a movie. 
 

J 
jpx 
A format developed by MAGIX which is used for photo editing. It enables free 
experimentation with effects without altering the original file. The effects settings are 
also displayed when the photos are opened using a different MAGIX program. 
 

M 
Menu 
Menus contain practically all function of a program. They can be opened using a 
simple mouse click on the corresponding menu. Keyboard shortcuts, if available, are 
also found at the end of menu entries. 

The graphical surface of a CD/DVD will also be represented as a menu. 
 

Menu bar 
Almost every program has a menu bar. It can normally be found underneath the title 
line of the program. A simple mouse click opens a corresponding menu. 
 

MIDI 
MIDI files do not contain the actual sounds like audio files, but only the note control 
information which can be interpreted during playback by the synthesizer chip on the 
sound card or an external synthesizer. 
 

MMC 
MMC stands for MIDI Machine Control and is part of the MIDI protocol. Transport 
control and position data is conveyed using MMC. 
 

Motherboard 
This is the centerpiece of hardware components of a computer. All other hardware 
components like CPU, RAM, hard disk, additional drives, graphics cards, as well as 
other cards for specialized uses are connected to the motherboard.  
 

Motherboard 
This is the centerpiece of hardware components of a computer. All other hardware 
components like CPU, RAM, hard disk, additional drives, graphics cards, as well as 
other cards for specialized uses are connected to the motherboard.  
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Motherboard 
This is the centerpiece of hardware components of a computer. All other hardware 
components like CPU, RAM, hard disk, additional drives, graphics cards, as well as 
other cards for specialized uses are connected to the motherboard.  
 

MOV 
MOV is a video and audio format developed by Apple, which has since become 
widely used with Windows. QuickTime supports lots of compression technology, 
which make it possible to optimize audio and video and even graphics for the Internet 
and multimedia/video applications. Conventional (hardware) DVD players are not 
able to play this format. 
 

Movie 
In MAGIX Movie Edit Pro 2013, an arrangement of various objects (videos, photos, 
text, sound, etc.) is called a movie. A movie file has an "mvm" extension. 
 

MP3 
MP3 (actually MPEG-1 layer 3) is currently the most important standard for 
compressing audio files. 
 

MPEG 
MPEG is short for "Moving Picture Experts Group" and refers to a committee 
concerned with the standardization of video and audio data compression as well as 
container formats. 
 

MS audio 
A process developed by Microsoft for compressing audio files with properties similar 
to those of MP3. 
 

MTC 
MTC stands for MIDI Time Code and it transmits the exact playback position via 
MIDI. In this way, programs and devices can be synchronized with each other. 
 

MXV 
This is the MAGIX video format for quicker processing with MAGIX products. It 
offers very low loss of quality, but it cannot be played via conventional DVD players. 
 

N 
Noise Sample 
Sample of a noise that is to be removed 
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NTSC (USA, Japan) 
NTSC stands for "National Television Systems Committee". This is a US institution 
that defined the first color carrier system for TV which is now used in most of 
America and some East Asian countries. 

The image repetition rate for NTSC is 29.97 Hz. 
 

Numeric keypad 
Also known as the numpad, or the number block. 
 

O 
Offset 
With an offset of 60:00:00 (1 hour) you can, for example synchronize a tape whose 
time code that starts at 1 hour, MAGIX Movie Edit Pro 2013 however, still starts the 
tape beginning at 0.  
 

OGG VORBIS 
This is a new, royalty-free format with similar properties to MP3. 
 

P 
PAL (Europe) 
Phase Alternating Line, or PAL, is a process for color transmission for analog TV that 
is primarily used in Europe, but also in Australia, South America, and many African 
and Asian countries.  

The image repetition rate for PAL  is 25 Hz. 
 

Play marker 
The play marker is a red vertical line which moves from left to right during playback. It 
indicates the current play position.  
 

Playlist 
Arrange your songs in playlists from various sources in different formats and in 
whatever way you like, sometimes updated daily. 

Important: Playlists are only links to songs on your hard drive or in your CD drive.  

When you add a song to your playlist whose real source is a CD in your computer's 
drive, the song will no longer be playable when the CD is removed from the drive. 

Similarly, when you move a folder on your hard drive, the playlist will no longer be 
able to play the song, since the link is no longer valid.  
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For the latter, however, there is a simple solution: If you know where the song has 
been saved, then you can redefine the path. A corresponding dialog window is 
provided for this purpose. You can reset the path by navigating through the Explorer 
folders. The playlist is now correct once again.  
 

Plug-in 
Plug-ins are additional programs that expand the functionality of the main program. 
They are inserted into the main program. 
 

POP3 
Stands for Post Office Protocol (version 3) and is used in standard email programs for 
receiving email (for example, Outlook Express). POP3 enables email to be collected 
by the provider's email server and loaded into your email program. 
 

Project 
A "Disc project" includes everything that you want to put on your CD and DVD.   

This normally contains one or more movies and includes a menu structure/menu 
design which allows you to choose a movie later on the CD or DVD. 
 

Provider 
A provider or ISP (Internet Service Provider) offers Internet services like webhosting 
or domains (DNS). In relation to the MAGIX Website Service, MAGIX is the provider. 
 

R 
RAM (Random Access Memory) 
This is a hardware component of a computer. RAM is needed to temporarily save 
files. This type of storage is erased when the computer is shut down or reset. The 
larger this storage is, the faster you can work with programs to change and save files. 
 

Ratio: 
The aspect ratio is the ratio between the height and width of a rectangle. In practice 
these are photos, screens or projection screens. This method can also be used to 
describe the aspect ratio of pixels. 

Here are some examples of typical aspect ratios: at home 4:3, 16:9 (typical for TV 
sets), or 16:10 (widescreen flat screens, widescreen notebooks), 3:2 for 35 mm films 
and photos. In cinemas you mostly find 1.85:1 
 

Red Book 
Specific standards have been established for the different CD types in order to unify 
their data structure and to make them compatible with the different CD drives. Their 
names refer to the color of the books where these standards were written.   
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The term "Red Book" is common language for the Compact Disc Audio Standard. The 
requirements listed here have to be observed for industrial CP production. Audio CD 
players only read CDs created according to the Red Book format. It is therefore 
necessary to first convert PC files into this format before writing them onto an audio 
disc compatible with any audio CD player. 
 

Restore 
Restoration of files originating from a backup will be called "Restoring". 
 

RM 
RealMedia includes all of the media formats from software developer RealNetworks. 
RealMedia especially refers to the "RealVideo" video format and the "RealAudio" 
sound format. The quality of RealVideo files is comparably good at high compression 
rates, but does have some loss of quality. These formats cannot be played back by 
(hardware) DVD players. 
 

S 
Scene 
Freely definable section of a video in MAGIX Movie Edit Pro 2013. 

In general, a scene is a segment of a film that is a product of various settings and 
conveys a certain action. 
 

Screenshot 
A screenshot is an image composed of all visible screen elements (messages, open 
dialogs, etc.) at a certain time. By pressing the "Print screen" key on the keyboard, this 
image is saved into the clipboard. Next, open a program which can edit images and 
select "Insert" (shortcut "Ctrl+V") in a new document to add the screenshot for 
editing and saving. 

Note: Press "Alt + Print screen" on the keyboard to capture the active window only. 

 

Slider 
Used for visual input of values. Similar to volume control on a mixing board, you can 
control various parameters by sliding the fader. A very common example for this is 
the zoom slider that lets you see a picture in more detail. 
 

SMTP 
Stands for Simple Mail Transfer Protocol and enables the exchange of emails across 
computer networks. 
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Software 
The name for all non-physical functional components of a computer. This primarily 
includes computer programs and files that are meant to be used by computer 
programs. 
 

Storyboard mode 
The Storyboard mode is the default edit screen view. This view offers an easy, 
streamlined interface to simplify the editing process. The alternative Timeline mode 
offers a more detailed interface for more extensive editing and scene arrangements, 
the scene overview mode offers a complete overview of all scenes on a small scale. 
You can toggle between the three view modes using the Tab key. 
 

Submenu 
Besides normal entries, a menu can contain submenus that offer additional functions. 
This makes menus more comprehensive. 
 

Super Video CD (SVCD) 
The Super Video CD (SVCD) is a technological advancement of the video CD. SVCDs 
are also like VCD-specified CD-ROMs which can be played using either a Super 
Video CD player (connected to the television), or directly with the CD-ROM drive of a 
computer. Many DVD players can also play SVCDs. MPEG-2 and the increase of the 
data transfer rate  makes it hard to tell videos from videos in DVD quality apart. 

Resolution: SVCDs use the better MPEG-2 encoder in a standardized resolution of 
480 x 576 (PAL). The MPEG-2 format offers a maximum resolution of up to 720 x 
576 points and improved compression methods characterized by excellent image 
definition and homogeneity. 

Hard disk capacity: An average 90-minute movie must be spread across 3 CDs. On 
one SVCD you can get about 30 minutes of good-quality movie. 

Encoder setting: Compared to the VCD with 1.3, the data transfer rate is doubled to 
2.6 Mbit/s. 

MPEG-2 format introduces the so-called variable bit rate (VBR). In contrast to the 
constant bit rate (CBR) of the MPEG-1 encoders, this encoder has the option of using 
more bits for movement-intensive sections, as well as saving bits if picture content 
remains the same. 
 

T 
Toolbar 
Here you will find small buttons that provide a function when clicked. For example, 
you can cut out a selected object by clicking on the scissors. 
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Toolbar 
All basic functions of the corresponding program can be found here. The 
corresponding functions can be called up via mouse click. 
 

Top-level domain 
Top-level domains (TLD) are always those separated by a dot at the end of an 
Internet address (for example, "http://www.magix.com" < here, .com is the top-level 
domain). Among these are also country top-level domains, such as .co.uk, .us, .de as 
well as so-called generic top-level domains like .net, .org, .biz, and so on. 
 

Traffic 
Traffic (data transmission) occurs within your MAGIX Website Service as soon as 
data is transferred across the Internet: for example, when uploading or downloading 
files to your website or when someone else opens your website. 
 

U 
Universal Plug & Play; UPnP 
Universal Plug ‘n’ Play (UPnP) is a network protocol which enables data exchange 
between different devices (PCs, hi-fi systems, video cameras, PDAs, and webservers). 
UPnP allows various devices to participate in network-wide communication, i.e. the 
initialization of functions and other device functions. Long-winded configuring or 
installing of drivers is not required as the devices can handle their own functions and 
data sources by themselves. Find out more at www.upnp.org. 

Hint: To work with UPnP you have to activate it first. This can be found under 
"Options" ("Y" -> UPnP).  

 

URL 
URL stands for Uniform Resource Locator and describes where a source can be found 
online (for example, a website). The address or the path to the storage location of a 
file on your computer is known as a URL. Often the term URL is used as a term for the 
domain. The URL for the MAGIX website is: http://www.magix.co.uk 
 

V 
VirtualDub plug-in 
Plug-ins are additional programs that expand the functionality of the main program. 
They are inserted into the main program. 

VirtualDub plug-ins are also referred to "VirtualDub filters" and have the "VDF" file 
extension. You can use them to apply additional video effects to video objects. 
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VST and DirectX plug-ins 
Plug-ins are additional programs that expand the functionality of the main program. 
They are inserted into the main program. 

Two standards exist for audio editing: VST (Steinberg) and DirectX (Microsoft). VST 
has asserted itself stronger in the current market.  
 

W 
WAV 
Wave (*.WAV) is a standard uncompressed audio format. 
 

Wave 
Wave (*.WAV) is a standard uncompressed audio format. 
 

Wave file 
Wave (*.WAV) is a standard uncompressed audio format. 
 

Webhosting 
This means that an Internet Service Provider makes domains and webspace available 
to its customers. With the MAGIX Website Service, MAGIX provides webhosting to 
its customers. 
 

Webmail 
Webmail enables the customer to view and receive the contents of their email inbox 
without having to install email software on their computer. Customers of the MAGIX 
Website Service can use MAGIX Webmail for this. 
 

Webmaster 
A webmaster is responsible for the administration and maintenance of a website. 
Often, the webmaster is also the owner of the website as well as the domain that 
belongs to it. Once you have registered a domain in the MAGIX Website Service, an 
email account will automatically be set up, for example: 
"mailto:webmaster@domainname.co.uk". 
 

Webserver 
Webserver refers to the computer on which your host saves your website's pages and 
which makes your pages accessible on the Internet 24-hours a day. 
 

WMA 
A process developed by Microsoft for compressing audio files with properties similar 
to those of MP3. 
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WMV 
Windows Media Video (WMV) is a trademark video codec from Microsoft. If you 
have Windows installed on your PC, then playing WMV files shouldn't be a problem. 
Only a few (hardware) DVD players are able to play this format. Read more about this 
in your DVD player's manual. 

This video format is very good for web videos as it allows relatively high compression 
rates. 
 

World Wide Web (WWW) 
WWW stands for "World Wide Web" and is the most used service of the Internet. 
On the WWW, web browsers (for example, Internet Explorer) are used to display 
information via websites. The process is colloquially called "Surfing the Internet". 
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If you still have questions 

Tips for program help 
The "Help" file features hints on how to use the program and additional information. 
Many important terms are indicated in the text in italics and clicking on them displays 
an explanation. 

Context help: Press the "F1" key at any point in the opened program and the help file 
will open with the matching topic (context help). 

Search function: Use the search function to find out information about specific words. 
Enter either the individual word or use logical operators (OR, AND, NEAR) to refine 
your search if you have several search words. 

• "OR" (between two words): All topics which contain both words or one of the 
words will be listed. 

• "AND" (between two words): Only those topics will be listed which contain both 
words. 

• "NEAR" (between two words): Only those topics will be listed which contain both 
words. A maximum of six other words may be added between the search terms. 

• "NOT" (before a word): Topics which contain this word will not be listed. 

Print: Use the help program's print function to make a printout of individual topics or 
entire sections. The print button is located at the top of the help window in the 
toolbar. 
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